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Imaging Controls

You can select which controls you want to be available via the 
Touch Panel during a clinical scan. When you select Preset--> 
Application and Control Mode--> Clinical, deselect the controls 
you DO NOT want to appear while scanning in this clinical 
application.

NOTE: If you select Research, all controls appear. 

Figure 10-33. Imaging Controls
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Imaging Controls  (continued)

Clinical vs. Research Touch Panel Example

Figure 10-34. Clinical Control Mode - example

Figure 10-35. Research Control Mode - example
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Comments and Body Patterns

Comments and Body Patterns were described earlier in this 
chapter.

Measurements

You can set the exam category measurement and calculation 
package you want to appear when you select the exam category 
Preset. 

 Figure 10-36. Application Measurements Menu
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User Specific

Refer to Chapter 3 “Monitor Display” for detail.
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3D/4D

Overview

3D/4D presets allow you to set up application-specific settings 
(presets) for each 4D image acquisition type. You can define 
different application-specific settings for each probe. Refer to 
Chapter 5 for more information. 

4D Presets

To set up 4D presets:

1. On the Touch Panel, select Utility.

2. On the Touch Panel, select 3D/4D.

The system displays the 4D Presets screen.

3. To select a probe, click on the plus sign (+) that appears 
next to the desired probe.

4. To select the application, click on the plus sign (+) that 
appears next to the desired application.

5. To select the acquisition type, click on the plus sign (+) that 
appears next to the desired application.

6. Double-click the desired application under the acquisition 
type. The Display tab is selected.
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4D Presets  (continued)

Figure 10-37. Display Preset Parameter

Table 10-67:  Image Display

Preset Parameter Description

Tile Determines the number of display windows. Values include: 1 (Single), 2 
(Dual), and 4 (Quad).

Visualization Determines the method of display for working with images. Selections 
available: Sectional, Render, VOCAL, VCI static and TUI.

3D Orientation (degrees) Determines the orientation of the ROI on the monitor display. Values include: 
0, 90, 180, 270.

Zoom Factor Determines the magnification factor of the zoom. Values include: 0.3 through 
4.0, in .01 increments.

Orientation Help Activate Orientation Help. 

Gain Set he desired Gain

Table 10-68:  Pre-mode ROI

Preset Parameter Description

ROI Center (cm) Determines the vertical center of the region of interest. Values vary by probe.

ROI Span (cm) Determines the height of the region of interest. Values vary by probe.

Tilt (degrees) Determines the degree of tilt from the vertical center location of the ROI. 
Values vary by probe. 

Width (degrees) Determines the width of the ROI. Values vary by probe. 

Volume Angle Set the range of the volume sweep. Values vary by probe. Listed in degrees 
for curved probes, cm for linear probes.
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Table 10-69:  Quality Setting

Preset Parameter Description

Setting Set quality setting -- balances speed with line density. Selections are Low, 
Mid1, Mid2, Hi1, Hi2, Max. High combines the highest density with the 
slowest speed. Low combines the lowest density with the highest speed. 

CF Setting Set quality setting -- balances speed with line density. Selections are Low, 
Mid1, Mid2, Hi1, Hi2. High combines the highest density with the slowest 
speed. Low combines the lowest density with the highest speed.
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Render Tab

Figure 10-38. Render tab

Table 10-70:  Render and Render for VCI Static

Preset Parameter Description

Render Mode 1:Mode2 
(Gray Inversion, and VCI 
Static)

Set render mode values. Surface Smooth, Surface Texture, Transp Max, 
Transp X-Ray, TransMin (Render 1) or Fetoscopic. Surface Smooth, Light, 
Gradient Light, Transp Max, Transp X-Ray, Transp Min (Render 2), or 
FetoSmooth. 

Mix/Mix Inversion/eMixVCI 
Static (% Render Mode 2)

Set mix of Render 1 / Render 2 Mode, 0-100. 

Lower Threshold Set a lower threshold below which weaker echoes are removed, 0-255. 

Transparency/ 
Transparency (Inversion)

Set the transparence of the image, 10/20-250. The higher the number, the 
more transparent the gray scale information.

Render Direction Set the direction in which the ROI is viewed. 

SonoRenderLive Check to use SonoRenderLive.

SonoRenderLive 
Sensitivity

Set the SonoRenderLive sensitivity from 1-100.

[VCI Static] Slice 
Thickness

Set slice thickness, 3-20. 
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Color / PDI Render tab

Figure 10-39. Color / PDI tab

Table 10-71:  Color / PDI Render

Preset Parameter Description

Render Mode 1 : Mode 2 
(Color)

Determine the render mode, selected from Render Mode 1 and Render Mode 
2.

Mix (Color) Set the percentage of Render Mode 1 to be mixed with Render Mode 2. 

Lower Threshold (Color) Set the lower threshold below which weaker echoes are removed. 

Transparency (Color) Determine the transparency of the image. The higher the number, the more 
transparent the gray scale information. Values: 20 to 255.

Render Gray: Color 
(GlassBody)

Determine the render mode, selected from Render Mode 1 and Render Mode 
2.

Mix (GlassBody) Set the percentage of Render Mode 1 to be mixed with Render Mode 2.
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Orientation Markers tab

Figure 10-40. Orientation Markers tab

Table 10-72:  Orientation Markers

Preset Parameter Description

Initial Body Position Set Head, Feet, Front, or Back

Body Rotation (degrees) Set 0, 45, 90, 135, 180, 225, 270, or 315. 

Probe Rotation (degrees) Set 0, 45, 90, 135, or 180. 

Probe Tilt (degrees) Set 0, 45, 90, 135, or 180. 

Probe Position Horizontal 
(0-Left;100-Right)

Set 0-100. 

Probe Position Vertical 
(0-Top;100-Bottom)

Set 0-100. 
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VOCAL tab

Figure 10-41. Vocal tab

Table 10-73:  VOCAL

Preset Parameter Description

Vocal Method Set Sphere, Manual, Contour Detect, or Semi-Auto Contour Detect. 

Vocal Semi-Auto-Detect 
type

Set Hypo, Cystic, or Hyper/Iso. 

Vocal Rotation step Set 6, 9, 15, or 30. 
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TUI tab

Figure 10-42. TUI tab

Table 10-74:  TUI

Preset Parameter Description

Display Format Set 1x1, 1x2, 2x2, or 3x3. 

Total Slices Set 3, 5, 7, 9, 11, 13, 15, 17, or 19. 

Slice Distance (mm) Set 0.5-10 (0.1 step increments). 
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Advanced tab

Figure 10-43. Advanced tab

Table 10-75:  Advanced

Preset Parameter Description

Upper Threshold Sets the higher threshold above which weaker echoes are removed. 

Volume Calibration Shift See a Field Service Engineer for information on this parameter.
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Configuring Connectivity

Overview

You use Connectivity functionality to set up the connection and 
communication protocols for the ultrasound system. The 
following page gives an overview of each of the Connectivity 
functions. Each function is described in detail in the following 
pages. 

About Wireless LAN and DICOM, see Chapter 13.
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Connectivity Functions

To set up your institution’s connectivity, you must login with 
administrator privileges. 

1. TCPIP: allows you to configure the Internet Protocol.

2. Device. allows you to set up devices. 

3. Service: allows you to configure a service (for example, 
DICOM services such as printers, worklist, and other 
services such as video print and standard print) from the list 
of supported services. This means that the user can 
configure a device with the DICOM service(s) that particular 
device supports.

4. Dataflow: allows you to adjust the settings of the selected 
dataflow and associated services. Selecting a dataflow 
customizes the ultrasound system to work according to the 
services associated with the selected dataflow. 

5. Button: allows you to assign a pre-configured output 
service (or a set of output services) to the Print keys on the 
control panel. 

6. Removable Media: enables formatting (DICOM, database, 
or blank formatting) and DICOM verification of removable 
media.

7. Miscellaneous: allows you to set up the patient exam menu 
options, print and store options, and the order of the 
columns in the examination list on the Patient menu. 

8. Tricefy: allows you to archive, collaborate, and share 
patient images via a cloud-based image viewer. 

9. Koios. Koios is a Breast Lesion Analysis Option. Koios is 
intergrated with the LOGIQ P8/P9/P10 via DICOM. Koios is 
configured similar to a DICOM Service. The user can 
accept/reject analysis results. 

Configure these screens from left to right, starting with the 
TCPIP tab first. 

NOTE: The ultrasound system is pre-configured for many services, with 
default settings selected. You can change these services and 
settings as needed.

CAUTION You must restart the LOGIQ P8/P9/P10 (shutdown) after 
making any changes to connectivity settings in the Utility 
menus. This includes any changes on the TCPIP or dataflow 
setup screens.
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TCP/IP

The left side of the TCP/IP screen displays the Wired Network 
Configuration; the right side of the screen displays the Wireless 
Network Configuration. 

Figure 10-44. TCP/IP Screen

The Wired Network Configuration shows what the LOGIQ P8/
P9/P10 local area network settings are configured to, while the 
Wired Connection section shows the actual network 
configuration the system is currently using and has recognized. 
If these two sections do not match, reboot the system and 
recheck the network settings. 

Determine Your Network Settings

Determine the type of network settings you will use and 
configure:

• IPv4 or IPv6: IPv4 is a 32-bit address, IPv6 is a 128-bit 
address. 

• DHCP (Dynamic Host Configuration Protocol): Enables a 
server to automatically configure the network settings.

• Static IP: Manually configured network settings. 
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DHCP

To configure DHCP network connectivity:

1. Select the DHCP check box to enable automatic 
configuration of your network settings.

Figure 10-45. DHCP Network Connectivity Menu

2. To use IPv6, check the IPv6 box. If unchecked, the system 
will use the default IPv4 settings. 

3. Press Save at the bottom of the screen to save the 
automated configuration. 

4. Restart the system to activate any saved changes. 
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Static IP

To configure Static IP network connectivity:

1. Uncheck the Enable DHCP box.

2. To use IPv4, leave the IPv6 box unchecked (IPv4 is the 
default Static IP configuration). 

To use IPv6, check the IPv6 box.

Figure 10-46. IPv4 and IPv6 Static IP Connectivity Menu

3. Type the name of the Ultrasound system in the Computer 
Name field. 

4. Enter the following information in the designated fields:

• IP-Address (acquire a unique static IP address from the 
network administrator)

• Subnet Mask

• Default Gateway (if applicable)

• Primary and Secondary DNS addresses (optional)

NOTE: At least one valid DNS address is needed for Insite remote 
service connectivity. 

5. Press Save at the bottom of the screen. 

6. Restart the system to activate any saved changes.

NOTE: Per system design, TCP/IP settings do not get restored 
when restoring backups. The LOGIQ P8/P9/P10 IP address 
MUST BE unique.
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TCP/IP Preset Menus

Table 10-76:  Computer Name

Preset Parameter Description

Computer Name Type the unique name for the Ultrasound system (no spaces in name).

Table 10-77:  Wired Network Configuration

Preset Parameter Description

Enable DHCP Select this box to enable dynamic IP Address selection (unless you use 
DICOM). When DHCP is enabled, the IP Address, Subnet Mask, Default 
Gateway, Primary DNS Server and Secondary DNS Server fields are 
disabled.

IPv6 Select this box to enter IPv6 Static IP settings. 

IP-Address Enter the IP Address of the Ultrasound system. NOTE: IP stands for Internet 
Protocol. Every device on the network has a unique IP address.

Subnet Mask Enter the subnet mask address. NOTE: The Subnet Mask is an IP address 
filter that eliminates communication/messages from network devices of no 
interest to your system. 

Default Gateway Enter the default gateway address (optional).

Primary DNS Server Enter the IP address for the Primary DNS server (optional - - at least one 
valid DNS address is needed for Insite remote service connectivity).

Secondary DNS Server Enter the IP address for the Secondary DNS server (optional). (Do not 
configure Secondary DNS server only; if only one DNS IP address is being 
used, enter it in the Primary DNS Server field.)

Network Speed Select the network speed (Auto Detect, 10Mbps/Half/Full Duplex, or 100 
Mbps/Half/Full Duplex, and 1000Mbps/Auto-negotiate).

Table 10-78:  Wired Connection

Preset Parameter Description

IP-Address The IP Address of the Ultrasound system. NOTE: IP stands for Internet 
Protocol. Every device on the network has a unique IP address. 

Subnet Mask The Subnet Mask is an IP address filter that eliminates communication/
messages from network devices of no interest to your system. 

Default Gateway The default gateway address (optional).

MAC Address Unique network card address. 

Speed (Mbps) Actual network speed in Megabits per second.

Connected (min) The number of minutes the system has been connected to the network. 
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Status Current network status. 
• Operational: Network adapter has been disabled, for example because of 

an address conflict.
• Unreachable: Network adapter that is not connected.
• Disconnected: For LAN adapters: network cable disconnected. For WLAN 

adapters: no carrier.
• Connecting: Network adapter that is in the process of connecting. 
• Connected: Network adapter that is connected to a remote peer. 

Table 10-79:  Wireless Network

Preset Parameter Description

Configuration Press to view or change the Wireless Networking settings. See Chapter 13 
for more information.

IP-Address The current IP address assigned to the wireless network adapter. 

Subnet Mask The current network mask assigned to the wireless network adapter. 

Default Gateway IP address of the local subnet gateway host.

MAC Address The Ethernet address assigned to the installed wireless adapter hardware.

Speed (Mbps) Actual network speed in Megabits per second.

Connected (min) The number of minutes the system has been connected to the network. 

Status Current network status. 
• Operational: Network adapter has been disabled, for example because of 

an address conflict.
• Unreachable: Network adapter that is not connected.
• Disconnected: For LAN adapters: network cable disconnected. For WLAN 

adapters: no carrier.
• Connecting: Network adapter that is in the process of connecting. 
• Connected: Network adapter that is connected to a remote peer. 

Table 10-78:  Wired Connection

Preset Parameter Description
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Device

To add a new device, 

1. Press Add.

2. Type the device name in the Name field. 

3. Type the device’s IP address in the IP Address field. 

Figure 10-47. Connectivity Device Preset Menu

Table 10-80:  Device

Preset Parameter Description

Add/Remove Press Add to add a new device; press Remove to delete a device. 

Ping Press Ping to confirm that a device is connected. 

Properties: Name Type the name of the device. 

Properties: IP Address Type the device’s IP address. 
The following IP address cannot be used for device's address, these are 
reserved for internal use by the system: 192.168.221.1/192.168.221.2

Properties: AE Title AE Title of the LOGIQ P8/P9/P10. NOTE: Only available for MyComputer.

Properties: Port Number IP Port Number Used for DICOM, set by default to 104. NOTE: Only available 
for MyComputer.

DICOM TLS: Use DICOM 
TLS Encrypted Connection

Check to use DICOM TLS Encrypted Connection

DICOM Verbose Logging: 
Enable Dicom Verbose 
Logging

Check to be enable Dicom Verbose Logging

DICOM Verbose Logging: 
Enable Dicom Verbose 
Logging for (Minutes)

Coose duration for Dicom Verbose Logging
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Device  (continued)

To ping a device, 

1. Select the device. 

2. Press Ping. If the smiley face smiles, then the connection 
has been confirmed. If the smiley face frowns, then the 
connection has not been made. Check the device name and 
IP address. 
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Service

For each Device that you added to the system, you need to set 
up the service(s) that device supports (you must be an 
administrator to update these screens). 

The Services screen has the following sections of information:

1. Destination Device - lists information about destination 
devices. You can select from a list of currently existing 
devices.

2. Service Type to Add - lists information about services for 
the destination device. You can add services, select from a 
list of currently existing services, and remove services.

3. Service Parameters - lists properties for the service 
currently selected in the Services section. The name and 
parameters in this section change, depending on what 
service is currently selected. In the above figure, this section 
shows DICOM Print parameters.
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Adding a service to a destination device

1. Select the service from the pull-down menu. Press Add.

2. Specify the properties for this service. Press Save.

3. Verify the service. 

Removing a service

1. Select the service. Press Remove.

2. Press Save.

Changing parameters for a service

There are certain parameters that may need to be set up for 
each service: 

Table 10-81:  Service Parameters: Common Service Parameters

Preset Parameter Description

Name Free text: give a descriptive name to the device.

AE Title The Application Entity Title for the service.

Port Number The port number of the service.

Maximum Retries Max # – the maximum number of times to try establishing a connection to the 
service.

Retry Interval (sec) Specify how often (in seconds) the system should try to establish a 
connection to the service. 

Timeout The amount of time after which the system will stop trying to establish a 
connection to the service.
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Changing parameters for a service  (continued)

Many service parameters are specific to each type of service. 
The parameters are described on the following pages:

• Standard Print

• Video Capture

• Save As

• USB Quick Save
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Standard Print

Table 10-82:  Standard Print

Preset Parameter Description

Printer Select the printer. 

Rows Specify 1-5. 

Columns Specify 1-5. 

Orientation Specify Landscape/Portrait

Top Margin (mm) Specify the top margin (0-51mm)

Bottom Margin (mm) Specify the bottom margin (0-51mm)

Left Margin Specify the left margin (0-51mm)

Right Margin Specify the right margin (0-51mm)
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Video Capture

Table 10-83:  Video Capture

Preset Parameter Description

Type Specify Color, BW, or DVD Record/Pause. 
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Save As

USB Quick Save

USB Quick Save provides the ability to easily send images to a 
USB memory stick or Network Storage. See ‘USB Quick Save’ 
on page 15-47 for more information.

Table 10-84:  Save As

Preset Parameter Description

Destination Specify destination device, Hard Drive, USB Flash Drive. 
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E-mail to MMS

NOTE: You can attach up to 10 images to an e-mail.

To use the E-mail service, the SMTP (Simple Mail Transfer 
Protocol) settings and user account are needed from your 
E-mail service provider.

• SMTP server name (Outgoing Messages) e.g., 
smtp.gmail.com

• SMTP authentication (Outgoing Messages) e.g., SSL

• SMTP port (Outgoing Messages) e.g., 465

NOTE: The LOGIQ P8/P9/P10 only supports the E-mail Send service; 
receiving E-mail is not supported. To receive E-mails, the same 
E-mail account needs to be installed on an Office-PC.

NOTE: Some E-mail servers allow less secure applications to access 
your account. If your account cannot gain access to the E-mail 
server from the LOGIQ P8/P9/P10, please contact the server 
administrator and configure access to your account to allow a 
less secure application. In case of Google gmail, please refer to 
the Accounts Help at https://support.google.com/accounts/
answer/6010255?hl=en.
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Setting up the Email to MMS

1. Enter IP Address and Name of SMTP server to add an 
Email connection device in Device Tab.

2. Press Verify icon and Press Add button if the ping test is 
executed successfully.

3. Move to Service Tab, select “Email to MMS” in Service 
menu and Press “Add” button.

4. Enter your Account name or Email Address in the Identity 
group. As an option, you can enter a different reply to 
address and a signature text.

5. To verify E-mail configuration, click on Verify icon. The test 
message will be sent to the entered E-mail address followed 
by a message box.

6. To save your configuration, select the Save button.

 Figure 10-48. Email to MMS

Table 10-85:  Network Storage Service

Preset Parameter Description

SMTP Server Free text: give a descriptive name to the email server.

Server Connection Options:
• IP Address: Try connecting via IP address.
• Server Name: Try connecting via SMTP server name.
Select server connection method to access mail server. 

Server Port The port number of the email server.
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Connection security Options:
• None
• SSLTTLS
• STARTTLS
If your SMTP server requires SSL or STAR connection, select the proper 
option.

Authentication method Enter user account and password for SMTP authentication. If your server 
doesn’t require User authentication, uncheck the box and do not enter 
anything. Leave the User Name and Password fields blank.

User Name Email Account User Name. 

Password Email Account Password.

Email Address Enter To (receiver) Email Address for sending test message (Mandatory). 
Note: It will be used for From (sender) Email Address.

Subject Free text: give a subject to test E-mail.

Message Free text: give a body text message to test email.

Enable MMS Enable MMS with E-mail service.

Domain Name for MMS Domain Server Name for the 3rd party provider to MMS message.

Table 10-85:  Network Storage Service (Continued)

Preset Parameter Description
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MMS Configuration

The MMS phone number is mapped into the recipient E-mail 
address of the MMS service provider.

NOTE: The LOGIQ P8/P9/P10 does not support MMS service. The 
LOGIQ P8/P9/P10 only supports patient phone number 
combined with MMS domain name when sending an email 
(“Phone number@DomainName”).

NOTE: To use the MMS function, you need to contract with a 3rd party 
provider that offers E-mail to MMS service (e.g. SMSglobal). 
Contact a service provider!

1. If it is desired to also use MMS, select “Enable MMS” in the 
Email Service Properties.

2. Enter 3rd party Domain Name. 

NOTE: Captured images will be sent to your E-mail account with 
“Phone number@DomainName”.

3. Store your configuration by selecting”Save” button.

Send Email

The user can send selected images from the Active Image page 
via “Send To”. 

 Figure 10-49. Batch Send to E-mail

E-mails contain JPEGs for still image and WMV for Cine loops.

NOTE: Exam send function is not supported for E-mail to MMS. You 
can only send selected images from the Active Image screen.
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How to enter Patient's E-mail address and Phone number in the Patient screen

To show and allow entering the patient’s E-mail address, enable 
the “Use Email to MMS” option on the Connectivity -> 
Miscellaneous screen.
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How to enter Patient's E-mail address and Phone number in the Patient screen  
(continued)

1. Press the “Details” button on the Patient screen. The 
Patient’s E-mail address and Phone number controls 
appear.

2. Enter patient information and Comment. The content of the 
Comments will be used for the body text of the email. The 
subject of the E-mail will be automatically generated using 
the Patient Name and Exam Date information. 

3. Select Register to save the patient’s email configuration.
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Setting up a Printer

Use Standard Print for digital peripherals. These are printers 
with either a USB interface or Ethernet interface (Sony 
UP-D25MD, for example). 

On the Utility --> Connectivity --> Button page, select the Print 
key in the upper, left-hand corner of the display. In the middle 
portion of the page, under Available Input/Outputs, select the 
printer you want to configure. Next, press the two right arrows 
(>>) in the upper, right-hand corner of the page to move this 
printer into the Printflow View. 

You can also configure the Standard Print button that appears 
on the Active Images screen. 

Example: For instance a video capture device, on the Utility --> 
Connectivity --> Service page, in the Service Type to Add box, 
and press Add. In the properties box on the upper, right-hand 
side, select the type of device and in the Properties box in the 
lower, left-hand side, type in a unique descriptive name for this 
device. 
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Dataflow

A dataflow is a set of pre-configured services. When you select 
a dataflow, the ultrasound system automatically works according 
to the services associated with the dataflow. The Dataflow tab 
allows you to select and review information about dataflows. You 
can also create, change, and remove dataflows.

Set up dataflows for the services. 

NOTE: You must be logged on as Administrator to use the Dataflow tab.

NOTE: Services added to the Dataflow View will receive images 
immediately if Direct Store is checked; or at the end of the exam 
if Direct Store is not checked.

Figure 10-50. Dataflow Preset Menu

Key Object 
Selection: Image 
Deletion 
Notification

Image Deletion Notification is available ONLY for the Direct 
Store Workflow and only generated when there are images 
deleted during the exam. This lets the reader at the PACS 
system know which images have been deleted. An indicator is 

CAUTION DO NOT rename the factory default dataflow. 

Table 10-86:  Dataflow 

Preset Parameter Description

Name Select the dataflow from the list.

Direct Store Select to store data directly to archive (no buffer storage).

Hidden Select so that this dataflow does not appear as a Dataflow on the Patient 
menu.

Default Dataflow Select to use this dataflow as the default dataflow when you start the system.
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placed on deleted images with a reason, “Rejected for Quality 
Reasons,” for example.
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Button

You can assign print buttons via the Utility --> Connectivity --> 
Button page. 

Assigning print buttons. First select the print button to configure 
on the upper, left corner of the page. Then select the device you 
want to add in the middle part of the pages. Then click on the 
right arrow in the top right corner of the page. 

NOTE: You can configure each print key to multiple output devices/
dataflows. 

NOTE: Only attach one DICOM service per print key (e.g., PACS and 
DICOM printer). Multiple DICOM devices should be configured 
via a dataflow.

NOTE: When using a print key to send an image directly to a DICOM 
device, this causes a single DICOM association per image. Most 
devices (all known printers) work fine with this. However, some 
storage devices, such as ALI, Kodak Access, and Cemax, 
assume that the end of each association is the end of the exam 
and can result in a new folder for each image. In the Utility 
menu, select a single association or open PR for the desired 
DICOM storage device. 
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Button  (continued)

Table 10-87:  Print Button

Parameter Description

Physical Print Buttons
• Print 1-6
• PrintScreenAutoSweep
• PrintScreen

M&A only (no images) Configures the system to send a DICOM structured report only; no image is 
generated or sent. 

Still Images • Format: Ultrasound Image, Secondary Capture (Image, Video, Screen) 
• Compression: None, Rle, Jpeg, Jpeg2000
• Quality: Lossless, 99, 98, 97, ... 50 (Displays when JPEG/JPEG2000 is the 

selected Compression) 

Clips/Volume • Clips: Add Multiframe Data: Checkbox
• Compression: None, Rle, Jpeg, Jpeg2000
• Quality: Lossless, 99, 98, 97, ... 50
• Volume File Format*: 1-Standard DICOM (Default), 2-Standard DICOM with 

Raw Data; 3-Enhanced DICOM, 2&3 (2 files)
*Easy3D replace format 3 with format 2

Note: The default Compression for Clips/Volumes is JPEG85. It is strongly recommended to keep the 
Compression set to JPEG85. 

Advanced • VNav Data: V Nav View (Default), Ultrasound Only, or VNav & Ultrasound (2 
files)

• Compare Assistant: Comparison view (Default), New image, Both 
Comparison & New (2 files)

• Scan Assistant Advance: On, Off, Use program (system uses setting from 
the Scan Assistant program which allows a user to configure two print keys 
identically except that one advances Scan Assistant and the other does 
not.) On =advances to the next step when that print key is pressed 
independently of the program setting. Off = does not advance to the next 
step when the print key is pressed independently of the program setting.

Press “Application/Print Controls/Live Store” to hyperlink to the Application 
Print Controls utility page. 

Active Images Page: Standard Print
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Removable Media

The Removable Media tab allows you to:

• Verify the DICOM directory on removable media.

• Verify the free space of the media.

• Verify that the media is finalized or unfinalized.

• Verify that the media is formatted or unformatted.

• Format removable media (rewritable CD/DVD)

Figure 10-51. Removable Media Preset Menu

The bottom of the screen lists properties of the selected media.

Table 10-88:  Tools

Preset Parameter Description

Removable Media Select the removable media to format or verify.

Label Type a label for a new removable media (free text).

Verify • Select to verify DICOM directory on removable DICOM disk.
• Verify the free space of the media.
• Verify that the media is finalized or unfinalized.
• Verify that the media is formatted or unformatted.

Format Select to format removable media.

Quick Format To format the media quickly, check this box. If you uncheck this box, the 
media is formatted with a full format. New media should always be formatted 
with a full format. 
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Formatting removable media

1. Select the removable media from the Media list.

2. Type a name for the removable media in the Label field.

NOTE: Do not use the following characters for labelling:

\ / : ; . , * < > | + = [ ] &

3. Select Format. Confirm OK or Cancel.

4. An information window confirms when the format has been 
completed. Select OK to exit. 

Verifying removable media

1. Select the removable media from the Media list.

2. Select Verify.
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Miscellaneous

The Miscellaneous tab allows you to configure tools related to 
patient management and print and store options. You can 
specify default system functionality, such as whether patient ID 
is required when you archive data, or if you want the system to 
automatically search the archive for a patient when you enter 
patient data.

Table 10-89:  Patient/Exam Menu Options

Preset Parameter Description

Use birthdate In the Patient information window, enter either the patient age or the birth 
date: When selected, enter birth date, then the age is calculated.When 
cleared, enter age (birth date field not available).

Auto search for patient In the Search/Create Patient window: When selected, the system 
automatically searches through the selected patient archive, while the user 
enters patient information.When cleared, the automatic search tool is turned 
off. If you are trying to keep the past patient data confidential, DO NOT use 
this feature. 

Automatic generation of 
patient ID

In the Search/Create Patient window: When selected, the Patient ID is not 
required when entering a new patient in the archive. The system 
automatically generates an ID number. When cleared, the Patient ID is 
required when entering a new patient in the archive.

Auto Archiving patient data Archives patient data automatically. 

After [End Current Patient], 
go to: 

Select Worklist screen or Patient screen. 

Keep Search String Search string is kept rather than cleared. 

Worklist Auto Query Automatically queries the worklist server. 

Show BBT Show BBT field on the OB patient screen to input the basal body 
temperature.

Double Click on Patient 
List to Start

Select Review or New Exam to display each time you double click on the 
patient name in the patient list on the Patient menu.

Detail Mode Select to display Detail Mode, rather than Exam View, when you select the 
patient name in the patient list on the Patient menu. You can also type 
comments while in Detail Mode.

Export to USB HDD: 
Create DICOMDIR

Create DICOMDIR is a DICOM file format which contains how the directory 
and DICOM files structured for diagnostic portable media behave. It is 
important for portability between the LOGIQ P8/P9/P10 to PACS. If you want 
to save exams to the USB Hard drive and look at it on the PACS, the 
DICOMDIR is a must.

Export to Network storage: 
Create DICOMDIR

Automatic Disable Patient 
Data

Select to automatically disable patient data. 
If selected, locks the patient name, date of birth and gender (like Patient ID). 
The Factory Default for this preset is unchecked.
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Remember Cursor Position 
on the Transfer Screen

To set a default cursor location on the Data Transfer screen: 
1. Select the “Remember cursor position in the Transfer screen” preset and 

press Save. 
2. On the Data Transfer screen, move the cursor to the desired field. 
3. Exit out of the Data Transfer screen. When returning to the Data Transfer 

screen, the cursor location is in the position your selected. 

Quick New Patient Entry Select to store new patient automatically by pressing the Patient key.

User Email to MMS To show and allow entering the patient¡¯s E-mail address in the patient 
information.

User Simple MPEGVue Select to transfer the captured images to PC format (JPEG, WMV).

Use Pet Name To show and allow entering the pet¡¯s name in the patient information. 

Table 10-90:  Patient/Exam Message Options 

Preset Parameter Description

Request acknowledge of 
End Exam action

When selected, the user is asked to confirm action when ending an 
examination.

Warn Image Store without 
Patient

Select to receive a warning when you press the Print key without an active 
patient.

Warn Register to No 
Archive

Select to receive a warning when you register a patient to the “No Archive” 
data flow. Select a different data flow for permanent storage of patient data.

Warn image store to Read 
Only dataflow

The system posts a warning message if you attempt to store images to a 
read-only Dataflow. 

Table 10-91:  Print and Store Options

Preset Parameter Description

P[1-6] Key Sound Select None, Click, Chimes, Ding, Ding-Dong, or Whoosh. 

Store Dual as Dicom Only Select to always store dual images as a DICOM (secondary capture) store, 
rather than Raw DICOM.

Dual When Color Support 
is Mixed

Dataflow Mixed is not available. While transferring dual images to the PACS, 
send black and white images as gray; send color images as color. Set up 2 
services (one gray and one color), set up 2 dataflows, and set up 2 buttons. 
Each button needs to be tied to a different service.
Select if you want to keep the user preset for Color Photometric Interpretation 
while in Dual mode.

Enable Smart Capture 
Area

Check box to select. 

Store 2D Loop with 
Timeline Data

Check box to select. 

Patient List Print-Font Size Select font size. 

Table 10-89:  Patient/Exam Menu Options (Continued)

Preset Parameter Description
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Add Titlebar Information to 
Multiframe Loops

Adds a title bar information to the multiframe loops. 

Add Scan Parameter 
Information to Multiframe 
Loops

Adds scan parameter information to the multiframe loops. 

Image Order Scheme Select to Direct Store images in Acquisition Order, Scan Assistant Order, or 
Off.
• Off. The clipboard on the Ultrasound system shows the image in the order it 

was acquired. Therefore, re-stored images appear where you’d expect. 
However, on the PACS system, images appear in arrival order or in image 
number order. 

• Acquisition Order. From the Ultrasound system perspective, the same as 
“Off.” But on the PACS system (if based on image number order), images 
are displayed consistently with the way they are stored on the Ultrasound 
system. 

• Scan Assistant Order. You can define the storage order (reading order) via 
Scan Assistant Creator. Therefore, based on the order defined in Scan 
Assistant, images are re-ordered and displayed in this manner both on the 
Clipboard and on the PACS system. 

Send Images via Wireless When connected to the network via Wireless LAN and this box is checked, 
then images will be sent to the DICOM device over the Wireless LAN. If not 
checked, images spooled in the Spooler will be sent when the system is 
connected to the wired network. 

Allow press and hold print 
key to replace an image

When an image is recalled and the user stores it locally on the system using 
press and hold the Print key, the currently recalled image is deleted from the 
exam and the newly stored image is saved. 
Or when you store the image without annotations, type the annotation and 
press and hold the Print key, the system replaces previously stored image 
with the new image. 

Table 10-92:  Other ID Options 

Preset Parameter Description

Enable Other ID Not selected is the Default.
If selected, allow entering Other ID, such as Citizen Service Number, Burger 
Service Number (BSN), National Health System (NHS) number, along with 
patient ID information on the Patient Screen.

Validation Format If the Enable Other ID preset is selected, the system validates the format of 
“Other ID” when an ID is entered. Choose: NHS Number *** ** *****, Letters 
and Numbers, Numbers, or Any (no restriction)

Table 10-93:  LOGIQ Apps

Function Description

Unpair Bluetooth Devices Un-paired from all trusted Bluetooth devices.

Table 10-91:  Print and Store Options

Preset Parameter Description
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Examination list 
window column 
configuration

You can create new columns, remove columns, and select the 
information to display in a column.

1. Move the Trackball to highlight a column.

2. Press Set.

3. Use the arrows (<< or >>) to reposition column headings. 
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Tricefy Activation

Tricefy is a cloud-based image viewer and a platform to archive, 
collaborate, and share. The corresponding DICOM destinations 
can be used via the Print keys. An internet connection is 
necessary for uploading data to Tricefy. The Wireless LAN 
Option is required. 

As soon as the Tricefy option is enabled, relevant Tricefy items 
are displayed.  

Figure 10-52. Tricefy Preset Menu

Table 10-94:  Configuration

Preset Parameter Description

Account Status [TBD]

Account Name Name for the account. 

Customer Name Customer’s name. 

Uplink ID Uplink ID. 

Table 10-95:  Activation

Preset Parameter Description

Account Email Account email

Activate Press to activate the Tricefy option. 
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Barcode

Overview

The Barcode Scanner supports 1D and 2D encoding 
symbologies. The protocols supported are shown as below:

Barcode Scanner

Select Barcode Scanner in the drop-down list.

NOTE: Reboot is required after the device is selected or changed.

Table 10-96:  Protocols supported by Barcode Scanner

Category Protocol

1D Code 128, Code 93, Interleaved 2 of 5

2D PDF417, Data Matrix
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Input Mode

Off

Enter the Patient ID using the keyboard.

Patient ID

Scan the Barcode as the Patient ID or enter the Patient ID using 
the keyboard instead of the barcode. 

Complexation

Scan the Barcode to input the Patient demographics or enter the 
Patient demographics using the keyboard instead of the 
barcode.

To enter the Patient demographics using the keyboard instead 
of the barcode, select Cancel.

1. Enter a string in the Input Data field by scanning from a 
barcode or typing with the keyboard.

2. Scan a sample barcode. The following items can be 
included in the barcode:

• Patient ID

• First Name, Last Name, Middle Name

• Birth Year, Birth Month, Birthday

NOTE: The length of BirthYear equals to 4, BirthMonth equals 
to 2 and BirthDay equals to 2, and they should always 
be provided together.

• Gender
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Complexation  (continued)

3. Configure the Start and End position for each item.

NOTE: If the barcode does not contain the information of any item, 
configure the Start and End position as “0“.

For example, if the scanned barcode is 
“000001LastNameFirstName191990101F“, the 
configuration and results display as the following:

 Figure 10-53. Barcode Configuration Page Example
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Cloud Reporting

Instead of storing and processing patient data on a local device, 
the user can store and access the patient data on a remote 
server which is outsourced to another company. The user can 
edit and print the report on the remote server. The patient data 
can be stored on the outsourced server though DICOM. Contact 
the Cloud Reporting vendor for DICOM service properties, such 
as IP Address, AE Title, Port number and URL address for 
Q-Path E.

There is currently one vendor for Cloud Reporting:

• Q-Path by Telexy

To review and edit the stored patient data on Cloud Reporting: 

1. Press Utility -> Connectivity -> Miscellaneous -> Cloud 
Reporting.

2. Check the box for “Enable Cloud Reporting”.

3. Select destination as “Q-Path E”.

4. Select one protocol type. There are two options: http://, 
https://.

• Q-Path Application URL is required to access Q-Path 
server. Contact the Telexy vendor for the URL
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Cloud Reporting  (continued)

5. Enter Username and Password.

• Q-Path Application URL is required to access Q-Path 
server. Contact the Telexy vendor for the URL

Figure 10-54. Input User information

6. Press Utility key on the touch panel and then select System. 
Go to User Configuration Key to assign Cloud Reporting 
button to User Defined Hard Key. 

• The Cloud Reporting button displays on User Defined 
Key If the Enable Cloud Reporting option is checked.
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Cloud Reporting  (continued)

7. Assign the Cloud Reporting button on User Defined Hard 
Key or MyPage User Defined Function Key.

8. Press Patient key on the touch panel and open the patient 
you sent to the Q-Path.

NOTE: To view the patient in the Web browser, you need to send 
the exam to the DICOM server of Q-Path. See ‘DICOM 
Image Storage’ on page 16-140 in Basic User Manual for 
more information.

9. Press the button you assigned to enter the website to edit 
the current patient exam.

10. The system opens the webpage for cloud Reporting of the 
selected destination.

• If Q-Path server requires authentication or the login 
information is wrong, you may need input correct 
Username and Password.

Figure 10-55. Example - Q-Path E WebPage - Login
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Cloud Reporting  (continued)

• You can review and edit the patient data on the 
Webpage via custom browser.

Figure 10-56. Example - Q-Path E Webpage

NOTE: Refer to the instruction from “Help” or “?” on the 
webpage or consult the DICOM server vendor about 
how to manage the patient data on the webpage.

Table 10-97:  Cloud Reporting 

Preset Parameter Description

Enable Cloud Reporting Select to enable Cloud Reporting. The Cloud Reporting button appears in 
Patient screen. Press the Cloud Reporting button to enter the website to edit 
and print the report.

Destination Select the destination of Cloud Reporting.
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Koios (not available in all countries)

Koios is a Breast Lesion Analysis Option. Koios is integrated 
with the LOGIQ P8/P9/P10 via DICOM. Koios is configured 
similar to a DICOM Service. The user can accept/reject analysis 
results. 

To activate Koios,

1. Access the Utiliy --> Connectivity --> Koios Configuration 
page. 

NOTE: The Koios Configuration page will only appear if the option 
activation code is present. If there is no option activation 
code, the Koios tab will not display. 

2. Type in the IP address of the Koios Server.

3. Select the Activate button.

Figure 10-57. Activate Koios

4. You will receive notification upon successfully connecting to 
the Koios Server (The activation was successful. Your 
system is connected to Koios). Confirm (Save Changes? --> 
Ok) that you want to save the changes on this Configuration 
page.

5. Confirm that the connection was successful by pinging the 
Koios Server via the Utiliy --> Connectivity --> Device page.

Figure 10-58. Ping the Koios Server
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Koios (not available in all countries)  (continued)

6. Confirm that the Koios Assessment service is running by 
pinging the Koios Assessment service via the Utility --> 
Connectivit --> Service page.

Figure 10-59. Ping the Koios Assessment Service
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System Administration

Overview

The Admin screen has the following sections:

• System Administration – lists all the options implemented 
in the system.

• Users – allows you to define user IDs, specify operator’s 
registration, operator’s rights, registration of staff related to 
an examination (for example, referral doctors and 
sonographers) and password update requirements.

• Logon – defines logon procedures, allows the System 
Administrator to set password policies, and LDAP 
Configuration.

• Groups -- The System Administrator can set up user groups 
on this page. 

• System Password -- Password for the Application 
Windows Logon Account.  

• Disk Encryption -- The System Administrator can encrypt 
the disk for highest system security, if required. 

• Audit Report -- Generates an audit report. 

• Vulnerability Scan Mode -- Part of the Advanced Security 
Option. Vulnerability Scan Mode configures the system so 
that an external scanner can analyze the LOGIQ P8/P9/
P10.

NOTE: Only the System Administrator can access the pages.
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Administrator Tasks

Here are the tasks typically performed by the LOGIQ P8/P9/P10 
System Administrator. Instructions for each of these tasks can 
be found in this chapter.  

• Privacy and Security Configuration options

• Define connection options for LDAP Directory Server

• Control encryption of the Patient Data drive

• Create Users/Groups

• Change rights for Users/Groups

• Change Encryption status for the system

• Change/Add Encryption Passwords

• Save/Print Recovery keys for encrypted drives

• Configure Password Policies

• Configure Session Policies

• Generate Audit Reports

• Configure Remote Logging Servers

Privacy and Security

Privacy protects both personal and private interests and 
information of persons. Security protects both system and 
information from risks to confidentiality, integrity, and availability. 
The LOGIQ P8/P9/P10 Privacy and Security capabilities are 
discussed in Chapter 12; Privacy and Security configuration is 
discussed below, followed by a description of each system 
administrative page. 
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Creating Password Policies and User Groups

The foundation of setting up effective privacy and security is 
controlling user groups, users, and their system permissions. 

Enabling Password Policies

Check the “Enable Password Policies” box on the Utility-> 
Admin-> LOGON page. 

In addition, set the password policy for each selection. These 
policies should be set BEFORE creating new users. Save the 
changes and reboot the system. This applies rules for the 
passwords. 

Figure 10-60. Enable Password Policies

HINTS Ensure the ADM password is known BEFORE rebooting the 
system. 
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Groups

You define Group access rights via the Utility-> Admin-> Groups 
page. When each user logs in, they will have access to the 
system according to the rights assigned to their group(s). 
Default system  groups are preset with pre-determined access 
rights. To view these access rights, highlight a group name in the 
Group List column on the left, then look in the Groups Rights 
column to see the permissions by group. 

 Figure 10-61. Groups Page

HINTS Admin has full access rights. 
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Adding users

You define Group access rights via the Utility-> Admin-> Users 
page. 

Figure 10-62. Page to Add Users

Creating a user

1. Press Add.

2. Type the user ID.  

3. Type the user’s information in the Identity section, ensuring 
that you are using the defined policies. User IDs are 
enforced as all uppercase letters for local users. 

NOTE: If a password is created, the user will be required to enter 
the password when logging on, even if Password Policies is 
not enabled. Remember, passwords are case-sensitive. 

4. Select the user’s group(s). Multiple groups can be selected, 
if needed. 

HINTS ENSURE that you DO NOT include the following 
characters in a user’s ID: slash (/), dash (-), asterisk (*), 
question mark (?), an underscore (_), ampersand (&), or 
blank spaces. 
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Creating a user  (continued)

5. If the user needs full configuration and advanced operations 
access, select Admin.

6. Press Save.

NOTE: DO NOT add users with the same User ID.  The system allows 
you to do this; however, the first user is erased and only the 
second user remains.

NOTE: When adding a new user, press Add first. Then edit the ID from 
the default of “NewUser” and edit the other fields. DO NOT
press Add again unless you actually want to create another 
user. Press Save after adding one or more users. The user 
listed as NewUser on the list will be updated with the edited ID 
when you re-enter this screen.

User Login

After the system administrator adds a new user, the new user 
should login with their new user name and password. If 
designated by the system administrator, they may be required to 
change their password. 

The user will be prompted for their password when logging into 
the system or when selecting their user name from the Patient 
menu as well. 

After logging in, the user will have access according to the rights 
available to them within their assigned group(s). 

Changing a user configuration

The system administrator can update a user. The system 
administrator can also specify whether the user’s account is 
“Active,” “Blocked,” or requires a password change. If needed, 
select the check box, “User must change password.” Then the 
user will be prompted to change their password the next time 
they log into the LOGIQ P8/P9/P10. 

1. Move the Trackball to a user ID in the User List.

2. Make the desired changes.
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Deleting a user

The system administrator can delete a user. 

1. Move the Trackball to a user ID in the User List.

2. Select Remove. This marks the account as inactive. 

The user is removed from the User List.

3. Select Remove again. 

NOTE: Accounts are not removed immediately because User data is 
retained for auditing purposes. This can be useful because their 
name will still appear in audit reports. Also, they can be 
reactivated. 

If you permanently remove the user, by selecting "Remove" on 
an inactive user, this traceability will be lost.  

User Accounts and Password Policies Frequently Asked Questions

Here are answers to some frequently-asked questions: 

Q I lost or forgot my password. 
A  System Admin can change your password. 

Q I entered the wrong password multiple times and now the 
system says I am locked out. 
A Wait until you are unlocked, enter the correct password.  If you 
have forgotten your password, the System Amin can access the 
system and user details. Utility>Admin>Users 

Q I am locked out after multiple attempts to remember my 
password, does the System Admin have to wait until my account 
is unlocked before accessing the system?
A The System Admin can logon with their own logon information 
before the users blocked time is over. The box “Block user 
account” Utility>Admin>User, should be unchecked to allow the 
user to logon.   

Q I have created a list of users on one u/s system, I have three 
more in the department, can I do a backup to disk and restore 
the user list onto the other systems? 
A Yes, you can copy both User and Password. 

Q I have a sonographer who left the facility, how do I delete this 
user? 
A The System Admin can deactivate or delete a user. 
Utility>Admin>Logon. Select the user and press “remove”
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User Accounts and Password Policies Frequently Asked Questions  

(continued)

Q I have a sonographer who is on medical leave for a few 
weeks. I do not want to remove their user logon but I want to 
make sure they cannot access the system while not working. 
A The System Admin can block a user account. 
Utility>Admin>Logon, select the user and check “Block user 
account,” or deselect "active user account." 

Q We have information that a weekend users password may 
have been compromised, I need  to ask the user to change their 
password the next time they logon.
A The System Admin can require the user to change their 
password.  Utility>Admin>Logon, select the user and check 
“Require password change”

Q I have created a new user for a new sonographer, how do I 
assign the correct group?
A When a new user is added to the list, the groups list is located 
on the right column of the screen.  Assign the user to a group or 
multiple groups with the appropriate access rights.    

Q Can I change the access rights for a pre-defined group?
A Currently this is not supported. You can select multiple groups 
from the factory default list for any user that needs additional 
access but not full admin rights; or create your own groups with 
desired rights. 

Q The default “ADM” user account does not have a password, 
can I create a password for this account?
A Yes, you can create a password for the default ADM.  Be sure 
to write this down for anyone who will need access to the 
system, such as GE Service. 

Q I was the last user on the system, the screen has gone black, 
do I need to logon again?
A Yes, once the Screen Lock time has been reached touch any 
button or the trackball on the operator panel to display the logon 
screen. Logon with your current credentials.   
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User Accounts and Password Policies Frequently Asked Questions  

(continued)

Q Can I use the Auto Logon feature? 
A Yes, the Auto logon if checked will logon with the last user if 
the “Use password policies” is unchecked and the user has 
blank password.  If the user is not assigned a password they will 
be logged on with no other entry required.  If the user is 
assigned a password the logon window will pop-up requiring the 
password to be entered. 

Locking the Screen and Logon

You define Automatically Lock Screen via the Utility-> Admin-> 
Logon page by checking the Enable Session Timeout (Lock 
Screen) box. Then go to the bottom of the column to designate 
after how many minutes the screen should be locked (Session 
Lock Screen Timeout (min)). 

Figure 10-63. Enable Lock Screen

The screen will lock after the designated time. During this time, 
the system will be completely black. To reactivate the system, 
the user will need to logon again. 

NOTE: If “use password policies” is unchecked and no password is set 
to the user, and when Auto Logon is checked, the system will 
start by using the ID of the last operator. If Admin is used as the 
operator, assure that all characters are removed from the 
password field. 

To lock the screen, 

• Type [Alt+L]. 
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System Admin

The System Admin screen has information about any options 
implemented for the system.

Figure 10-64. Administrative System Admin Preset Menu 

Table 10-98:  Product

Preset Parameter Description

Product The name of the product.

HW Number The hardware number of the product.

Table 10-99:  Software Option Key

Preset Parameter Description

Enter New Option Key Type the key for the option you wish to add and press Add. 
Note: The Option Key may contain alphanumeric characters (2-9, A-H, J-N, 
P-Z) and special characters ("?", "%" and "&"). 

Installed Option Keys Lists the key for the installed options. 

Add Press to add a software option key. 

Remove To remove a software option key, select the key in the SW Option Key list, 
and then select Remove.

Import Used to import option strings stored on media (USB or DVD) or in the system 
(OptionKeys.txt may be stored at d:\service).  When you press Import, a 
dialog box comes up that allows you to select from the following locations: 
USB drive, DVD drive, and d:\service.  
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If your site decides to deactivate the InSite RSVP Agent, then 
Remote Connectivity is no longer available on the LOGIQ P8/
P9/P10. This also means that Remote Service can no longer 
connect to the LOGIQ P8/P9/P10 via Disruptive Mode to 
diagnose system issues.  and the “Service” section will be 
removed from this Utility page. In addition, you will not be able to 
initiate a Request for Service or Clinical Support Request via the 
“GE InSite RSVP” icon control located at the bottom of the 
Monitor Display.

 Figure 10-65. Remote Connectivity Deactivated; Service Fields Removed

Table 10-100:  Service

Preset Parameter Description

Enable Request for 
Service

Check this box to enable the system to send system-generated requests for 
service, without your intervention. 

Transfer Machine Logs to 
GE

Usage Analysis: Allows transfer of monitoring errors and status logs to GE 
back office for data analytics.

Transfer Operator 
Information to GE

Usage Analysis: Allows transfer of operator information to GE back office for 
usage analytics. 

Transfer Images (captured 
without patient information) 
to GE

Usage Analysis: Allows transfer of images for analysis. 

Include Annotation with 
Image transfer to GE

Usage Analysis: ? Allows transfer of operator information to GE back office 
for usage analytics. 
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Table 10-101:  Protecting Health Information (PHI)

Preset Parameter Description

Prevent Writing to 
Removable Media CD/
DVD/USB (requires 
reboot)

Check this box to prevent users from copying/saving information to 
removable media. 

Table 10-102:  USB External Media

Preset Parameter Description

USB External Media 
disabled (requires reboot)
By Checking this box you 
will disconnect all external 
USB Mass Storage 
devices

Select to disable any USB media from connecting to the LOGIQ P8/P9/P10. 
Please remember to enable this feature to reload software or to install 
the eIFU USB Media. 

Table 10-103:  Rights

Preset Parameter Description

Require Admin Operator 
Rights to Save Imaging 
Settings

Check this box to require the User to have Administrative rights in order to 
save image settings.  

Table 10-104:  Option Status

Preset Parameter Description

Options A list of the option name and status.

Status Lists each option’s effectivity. 
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Users

The Users screen allows you to define user IDs. It also allows 
you to specify operators registration, operator’s rights setting, 
and registration of staff related to an examination (for example, 
referring and interpreting physicians).

Figure 10-66. Users Preset Menu

Table 10-105:  User List 

Preset Parameter Description

User List Lists the user ID for all system users. 

Identity Type the operator’s user ID, Password, Prefix, Last Name, First Name, Middle 
Name, Suffix, Phone Number. 

User Controls The System Administrator can specify whether a user’s account is active, 
blocked, or requires a password update.  

Group Membership Select the user’s group: Operator (sonographers, doctors, or any person using 
the ultrasound system); Ref.Phys. (referring physician can be associated to the 
patient examination in the extended Patient information window); Perf.Phys. – 
physician performing the exam can be associated to the patient examination in 
the extended Patient information window. 
Note, other groups may exist as set up by the System Administrator. 
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Logon

The Logon section defines log on procedures.

Figure 10-67. Administrative Logon Preset Menu

Table 10-106:  Logon

Preset Parameter Description

Auto Logon Specifies logon procedures:
• Use Auto Logon

• When selected, the system is started automatically, using the last user 
logon.

• When blank, the user must select a user ID and enter a password when 
logging on.

Note: Auto LOGON only works when password policies are disabled and if 
there is no password assigned to the user. 

• Allow Auto Logon for Admin users: The system is started automatically 
when logging in as an ADM user. 

• Allow Emergency User: The system will allow the EUSR user for emergency 
use.

Common Network Login Specifies the user ID and password used to access the network.
• User – User ID for network access
• Password – Password for network access

Connectivity Maintenance Reset to factory default.  

LDAP Configuration Refer to the next section for LDAP instructions. 
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Security Baseline Choose Security Baseline. Select a baseline set of security policies for 
password and session management. For example: 
Lowest (default):
Autologon available. No password complexity rules. 
Medium:
Autologon unavailable. Passwords must meet the following criteria: 
• Minimum password length of 8. 
• Minimum of 2 character sets. 
• Password should not contain username. 
• Password should not be any of the last 10 passwords. 
High:
Autologon unavailable. Passwords must meet the following criteria: 
• Minimum password length of 10. 
• Minimum of 4 character sets. 
• Minimum of 1 lower case characters. 
• Minimum of 1 upper case characters. 
• Minimum of 1 special characters. 
• Minimum of 1 digits. 
• Password should not contain username. 
• Password should not be any of the last 15 passwords. 
Highest:
Autologon unavailable. Passwords must meet the following criteria: 
• Minimum password length of 14. 
• Minimum of 4 character sets. 
• Minimum of 1 lower case characters. 
• Minimum of 1 upper case characters. 
• Minimum of 1 special characters. 
• Minimum of 1 digits. 
• Password should not contain username. 
• Password should not be any of the last 25 passwords. 
Reset Security Baseline: Clears the stored value for customer-selected 
security baseline. This forces the dialog which allows you to choose a 
baseline to be presented at the next Admin logon. 

Table 10-107:  Policies 

Preset Parameter Description

Enable  Password Policies Specify whether to enable establishing policies for acceptable passwords, 
This specifies Password requirements such as # of letters, numbers, 
symbols, etc. 

Enable Session Timeout 
(Lock Screen)

2-step logout: 
1. System will display a lock screen after a set amount of time (configurable 

below under “session Lock Screen Timeout”). 
2. System attempts to logout the user if "Automatic Logoff" is enabled and 

the timeout for it is reached or another user logs in instead.  

Enable Session Timeout 
(Automatic Logoff)

This logs out a user automatically after a set amount of time. 

Table 10-106:  Logon (Continued)

Preset Parameter Description
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Table 10-108:  User Name Policies

Preset Parameter Description

Display Login User List Check this box to display a list of Users. 

Table 10-109:  Password Policies

Preset Parameter Description

Password cannot contain 
username

Password policy stating that the password cannot contain the user's name. 

Minimum Password Length Password policy for password minimum length.

Minimum Number of 
Character Sets

Password policy for minimum number of characters types (Upper-Case, 
Lower-Case, Digits, Symbols). 

Minimum Number of Upper 
Case Letters

Password policy for minimum number of upper-case letters allowed (A, B, C, 
etc.)

Minimum Number of Lower 
Case Letters

Password policy for minimum allowed for number of lower-case letters (a, b, 
c, etc.)

Minimum Number of Digits Password polilcy for minimum number of numbers (1, 2, 3, etc). 

Minimum Number of 
Symbols (~#$% etc.)

Password policy for minimum number of symbols allowed (#, @, etc.).

Minimum Password Age 
(hours)

Password policy for the minimum age for a password, in hours. 

Maximum Password Age 
(days)

Password policy for the maximum age for a password, in days.

Password Reuse History 
Count

Password policy -- users can't reuse old password -- # of old passwords it 
stores so you can't reuse it

Failed Logins Before 
Account Blocked

Password policy for the number of failed attempts to login that are allowed. 

Account Block Time (min) There's a policy which will block an account for a certain amount of time after 
a certain number of failed logins -- you can set how long that time is

Session Lock Screen 
Timeout (min)

Password policy for the time, in minutes, before the system will lock the 
screen. 

Session Auto Logoff 
Timeout (min)

Password policy for the time, in minutes, before the system will automatically 
log a user off the system. 
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LDAP Configuration

To enable LDAP authentication, check the “Enable LDAP 
authentication” box at the top of the LDAP Configuration page. 

Figure 10-68. LDAP Configuration

Table 10-110:  Connection Configuration

Preset Parameter Description

Enable LDAP 
authentication

The administrator can select to enable system credentials using LDAP

Connection Configuration: 

Directory Server URL for the Directory Server

Port Port for the Directory Server

SSL SSL (Secure Sockets Layer) -- Select to enable LDAPs (LDAP over SSL).

Lookup... Button that opens up a Query pop-up for groups, domain, LDAP server, etc. 

Domain Domain name for LDAP server (if needed). 

Connect... Select to connect to server as...

DN for users Distinguished Name for users. 
The LDAP API references an LDAP object by its distinguished name (DN). A 
DN is a sequence of relative distinguished names (RDN) connected by 
commas.

... Select to open a list of DNs supported by the server. 

User caching: 

Enable caching The administrator can select to allow the user to cache their password 
credentials. 
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Lookup LDAP Servers

To look up LDAP Servers, select “Lookup” from the LDAP 
Configuration menu. Select the Domain from the pull-down 
menu, then select the LDAP Server from the list and press OK. 

Logging on to the LDAP Server

To logon to the LDAP server, type your User Name and 
Password, then press OK. 

Cleaning Up the Cache of Credentials

To clean up (empty) the cache of credentials, type your User 
Name and Password, then press OK. 

Remember user ____ days This field specifies the number of days to remember the user for caching 
purposes. 

Cleanup cache The user can cache credentials. When they select this, it clears out the cache 
of credentials. 

Field mapping: 

Field mapping The mapping between attributes on the Ultrasound system and LDAP 
attributes. This allows you (for instance) to select which of several phone 
numbers that may be stored in your AD server are mapped to the Phone 
Number field of a user on the system or to refrain from mapping any AD 
element to that field.  

Group mapping: 

Group mapping Maps an LDAP group to a local group on the machine. 

Selection buttons on bottom of screen: 

Reset field mapping Resets field mapping to the factory defaults

Advanced config... Entries in this menu should only be changed by experienced network 
administrators. 

Certificates... Server Certificate

Reload settings Reloads LDAP settings. 

Return to Admin Press to go back to the Utility--> Admin configuration screens. 

Table 10-110:  Connection Configuration (Continued)

Preset Parameter Description
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Certificate Management

The Certificate Manager displays the system’s Intermediate and 
Trusted Root Certification Authorities, as noted on the 
Certificate Manager’s Tabs (Intermediate Certification 
Authorities and Trusted Root Certification Authorities). You can 
import or remove certificates.  

Figure 10-69. Certificate manager

Select the appropriate Certification Authority, then press “Import” 
to import Certificates or press “Remove” to remove Certificates. 

Figure 10-70. Certificate Import Dialog
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Advanced LDAP Configuration

Advanced LDAP Configuration Settings can be set on the 
Advanced LDAP Configuration menu. 

Figure 10-71. Advanced LDAP Configuration

Table 10-111:  Advanced LDAP Configuration

Preset Parameter Description

Default naming context 
attribute

Attribute name for the naming context.  

User search filter Search for the user using a keyword

Account name attribute Attribute name for LDAP Attribute to be used as Account/User Name 

Group search filter Search for the group using a keyword

Group name attribute Attribute name for the LDAP group. 

Member Of attribute Attribute name for the "Member Of". 

Search timeout(s) Limits the time to perform a search

Search page size (objects) Limits the number of search results

Two step authentication Under LDAP there's a option for a secondary authentication so you give it a 
user name and password to login to the LDAP server. (Advanced 
Configuration)

Enabled Check this box to enable two-step authentication. 

User distinguished name The user's distinguished name.  
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Logon Banner

The Power On Logon Banner displays the text at power-on and 
requires user confirmation to complete booting the system. This 
is user-configurable.

Updating the Logon Banner Page

You can change the text that displays when the user logs onto 
the LOGIQ P8/P9/P10 via the Utility-> Admin-> Login screen. 

There are three login screens that can be used: 

• GE Default Login Screen

• Department of Defense (DoD) Default Login Screen

• User-customized Login Screen

Figure 10-72. GE Default Login Window

User password The user’s password. 

Load default settings The user can select to load system default settings.

Table 10-111:  Advanced LDAP Configuration (Continued)

Preset Parameter Description
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Updating the Logon Banner Page  (continued)

To configure a customer-specific Login Banner page, 

1. Access the Utility-> Admin-> Login screen. 

Update the Logon Banner portion of this screen: 

2. Type the Title into Logon Title Text. 

3. Type the text into Logon Disclaimer Text. 

4. Press Save. 
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Updating the Logon Banner Page  (continued)

To set the GE Default as the Login window, press Load GE 
Default. Then press OK-> Save. 

Figure 10-73. Default GE Logon Banner

To set the DoD Default as the Login window, press Load DoD 
Default. Then press OK-> Save.

Figure 10-74. Department of Defense Logon Banner
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Enabling the Power On Logon Banner

To ensure the Power On Logon Banner displays and requires 
user confirmation to complete booting the system,

Figure 10-75. Power On Logon Banner

1. Access the Utility-> Admin-> Login screen.

2. Checkmark Enable Power On Logon Banner.

3. Press Save and Exit.
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Adding a Logon Logo

The system default logo on the LOGIQ P8/P9/P10 is the GE 
Logo. To add your own Logo,

1. Insert the USB Flash Drive with the Logo into a USB port on 
the LOGIQ P8/P9/P10.

Specifications: The ‘Logo’ image should be a bitmap image 
(.BMP) format ONLY, with a size of 128x128.

2. Navigate to the Utility-> Admin-> Login screen. 

3. Select Browse Logo. A pop-up window appears for you to 
navigate to the USB Flash Drive and Logo you want to add. 

4. Select the Logo. Select OK. Then Save. 

Adding a “Lock Screen” Image

You can add a custom lock-screen image. 

Specifications: The ‘Lock Screen’ image should be a bitmap 
image (.BMP) format ONLY, with a size of 1920x1080.

NOTE: Please select a screen that does not have high contrast or bright 
colors.

To add a ‘Lock Screen’ image, 

1. Insert the USB Flash Drive with the image into a USB port 
on the LOGIQ P8/P9/P10. 

2. Navigate to the Utility-> Admin-> Login screen. 

3. Select Lock Screen Image. A pop-up window appears for 
you to navigate to the USB Flash Drive and image you want 
to add. 

4. Select the image. Select OK. Then Save. 
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Groups

System rights are set by the Administrator. If you do not have 
rights to a feature/function, please contact the Administrator. If 
access is denied, a message in red will appear in the status line 
(such as “You do not have the required permission to perform...” 
or a dialog will be displayed with more information. In some 
cases, buttons or sections of the screen may simply be disabled 
if you do not have appropriate rights. 

 Figure 10-76. Groups Configuration

Table 10-112:  Group List 

Preset Parameter Description

Add This creates a new group. 

Default Groups BioMed, DiagPhys, Emergency User, Lead Sonographer, Operator, 
Physician, RefDoc, Sonographer, and SysAdmin. 

SysAdmin All Group Rights

BioMed All Group Rights, except Admin. Can edit Imaging/Connectivity Utility pages. 
Can change the system time and date. Can access the Service Desktop. 
Cannot edit Admin Utility pages. 

Lead Sonographer Login, Create/Update/Delete/Transfer/Export Patient Data, Basic/Imaging 
Configuration, Authorize Remote Service Access, and Capture Logs. Can 
edit Imaging Utility pages. Cannot edit Connectivity or Admin Utility pages 
and cannot change the system time and date. 

Sonographer Login, Create/Update/Transfer/Export Patient Data, Basic Configuration, 
Authorize Remote Service Access, and Capture Logs

Physician Login, Create/Update/Delete/Transfer/Export Patient Data, Basic/Imaging 
Configuration, Authorize Remote Service Access, and Capture Logs
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Table 10-113:  Name and Description

Preset Parameter Description

Id The Id, from the Group List. 

Description A description of the Group List Id. 

Table 10-114:  Group Rights

Preset Parameter Description

Rights assigned to each 
Group, by default

Login Allows users in this group to logon to the system.   

Admin Allows users in this group to have an system administrator’s rights. Can add/
remove users and enable/disable encryption, etc.  

Create Patient Data Allows users in this group to create patient and exam data.  

Update Patient Data Allows users in this group to change patient and exam data.  

Delete Patient Data Allows users in this group to delete patient and exam data.  

Transfer Patient Data Allows users to transfer patient and exam data over DICOM. 

Export Patient Data Allows users to export patient and exam data to media. 

Basic Configuration Allows access to and modification of basic Utility pages, which everyone has 
access to, except members of the Emergency User’s Group. 

Imaging Configuration Allows modification of imaging preset Utility pages.
Note, If the “Require Admin Operator Rights to Save Imaging Settings” is 
checked on the Utility page, then the “Imaging Configuration” right can only 
be used by a SysAdmin.

Advanced Configuration Allows access to and modification of advanced configuration pages.  

Authorize Remote Service 
Access

Allows users to authorize service engineers to connect to the system 
remotely and perform service tasks. 

Capture Logs Allows users in this group to capture and export a system log to monitor 
system performance. 



Customizing Your System

10-152 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

To set up a new group, 

1. Select the Group. 

2. Assign the Rights you wish this Group to have. 

Capture Logs with PHI Allows users in this group to export log files with PHI included. 

Access Service Desktop Allows users in this group to access the Service Desktop. 

Table 10-114:  Group Rights (Continued)

Preset Parameter Description
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System Password

The System Password is the Windows Password used by the 
LOGIQ P8/P9/P10 to automatically log into Windows. Users of 
the system will never need to use this password. The only 
reason to change the password will be if the user, for security 
reasons, prefers to define their own password instead of using 
the factory-created default password. As with all passwords, this 
should be treated with care and archived appropriately so that it 
can be provided to service personnel if necessary. 

If you have changed the System Password, you must have the 
Current Password to change it. 

To change the System Password, 

1. Type your current password in the System Password field 

NOTE: There is no need to enter the “current password” to change 
the System Password if the System Password has not been 
previously changed from the factory default. The same is 
true for the Database Password.

2. Type the new password in the New Password field. 

3. Type the new password again in the Confirm Password 
field. 

4. Press Save to save the new Password; then press Exit. 

NOTE: ‘Windows System password' is the password for the underlying 
Windows OS user running this application. Do not change this 
password unless you are the system administrator of the device. 
This password is not needed for users of the system. It will only 
be needed by GEHC service in special situations. If you change 
the password, be sure to keep the new password secured and 
available if needed by GEHC service. 
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Disk Encryption 

Disk Encryption is designed to protect data privacy and assist 
your organization with HIPAA/HITECH compliance. Safeguards 
include: 

• All patient data on the system’s patient archive drive can be 
encrypted to provide protection in the event of a stolen 
device or hard drive. 

CAUTION Make sure the system power cable is plugged into external 
power. DO NOT attempt to perform the initial encryption 
function on battery power. 

CAUTION The security of the system, with respect to user encryption at 
rest, relies on the user’s protection of the recovery key(s) and 
encryption passwords. If an adversary obtains an encrypted 
system or its hard-disk together with the recovery key(s) or 
encryption password, the encryption at rest will have no effect 
and give no protection of the data. 

The selected encryption password and the recovery key(s) 
must be stored and managed in a safe and secure manner. 
It is the responsibility of the owner of the system to take 
care of these keys. If the keys are lost, the patient data 
stored on the system will be lost. There is no way for GE 
Healthcare to recover the data if the keys and password 
are lost.

For those using manual unlock with a recovery key(s) stored on 
USB rather than a password to regularly unlock the system. It 
is recommended to remove the USB when the system is not 
used. 
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Disk Encryption  (continued)

CAUTION If you’ve selected “Encryption ON. Key is stored on USB / 
password is entered manually” encryption, both password and 
recovery key are lost, you will not be able to access archived 
patient data (images and measurements included) nor store 
new patient data on this system.

The only way to recover the system to allow storing patient 
data is to reset the entire disk, which deletes all the archived 
patient data on the disk.

It is strongly recommended that all the patient data be stored in 
PACS or backed up to media prior to encrypting the disk.

In addition, it is recommended that the recovery key be stored 
on a USB storage device, printed, and kept in a secure 
location, ensuring that it will not be lost.
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Disk Encryption  (continued)

The system encrypts patient data by default (Encryption On. 
Disks are unlocked automatically). 

1. If you wish to change the default encryption setting, select 
the desired Encryption Policy, then press Accept.  

Figure 10-77. Initialize System Encryption

NOTE: If you (or the Field Service Engineer) reloads system 
software, you will need to press press “Initialize System 
Encryption” to encrypt the system and reset System 
Encryption password and preferences. .

NOTE: If you choose to dismiss this dialog, you will be reminded to 
continue configuring encryption at each logon.   

Table 10-115:  Encryption Policy Selections 

Encryption Policy Description

Encryption OFF Patient Data will not be encrypted. Selecting “OFF” will unencrypt the drive. 
System drive and recovery partition will remain encrypted.  

Encryption ON. Disks are 
unlocked automatically

System Default. Patient data is encrypted and unlocked at system boot-up. 
Recovery Key and Password tied to the hard drive.  

Encryption ON. Key is stored 
on USB / password is entered 
manually

The system will request the encryption password or recovery key at system 
startup. The system is not accessible until this password or a disk recovery 
key is provided. Requiring a password to access the patient archive may 
prevent emergency usage of the system. 
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Disk Encryption  (continued)

2. You must set the Encryption Password and record the 
Recovery Key in order to ensure access to your institution’s 
patient data (required if replacing the system drive, ECB 
Board, or reformatting the C:\ Drive). 

a. To reset the Encryption Password, “Change password”. 

NOTE: If you receive this question, reply “No”: “Password is 
already set on a disk. Do you want to reuse it? Press 
Yes to reuse existing password. Press No to delete 
existing password.”  

You can now update the encryption password, then 
press OK.  
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Disk Encryption  (continued)

3. Recovery Keys are not backed up by the system; you must 
record / archive the Recovery Key in order to retrieve patient 
data. 

You can Show or Hide the Encryption key. Store the 
Recovery Key in a secure location, accessible to the ADM 
user as necessary. 

a. Insert the USB flash drive into a USB port to save the 
recovery key.

NOTE: Use the USB flash drive as the repository only for the 
recovery key. DO NOT use it for data archiving or DVR 
recording.

Save recovery key to a USB Flash Drive by pressing 
Save recovery keys.

b. View the Recovery Key by pressing Show recovery 
key, then print it to a local printer or PACS. 

Press the Print key to print the recovery key on the 
local printer. 

c. Press Show recovery key to display the recovery key 
on the screen. 

Press Hide recovery key to hide the recovery key.

CAUTION Make sure to keep the password, recovery key, and any 
backup of these in a secure place, not accessible for any 
unintended audience.
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Change password

Press Change Password to change the password as 
necessary.

Change the recovery key

If you want to change the recovery key, select Change 
recovery key to generate a new key.

NOTE: Generating a new key causes the previous key to expire.

Disk Encryption Frequently Asked Questions

Here are answers to some frequently-asked questions: 

Q What type of encryption technology is used on my ultrasound 
system?
A AES (Advanced Encryption Standard) 256 bits supported.  
https://technet.microsoft.com/en-us/library/
cc731549(v=ws.10).aspx

Q The system was accidentally turned off or lost power during 
the disk encryption process.
A The system will resume encryption automatically when 
restarted. 

Q The USB recovery key was accidentally formatted. How do I 
access the system? 
A If a password was created or the recovery key written down, 
enter this in the pop up window.  Then go to Utility>Admin>Disc 
Encryption Select Change recovery key.   Be sure to print and 
save the new recovery key and store the USB in a secure 
location. 

Q Is it possible to stop encrypting the data?
A Yes, via Utility>Admin>Disk encryption, choose Encryption, 
and select the “Encryption Off” from the pull-down menu. The 
process to unencrypt may take up to 15 minutes.  
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Disk Encryption Frequently Asked Questions  (continued)

Q Is there a step I need to take every day to encrypt new data?
A No, the encryption will happen in the background without the 
need for any additional manual steps.  

Q The encryption was done it took nearly 90 minutes, is this 
going to happen every time the data is encrypted?
A No, after the initial encryption process is completed, new data 
will be encrypted automatically.

Q How does this protect the patient data? 
A The data is unreadable by anyone who attempts to use the 
system without the proper user rights and/or entering the 
password or recovery key.  

Q I am using the system portable with Power Assistant, do I 
have to enter the password or recovery key after each exam?
A No, the password or recovery key will only need to be entered 
at each full boot up, and only if you have selected manual 
unlock.   

Q I do not have Power Assistant but I take the system portable 
occasionally do I need to enter the recovery key or password 
each time?
A Only if “Disks unlocked manually” has been selected as the 
Encryption Policy. In this case the recovery key or password 
must be entered each time the system is turned on. If a USB 
with Recovery key is connected you will not need to manually 
enter the password or recovery key 
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Disk Encryption Frequently Asked Questions  (continued)

Q The USB recovery key has been lost, how do I unlock the 
system? 
A Manually enter the password or recovery key, then create a 
new USB key from the Disk Encryption page.  

Q The USB recovery key and the password has been lost how 
do I unlock the disk?
A Contact your service, the system will need a base image and 
application reload.  Create a new encryption key.  *Note the 
patient data on the system is not recoverable from this scenario.  
Always store patient data to a PACS or backup to external 
media. 

Q If it is not possible to unlock the data can I still scan and what 
cannot be used? 
A If manual unlocking is used, the system cannot be operated 
without the password or recovery key.  
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Audit Report and System Log Server Configuration

Figure 10-78. Audit Report 

Table 10-116:  Audit Report

Preset Parameter Description

Report Filter: Specify the following criteria. 

Search Type Select the type of search. 

Date Range Specify the “From” and “To” date range.  

Status Specify the status. 

Anonymize Indicate whether to anonymize the report (remote patient data). 

Generate Report Press to generate the report. 

Report Information: Generated report information. 

Report File Path The location where to place the generated report. 

Report Status Report status. 
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Audit Report and System Log Server Configuration  (continued)

Audit Report System Log Server Configuration page allows you 
to customize where to draw information from for the Audit 
Report.

You are also able to connect the LOGIQ P8/P9/P10 to a 
centralized logging database at your institution to monitor for 
pattern analysis. This way, if your system is compromised, the 
data can be analyzed for incident response. 

This centralizes all the sytsem’s data in the customer’s data 
center -- It’s like a DICOM connection page, but connects logs to 
a central location. 

Figure 10-79. System Log Server Configuration

Table 10-117:  Audit Report 

Preset Parameter Description

Connection.

IP Address of the Server The Server’s IP address

TCP Listener Port Transfer Control Protocol Listener Port. This is the port which we transfer 
logging data to use the syslog data protocol.  It can be done by UDP or TCP, 
depending on the configuration of the customer logging server. 
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Vulnerability Scan Mode (Option)

Please refer to the  Advanced Security Option in Chapter 13. 

UDP Listener Port User Datagram Protocol Listener Port. This is the port which we transfer 
logging data to use the syslog data protocol.  It can be done by UDP or TCP, 
depending on the configuration of the customer logging server.

Mode of Transfer Mode of transferring the data to the server (UDP, TCP, or TLS). 

Windows Event Log 

Type of Logs to transfer • Application Logs
• Security Logs

Source of application event 
log to transfer: (Add * for 
no filter)

• Add Source: The user needs to specify where to draw data from for the 
audit report. 

• Delete Source: Delete the event log source from the application. 

Transfer

Send Time Period (Sec): How often the system will attempt to contact the logging server to send logs. .

Number of days of Historic 
data to send: 

If logging server connectivity has not been available, how many days of 
history should be sent when it is restored? 

Batch Send Size When sending historic data, how much to send in each transaction – this can 
help manage network traffic and server load, not typically necessary to 
change this. 

Table 10-117:  Audit Report  (Continued)

Preset Parameter Description
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Search

Utility Parameter Search

Opens up a search window to find a parameter on the utility 
pages. 

To search for a utility parameter, 

1. Press Search from the Utility Touch Panel or from another 
Utility page. 

2. Type in the search string. For instance, if you’re searching 
for Zoom you would just type ‘zoom’. 

Figure 10-80. Search Example

3. A list of possible matches appears to the right. Select the 
correct match. 

NOTE: You cannot perform a search on the Measure, Reports or 
Service utility pages. 
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Measure

Please refer to Chapter 7, General Measurements and 
Calculations for more information on setting up Measurement 
and Analysis Presets. 
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Imaging Preset Manager

Overview

The Imaging Preset Manager allows you to: 

• Create and Edit User Presets

• Update User Presets

• Rename User Presets

• Delete User Presets

• Arrange presets on the Touch Panel

• Share User Presets across LOGIQ P8/P9/P10 systems

• Export User Presets

• Import User Presets
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Creating a User-Defined Application Preset

To create a User-Defined Application Preset, 

1. From the Touch Panel, select the active probe icon. The 
Model Touch Panel appears: 

Figure 10-81. Model Touch Panel

2. Select the Model and Application you want to use as a 
basis for the new Application Preset. 

You are now ready to create your own user preset. 
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Creating a User-Defined Application Preset  (continued)

3.  Press Save. A pop-up menu appears: The Create New 
Application menu appears.

Figure 10-82. Create New User Pop-up Menu
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Creating a User-Defined Application Preset  (continued)

4. Select Create New. The Create New Application menu 
appears. 

Type the name of the new application. Select Create OR 
press Cancel if you do not wish to proceed.

Figure 10-83. Create New Preset

NOTE: The new user application is based upon the current exam 
model and application, plus any modifications you have 
made, including the comment library and M&A calcs. 

NOTE: The name of the new application cannot include spaces or 
symbols. However, the name can include numbers and 
letters. 

NOTE: There is no limit to the number of user-defined application 
presets you can create for each exam category; you do not 
need to map all created presets to the Touch Panel. 
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Creating a User-Defined Application Preset  (continued)

After you select to create the new preset, the Imaging Preset 
Manager screen appears. The preset you just created now 
appears in the Available Imaging Presets column. You’ll notice 
that it has the name you assigned it (Jeannette) + [Thyroid], the 
name of the application upon which it was based. 

 Figure 10-84. Imaging Preset Manager
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Updating User Presets

You can edit, reset to factory default, or delete any user preset 
you create, as long as you have selected it in the “Available 
Imaging Presets” column on the left.

Editing Imaging Parameters

To view/edit the parameters for the user-defined preset,

1. Adjust the image while in the user preset you want to edit. 

2. Press active probe icon the Touch Panel screen. 

3. Press Save-->Overwrite [Preset Name]. 

4. From the Utility--> Imaging menus. 

To view/edit the parameters for the user defined preset

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to view/edit from Available Imaging Presets 
Column.

2. Press Edit. The Imaging page appears. 

3. Edit the presets as necessary and press Save.

or

1. Adjust the image while in the user preset you want to edit. 

2. Press Model.

3. Press Save-->Overwrite [Preset Name].

Renaming a User Preset

To rename a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to rename. 

2. Press Rename. The Rename Preset pop-up menu appears. 

3. Type the new name and press Rename. 
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Deleting a User Preset

To delete a user preset, 

1. Press Utility--> Imaging Preset Manager. Select the user 
preset you want to delete. 

2. Press Delete. The Delete Preset pop-up menu appears. 

3. Confirm that you want to delete this user preset and press 
OK. 
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Arranging Presets on the Touch Panel

On this screen, you specify where you want the new user (and 
existing) presets to appear on the exam’s Touch Panel screen. 

NOTE: In the example above, the new user preset (Jeannette [Thyroid]) 
appears directly below Thyroid on the Touch Panel in the #5 
position). 

Each control on the Touch Panel aligns with the numbers below. 
The Touch Panel has 12 controls that can be controlled by the 
user. In the example below, “1-Thyroid” would appear where the 
number “1” is on the Touch Panel Mapping grid. “2-Breast” 
would appear where the number “2” is on the Touch Panel 
Mapping grid. And so on. These applications can be positioned 
by you. 

 Figure 10-85. Mapping Touch Panel keys
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Arranging Presets on the Touch Panel  (continued)

You can move the location of where the application appears on 
the Touch Panel via the Imaging Preset Manager (accessed 
from the Utility Touch Panel). 

To reposition an application on the Touch Panel grid,   

1. Select the Imaging Preset you want to move from the 
Imaging Preset Selection Column. 

2.  Use the up/down arrow on the right side of the screen to 
move the preset to a position, next to the new map number

Figure 10-86. Adjusting the position of the Preset
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Arranging Presets on the Touch Panel  (continued)

In the example below, the “Jeannette [Thyroid]) preset has been 
moved to the 9th position on the Touch Panel grid. 

Figure 10-87. Repositioned User Preset
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Sharing User Presets between LOGIQ P8/P9/P10 Systems

You can share the user presets you have created between 
LOGIQ P8/P9/P10 systems by exporting/importing the preset(s) 
you want to share.   

To move a user preset from one LOGIQ P8/P9/P10 to another 
LOGIQ P8/P9/P10 system (same software level), first export the 
user preset(s) you wish to share. 

Exporting User Presets

To export a user preset (or presets), 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel.

Figure 10-88. Imaging Preset Manager Location on the Utility 
Touch Panel

2. Insert the media. 
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Exporting User Presets  (continued)

3. Press Export (on the bottom). 

Figure 10-89. Exporting a User Preset
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Exporting User Presets  (continued)

4. An Export Presets pop-up menu appears that indicates: 

a. destination location (USB Flash Drive/Hard Disk Drive 
drive location). 

b. preset directory where the preset should be saved 
(Preset Export). 

c. available presets on the scanner. 

Select the name for the Preset Directory from the Preset 
Directory pull-down. 

Figure 10-90. Export Presets

5. Select the User Defined Presets under Available presets on 
Scanner and press Export. 

6. Upon a successful Export, an informational message will 
pop-up indicating that “1 preset successfully exported.” 
Press Ok. Then press Exit to close the Export Presets 
pop-up menu. 

7. Press F3 to Eject the media. Take the media to the other 
LOGIQ P8/P9/P10 and follow the Importing User Presets 
instructions below. 
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Importing User Presets

To import a User Preset, 

1. Activate the Imaging Preset Manager from the Utility Touch 
Panel.

2. Insert the media (Flash Drive, USB Hard Drive). 

3. Press Import. The Import Presets pop-up appears and 
displays the Source Directory and Available Imaging 
Presets.    

4. Select the “User Defined Presets” under Available Imaging 
Presets and press Import. 

If these presets are already on this LOGIQ P8/P9/P10, you 
will be asked whether you want to: 

• Overwrite this preset (Yes, Yes to All, No, or No to All). 

• Rename this preset (Type the new name and press 
Rename). 

• Cancel

5. Upon a successful Import, an informational message will 
pop-up indicating that “1 preset successfully imported.” 
Press Ok. Then press Exit to close the Import Presets 
pop-up menu. 

6. Press F3 to Eject the media. 
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Retain Field of View

Selecting Retain Field of View ensures that the Imaging 
Parameters shown in the table below stay constant over Probe 
and Preset changes.

Figure 10-91. Model Touch Panel

Table 10-118:  Retain Field of View

Mode Probe Retain Field of View Imaging Parameters

B-Mode, Harmonics, 
Contrast and B-Flow

Convex and Sector Depth, Tilt, Zoom, Width

Linear Virtual Convex, Zoom, Depth, Steer

Color Flow Mode Convex and Sector ROI Size/Position

Linear ROI Size/Position, CF Virtual Convex, CF Steer

Doppler Mode Doppler Cursor Position
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MyPreset

Overview

MyPreset allows you to configure the specific-presets according 
to probe.

The MyPreset allows you to:

• Arrange and edit presets on the Touch Panel
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Activating MyPreset

1. From the Touch Panel, select the active probe icon.

The star icon appears at the top left of the touch panel:

Figure 10-92. MyPreset button on touch panel

2. Select the MyPreset button(star icon). Display the MyPreset 
page on touch panel.

Figure 10-93. MyPreset page
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Arranging MyPreset

On this screen, you specify where you want the new user (and 
existing) presets to appear on the exam’s Touch Panel screen 
according to probe. 

For information about the specific MyPreset manager in utility, 
refer to “Imaging Preset manager”

Figure 10-94. MyPreset mapping touch panel keys
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Service

Press Service to activate the Service browser interface. 
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Scan Screen

For more information, see the Wide Monitor section of Chapter 
3. 
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Test Patterns

Overview

There are different test patterns available: Gray Bars, Color 
Bars, Resolution, Text, Angularity, Brightness Calibration, White, 
Gray, Red, Green, Blue and Pixel test patterns.

Pixel Test Patterns

Pixel patterns should appear to be a uniform color rectangle on 
the Blue/Yellow (B/Y and Y/B), Cyan/Red (C/R and R/C), Green/
Magenta (G/M and M/G) and Black/White (K/W and W/K). If an 
area of the screen appears to have a dark or light grouping of 
pixels, first clean the screen to ensure that gel or dust is not 
causing an optical defect. If a pixel is defective, contact your 
Service Representative. 
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Chapter 11

Probes and Biopsy

This chapter consists of the information of each probe 
and describes some special concerns, biopsy kits and 
accessories as well as basic procedures for attaching a 
biopsy guide to the different types of probes. 
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Probe Overview

Ergonomics

Probes have been ergonomically designed to:

• Handle and manipulate with ease

• Connect to the system with one hand

• Be lightweight and balanced

• Have rounded edges and smooth surfaces.

• Stand up to typical wear by cleaning and disinfectant 
agents, contact with approved gel, etc.

Cables have been designed to:

• Connect to system with appropriate cable length

Cable handling

Take the following precautions with probe cables:

• Keep free from wheels

• Do not bend the cable acutely

• Avoid crossing cables between probes. 
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Probe Orientation

Each probe is provided with an orientation marking. This mark is 
used to identify the end of the probe corresponding to the side of 
the image having the orientation mark on the display. 

Figure 11-1. Orientation Marking on Probe (Example)

1. Notch

Figure 11-2. Probe orientation marker on the display

Labeling

Each probe is labeled with the following information:

• Seller’s name and manufacturer

• Operating frequency (not shown on all probes)

• GE part number

• Probe serial number

• Month and year of manufacture

• Probe designation-provided on the probe grip and the top of 
the connector housing, so it is easily read when mounted on 
the system and is also automatically displayed on the 
screen when the probe is selected. 
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Supported probes

The LOGIQ P8/P9/P10 supports the following types of probes:

• Sector Phased Array

• Linear Array

• Convex Array

• Micro convex Array

• Matrix Array

• Split Crystal

• Volume probe (4D)

• Convex Array

• Micro Convex Array

• Linear Array

NOTE: Not all probes described in this document may be available 
or cleared for sale in all markets.

Probe Naming Conventions

Table 11-1:  Probe Naming Convention

Type Application Frequency Connector Type

C=Convex
L=Linear
M=Matrix
S=Sector
R=Real time 4D

AB=Abdominal
IC=Intracavitary
NA=Neonatal
SP=Small Parts

“1-5” RS
D=DLP
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Probe Description
Table 11-2:  Probe Description

Probe Illustration Application Feature

C1-5-RS Abdomen (incl. 
Pleural), Vascular 
(No transcranial), 
OB/GYN, Urology

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Contrast, Elastography, 
Shearwave Elastography, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D, Biopsy, B Steer+

8C-RS Pediatrics, Neonatal B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, CrossXBeam, LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, B 
Steer+

E8C-RS OB/GYN, Urology, 
Transvaginal, 
Transrectal

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, CrossXBeam, LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Biopsy

E8CS-RS OB/GYN 
(Transvaginal), 
Urology 
(Transrectal)

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, CrossXBeam,LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Elastography, Biopsy

IC9-RS OB/GYN, Urology, 
(Transvaginal, 
Transrectal)

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, CrossXBeam,LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, 
Elastography, Shearwave Elastography, 
Biopsy, Contrast, Max Angle
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BE9CS-RS Urology 
(Transrectal)

B, CHI, CF, PDI, B-Flow, B-Flow Color, 
M, Anatomical M, PW, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D, Elastography, Contrast 
Biopsy

ML6-15- RS Abdomen (incl. 
Pleural), Small 
Parts, Vascular (No 
transcranial), 
Pediatric, Neonatal, 
Musculoskeletal, 
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Shearwave 
Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced 3D, Biopsy, B 
Steer+

L3-12-RS Abdomen (incl. 
Pleural), Vascular 
(No transcranial), 
Small Parts, 
Pediatric, Neonatal, 
OB, Breast, 
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced 3D, Biopsy, B 
Steer+, Shear Wave Elastography

L4-12t-RS Abdomen (incl. 
Pleural), Small 
Parts, Vascular (No 
transcranial), 
Pediatric, Neonatal, 
Musculoskeletal, 
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced 3D, Biopsy, B 
Steer+

12L-RS Abdomen (incl. 
Pleural), Small 
Parts, Vascular (No 
transcranial), 
Pediatric, Neonatal, 
Musculoskeletal, 
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Shearwave 
Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced 3D, Biopsy, B 
Steer+

L6-12-RS Abdomen (incl. 
Pleural), Vascular 
(No transcranial), 
Small Parts, 
Pediatric, Neonatal, 
Breast

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced3D, Biopsy, B 
Steer+

Table 11-2:  Probe Description (Continued)

Probe Illustration Application Feature
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9L-RS Abdomen (incl. 
Pleural), Small 
Parts, Vascular (No 
transcranial), 
Pediatric, Neonatal, 
OB, Breast, 
Musculoskeletal

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Elastography, Virtual Convex, 
CrossXBeam, LOGIQView, ATO/ASO, 
CTO, SRI-HD, Advanced 3D, Biopsy, B 
Steer+

L10-22-RS 
(LP10/LP9
only)

Small Parts, 
Musculoskeletal, 
Neonatal

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Virtual Convex,CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D

L8-18i-RS Small Parts, 
Vascular (No 
transcranial), 
Neonatal, Pediatrics, 
Intraoperative
(Not for China) 
Musculoskeletal, 
Peripheral Vascular

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Virtual Convex, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D

3Sc-RS Cardiac, Abdomen 
(incl. Pleural), 
Transcranial

B, CHI, CF, M, MCF, Anatomical M, PW, 
CW, TVI, TVD, Virtual Convex, 
LOGIQView, ATO/ASO, CTO, Stress 
Echo, SRI-HD, Advanced 3D, Biopsy, 
Contrast

6S-RS Abdomen (incl. 
Pleural), Cardiac, 
Pediatrics, Neonatal, 
OB

B, CHI, CF, PDI, M, MCF, Anatomical M, 
PW, CW, TVI, TVD, Virtual Convex, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced3D

Table 11-2:  Probe Description (Continued)

Probe Illustration Application Feature
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12S-RS Abdomen (incl. 
Pleural), Pediatrics, 
Neonatal

B, CHI, CF, PDI, M, MCF, Anatomical M, 
PW, CW, TVI, TVD, Virtual Convex, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced3D

RAB2-6- RS Abdomen, OB/GYN, 
Urology

B, CHI, CF, PDI, M, PW, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
3D/4D real-time imaging, Biopsy, 
Advanced 3D, B Steer+

RIC5-9A-RS OB/GYN 
(Transvaginal), 
Urology 
(Transrectal)

B, CHI, CF, PDI, M, PW, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced3D, 3D/4D, Biopsy, Max Angle

P8D Cardiac, Vascular 
(No transcranial)

CW, ASO

P6D Cardiac, Vascular
(No transcranial)

CW, ASO

P2D Cardiac, Vascular
 (No transcranial)

CW, ASO

L3-9i-RS 
(LP10/LP9
only)

Small Parts, 
Vascular, 
Musculoskeletal, 
Neonatal, 
Intraoperatives (Not 
for China)

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Virtual Convex,CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D

Table 11-2:  Probe Description (Continued)

Probe Illustration Application Feature



Probe Overview

LOGIQ P8/P9/P10 – Basic User Manual 11-9
Direction 5841298-1EN Rev. 2

6Tc-RS Cardiac 
(Transesophageal)

B, CHI, CF, PDI, M, MCF, Anatomical M, 
PW, CW, TVI, TVD, Virtual Convex, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D
Note: 6Tc-RS probe requires special 
handling. Refer to the TEE Probe User 
Manual enclosed with 6Tc-RS probe.

C1-6-D
(LP10/LP9
only)

Abdomen (incl. 
Pleural), OB, 
Gynecology, 
Vascular (No 
transcranial), 
Urology

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Contrast, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D, Elastography, Shearwave 
Elastography, Biopsy, B Steer+, UGAP 

C2-7-D Abdomen (incl. 
Pleural)

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, Contrast, CrossXBeam, 
LOGIQView, ATO/ASO, CTO, SRI-HD, 
Advanced 3D, B Steer+

C3-10-D 
(LP10 only)

Abdomen (incl. 
Pleural), Neonatal, 
Pediatric, Vascular 
(No transcranial)

B, CHI, CF, PDI, M, PW, B-Flow, B-Flow 
Color, CrossXBeam, LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, B 
Steer+

10C-D Neonatal, Pediatric, 
Vascular, (No 
transcranial)

B, CHI, CF, PDI, M, PW, B-FLow, B-Flow 
Color, CrossXBeam, LOGIQView, ATO/
ASO, CTO, SRI-HD, Advanced 3D, B 
Steer+

M5Sc-RS 
(LP10 only)

Cardiac, 
Transcranial, 
Abdomen (incl. 
Pleural)

B, CHI, CF, PDI, M, MCF, Anatomical M, 
PW, CW, TVI, TVD, Contrast, Virtual 
Convex, LOGIQView, ATO/ASO, CTO, 
Stress Echo, SRI-HD, Advanced 3D, 
Biopsy

Table 11-2:  Probe Description (Continued)

Probe Illustration Application Feature
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BE9CS-RS Probe Changing Scan Method

Changing scan methods between two micro-convex. Press the 
switch on the BE9CS-RS probe.

Figure 11-3. Switching button

a. Switching button

Figure 11-4. Scan plane orientation



Probe Safety

LOGIQ P8/P9/P10 – Basic User Manual 11-11
Direction 5841298-1EN Rev. 2

Probe Safety

Probe handling and infection control

This information is intended to increase user awareness of the 
risks of disease transmission associated with using this 
equipment and provide guidance in making decisions directly 
affecting the safety of the patient as well as the equipment user.

Diagnostic ultrasound systems utilize ultrasound energy that 
must be coupled to the patient by direct physical contact. 
Depending on the type of examination, this contact occurs with a 
variety of tissues ranging from intact skin in a routine exam to 
recirculating blood in a surgical procedure. The level of risk of 
infection varies greatly with the type of contact.

One of the most effective ways to prevent transmission between 
patients is with single use or disposable devices. However, 
ultrasound transducers are complex and expensive devices that 
must be reused between patients. It is very important, therefore, 
to minimize the risk of disease transmission by using barriers 
and through proper processing between patients. 

CAUTION Adequate cleaning and disinfection are necessary to prevent 
disease transmission. It is the responsibility of the equipment 
user to verify and maintain the effectiveness of the infection 
control procedures in use.

CAUTION To minimize the risk of infection from blood-borne pathogens, 
you must handle the probe and all disposables which have 
contacted blood, other potentially infectious materials, mucous 
membranes, and non-intact skin in accordance with infection 
control procedures. You must wear protective gloves when 
handling potentially infectious material. Use a face shield and 
gown if there is a risk of splashing or splatter. 
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Using protective sheaths

Instructions. Custom made sheaths are available for each 
probe. Each probe sheath kit consists of a flexible sheath used 
to cover the probe and cable and elastic bands used to secure 
the sheath.

Sterile probe sheaths are supplied as part of biopsy kits for 
those probes intended for use in biopsy procedures. In addition 
to the sheath and elastic bands, there are associated 
accessories for performing a biopsy procedure which are 
included in the kit. Refer to the biopsy instructions for the 
specific probes in the Discussion section of this chapter for 
further information.

Reordering. To reorder sheaths, please contact your local 
distributor or the appropriate support resource. 

WARNING Probe sheaths are disposable and must not be reused.

CAUTION Protective barriers may be required to minimize disease 
transmission. Probe sheaths are available for use with all 
clinical situations where infection is a concern.

Always use a legally marketed, sterile probe sheaths for 
intra-cavitary and intra-operative procedures.

For neurological intra-operative procedures, use of a legally 
marketed, sterile, pyrogen free probe sheath is REQUIRED.

CAUTION Devices containing latex may cause severe allergic reaction in 
latex sensitive individuals. Refer to FDA's March 29, 1991 
Medical Alert on latex products.

CAUTION DO NOT use an expired probe sheath. Before using probe 
sheaths, verify whether the term of validity has expired.

CAUTION Do not use pre-lubricated condoms as a sheath. In some 
cases, they may damage the probe. Lubricants in these 
condoms may not be compatible with probe construction.
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Using protective sheaths  (continued)

Handling precautions 

WARNING Ultrasound probes are highly sensitive medical instruments 
that can easily be damaged by improper handling. Use care 
when handling and protect from damage when not in use. DO 
NOT use a damaged or defective probe. Failure to follow these 
precautions can result in serious injury and equipment 
damage.

WARNING Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals. Failure to 
follow these precautions can result in serious injury and 
equipment damage.

• Do not immerse the probe into any liquid beyond the level 
specified for that probe. Never immerse the transducer 
connector and the adapter into any liquid.

• Avoid mechanical shock or impact to the transducer and do 
not apply excessive bending or pulling force to the cable.

• Transducer damage can result from contact with 
inappropriate coupling or cleaning agents:

• Do not soak or saturate transducers with solutions 
containing alcohol, bleach, ammonium chloride 
compounds or hydrogen peroxide

• Avoid contact with solutions or coupling gels containing 
mineral oil or lanolin

• Avoid temperatures above 60 C.

CAUTION Probes for transvaginal and transrectal applications require 
special handling. Transvaginal/transrectal examinations and 
probe insertions should be performed only by personnel with 
adequate training.
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Transesophageal probe safety

Mechanical hazards 

WARNING Never use excessive force when manipulating the 
transesophageal probe. The detailed operator manual 
enclosed with the transesophageal probe must be read 
carefully.

CAUTION Transesophageal probes require special handling. Refer to the 
user documentation enclosed with these probes.

CAUTION TEE probes should always be used with an appropriate Bite 
Guard in place.

CAUTION A defective probe or excessive force can cause patient injury or 
probe damage:

• Observe depth markings and do not apply excessive force 
when inserting or manipulating intercavitary probes.

• Inspect probes for sharp edges or rough surfaces that 
could injure sensitive tissue.

• DO NOT apply excessive force to the probe connector 
when inserting into the probe port.
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Electrical shock hazard 

Electrical
Hazard

The probe is driven with electrical energy that can injure the 
patient or user if live internal parts are contacted by conductive 
solution:

• DO NOT immerse the probe into any liquid beyond the 
level indicated by the immersion level diagram. Refer to the 
immersion illustration in the Probe Cleaning Process 
section. Never immerse the probe connector or probe 
adaptors into any liquid.

• DO NOT drop the probes or subject them to other types of 
mechanical shock or impact. Degraded performance or 
damage such as cracks or chips in the housing may result.

• Prior to each use, visually inspect the probe lens and case 
area for cracks, cuts, tears, and other signs of physical 
damage. DO NOT use a probe which appears to be 
damaged until you verify functional and safe performance. 
You must perform a more thorough inspection, including 
the cable, strain relief, and connector, each time you clean 
the probe. 

• DO NOT kink, tightly coil, or apply excessive force on the 
probe cable. Insulation failure may result.

• Electrical leakage checks should be performed on a routine 
basis by GE Service or qualified hospital personnel. Refer 
to the service manual for leakage check procedures.
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6Tc-RS Probe Thermal Safety

Maintaining a safe thermal environment for the patient has been 
a design priority at GE. In order to avoid damage to body 
tissues, for long term exposures, tissue contact probe tip 
temperatures should be less than 42-43 degrees C. The 
ultrasound scanner incorporates an elaborate thermal safety 
system which informs the physician of the operating 
temperature of the probe, and prevents the operative 
temperature from exceeding given limits. Whenever the 6Tc-RS 
Probe is plugged into the system and selected, the probe tip 
temperature is displayed on the system monitor.

If the temperature sensor is not working properly when you plug 
the probe into the system, the probe will not be accepted and 
scanning will not be possible.

The lower limits of the temperature observation of the system is 
29 degrees C.

NOTE: The system displays “29” on the title bar even if the temperature 
of the probe tip becomes less than 29 degrees C. 

High temperature protection levels

The temperature is always displayed on the system monitor. 
The system has two levels of upper thermal limit: the first high 
limit is set at 41.0 degrees C, and the second high limit is set at 
42.7 degrees C. If the temperature of the probe tip reaches 41.0 
degrees C, the temperature display turns red, the system enters 
freeze mode, and a warning appears on the monitor, asking the 
user if he/she wishes to continue scanning up to a higher 
temperature limit. If the response is OK, the scanner will resume 
scanning. If he/she selects Cancel, or no response is given, the 
system will remain in Freeze mode. If the temperature reaches 
42.7 degrees C, the system will freeze unconditionally. The user 
will not be allowed to start scanning until the temperature has 
decreased 0.5 degrees C below the limit where the system 
entered Freeze mode. To restart scanning, the user must press 
the Freeze button.

NOTE: If you receive a system error message while scanning with the 
6Tc-RS TEE probe, discontinue scanning with this probe 
immediately -- the temperature exceeds normal operating 
conditions. Remove the probe from patient contact until the 
system no longer reports the overheating message. If the 
system continues to report an overheating message, contact 
Service. Refer to the TEE Probe User Manual for more 
information. 



Probe Safety

LOGIQ P8/P9/P10 – Basic User Manual 11-17
Direction 5841298-1EN Rev. 2

Endocavitary probe safety

If the sterilization solution comes out of the endocavitary probe, 
please follow the cautions below.

WARNING Sterile/sanitary sheaths are to be used on the probe during its 
actual use with patients. Wearing gloves protects the patient 
and operator.

CAUTION Sterilant Exposure to Patient (e.g., Cidex)-Contact with a 
sterilant to the patient’s skin or mucous membrane may cause 
an inflammation. If this happens, refer to the sterilant’s 
instruction manual. Sterilant Exposure from Probe Handle/
Connector to Patient (e.g., Cidex)-DO NOT allow the sterilant 
to contact the patient. Only immerse the probe to its specified 
level. Ensure that no solution has entered the probe’s handle 
before scanning the patient. If sterilant comes into contact with 
the patient, refer to the sterilant’s instruction manual. 
Endocavitary Probe Point of Contact-Refer to the sterilant’s 
instruction manual.
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Care and Maintenance

Planned maintenance

The following maintenance schedule is suggested for the 
system and probes to ensure optimum operation and safety.

It is recommended to keep a maintenance log and note all probe 
malfunctions, along with a picture of any probe malfunction.

CAUTION Improper handling can lead to early probe failure and electric 
shock hazards.

DO follow the specific cleaning and disinfection procedures 
provided in this chapter and the germicide manufacturers 
instructions.

Failure to do so will void probe warranty.

Table 11-3:  Planned Maintenance Program

Do the Following Before Each Use After Each Use As Necessary

Inspect the Probes X X X

Clean the Probes X X

Disinfect Probes X
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Care and Handling

The following recommentions help to reduce preventable probe 
damage. 

NOTE: Sporadically, silicone grease can leak in small amounts from 3D/
4D probes’ cable bushing. This leakage is not a failure or 
harmful to the human body, Silicone grease does not contain 
any hazardous substances and is only used to seal the cable 
bushing. In case of a leakage wipe the grease with a cloth. 

WARNING Failure to follow these precautions can result in serious injury 
and/or equipment damage. 

Table 11-4:  Probe Care Recommendations

Do: Don’t Do:

Handle all probes with extreme care. DO NOT drop or knock the probe or probe lens. 
Impacting the probe lens face can cause fractures of 
the crystal elements leading to failulre. 

Ensure that connected probes are placed in the 
probe holder yoke when not in use. Be sure to utilize 
the endocavity probe holder and the probe inserts 
for the 3D and small aperture probes that were 
provided at delivery.

DO NOT leave probes in places where they may be 
knocked over or dropped.  

Use wall-mounted probe holders with lens facing 
upward. 

Ultrasonic cleaning IS NOT approved for GE 
probes. 

Visually inspect probes and cables for damage prior 
to connecting them to the LOGIQ P8/P9/P10. If a 
probe appears to be damaged, discontinue use and 
notify your GE Customer Service Representative. 
Possible damage may include, but is not limited to: 
• Bent or broken probe pins
• Cable cuts or splitting
• Surface cracks
• Exposed wires or shielding
• Fluid leaks

DO NOT drop probes into holders or into 
disinfectant containers with the probe’s lens face 
down.

Disconnect probes from the system prior to cleaning 
or disinfecting the probe. 

DO NOT let probe cables dangle loosely from the 
LOGIQ P8/P9/P10 where they might be caught in 
the wheels/casters while moving. 

Ensure you follow the chemical manufacturer 
recommendations regarding the use and handling of 
the chemical. 

DO NOT immerse probes deeper than permissible 
levels. NEVER immerese the connector or adapter 
into any liquid. 

Always use bite guards withTransesophageal (TEE) 
probes. 

DO NOT apply excessive bending or pulling force to 
the probe cable. 
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Clean and disinfect all probes following the 
procedures contained in this manual, Probe User 
Manual and Probe Care Carad.. 

DO NOT kink, tightly coil, or apply excessive force 
on the probe cable or TEE endoscope shaft. 
Insulation failure may result. 

Table 11-4:  Probe Care Recommendations (Continued)

Do: Don’t Do:
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Inspecting probes

Before each use

1. Inspect the probe's lens, cable, casing, and connector for
cracks, cuts, tears, and other signs of physical damage.

2. Test the functionality of the probe.

Figure 11-5. Probe parts

1. Housing

2. Strain relief

3. Seal

4. Lens

After each use

1. Inspect the probe's lens, cable, casing, and connector for
cracks, cuts, tears, and other signs of physical damage.

2. Look for any damage that would allow liquid to enter the
probe.

CAUTION If any damage is found, DO NOT use the probe until it has 
been inspected and released for further use by a GE service 
representative.



Probes and Biopsy

11-22 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Cleaning and disinfecting probes

WARNING Ultrasound transducers can easily be damaged by improper 
handling and by contact with certain chemicals. Failure to 
follow these precautions can result in serious injury and 
equipment damage.

Use only germicides that are listed in the Probe Care Card 
enclosed with the probe. In addition, refer to the local / national 
regulations.

WARNING Do not steam, heat autoclave on general surface probes.

CAUTION You MUST disconnect the probe from the LOGIQ P8/P9/P10 
prior to cleaning/disinfecting the probe. Failure to do so could 
damage the system. 

CAUTION Avoid cross-contamination, follow all infection control policies 
established by your office, department or hospital as they apply 
to personnel and equipment.

CAUTION Inspect the probe before and after each use for damage or 
degradation to the housing, strain relief, lens, seal, cable and 
connector. DO NOT use a transducer which appears damaged 
until functional and safe performance is verified. A thorough 
inspection should be conducted during the cleaning process.

CAUTION Take extra care when handling the lens face of the ultrasound 
transducer. The lens face is especially sensitive and can easily 
be damaged by rough handling. NEVER use excessive force 
when cleaning the lens face.
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Cleaning and disinfecting probes  (continued)

CAUTION Probes for neuro surgical intra-operative use must NOT be 
sterilized with liquid chemical sterilants because of the 
possibility of neuro toxic residues remaining on the probe. 
Neurological procedures must be done with the use of legally 
marketed, sterile, pyrogen free probe sheaths.

Biological
Hazard

CREUTZFIELD-JACOB DISEASE

Neurological use on patients with this disease must be 
avoided. If a probe becomes contaminated, there is no 
adequate disinfecting means.
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Probe Cleaning Process

To clean the probe:

NOTE: Do not immerse the probe into any liquid beyond the level 
specified for that probe (See ‘Immersion Level’ on page 11-30 
for more information. ). Never immerse the transducer connector 
into any liquid.

1. Inspect the probe's lens, cable, casing, and connector for
cracks, cuts, tears, and other signs of physical damage.

2. Disconnect the probe from the ultrasound console and
remove all coupling gel from the probe by wiping with a soft
cloth and rinsing with flowing water.

NOTE: DO NOT wipe the probe with a dry cloth.

3. Soak the probe head in water. Scrub the probe as needed
using a soft sponge, gauze, or cloth to remove all visible
residue from the probe surface.

4. Rinse the probe with enough clean potable water.

5. Air dry or dry with a soft cloth.

6. After cleaning, inspect the probe's lens, cable, casing and
connector. Look for any damage that would allow liquid to
enter the probe. Also, inspect the probe functionality by live
scan. If any damage is found, do not use the probe until it
has been inspected and repaired/replaced by a GE service
representative.

CAUTION • Do not use paper products or products that are abrasive
when cleaning the probe. They damage the soft lens of the
probe.

• Before storing the probes, ensure that they are thoroughly
dry. If it is necessary to dry the probe after cleaning, blot
the probe with a soft cloth.
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Choosing a Disinfectant

When choosing a disinfectant, determine the required level of 
disinfection. If the possibility of cross-contamination or exposure 
to unhealthy or non-intact skin exists, then high level disinfection 
should be performed. Good hand hygiene practice is highly 
recommended to help further reduce the risk of 
cross-contamination. 

NOTE: For additional information about cleaning and disinfection, refer 
to the recommendations of the Association for Professionals in 
Infection Control (APIC), the U.S. Food and Drug Administration 
(FDA), and the U.S. Centers for Disease Control (CDC). For 
country-specific disinfection regulations, check with your local 
regulatory infection control authorities. 

WARNING Disinfectant wipes and topical spray products are not FDA 
cleared high level disinfectants and do not provide adequate 
protection should the probe become cross contaminated or in 
contact with unhealthy or  non-intact skin. 

HINTS A validated, high-level disinfection process, combined with the 
use of a sterile gel and a probe cover/sheath is an accepted 
method of infection control for Ultrasound probes. Adequate 
records or a log book detailing the time, date, disinfection 
method, and verification of disinfectant effectiveness or test 
results is recommended. For more information about 
establishing an evidence based disinfection protocol for your 
practice, refer to the FDA, CDC, HICPAC, APIC, or the Joint 
Commission websites. 
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Disinfecting probes

In order to provide users with options in choosing a germicide, 
GE routinely reviews new medical germicides for compatibility 
with the materials used in the transducer housing, cable and 
lens. Although a necessary step in protecting patients and 
employees from disease transmission, liquid chemical 
germicides must also be selected to minimize potential damage 
to the transducer.

Refer to the Probe Care Card enclosed in the probe case or to 
the following web site for the latest list of compatible cleaning 
solutions and disinfectants.

• http://www3.gehealthcare.com/Products/Categories/
Ultrasound/Ultrasound_Probes#cleaning

• http://www3.gehealthcare.com/en/Products/Categories/
Ultrasound/Ultrasound_Probes#cleaning

Table 11-5:  Description of Pictogram on Probe Care Cards

Pictogram Description

“ATTENTION” - Consult accompanying documents” is intended to alert the 
user to refer to the operator manual or other instructions when complete 
information cannot be provided on the label.

“CAUTION” - Dangerous voltage (the lightning flash with arrowhead) is used to 
indicate electric shock hazards.

Biohazard - Patient/user infection due to contaminated equipment.
Usage
• Cleaning and care instructions
• Sheath and glove guidelines

Ultrasound probes are highly sensitive medical instruments that can easily be 
damaged by improper handling. Use care when handling and protect from 
damage when not in use. 

Do not immerse the probe into any liquid beyond the level specified for that 
probe. Refer to the user manual of the ultrasound system.
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Since there is a possibility of having negative effects on the probe, observe the 
specified immersing time by the germicide manufacturer strictly. Do not 
immerse the probe in liquid chemical germicides more than the time prescribed 
in the care card.

“Consult accompany document” - Refer to the ultrasound system user manual 
for important probe care and cleaning instruction.

Table 11-5:  Description of Pictogram on Probe Care Cards (Continued)

Pictogram Description
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Disinfecting probes  (continued)

Use additional precautions (e.g. gloves and gown) when 
decontaminating an infected probe.

NOTE: About the recommended disinfectant, review the probe care 
card that is packed with each probe.

Low-level 
disinfection

1. After cleaning, the probe and cable may be wiped with a
tissue sprayed with a recommended disinfectant.

NOTE: In order for liquid chemical germicides to be effective, all
visible residue must be removed during the cleaning
process. Thoroughly clean the probe, as described earlier
before attempting disinfection.

2. After disinfecting, inspect the probe's lens, cable, casing
and connector. Look for any damage that would allow liquid
to enter the probe. Also, inspect the probe functionality by
live scan. If any damage is found, do not use the probe until
it has been inspected and repaired/replaced by a GE
service representative.

NOTE: See ‘Probe Cleaning’ on page 12-28 for more information. 



Care and Maintenance

LOGIQ P8/P9/P10 – Basic User Manual 11-29
Direction 5841298-1EN Rev. 2

Disinfecting probes  (continued)

High-level 
disinfection

High-level Disinfection destroys vegetative bacteria; lipid & 
non-lipid viruses, fungi and, depending highly on time of contact, 
is effective on bacterial spores.

1. Prepare the high-level disinfectants solutions according to
the manufacturer's instructions. Be sure to follow all
precautions for storage, use and disposal.

NOTE: In order for liquid chemical germicides to be effective, all
visible residue must be removed during the cleaning
process. Thoroughly clean the probe, as described earlier
before attempting disinfection.

2. Place the cleaned and dried probe in contact with the
germicide for the time specified by the germicide
manufacturer. High-level disinfection is recommended for
surface probes and is required for endocavitary and
intraoperative probes (follow the germicide manufacturer's
recommended time).

NOTE: DO NOT soak probes in liquid chemical germicide for longer
than is stated by the germicide instructions for use.
Extended soaking may cause probe damage and early
failure of the enclosure, resulting in possible electric shock
hazard.

3. Rinse the part of the probe which was in contact with the
germicide according to the germicide manufacturer's
instructions. Flush all visible germicide residue from the
probe and allow to air dry.

NOTE: Do not immerse the probe into any liquid beyond the level
specified for that probe. Never immerse the transducer
connector into any liquid.

4. After disinfecting, inspect the probe's lens, cable, casing
and connector. Look for any damage that would allow liquid
to enter the probe. Also, inspect the probe functionality by
live scan. If any damage is found, do not use the probe until
it has been inspected and repaired/replaced by a GE
service representative.
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Immersion Level

 Figure 11-6. Probe Immersion Level

1. Fluid Level



Care and Maintenance

LOGIQ P8/P9/P10 – Basic User Manual 11-31
Direction 5841298-1EN Rev. 2

Coupling gels

Applying

In order to assure optimal transmission of energy between the 
patient and probe, a conductive gel or couplant must be applied 
liberally to the patient where scanning will be performed.

Precautions

Coupling gels should not contain the following ingredients as 
they are known to cause probe damage:

• Methanol, ethanol, isopropanol, or any other alcohol-based
product

• Mineral oil

• Iodine

• Lotions

• Lanolin

• Aloe Vera

• Olive Oil

• Methyl or Ethyl Parabens (para hydroxybenzoic acid)

• Dimethylsilicone

• Polyether glycol based

• Petroleum

WARNING Do not use unrecommended gels (lubricants). They may 
damage the probe and void the warranty.

About the recommended gel, review the probe care card that is 
packed with each probe.

CAUTION Do not apply gel to the eyes. If there is gel contact to the eye, 
flush eye thoroughly with water.
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Sterile Ultrasound Procedures

ONLY ultrasound gel that is labeled as sterile, is sterile. 

Ensure you always use sterile ultrasound gel for those 
procedures that require sterile ultrasound gel.

Once a container of sterile ultrasound gel is opened, it is no 
longer sterile and contamination during subsequent use is 
possible.
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Returning/Shipping Probes and Repair Parts

US Department of Transportation and GE policy requires that 
equipment returned for service MUST be clean and free of blood 
and other infectious substances.

When you return a probe or part for service (Field Engineer or 
customer), you need to clean and disinfect the probe or part 
prior to packing and shipping the equipment.

Ensure that you follow probe cleaning and disinfection 
instructions provided in the Basic User Manual.

This ensures that employees in the transportation industry as 
well as the people who receive the package are protected from 
any risk.
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Biopsy Special Concerns

Precautions Concerning the Use of Biopsy Procedures

WARNING Do not freeze the image during a biopsy procedure.  The image 
must be live to avoid a positioning error.

Biopsy guidezones are intended to assist the user in 
determining optimal probe placement and approximate the 
needle path.  However, actual needle movement is likely to 
deviate from the guideline.  Always monitor the relative 
positions of the biopsy needle and the subject mass during the 
procedure.

WARNING NEVER reuse the TR5° disposable biopsy guide attachment 
and Disposable sterile Ultra-Pro II Needle guide kits.

CAUTION The use of biopsy devices and accessories that have not been 
evaluated for use with this equipment may not be compatible 
and could result in injury.
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Precautions Concerning the Use of Biopsy Procedures  (continued)

Freehand Biopsy

CAUTION The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

• Follow the probe cleaning and disinfection procedures and 
precautions to properly prepare the probe.

• Follow the manufacturer's instructions for the cleaning of 
biopsy devices and accessories.

• Use protective barriers such as gloves and probe sheaths.

• After use, follow proper procedures for decontamination, 
cleaning, and waste disposal.

CAUTION Improper cleaning methods and the use of certain cleaning and 
disinfecting agents can cause damage to the plastic 
components that will degrade imaging performance or increase 
the risk of electric shock. 

CAUTION Ensure that the needle (especially the needle tip) is always 
visible in the ultrasound image during the whole biopsy 
procedure. 

CAUTION Ensure the correct position and optimal fit every time before 
using a biopsy guide.

CAUTION When performing a freehand biopsy, i.e. without a biopsy 
guide, it is the user’s responsibility to use appropriate 
equipment. 
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Perform a biopsy

Displaying the Guidezone

Activate the Biopsy Kit by selecting it from the B-Mode Touch 
Panel.

Figure 11-7. B-Mode Touch Panel menu

The available biopsy options appear when Biopsy Kit is 
selected. There are fixed and adjustable angle biopsy kits and 
plastic/disposable and reusable biopsy guides available with the 
LOGIQ P8/P9/P10 depending on the probe. Select the desired 
biopsy kit. 

NOTE: You can display the biopsy guideline on the CFM image in 
simultaneous mode. Enabling Color Flow allows for visualization 
of the vascular structure around the area to be biopsied. Select 
the Show Biopsy Mark on CFM simultaneous Mode preset in the 
Utility -> System -> System Image -> Biopsy Guide screen.
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Displaying the Guidezone  (continued)

Figure 11-8. Biopsy Guidezone display (example)

The biopsy guidezone represents a path of the needle. The dots 
which make up the guidezones is the depth readout where: 

• Yellow represent 1 cm increments. 

• Red represents 5 cm increments.

The display should be carefully monitored during a biopsy for 
any needle deviation from the center line or guidezone.

NOTE: Biopsy Guide Lines do not appear on Recalled Images and 
PACS when the Print Button is set to DICOM or Secondary 
Capture.
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Displaying the Guidezone  (continued)

The Biopsy Guidezone adjusts along with image adjustments, 
such as image inversion/rotations, zoom and depth changes.

NOTE: To set up biopsy guidezones, refer to Table 16-9 for more 
details.

The needle may vary from the center line or guidezone for 
various reasons:

• Needle barrel to needle clearance or strength.

• Bracket manufacturing tolerance.

• Needle deflection due to tissue resistance.

• Needle size chosen. Thinner needles may deflect more.

DANGER Failure to match the guidezone displayed to the guide may 
cause the needle to track a path outside the zone.

It is extremely important that when using the adjustable angle 
biopsy guides, the angle displayed on the screen matches the 
angle set on the guide, otherwise the needle will not follow the 
displayed guidezone which could result in repeated biopsies or 
patient injury.
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Preparing the Biopsy Guide Attachment

Convex, Sector and Linear probes have optional biopsy guide 
attachments for each probe.  The guide consists of a 
non-disposable bracket to attach to the probe, disposable 
needle clip to attach to the bracket, sheath, gel (sterile gel if 
necessary) and disposable needle barrels.

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood.

Table 11-6:  Biopsy Guide Attachments

Probe Attachment Attachment with Probe

C1-5-RS 
Multi-angle

9L-RS 
Multi-angle

ML6-15-RS 
Multi-angle
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3Sc-RS 
Multi-angle

12L-RS 
Multi-angle

12L-RS 
Infinite-angle

12L-RS 
Transverse 
Bracket

Table 11-6:  Biopsy Guide Attachments (Continued)

Probe Attachment Attachment with Probe
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RAB2-6-RS
Multi-angle

E8C-RS with 
reusable

E8C-RS with 
TR5 (PROTEK)

E8C-RS with 
TR5 (CIVCO)

L6-12-RS 
Multi-angle

RIC5-9A-RS with 
reusable

Table 11-6:  Biopsy Guide Attachments (Continued)

Probe Attachment Attachment with Probe
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RIC5-9A-RS 
(CIVCO)

BE9CS-RS with 
reusable

BE9CS-RS
(PROTEK)

BE9CS-RS
(CIVCO)

BE9CS-RS
(CIVCO)

E8CS-RS with 
reusable

E8CS-RS with 
TR5 (PROTEK)

Table 11-6:  Biopsy Guide Attachments (Continued)

Probe Attachment Attachment with Probe
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E8CS-RS with 
TR5 (CIVCO)

L4-12t-RS 
Multi-angle

L4-12t-RS 
Infinite-angle

L4-12t-RS 
Transverse 
Bracket

L3-12-RS 
Multiangle

Table 11-6:  Biopsy Guide Attachments (Continued)

Probe Attachment Attachment with Probe
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IC9-RS with 
reusable

IC9-RS
Disposable

C1-6-D
Multi-angle

C2-7-D
Stainless 
reusable

C2-7-D
Multi-angle

M5Sc-RS
Multi-angle

Table 11-6:  Biopsy Guide Attachments (Continued)

Probe Attachment Attachment with Probe
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Multi Angle Biopsy Guide Assembly

1. Scan the patient and identify the target for biopsy. Move the 
probe to locate the target to the center of the image. Enable 
the system biopsy guidezone and try guidezone angles 
MBX1 to MBX3 to decide the best angle setting for needle 
path.

Figure 11-9. Example

2. Pull up on the pin (Figure 11-10  a) to freely move the 
needle guide attachment. Align the pin with the selected 
position of the needle guide attachment.

Push the pin down (Figure 11-10  b) into the desired slot to 
secure the angle position of the needle guide attachment.

Figure 11-10. Pull up and push down the pin

WARNING DO NOT attempt to use the biopsy bracket and needle guide 
until the manufacturer's instructions, provided with the biopsy 
bracket and needle guide in the kit, have been read and 
thoroughly understood.
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Multi Angle Biopsy Guide Assembly  (continued)

3. Fit a convex piece of the biopsy bracket (a) into the concave 
position of the probe (b).

Figure 11-11. Probe/Bracket Alignment

Hold the side (a) and tuck down the needle guide side (b) 
until it clicks or locks in place. 

Figure 11-12. Probe/Multi-angle Bracket Alignment 2

4. Place an adequate amount of coupling gel on the face of the 
probe.
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Multi Angle Biopsy Guide Assembly  (continued)

5. Place the proper sanitary sheath tightly over the probe and 
biopsy bracket. Use the rubber bands supplied to hold the 
sheath in place.

Figure 11-13. Applying Sanitary Sheath

6. Snap the needle guide onto the biopsy guide bracket.

Figure 11-14. Snap the needle guide
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Multi Angle Biopsy Guide Assembly  (continued)

7. Push the locking mechanism towards the bracket to secure
the lock (a). Make sure the needle guide is firmly attached to
the bracket.

Figure 11-15. Lock the Needle guide

8. Choose the desired gauge (size) needle barrel. Twist it back
and forth to remove it from the plastic tree.

Figure 11-16. Needle Barrel

9. Place the needle barrel into the needle clip with the desired
gauge facing the needle clip and snap into place.

Figure 11-17. Needle Barrel Installation
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Multi Angle Biopsy Guide Assembly  (continued)

Remove the biopsy guide

1. Hold the other side and push out the needle clip attachment 
side. See Figure 11-18 .

Figure 11-18. Remove the biopsy guide

CAUTION Prevent damage to the probe lens with finger nails. 
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Releasing the needle

According to the following procedure, you remove the needle 
from a probe and an assembly without moving the needle.

Figure 11-19. Release the needle from assembly

a. Push the knob portion of a sleeve in the direction of the
arrow.

b. The needle is released from the assembly.

c. Push the probe and the assembly in the direction of the
larger arrow to remove the needle.
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4D Biopsy Guide Assembly - Representative Example

1. Place the needle guide onto the probe.

2. Push the needle guide until the bracket (b) catches in the
support on the housing of the probe (a).

Figure 11-20. Support on the housing

Figure 11-21. Biopsy Needle Guide

3. Fix the needle guide by locking the frame on the opposite
side.
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4D Endocavitary Probe

1. Place an adequate amount of ultrasound gel inside the
sheath tip (the gel is between the sheath inner surface and
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this
purpose.

2. Place the sheath tip over the probe aperture and then pull
the sheath end toward the probe handle.

3. Inspect the sheath for nicks, cuts or tears.

4. Rub a finger over the tip of the probe to ensure all air
bubbles have been removed.

5. Position the small swelling of the needle guide on the notch
at the probe tip. Snap the needle guide.

Figure 11-22. Installation (without probe sheath)

NOTE: Material: Stainless Steel

NOTE: Needle guide sterilization with autoclave possible.
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4D Probe Biopsy Needle Path Selection

To select the needle path and verify that the path of the needle is 
accurately indicated within the guidezone on the system 
monitor, perform the following before use:

1. Properly install the bracket and biopsy guide.

2. Scan in a container filler with water (47° C).

3. Select Biopsy kit. The available biopsy options from the
Touch Panel.

Select the biopsy guidezone where the needle echo passes
through the center of the guidezone. Use the selected
biopsy guidezone when performing the biopsy.

Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

• Properly install the bracket and biopsy guide.

• Scan in a container filled with water (47° C).

• Display the biopsy guidezone on the monitor.

• Ensure that the needle echo falls within the guidezone
markers.
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Endocavitary Probe Biopsy Guide Assembly - Representative 

Example

Preparation

To prepare the endocavitary probe for use:

1. Remove the probe from the box and carefully examine it for
any damage.

2. If the biopsy guide is to be attached, use the filling removal
tool to clean out the attachment area on the probe head.

Figure 11-23. Attachment Filling Removal

a. Probe Head

b. Attachment

c. Filling Removal Tool

3. Clean, then disinfect the probe.

NOTE: Ensure that protective gloves are worn.

WARNING DO NOT use the needle with the catheter (soft tube). There is a 
possibility of breaking the catheter in the body.

CAUTION Patient injury or repeated biopsies may result. The needle 
placement will not be as intended if the needle guide is not 
properly seated and secure.

CAUTION Before inserting the needle, scan the patient to determine the 
correct puncture depth and site. Only the sterile/sanitary 
sheath and rubber band are on the probe during the pre-needle 
placement scanning.
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Installing the sheath

To install the sheath:

1. Remove the sheath from its package. Do not unroll the
sheath.

NOTE: Remember to rinse all sanitary probe sheaths of powder
before placing on the probe. Powder can degrade the
displayed image.

2. Place an adequate amount of ultrasound gel inside the
sheath tip (the gel is between the sheath inner surface and
the probe aperture).

NOTE: Ensure that only acoustic coupling gel is used for this
purpose.

3. Place the sheath tip over the probe aperture and then pull
the sheath end toward the probe handle.

4. Inspect the sheath for nicks, cuts or tears.

Figure 11-24. Endocavitary Probe with Sheath

a. Probe Handle

b. Sanitary Sheath

c. Probe Body

5. Rub a finger over the tip of the probe to ensure all air
bubbles have been removed.
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Endocavitary Probe Biopsy Guide Preparation

1. If a biopsy is to be performed, snap the metal or plastic
biopsy guide on to the probe over the sheath.

Figure 11-25. Disposable Biopsy Guide 5 degree Angle

Figure 11-26. Reusable Biopsy Guide

a. Fix with a screw

NOTE: For the E8C-RS,E8CS-RS and IC9-RS probe, use the TR5 
guidelines for the plastic (disposable-only) biopsy guides; 
use the RU guidelines with the stainless steel reusable 
biopsy guides.

2. Place an adequate amount of ultrasound gel on the gel-filled
sheath tip’s outer surface.

3. Ensure the guide is properly seated and secure by pushing
forward on the needle insertion end of the guide until the
attachment node is firmly in place in it’s hole.
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Biopsy Guideline Display

Figure 11-27. Endocavitary Probe Biopsy Guideline - 
Reusable

Figure 11-28. Endocavitary Probe Biopsy Guideline - TR5
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BE9CS-RS Biopsy Guide Preparation

NOTE: The following graphics do not have a sheath pictured but a 
sheath must be installed before attaching the biopsy guide. 

NOTE: Recommended Needle Length: greater or equal than 220 mm.

NOTE: Recommended Needle Gauge: 16 G or thinner needle 

Reusable type

1. Ensure that the fixing screw is loose.

Figure 11-29. BE9CS-RS Biopsy Guide Screws

1. Fixing screw
2. Loosened fixing screw (ensure that the screw end is not

sticking out). Left side is a spring (not a screw).
3. Tightened fixing screw (the screw end is sticking out)
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Reusable type  (continued)

2. Align the tip of the biopsy guide to the edge on the probe
shaft.

Figure 11-30. Biopsy Guide Alignment

a. Align with edge of probe

3. Push the guide down to the probe and snap the guide in
place.

4. The biopsy guide should mate with the dent of the shaft on
the handle side.

5. The fixing screws of the biopsy guide must be securely
tightened.

NOTE: Take care not to tear the sheath when tightening the screw.

 Figure 11-31. Biopsy Guide Setting 3

6. Place an adequate amount of ultrasound gel on the gel-filled
sheath tip's outer surface.
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Disposable type

1. Align the tip of the biopsy guide to the edge on the probe
shaft.

Figure 11-32. Align the biopsy guide

2. Push the guide down to the probe and snap the guide in
place.

Figure 11-33. Push down the biopsy guide

Figure 11-34. BE9CS-RS with disposable biopsy guide
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Biopsy Guideline display

Figure 11-35. BE9CS-RS Biopsy Guide Line - Longitudinal

Figure 11-36. BE9CS-RS Biopsy Guide Line - Transverse
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Biopsy Needle Path Verification

To verify that the path of the needle is accurately indicated within 
the guidezone on the system monitor, perform the following:

• Properly install the bracket and biopsy guide.

• Scan in a container filled with water (47° C).

• Display the biopsy guidezone on the monitor.

• Ensure that the needle echo falls within the guidezone
markers.
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The Biopsy Procedure

1. Place coupling gel on the scanning surface of the probe/
sheath/biopsy guide assembly.

2. Activate the biopsy guidezone on the system through the
B-Mode Touch Panel.  When using multi-angle guides,
ensure that the proper guidezone angle is displayed.

3. Scan to locate the target.  Center the target in the electronic
guidezone path.

NOTE: Enabling color flow would allow for visualization of the
vascular structure around the area to be biopsied.

4. Place the needle in the guide between the needle barrel and
needle clip.  Direct it into the area of interest for specimen
retrieval.

WARNING Biopsy procedures must only be performed on live images.

CAUTION Ensure that all guide parts are seated properly prior to 
performing a biopsy.
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Post Biopsy

When the biopsy is complete, remove the needle barrel, needle 
clip and probe sheath.  Properly dispose of these items in 
accordance with current facility guidelines.

Clean and disinfect the probe. 

The biopsy bracket can be cleaned and disinfected in a 
recommended disinfecting agent and reused.

CAUTION When the biopsy needle guide kit is opened, all parts must be 
discarded after the procedure whether they have been used or 
not.
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Surgery/Intra-operative Use

Preparing for Surgery/Intra-operative Procedures

Preparing the transducer for intra-operative use follows the 
same sterile procedure as for biopsy use except that no biopsy 
attachments are used. See ‘Preparing the Biopsy Guide 
Attachment’ on page 11-39 for more information.  Sterile gel is 
applied to the transducer face and a sterile sheath completely 
covers the transducer and cable which has first undergone a 
thorough cleaning and high-level disinfection.

The invasive nature of biopsy procedures requires proper 
preparation and technique to control infection and disease 
transmission.  Equipment must be cleaned as appropriate for 
the procedure prior to use.

CAUTION For surgery/intra-operative procedures, a sterile environment is 
required.  Therefore, both the operator and probe needs to be 
sterile.
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Preparing for Surgery/Intra-operative Procedures  (continued)

To ensure a sterile environment during the procedure, it is 
recommended that this be a two-person job. 

1. Perform a high level disinfection of the probe. 

2. The scanner (surgeon, sonographer, etc.) should be sterile 
and gloved.

3. Place an adequate amount of sterile coupling gel on the 
face of the probe.

4. Place the proper sterile sheath over the probe and cord.

Figure 11-37. Applying Sterile Sheath

5. Depending on the type of procedure, use either sterile water 
or sterile gel on the sheath cover.

NOTE: Follow your institutions guidelines on post surgery/
intra-operative procedures for probe cleaning and disinfection.
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Chapter 12

User Maintenance

This chapter supplies system data, assistance 
information, and system care and maintenance 
instructions. 
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System Data

Features/Specifications

Table 12-1:  Physical Attributes

Dimensions and Weight
• Height: 1,345mm (Minimum), 1,595mm (Max.)
• Height (with HD Display): 1,390mm (Minimum),

1,640mm (Max.)
• Width : 545mm (23.8 inch monitor), 565mm (23.8

inch HD Display), 430mm (Operator Panel)
• Depth: Max 740mm
• Weight: 67 kg (148 lb.) (69 kg with HD Display (152 

lb.))

Console Design
• 4 active probe ports
• 1 non imaging, CW pencil probe port (Option)
• Integrated SSD
• Integrated DVD-RW Multi Drive (Option)
• On-board storage of BW thermal printer
• Integrated speakers
• Locking mechanism that provides rolling lock and

caster swivel lock
• Integrated cable management
• Front handle
• Rear handle (Option)
• Gel holder
• Easily removable air filters

Electrical Power
• Voltage:100V - 240V AC
• Frequency: 50/60 Hz
• Power: Consumption maximum of 500 VA with

peripherals
• Power cord: Type SJT, SJE, SJO or SJTO,

14AWG, 3-Conductor, VW-1, 125 V or 250 V, 10 A, 
max 3.0 m long; One end with Hospital Grade
Type, NEMA 5-15P or 6-15P. Other end with
appliance coupler.

Operator Panel
• Operating keyboard adjustable in two dimensions

of Height and Rotation
• Backlit alphanumeric keyboard (Option)
• Ergonomic hard key layout
• Interactive back-lighting
• Integrated recording keys for remote control of up

to 6 peripheral or DICOM devices
• Gel warmer (Option)

Touch panel
• Wide 10.4 in High Resolution, Color, Touch, LCD

screen
• Interactive dynamic software menu
• Brightness adjustment
• User-configurable layout
• Probe light

LCD Monitor 
• 23.8inch bezel-less LCD LED backlight monitor
• 23.8inch HD Display (option)
• LCD translation (independent of console): 500 mm 

horizontal (end to end), 150 mm vertical (end to
end), 90  Swivel

• Fold-down and lock mechanism for transportation
• Brightness & contrast adjustment
• Resolution: 1920 x 1080
• Horizontal/Vertical viewing angle of +/- 178
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Table 12-2:  System Overview

Applications
• Abdominal
• Obstetrical
• Gynecological
• Breast
• Small Parts
• Vascular
• Transcranial
• Transrectal
• Transvaginal
• Pediatric and Neonatal
• Musculoskeletal
• Urological
• Cardiac
• Intraoperative (Not for China)
• Peripheral vascular
• Transesophageal (Not for China)

Scanning Methods
• Electronic Sector
• Electronic Convex
• Electronic Linear
• Mechanical Volume Sweep

Operating Modes
• B-Mode
• M-Mode
• Color Flow Mode (CFM)
• M-Color Flow Mode
• Power Doppler Imaging (PDI)
• PW Doppler Mode
• CW Doppler Mode (Option)
• Volume Mode (Easy 3D, Advanced 3D, 4D, STIC,

Omiview, HDLive)
• Anatomical-M Mode
• Curved Anatomical M-Mode
• B-Flow/B-Flow Color (Option)
• Extended Field of View (LOGIQView, Option)
• TVI Mode (Option)
• Coded Contrast Imaging (LP9 Only, Option)
• B-Steer + (Option)
• Coded Harmonic Imaging
• M-Color Flow mode
• Offline scanning mode (Power Assistant Option)
• Strain Elastography (Option)
• Shear Wave Elastography (Option)
• UGAP (Option)

Display Modes
• Simultaneous Capability

• B or CrossXBeam / PW
• B or CrossXBeam / CFM or PDI
• B / M
• B or CrossXBeam + CFM or PDI / PW

(Real-time Triplex Mode)
• B / CW (option)

• Selectable Alternating Modes
• B or CrossXBeam / PW
• B or CrossXBeam + CFM(PDI) / PW
• B / CW (option)

• Colorized Image
• B mode
• M mode
• Doppler mode

• Time line Display
• Independent Dual B or CrossXBeam || PW

Display
• CW Display
• 2 Display Formats (Top / Bottom, Side / Side

selectable Format)
• Selectable Size Formats (Full format,

Switchable after freeze, Vert 1/3 B, Vert 1/2 B,
Vert 2/3 B, Horiz 1/2 B, Horiz 1/4 B)

• 2 Timeline Methods (Scrolling, Moving Bar)
• Virtual Convex
• Multi-image (split/quad screen)
• Live and/or frozen

• B or CrossXBeam + B or CrossXBeam || CFM 
or PDI

• PW/M
• Zoom: Write/Read
• Simultaneous Bi-plane for Urology application

• BE9CS-RS

Transducer Types
• Sector Phased Array
• Linear Array
• Convex Array
• Micro convex Array
• Matrix Array (LP9 Only)
• Single CW (Pencil) Probes
• Volume probe (4D)
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Standard Features
• Advanced user interface with high resolution 10.4

inch wide touch screen
• Automatic Optimization
• CrossXBeam
• Speckle Reduction Imaging (SRI-HD)
• Fine Angle Steer
• Coded Harmonic Imaging
• Virtual Convex
• Patient information database
• Image Archive on integrated CD/DVD and hard

disk drive
• Real-time automatic Doppler calcs
• OB Calcs
• Fetal Trending
• Multi gestational Calcs
• Hip Dysplasia Calcs
• Gynecological Calcs
• Vascular Calcs
• Urological Calcs
• Renal Calcs
• Cardiac Calcs
• inSite ExC Capability
• On-board electronic documentation
• Raw Data Analysis
• MPEGVue
• Key Macro
• Network Storage
• Quick Save
• Quick Patient Entry
• Email2MMS
• Easy 3D

Options
• Auto EF
• Cardiac Strain
• Auto IMT
• B-Flow/B-Flow Color
• Breast Measure Assistant
• Breast Productivity Package
• B Steer+
• Coded Contrast Imaging (CEUS, HRes)
• Compare Assistant
• CW Doppler
• DICOM 3.0 connectivity
• Digital Video Recording Software (Software DVR)
• Elastography Quantification
• LOGIQView
• OB Measure Assistant
• Offline scanning
• Power Assistant
• Standard Battery
• Extended Battery

• Quantitative Flow Analysis
• Real-Time 4D
• Automated Volume Calculation (VOCAL II)
• Tomographic Ultrasound Imaging
• Volume Contrast Imaging (VCI) Static
• OmniView
• STIC
• HDLive
• Report Writer
• Scan Assistant
• Shear Wave Elastography
• Strain Elastography
• Stress Echo
• Thyroid Productivity Package
• Tissue Velocity Imaging (TVI)
• LOGIQApps
• Bluetooth
• Wireless LAN
• Gel warmer
• DVDCabinet: High/Low Drive
• Koios Breast Lesion Decision Support
• Thyroid Productivity Package
• UGAP
• Hepatic Assistant

Peripheral Options
• Integrated options for

• Digital B/W thermal printer
• Digital color thermal printer

• Digital A6 color thermal printer
• External USB Printer connection
• HDMI output available for compatible device
• S-Video output available for compatible device
• Composite Video output available for compatible

device
• Wireless LAN
• Printing using Bluetooth connectivity (Inkjet printer

option)
• Printer installation kit
• Footswitch with programmable functionality
• Isolation Transformer
• Isolated USB connector
• EMI filter (PWR supply noise filter)
• Drawer
• Small Probe Holder (Probe Holder Adapter for

Small Probe)
• Probe cable hanger
• ECG + AHA/IEC Cables
• Power Assistant
• Extended battery life
• Battery Pack (for Power Assistant/Extended

battery life)

Table 12-2:  System Overview (Continued)
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Table 12-3:  System Parameters

Controls Available on Freeze or Recall
• Automatic Optimization
• SRI-HD
• CrossXBeam - Display non-compounded and

compounded image simultaneously in split screen
• 3D reconstruction from a stored CINE loop
• B/M/CrossXBeam Mode (Gray Map; TGC,

Colorized B and M; Frame Average [Loops only];
Dynamic Range)

• Anatomical M-Mode
• Max Read Zoom to 20x
• Base Line Shift
• Sweep Speed
• PW-Mode (Gray Map; Post Gain; Baseline Shift;

Sweep Speed; Invert Spectral Waveform;
Compression; Rejection, Colorized Spectrum;
Display Format; Doppler Audio; Angle Correct;
Quick Angle Correct, Auto Angle Correct)

• Color Flow (Overall Gain [Loops and Stills]; Color
Map; Transparency Map; Frame Averaging [Loops 
only]; Flash Suppression, CFM Display Threshold; 
Spectral Invert for Color/Doppler)

• Anatomical M-Mode on CINE Loop
• 4D (Gray Map, Colorize; Post Gain; Change

display between single, dual, quad sectional or
rendered)

Controls Available While “Live”
• Write zoom
• B/M-Mode (Gain; TGC; Dynamic Range; Acoustic

Output; Transmission Focus Position;
Transmission Focus Number; Line Density
Control; Sweep Speed for M-Mode; # of Angles for 
CrossXBeam)

• PW-Mode (Gain; Dynamic Range; Acoustic
Output; Transmission Frequency; PRF; Wall Filter; 
Spectral Averaging; Sample Volume Gate for
PW-Mode Length and Depth; Velocity Scale)

• Color Flow (CFM Gain; CFM Velocity Range;
Acoustic Output; Wall Echo Filter; Packet Size;
Frame Rate Control; CFM Spatial Filter; CFM
Frame Averaging; CFM Line Resolution;
Frequency/Velocity Baseline Shift)

Scanning Parameters
• Displayed Imaging Depth: 0 - 48 cm
• Minimum Depth of Field: 0 - 1 cm (Zoom) (probe

dependent)
• Maximum Depth of Field: 0 - 48 cm (probe

dependent)
• Continuous Dynamic Receive Focus / Continuous

Dynamic Receive Aperture
• Adjustable Dynamic Range
• Adjustable Field of View [FOV]
• Image Reverse: Right/ Left
• Image Rotation: 0 , 90 , 180 , 270

Image Storage 
• On-board database of patient information from

past exams
• Storage Formats:

• DICOM - compressed/ uncompressed, single/
multiframe, with/ without Raw Data

• Export JPEG,JPEG2000, WMV MPEG 4 and
AVI formats

• Storage Devices:
• USB Flash Device: 64MB to 4GB (for

exporting individual images/clips)
• CD-R storage: 700MB
• DVD storage: -R (4.7GB)
• Hard Drive Image Storage: ~350GB

• Compare old images with current exam
• Reload of archived data sets

CINE Memory/Image Memory 
• 776 MB of CINE Memory
• Selectable CINE Sequence for CINE Review
• Prospective CINE Mark
• Measurements/Calculations & Annotations on

CINE Playback
• Scrolling timeline memory
• Dual Image CINE Display
• Quad Image CINE Display
• CINE Gauge and CINE Image Number Display
• CINE Review Loop
• CINE Review Speed
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Table 12-4:  Measurements and Calculations

B-Mode
• Depth and Distance
• Circumference and Area (Ellipse/Trace)
• Volume (Ellipsoid)
• Angle between 2 Lines
• % Stenosis (Area or Diameter)

M-Mode
• M Depth and Distance
• Time
• Slope
• Heart Rate

Doppler Measurements/Calculations
• Velocity
• Time
• A/B Ratio (Velocities/Frequency Ratio)
• PS (Peak Systole)
• ED (End Diastole)
• PS/ED (PS/ED Ratio)
• ED/PS (ED/PS Ratio)
• AT (Acceleration Time)
• Accel (Acceleration)
• TAMAX (Time Averaged Maximum Velocity)
• Volume Flow [TAMEAN and Vessel Area]
• Heart Rate
• PI (Pulsatility Index)
• RI (Resistivity Index)

Vascular Measurements/Calculations
• Carotid, Vertebral, Subclavian Measurements,

Auto IMT
• Summary Reports

Obstetrics Measurements/Calculations
• Gestational Age Calculation
• EFW Calculation
• Calculations and Ratios
• Measurements/Calculations
• Fetal Graphical Trending
• Growth Percentiles
• Multi-Gestational Calculation
• Fetal Qualitative Description (Anatomical Survey)
• Fetal Environmental Description (Biophysical

profile)
• Programmable OB Tables
• Over 20 selectable OB Calcs
• Expanded Worksheets

Obstetrics Measurements/Calculations
• Gestational Age Calculation
• EFW Calculation
• Calculations and Ratios
• Measurements/Calculations
• Fetal Graphical Trending
• Growth Percentiles
• Multi-Gestational Calculation
• Fetal Qualitative Description (Anatomical Survey)
• Fetal Environmental Description (Biophysical

profile)
• Programmable OB Tables
• Over 20 selectable OB Calcs
• Expanded Worksheets

Gynecology Measurements/Calculations
• Right/Left Ovary Length, Width, Height
• Uterus Length, Width, Height
• Cervix Length, Trace
• Ovarian Volume
• ENDO (Endometrial thickness)
• Ovarian/Uterine RI
• Summary Report

Urology Calculation
• Bladder, Prostate, Renal, Generic Volume

Measurements
• Post-Void Bladder Volume

Cardiology Measurements/Calculations
• Cardiology Measurements and Calculations
• Summary Worksheet
• Summary Report
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*LOGIQ P10/P9
only

**LOGIQ P10 only

Table 12-5:  Probes

• C1-5-RS [Applications: Abdomen(incl. Pleural),
Vascular(No transcranial), OB/GYN, Urology]

• C2-7-D [Applications: Abdomen(incl. Pleural)]
• 8C-RS [Applications: Pediatrics, Neonatal]
• 10C-D [Applications: Neonatal, Pediatric,

Vascular(No transcranial)]
• E8C-RS [Applications: OB/GYN, Urology,

Transvaginal, Transrectal]
• E8CS-RS [Applications: OB/GYN(Transvaginal),

Urology(Transrectal)]
• IC9-RS [Applications: OB/GYN,

Urology(Transvaginal, Transrectal)]
• BE9CS-RS [Applications: Urology(Transrectal)]
• ML6-15-RS [Applications: Abdomen(incl. Pleural),

Small Parts, Vascular(No transcranial), Pediatric,
Neonatal, Musculoskeletal, Breast]

• L3-12-RS [Applications: Abdomen(incl. Pleural),
Vascular(No transcranial), Small Parts, Pediatric,
Neonatal, OB, Breast, Musculoskeletal]

• L4-12t-RS [Applications: Abdomen(incl. Pleural),
Small Parts, Vascular(No transcranial), Pediatric,
Neonatal, Musculoskeletal, Breast]

• 12L-RS [Applications: Abdomen(incl. Pleural),
Small Parts, Vascular(No transcranial), Pediatric,
Neonatal, Musculoskeletal, Breast]

• L6-12-RS [Applications: Abdomen(incl. Pleural),
Vascular(No transcranial), Small Parts, Pediatric,
Neonatal, Breast]

• 9L-RS [Applications: Abdomen(incl. Pleural),
Small Parts, Vascular(No transcranial), Pediatric,
Neonatal, OB, Breast, Musculoskeletal]

• L8-18i-RS [Applications: Small Parts, Vascular(No
transcranial), Peripheral Vascular, Neonatal,
Pediatrics, Intraoperative(Not for China),
Musculoskeletal]

• 3Sc-RS [Applications: Cardiac, Abdomen(incl.
Pleural), Transcranial]

• 6S-RS [Applications: Abdomen(incl. Pleural),
Cardiac, Pediatrics, Neonatal, OB]

• 12S-RS [Applications: Abdomen(incl. Pleural),
Pediatrics, Neonatal]

• RAB2-6-RS [Applications: Abdomen, OB/GYN,
Urology]

• RIC5-9A-RS [Applications: OB/GYN(Transvaginal),
Urology(Transrectal)]

• P8D [Applications: Cardiac, Vascular(No
transcranial)]

• P6D [Applications: Cardiac, Vascular(No
transcranial)]

• P2D [Applications: Cardiac, Vascular(No
transcranial)]

• L3-9i-RS* [Applications: Small Parts, Vascular,
Musculoskeletal, Neonatal, Intraoperative(Not for
China)]

• L10-22-RS* [Applications: Small Parts,
Musculoskeletal, Neonatal]

• 6Tc-RS [Applications: Cardiac(Transesophageal)]
• C1-6-D* [Applications: Abdomen(incl. Pleural), OB, 

Gynecology, Vascular(No transcranial), Urology]
• C3-10-D** [Applications: Abdomen(incl. Pleural),

Neonatal, Pediatric, Vascular(No transcranial)]
• M5Sc-RS** [Applications: Cardiac, Transcranial,

Abdomen(incl. Pleural)]

Table 12-6:  Biopsy Guides

• Single-Angle, disposable with a reusable bracket
• Multi-Angle, disposable with a reusable bracket

• Single-Angle, disposable with a disposable bracket

Table 12-7:  Inputs and Outputs Signal

• USB 2.0 x 5 ports, USB 3.0 x 2 ports
• HDMI connector

• Ethernet 1000/100/10BaseT
• Audio Line Out (1.5mm pin jack)

Table 12-8:  Physiological Input Panel (Option)

• Physiological Input
• ECG 2 lead
• Dual R-Trigger
• Pre-settable ECG R Delay Time
• Pre-settable ECG Position
• Adjustable ECG Gain Control

• Automatic Heart Rate Display
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Clinical Measurement Accuracy

Basic Measurements

The following information is intended to provide guidance to the 
user in determining the amount of variation or measurement 
error that should be considered when performing clinical 
measurements with this equipment.  Error can be contributed by 
equipment limitations and improper user technique.  Be sure to 
follow all measurement instructions and develop uniform 
measurement techniques among all users to minimize the 
potential operator error.  Also, in order to detect possible 
equipment malfunctions that could affect measurement 
accuracy, a quality assurance (QA) plan should be established 
for the equipment that includes routine accuracy checks with 
tissue mimicking phantoms.

Please be advised that all distance and Doppler related 
measurements through tissue are dependent upon the 
propagation velocity of sound within the tissue.  The propagation 
velocity usually varies with the type of tissue, but an average 
velocity for soft tissue is assumed.  This equipment is designed 
for, and the accuracy statements listed on are based on, an 
assumed average velocity of 1540 m/s.  The percent accuracy 
when stated applies to the measurement obtained (not the full 
scale range).  Where the accuracy is stated as a percent with a 
fixed value, the expected inaccuracy is the greater of the two.
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Basic Measurements  (continued)

Table 12-9:  System Measurements and Accuracies

Measurement Units Useful 
Range

Accuracy Limitations or 
Conditions

Depth mm Full Screen max (5% or 1 mm)

Angle degree Full Screen max (10% or 1deg)

Distance:

Axial mm Full Screen max (5% or 1 mm)

Lateral mm Full Screen max (5% or 2 mm) Linear Probes

Lateral mm Full Screen max (5% or 4 mm) Convex 
Probes

Lateral mm Full Screen max (5% or 4 mm) Sector Probes

Circumference:

Trace mm Full Screen max (10% or 1 mm)

Ellipse mm Full Screen max (5% or 1 mm)

Area:

Trace mm2 Full Screen max (5% or 1 mm2)

Ellipse mm2 Full Screen max (5% or 1 mm2)

3D Volume 
Accuracy

cm3 Full Screen max (10% or 1.0 
cm3)

Time s Timeline 
Display

max (5% or 10 ms) M mode, PWD 
mode, CWD 
mode, TVD 
mode

Slope mm/s Timeline 
Display

max (5% or 1 mm/
s)

M-Mode

Doppler SV 
Position

mm Full Screen 2 mm PWD mode, 
TVD mode

Velocity cm/s Timeline 
Display

max (10% or 1cm/s) PWD mode, 
CWD mode, 
TVD mode
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Doppler Angle 
Correction

cm/s From 0-60

From 60-80

max (5% or 1deg)

12%

PWD mode, 
CWD mode, 
TVD mode

Table 12-9:  System Measurements and Accuracies

Measurement Units Useful 
Range

Accuracy Limitations or 
Conditions
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Clinical Calculation Accuracy

Estimate the overall inaccuracy of a combined measurement 
and calculation by including the stated inaccuracy from the basic 
measurement accuracy statements.

Calculation formulas and databases are provided as a tool to 
assist the user, but should not be considered an undisputed 
database, in making a clinical diagnosis.  The user is 
encouraged to research the literature and judge the equipment 
capabilities on an ongoing basis in order to assess its utility as a 
clinical tool.

CAUTION Diagnostic errors may result from the inappropriate use of 
clinical calculations.  Review the referenced source of the 
stated formula or method to become familiar with the intended 
uses and possible limitations of the calculation.
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Anti-Virus Software Note

LOGIQ P8/P9/P10 Security

Since the LOGIQ systems are integrated into your IT-network, 
GE wants to make sure that you are aware of the proactive 
measures we are taking to secure the system. Below are 
measures we have implemented to secure the LOGIQ systems. 

• Use of Windows* Embedded Standard 10, a componentized
version of Windows 10 specifically made for embedded
systems. Only the components required are used for the
LOGIQ scanners, thereby reducing the OS attack surface.
Please note that Windows Embedded Standard 7 is NOT
the same operating system as Windows 10.

• Disabled the user’s ability to access the internet and
Windows desktop.

• Disabled, or made inaccessible, functionality that is typically
used as malware vectors for spreading viruses (e.g. email
services, web browsers).

• Disabled AutoRun functionality on removable media.

• Closed network entry points that are not in use by the
LOGIQ scanner software by strict firewall configuration and
by disabling Services. The only Internet connection needed
is on outbound port to GE’s remote service platform
(Insite™  ExC), which is only opened on request by the user
and through a secure HTTPS connection (port 443), and
inbound and outbound connections through port 104 for
DICOM connectivity.
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LOGIQ P8/P9/P10 Security  (continued)

• System provides user access controls under customer
management to control scanner access.

• Uses secure integration and communication between
systems (Scanners, Workstations and Servers).

• Monitor public security bulletins from software vendors and
news services, analyze for applicability to the LOGIQ
scanner, and include third party software security patches
as necessary within GE software.

• Release GEHC Ultrasound validated software or use other
measures as necessary to resolve or mitigate product
vulnerabilities.

• Assess potential vulnerabilities of our systems using
up-to-date commercially available vulnerability scanning
tools. Identified vulnerabilities are mitigated as appropriate
based on risk assessment of the product.

GE believes that this Defense in Depth strategy using the 
combination of the security measures above and the security 
standards of Microsoft’s Windows Embedded Standard 10 will 
provide security against malware, especially for a system used 
in a professinoal, hospital grade networking environment that 
itself should provide a high level of security measures.

Finally, a few points as to why GE (as well as all other 
manufacturers of PC-based medical Ultrasound devices) do not 
use Anti-Virus software: Commercial Anti-Virus software is 
commonly used on general-purpose computers to detect the 
presence of malicious software (e.g. virus, Trojan horse, worm). 
Anti-Virus software is useful on general-purpose computers as 
they typically cannot be sufficiently hardened against the attack 
vectors used by malicious software.
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LOGIQ P8/P9/P10 Security  (continued)

The LOGIQ ultrasound systems however are single purpose 
(dedicated) devices that have controlled intended use, and thus 
are well hardened. For the LOGIQ ultrasound systems, the 
potential patient safety and security risks introduced by using 
commercial Anti-virus software would outweigh the security 
benefits.  Such risks include:

• Real-time anti-virus scanning can affect ultrasound system
performance.

• The effectiveness of Anti-Virus software depends on regular
updates of the virus definitions files. This would typically
require internet connectivity for the ultrasound system.

• The Anti-Virus software itself is a popular attack vector.

• Disruptive nature of the support of the Anti-Virus software
throughout the life cycle of the medical device. The
operating system of a medical ultrasound system is part of a
medical device that requires a special and controlled
release process. Any update of the Anti-Virus software
would require a change of the system software.

Due to the cited risks, the use of commercial anti-virus software 
is not part of the LOGIQ systems product security strategy.

*Microsoft and Windows are trademarks of Microsoft Corporation.

NOTE:

NOTE:
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Copyrighted Material

Viewing Copyrighted Third Party Software License Information

The LOGIQ P8/P9/P10 contains copyrighted material. For more 
information, you can view Copyrighted Third Party Open Source 
Software Licenses via the Utility-> System-> Licenses page. 

• Select Utility-> System-> Licenses

• Scroll to select the license you wish to view in the License
Title section. Press Set.

Figure 12-1. Third Party Software License Information

• The selected software license appears in the License
window. Use the Set+Trackball to scroll through the license.
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System Care and Maintenance

Overview

The user must ensure that safety inspections are performed at 
least every 12 months according to the requirements of the 
patient safety standard IEC 60601-1 (1988). Refer to the Service 
manual, Chapter 10. Only trained persons are allowed to 
perform the safety inspections mentioned above. Technical 
descriptions are available on request. To ensure that the unit 
constantly operates at maximum efficiency we recommend that 
the following procedures be observed as part of the customer’s 
internal routine maintenance program.

Contact the local Service Representative for parts or periodic 
maintenance inspections.

Expected Service Life Description

The expected service life for the LOGIQ P8/P9/P10 system and 
probes is identified in this table: 

Table 12-10:  Expected Service Life

Equipment / Accessory Expected Service Life

LOGIQ P8/P9/P10 system The expected service life for the LOGIQ P8/P9/P10 is at least seven 
(7) years from the manufacturing date under the provision of regular
maintenance by authorized service personnel.

LOGIQ P8/P9/P10 Probes The expected service life for the LOGIQ P8/P9/P10 probes meets or 
exceeds five (5) years from the date the probe is placed in service, 
under the provision that the customer follows the care instructions 
provided on the Probe Care Card / Accompanying LOGIQ P8/P9/P10 
Instructions for Use.
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Inspecting the System

CAUTION To avoid electrical shock hazard, do not remove panels or 
covers from console. This servicing must be performed by 
qualified service personnel. Failure to do so could cause 
serious injury.
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Maintenance Schedule

Monthly Maintenance

Examine the following on a monthly basis (or whenever there is 
a reason to assume that any issue may have occurred):

• Connectors on cables for any mechanical defects.

• Entire length of electrical and power cables for cuts or
abrasions.

• Equipment for loose or missing hardware.

• Control panel and keyboard for defects.

• Casters for proper locking operation.

• Trackball movement

If the trackball is dusty, please clean it. See ‘Trackball’ on
page 12-24 for more information.
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Weekly Maintenance

The system requires weekly care and maintenance to function 
safely and properly. Clean the following:

• System Cabinet

• Monitor

• Operator control panel

• Touch Panel

• Probe holder

If the probe holder is dusty, please clean it.

• Gel warmer

If the gel warmer is dusty, please clean it. ‘Gel warmer’ on
page 12-25

• Footswitch

• Air filter

If the air filter is dusty, please clean it. See ‘Cleaning the air
filter’ on page 12-26 for more information.

NOTE: Frequency of the cleaning is depend on environment.

Failure to perform required maintenance may result in 
unnecessary service calls.
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Appropriate Cleaning  Agents

Table 12-11:  Appropriate Cleaning Agents

Components
Probe 
holder

User 
interface

*
Touch 
Panel

Monitor 
display

Hou-
sing Probes

Air
Filter

Peri-
pherals 

(e.g. 
Printers

...)

When to clean See ‘Maintenance Schedule’ on page 12-18 for more information.
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S
e

e 
‘C

le
a

n
in

g
 a

n
d

 d
is

in
fe

ct
in

g
 p

ro
b

e
s’

 o
n

 p
a

g
e

11
-2

1
 f

o
r 

m
o

re
 in

fo
rm

a
tio

n
.

C
le

a
n

 w
ith

 a
 v

a
cu

u
m

 c
le

a
n

e
r 

fr
o

m
 t

h
e

 o
ut

si
d

e

C
le

a
n

in
g

 A
g

e
n

t

OXIVIR TB 
WIPES

X X X - X

Acryl-Des 
Wipes

X X X X X

Alcohol 
(Isopropyl) 
70%

X X X X X

CAVIWIPES 
1

X X X X X

Cleanisept 
Wipes

X X X X X

Clinell Clorox 
Wipes

X X X X X

Clinell 
Universal
Sanitizing
Wipes

X X X X X

Clorox
Healthcare™ 
Bleach 
Germicidal 
Wipes

X X X X X

Distel X X X X X

Mikrobac® 
Tissues

X X X X X

Mikrozid® 
Sensitive
Wipes

X X X X X

PDI Easy 
Screen
Cleaning®

X X X X X
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X : can be used on the component of the ultrasound console

- : do not use on component of the ultrasound console

NOTE: * Effective cleaning for parts with narrow gaps and holes (e.g. 
Keyboard, trackball...) is not possible. For more information, visit 
to http://cleaning.gehealthcare.com/. GE verified that the above 
listed agents are chemically compatible with the product. No 
statement on the cleaning or disinfection effectivity of the 
individual agents can be done by GE.

Table 12-12:  Appropriate Cleaning Agents 
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Sani-Cloth® 
Bleach

X X X X X

Sani-Cloth® 
HB

X X X X X

Sani-Cloth® 
Plus

X X X X X

Sani-Cloth® 
Prime

X X X X X

Septiwipes X X X X X

Sodium 
Hypochlorite 
5.25% 
(Bleach) 
Diluted 10:1

X X X X X

Sono 
Ultrasound 
Wipes

X X X X X

Super 
Sani-Cloth®

X X X X X

Trophon 
Companion 
Cleaning 
Wipes

X X X X X
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Cleaning the system

Prior to cleaning any part of the system:

1. Turn off the system power. If possible, disconnect the power
cord. See ‘Power Off’ on page 3-36 for more information.

System Cabinet

To clean the system cabinet:

1. Moisten a soft, non-abrasive folded cloth with a mild,
general purpose, non-abrasive soap and water solution.

NOTE: The cloth should be damp, not dripping wet.

2. Wipe down the top, front, back, and both sides of the system
cabinet.

NOTE: Do not spray any liquid directly into the unit.

LCD Monitor and Touch Panel

NOTE: Never use thinner, benzene, alcohol (ethanol or methanol), 
abrasive cleaners, or other strong solvents, as these may cause 
damage to the cabinet or LCD panel.

NOTE: DO NOT scratch or press on the panel with any sharp objects, 
such as pencils or pens, as this may result in damage to the 
panel.

To clean the LCD panel and the Touch Panel:

• The surface can be cleaned with a dry and soft cloth, such
as cloths for cleaning glasses.

• If necessary, stubborn stains can be removed by moistening
part of a cloth with water to enhance its cleaning power.
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Operator Control Panel

To clean the operator control panel:

1. Moisten a soft, non-abrasive folded cloth with a mild,
general purpose, non-abrasive soap and water solution.

2. Wipe down operator control panel.

3. Use a cotton swab to clean around keys or controls. Use a
toothpick to remove solids from between keys and controls.

NOTE: When cleaning the operator control panel, make sure not to spill 
or spray any liquid on the controls, into the system cabinet, or in 
the probe connection receptacle.

NOTE: In case of SARS, use bleach, alcohol, or Cidex in a normal 
diluted form for cleaning/disinfecting the operator panel. 

NOTE: DO NOT use T-spray or Sani Wipes on the control panel. 

NOTE: The cloth should be damp, not dripping wet. 

Footswitch

To clean the footswitch:

1. Moisten a soft, non-abrasive folded cloth with a mild,
general purpose, non-abrasive soap and water solution.

2. Wipe the external surfaces of the unit then dry with a soft,
clean, cloth.

CAUTION Before cleaning the control panel, make sure the key cap is 
firmly in place. 
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Trackball

1. Power off the system.

2. Rotate the retainer counterclockwise until it can be removed
from the keyboard.

Figure 12-2. Remove the retainer

3. Separate the trackball and the retainer. Wipe off any oil or
dust from the trackball, retainer and the trackball housing
using a cleaner or cotton swab.

4. Assemble the trackball and retainer, then put it into the
housing and rotate it clockwise until its notches are set in
position.

CAUTION When cleaning, make sure not to spill or spray any liquid into 
the trackball housing (keyboard or system).
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Probe holder

1. Remove the holder.

Figure 12-3. Remove the holder

2. Wash the holder with mild soap in lukewarm water. Scrub it
using a soft sponge, gauze, or cloth to remove all visible
residue from the surface. Prolonged soaking or scrubbing
with a soft bristle brush (such as a toothbrush) may be
necessary if material has dried onto the surface.

3. Rinse the holder with enough water.

4. Dry with a soft cloth and put it back.

Gel warmer

NOTE: Gel Warmer is expected to be cleaned when dust or other debris 
cumulates.

1. Remove the screw-on lid of the bottom.

Figure 12-4. Gel warmer cap

2. Wipe inside of the gel warmer with soft cloth.

3. Wash the cap with mild soap in lukewarm water. Rinse the
cap with enough water.

4. Dry with a soft cloth and put it back.
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Cleaning the air filter

Clean the system's air filters to ensure that a clogged filter does 
not cause the system to overheat and reduce system 
performance and reliability. It is recommended the filters be 
cleaned every two weeks, but the requirements will vary due to 
your system use.

Cleaning

1. Pull the front cover of cabinet with hand and pull out the air
filter.

Figure 12-5. Air filter location

CAUTION Be sure to lock the wheels before cleaning the air filters to 
avoid injury by any unexpected movement of the system.

DO NOT operate the unit without the air filters in place.

Allow the air filters to dry thoroughly before re-installing them 
on the unit.
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Cleaning  (continued)

2. Pull out the filter.

Figure 12-6. Air filter location

3. Dust the filter with a vacuum cleaner and/or wash it with a
mild soapy solution.

If washed, rinse and dry the filter before re-installation.

4. Put back the air filter and the front cover.
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Probe Cleaning

Refer to Chapter 17, the Probes Chapter, for probe cleaning and 
disinfecting instructions. 

When cleaning/disinfecting probes using a spray cleaner/
disinfectant, DO NOT spray the probe while the probe is set in 
its probe holder on the Ultrasound system. Overspray can 
damage the TGC controls. 

Figure 12-7. DO NOT Spray a Probe While in its Holder

CAUTION NEVER use any cleaner or disinfectant containing alcohol.
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Probe Cleaning  (continued)

If you use a spray cleaner, spray AWAY from the Ultrasound 
system. 

Figure 12-8. Spray Probes AWAY from the Ultrasound System

If you are cleaning/disinfecting probes while they are on the 
Ultrasound system, use a wipe cleaner/disinfectant instead. 

Figure 12-9. Using a Wipe to Clean/Disinfect a Probe



User Maintenance

12-30 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Prevention of static electricity interference

Interference from static electricity can damage electronic 
components in the system. The following measures help to 
reduce the likelihood of electrostatic discharge:

• Wipe the alphanumeric keyboard and monitor with lint-free
tissue or a soft cloth dampened with anti-static spray on a
monthly basis.

• Spray carpets with anti-static spray because constant
walking on carpets in or near the scanning room may be a
source of static electricity.
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Disposal

Disposal of Old Electrical & Electronic Equipment (applicable in 
the European Union and other European countries with 
separate collection systems). This symbol on the product or on 
its packaging indicates that this product shall not be treated as 
household waste. Instead it shall be handed over to the 
applicable collection point for the recycling of electrical and 
electronic equipment. By ensuring this product is disposed of 
correctly, you will help prevent potential negative consequences 
for the environment and human health, which could otherwise 
be caused by inappropriate waste handling of this product. The 
recycling of materials will help to conserve natural resources. 
For more detailed information about recycling of this product, 
please contact your local city office, your household waste 
disposal service or the shop where you purchased the product.

Battery Replacement and Disposal

Battery replacement every two years is recommended. Contact 
a local Service Representative for the replacement of the 
battery.

Power Assistant uses a Lithium Ion battery. Used battery will 
require to discard as chemical waste. Please contact your local 
authority for the directions 

NOTE: WHEN REMOVING A DEFECTIVE BATTERY, ENSURE THAT 
IT IS DISPOSED OF IN ACCORDANCE WITH LOCAL 
REGULATIONS. ALTERNATIVELY, FORWARD IT TO GE 
MEDICAL SYSTEMS FOR PROPER DISPOSAL.

Table 12-13:  WEEE symbol

Rear of the system
Probe connector
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Troubleshooting

Refer to the LOGIQ P8/P9/P10 Service Manual if other 
messages appear on the monitor display.

Table 12-14:  Error message and workaround

The system has detected the lower air filter requires cleaning.
Please clean the lower filter.
1. Shutdown the system.
2. Clean the air filter according to ‘Cleaning the air filter’ on

page 12-26 .

System temperature is too high. System will shut down.
1. Shutdown the system.
2. Clean the air filter according to ‘Cleaning the air filter’ on

page 12-26 .

System voltage fault. System will shut down.
1. Select OK and reboot the system.
2. If the same message appears after reboot, shut down the

system and turn off the breaker. Then turn on the system
according to ‘Power On’ on page 3-31.

System Error. Please reboot the system.
1. Select OK and reboot the system.
2. If the same message appears after reboot, shut down the

system and turn off the breaker. Then turn on the system
according to ‘Power On’ on page 3-31.
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Image Quality Check

Image Quality Check is intended to facilitate Image Quality 
checks during Quality Assurance Evaluations. Quality 
Assurance tests are used to determine whether a scanner is 
providing the same level of performance year after year. 

By using the same settings year after year, this ensures that the 
data collection is consistent, independently of who performs the 
test. 

This preset only includes fundamental settings for B-Mode. 
Processing modes like SRI, Harmonics, etc., are turned off. 

To do an Image Quality Check (IQC), 

1. Activate IQC via Utility--> Imaging Preset Manager-->
Category (select the Category first).

2. Click on the plus sign in front of IQC for Service and select
IQC.

3. Assign IQC to a Touch Panel key by using the right arrow
key. Map the IQC to the location you want it to appear on the
Touch Panel.

4. Map the IQC to the location you want it to appear on the
Touch Panel.

5. Select Model. Then select IQC.
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Quality Assurance

Introduction

A good Quality Assurance Evaluation program consists of 
periodic systematic actions that provide the user with adequate 
confidence that their diagnostic ultrasound system will produce 
consistently high quality images and quantitative information.

Therefore, it is in the best interests of every ultrasound user to 
routinely monitor equipment performance.

The frequency of Quality Assurance evaluations should be 
based on user's specific needs and clinical practice.

Periodic monitoring is essential in order to detect the 
performance changes that occur through normal aging of 
system components. Routine equipment evaluations may also 
reduce the duration of exams, number of repeat exams, and 
maintenance time required.

For details on system and peripheral routine preventive 
maintenance instructions, See ‘System Care and Maintenance’ 
on page 12-16 for more information.
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Typical Tests to Perform

Quality assurance measurements provide results relating to 
system performance. Typically these are:

• Axial Measurement Accuracy

• Lateral Measurement Accuracy

• Axial and Lateral Resolution

• Penetration

• Functional & Contrast Resolution

• Gray Scale Photography.

With these tests, a performance baseline can be set at 
installation with the phantom in your department. Future test 
results can be compared to the baseline in order to maintain a 
record of system performance trends. 

Frequency of tests

Quality assurance tests are used to determine whether a 
scanner is providing the same level of performance from day to 
day.

The frequency of testing varies with the amount of system usage 
and modes to be tested. It is recommended that the user 
perform quality assurance tests at least every three months or 
every 400 patient studies. Tests should also be performed when 
a question about system performance exists.

A mobile system may require more frequent tests.

Image quality should also be tested immediately after the 
following events:

• Service calls

• System upgrades/modifications

• Dropped probe, power surge, etc.
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Phantoms

Quality Assurance Evaluations may be done with phantoms and 
test objects that are applicable to the parameters being 
evaluated or to the user's clinical practice.

Typical phantoms are composed of material that acoustically 
mimic human tissue. Pins, anechoic and echogenic targets are 
physically positioned to provide information for a variety of tests.

Doppler phantoms are currently expensive and complicated to 
deal with on the user level. If a problem with any Doppler 
parameters or measurement is suspected, contact a local 
service representative for evaluation.

The RMI 403GS phantom is shown in the illustration below as a 
representative example of a phantom. 
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Phantoms  (continued)

 Figure 12-10. Representative Phantom Example

1. Penetration

2. Axial Distance Measurement

3. Functional Resolution

4. Lateral Resolution

5. Lateral Distance Measurement

6. Axial Resolution

7. Contrast Resolution and Gray Scale Photography

8. Gray Scale Plane Targets
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Baselines

An absolute necessity for a quality assurance program is 
establishing baselines for each test or check. Baselines are 
established after the system has been verified to be working 
properly at installation or after a repair. If a probe or major 
assembly is replaced, new baselines should be generated.

Baselines can be made by adjusting system parameters to 
prescribed levels or to the best possible image. The key factor to 
remember is reproducibility. The same conditions must be 
reproduced for each periodic check.

All system parameters not displayed on the monitor should be 
recorded for the permanent record.

Periodic Checks

Periodic checks should be performed in accordance with your 
facility’s quality assurance requirements. For the data to be 
valid, periodic checks should mimic the baseline setup 
parameters.

The resulting image, when scanning the phantom exactly as 
before, should be recorded and compared to the baseline. 
When a matching image is obtained, it can be assumed that the 
system performance has not degraded from the baseline.

If a significant difference between the baseline and periodic 
check is noted, double check the system setup and repeat the 
test. If the difference between the baseline and periodic check 
persists, contact a local Service Representative.

Failing to reproduce the control settings as in the baselines will 
introduce errors in the data and potentially invalidate the results.
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Results

Lack of standardization among test instruments, the wide range 
of acceptance criteria, and incomplete knowledge regarding the 
significance of certain performance parameters prohibit the 
establishment of absolute performance criteria for these tests.

Quality Assurance Evaluation results should be compared to 
previously-recorded results. 

Performance trends can then be detected. Unacceptable 
performance or diminishing trends should be identified for 
maintenance or repair before a malfunction or inappropriate 
diagnosis occurs. 

The user should determine the best method for recording and 
archiving the baseline and periodic checks. In most cases the 
choice is hard copy.

It is important to maintain good consistent records for 
inspections that may arise, as well as to detect system 
performance trends.
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System Setup

The user should tailor the tests to their particular needs. It is 
certainly not necessary to make all checks with all probes. A 
representative example, with the probes used most often by the 
customer, should be adequate in judging system performance 
trends.

Use a gray scale phantom as the scan object for the tests. 
Commercial phantoms are supplied with its own operator 
manual. Be familiar with proper phantom operating procedures 
prior to use for quality assurance evaluations.

1. Adjust image monitor. Brightness and contrast should be set 
to the normal viewing of a good gray scale image.

2. Check all recording devices for proper duplication of image 
monitor. Ensure that what is seen is what is recorded. 

3. Annotate non-displayed image processing controls. 

4. Set TGC slide pots to center (detent) position. 

5. Place focal zone marker(s) in area of interest for an 
optimum image.

Test Procedures

The following are recommended Quality Assurance tests. A brief 
description of the test, the benefit it provides and steps to 
accomplish the test are supplied.

The importance of recording scan parameters and consistent 
record keeping cannot be stressed enough. Reproducibility to 
monitor system trends is the key to quality assurance 
evaluations.

Using the system's dual image display format is often very 
convenient and saves recording media.
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Axial distance measurements

Description

Axial measurements are the distance measurements obtained 
along the sound beam. See Figure 12-10  for more information.

Benefit

The accurate measurement of the size, depth and volume of a 
structure is a critical factor in determining a proper diagnosis. 
Most imaging systems use depth markers and/or electronic 
calipers for this purpose.

Method

Axial distance should be measured in the near, mid and far fields 
as well as in zoom. If necessary, different depths or fields of 
view can be tested.

Procedure

To measure axial distance:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets to typical depths for the probe being 
used.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the vertical pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if vertical measurements differ by 
more than 1.50% of the actual distance.
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Lateral distance measurements

Description

Lateral measurements are distance measurements obtained 
perpendicular to the axis of the sound beam. See Figure 12-10  
for more information.

Benefit

The purpose is the same as vertical measurements. 
Precisely-spaced horizontal pin targets are scanned and results 
compared to the known distance in the phantom.

Method

Lateral distance should be measured in the near, mid and far 
fields as well as in zoom. If necessary, different depths of fields 
of view can be tested.

Procedure

To measure lateral distance:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets. Adjust all scan controls, as necessary, for the best 
image of the pin targets from side to side.

2. Press Freeze to stop image acquisition and perform a 
standard distance measurement between the pins at 
different points in the image. Record all images for 
archiving.

3. Scan the horizontal pins in zoom or at different depth/scale 
factors.

4. Press Freeze to stop image acquisition; repeat the distance 
measurements between pins and record the images for 
archiving.

5. Document the measurements for reference and future 
comparison.

Contact a Service Engineer if horizontal measurements differ by 
more than 3mm or 3% of that depth, whichever is greater.
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Axial resolution

Descprition

Axial resolution is the minimum reflector separation between two 
closely-spaced objects to produce discrete reflections along the 
axis of the sound beam. It can also be monitored by checking 
the vertical size of known pin targets. See Figure 12-10  for 
more information.

Axial resolution is affected by the transmitting section of the 
system and the probe.

Benefit

In clinical imaging, poor axial resolution displays small 
structures lying close together as a single dot. This may lead to 
improper interpretation of the ultrasound image.

Procedure

To measure Axial resolution:

1. Scan a test phantom with precisely-spaced vertical pin 
targets. 

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets to typical depths for the probe being used.

3. Press Freeze to stop image acquisition.

4. Perform a standard distance measurement of the pin 
vertical thickness at different points in the image. Record all 
images for archiving.

5. Scan the vertical pins in zoom or at different depth/scale 
factors.

6. Press Freeze to stop image acquisition; repeat the vertical 
thickness measurements of the pins and record the images 
for archiving.

7. Document the measurements for reference and future 
comparison.

Axial resolution should remain stable over time. Contact a 
Service Engineer if any changes are observed.
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Lateral resolution

Description

Lateral resolution is the minimum reflector separation between 
two closely spaced objects to produce discrete reflections 
perpendicular to the axis of the sound beam. It can also be 
monitored by checking the horizontal size of known pin targets. 
See Figure 12-10  for more information.

Lateral resolution is dependent upon the beam width produced 
by the probe. The narrower the beam, the better the lateral 
resolution.

The beam width is affected by the frequency, degree of focusing, 
and distance of the object from the face of the probe.

Benefit

Clinically, poor lateral resolution will display small structures 
lying close together as a single dot. This may lead to improper 
interpretation of the ultrasound image.

Procedure

To measure lateral resolution:

1. Scan a test phantom with precisely-spaced horizontal pin 
targets.

2. Adjust all scan controls, as necessary, for the best image of 
the pin targets from side to side.

3. Press Freeze to stop image acquisition and perform a 
standard distance measurement of the horizontal thickness 
of a pin at different points in the image. Record all images 
for archiving.

4. Scan the horizontal pins in zoom or at different depth/scale 
factors.

5. Press Freeze to stop image acquisition; repeat the 
horizontal thickness measurements of the pins and record 
the images for archiving.

6. Document the measurements for reference and future 
comparison. 

Pin width should remain relatively constant over time ("1mm). 
Dramatic changes in pin width may indicate beamforming 
problems. Contact a Service Engineer if beam width changes 
consistently over 2 to 3 periodic tests. 
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Penetration

Description

Penetration is the ability of an imaging system to detect and 
display weak echoes from small objects at large depths. See 
Figure 12-10  for more information.

Penetration can be affected by the system's: 

• Transmitter/receiver

• Degree of probe focusing

• Attenuation of the medium

• Depth and shape of reflecting object

• Electromagnetic interference from local surroundings. 

Benefit

Weak reflecting echoes are commonly produced from the 
internal structure of organs. Definition of this tissue texture is 
important in the interpretation of the ultrasound findings.

Method

Scan a phantom to see how echoes begin to fade as depth is 
increased. The maximum depth of penetration is the point at 
which homogeneous material in the phantom begins to lose 
brightness.

Procedure

To measure penetration:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom along the vertical pin targets to typical 
depths for the probe being used.

4. Perform a standard distance measurement from the top of 
the image displayed to the point at which homogeneous 
material in the phantom begins to lose brightness.

5. Document the depth measurement for reference and future 
comparison. 

Contact a Service Engineer if the depth of penetration shifts 
more than one centimeter (1cm) when using the same probe 
and same system settings.
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Functional resolution

Description

Functional resolution is an imaging system's ability to detect and 
display the size, shape, and depth of an anechoic structure, as 
opposed to a pin target. See Figure 12-10  for more information.

The very best possible image is somewhat less important than 
reproducibility and stability over time. Routine tests at the same 
settings should produce the same results.

Benefit

The data obtained will give a relative indication of the smallest 
structure the system is capable of resolving at a given depth.

Procedure

To measure functional resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position.

2. Gain and acoustic output can be adjusted as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with a vertical row of anechoic cyst 
targets to typical depths for the probe being used.

4. Evaluate the cysts at various depths for a good (round) 
shape, well-defined borders and no fill in. Remember, TGC 
slide pots are centered and should remain fixed. This may 
NOT provide optimal cystic clearing.

5. Document all results for future reference and comparison.

Contact a Service Engineer if a greatly distorted image is 
obtained.
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Contrast resolution

Description

Contrast resolution is the ability of an imaging system to detect 
and display the shape and echogenic characteristics of a 
structure. See Figure 12-10  for more information.

Specific values measured are less important than stability over 
time. Routine tests at the same settings should produce the 
same results.

Benefit

A correct diagnosis is dependent upon an imaging system's 
ability to differentiate between a cystic or solid structure versus 
echo patterns from normal surrounding tissue.

Method

A phantom with echogenic targets of different sizes and depths 
should be used.

Procedure

To measure contrast resolution:

1. Set the front panel TGC slide pots to their center (detent) 
position. Set dynamic range to 54 db.

2. Gain and acoustic output can be adjusted, as necessary, 
since these values are displayed on the monitor.

3. Scan a test phantom with echogenic targets at the depths 
available.

4. Evaluate the echogenic targets for contrast between each 
other and between the surrounding phantom material. 
Remember, TGC slide pots are centered and should remain 
fixed. This may NOT provide an optimal scan image.

5. Document all results for future reference and comparison.

Contact a Service Engineer if the echogenic characteristics or 
shapes of the targets appear distorted.
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Gray Scale photography

Description

Poor photography will cause loss of low level echoes and the 
lack of contrast between large amplitude echoes. See 
Figure 12-10  for more information.

Benefit

When photographic controls and film processors are properly 
adjusted, weak echoes, as well as strong echoes, are accurately 
recorded on film.

Procedure

1. Adjust the camera according to the manufacturer's 
instructions until the hard copy and video display are equal.

2. Scan the phantom and it's echogenic contrast targets.

3. Make a hard copy photograph of the display and compare it 
to the image on the video monitor for contrast and weak 
echo display.

4. Document all results for future reference and comparison.

Contact a Service Engineer if camera cannot duplicate what is 
on the image monitor.

NOTE: Optimization of brightness/contrast controls on the display 
monitor is imperative in order to make sure that the hardcopy 
and monitor look alike.

The display monitor is adjusted first. The hardcopy camera or 
printer is adjusted to match the display monitor.
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Setting up a Record Keeping System

Preparation

The following is needed: 

• Quality Assurance binder.

• Hard copy or electronic file of images.

• Quality Assurance Checklists. 

• Display the following information while testing quality 
assurance: 

• Acoustic Output

• Gain

• Depth

• Probe

• Dynamic Range

• Set up new patient to be the name of the test.

• Annotate the following: 

• Any control where its value is NOT displayed. 

• Significant phantom information.

Record Keeping

Complete the following: 

1. Fill out the Ultrasound Quality Assurance Checklist for each 
probe, as scheduled. 

2. Make a hard copy or archive the image. 

3. Compare images to baseline images and acceptable 
values. 

4. Evaluate trends over previous test periods. 

5. File hard copy or electronic file of images and checklist in 
Quality Assurance binder. 
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Ultrasound Quality Assurance Checklist 

Table 12-15:  Ultrasound Quality Assurance Checklist (Part 1)

Performed By Date

System Serial Number

Probe Type Probe Model Serial Number

Phantom Model Serial Number Room Temperature

Acoustic Output Gain Focal Zone

Gray Map TGC Depth

Monitor Setting

Peripheral Settings

Other Image Processing Control Settings

Table 12-16:  (Part 2)
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Assistance

Supplies/Accessories

Not all features or products described in this document may be 
available or cleared for sale in all markets. Contact the 
distributor, GE affiliate or sales representative for approved 
peripherals. For HCATs, contact your sales person. For 2million/
5million number part numbers, these are service replacement 
part numbers that may be either new or refurbished. To order 
these, contact CARES in the US, or call service in Europe and 
Asia.

The following supplies/accessories have been verified to be 
compatible with the system:

CAUTION DO NOT connect any probes or accessories without approval 
by GE.

CAUTION Use only GE approved internal equipment when replacing an 
internal peripheral.

The user or the operator should never install/replace the 
internal peripheral. Service representatives authorized by 
GEHC will install/replace the internal peripheral.
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Peripherals

ECG Accessories

Table 12-17:  Peripherals and Accessories

Accessory

Sony B/W Printer Model UP-D898

Sony Color Printer Model UP-D25MD

DVR

UVC

Digital expert

Table 12-18:  ECG Accessories

Accessory

ECG module

ECG cable - AHA typee

ECG cable - IEC type

External ECG Cable
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Console

Table 12-19:  Console Accessories

Accessory

Footswitch

Endocavity Probe Holder

Optional Probe Holder

Side Tray

Low cabinet

Mid cabinet

High cabinet

Side cabinet

Greek Keyboard

Russian Keyboard

English keyboard

French keyboard

German keyboard

Norwegian/Danish Keyboard

Swedish Keyboard

Power Cord - US 

Power Cord - Argentina

Power Cord - Italy

Power Cord - UK-Ireland

Power Cord - Switzerland

Power Cord - Denmark

Power Cord - Israel

Power Cord - Japan

Power Cord - China

Power Cord - Australia

Power Cord - India

Power Cord - Taiwan

Power Cord - South Africa

Power Cord - Brazil
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Probes

Table 12-20:  Probes and Accessories

Probe Biopsy Guide

C1-5-RS Multi Angle, Disposable with a Reusable Bracket

E8C-RS Single Angle, Disposable with a Plastic Bracket or Reusable with 
a Stainless Steel Bracket

L8-18i-RS Not Available

9L-RS Multi Angle, Disposable with a Reusable Bracket

P8D Not Available

12L-RS Multi Angle, Disposable with a Reusable Bracket
Infinite-angle (in plane biopsy kit), Disposable with a Reusable 
Bracket
Transverse Bracket (off plane biopsy kit), Disposable with a 
Reusable Bracket

ML6-15-RS Multi Angle, Disposable with a Reusable Bracket

3Sc-RS Multi Angle, Disposable with a Reusable Bracket

RAB2-6-RS Single Angle, Disposable with a Reusable Bracket, Single angle 
reusable

8C-RS Not Available

6S-RS Not Available

L6-12-RS Multi Angle, Disposable with a Reusable Bracket

RIC5-9A-RS Single Angle, Disposable with a Plastic Bracket or Reusable with 
a Stainless Steel Bracket

BE9CS-RS Single Angle, Disposable with a Plastic Bracket or Reusable with 
a Stainless Steel Bracket

E8CS-RS Single Angle, Disposable with a Plastic Bracket or Reusable with 
a Stainless Steel Bracket

L4-12t-RS Multi Angle, Disposable with a Reusable Bracket
Infinite-angle (in plane biopsy kit), Disposable with a Reusable 
Bracket
Transverse Bracket (off plane biopsy kit), Disposable with a 
Reusable Bracket

L10-22-RS Not Available

L3-9i-RS Not Available

12S-RS Not Available

P6D Not Available

L3-12-RS Multi Angle Bracket
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6Tc-RS Not Available

P2D Not Available

IC9-RS Reusable, Disposable Bracket

C1-6-D Multi-Angle, Disposable wih a Reusable Bracket

C2-7-D Multi-Angle, Disposable with a Reusable Bracket
Multi-Angle, Reusable with a Stainless Steel Bracket

C3-10-D Not Available

10C-D Not Available

M5Sc-RS Multi-Angle, Disposable with a Reusable Bracket

Table 12-20:  Probes and Accessories (Continued)

Probe Biopsy Guide
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Options

Table 12-21:  Options

Accessory

LOGIQView

Contrast Enhanced Ultrasound*

Scan Assistant

DICOM 3.0 connectivity

Report Writer

Real time 4D

4D with VCI

VOCAL II (Volume Calculation)

Tomographic Ultrasound Imaging

Continuous Wave (CW)

Tissue Velocity Imaging (TVI)

Elastography

Elastography Quantification (Not available in the USA)

Advanced 3D

B-Flow

Auto IMT

Flow Quantification

Stress Echo

B Steer+

ECG

SW DVR

Footswitch

Auto EF

Advanced 3D

Volume Contrast Imaging (VCI) 

STIC

Omniview

HD Live

Wireless Lan (WLAN) 
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LOGIQ Apps 

Bluetooth 

Compare Assistant

Breast Productivity Package

Thyroid Productivity Package

OB Measure Assistant

Breast Measure Assistant

Video Scan Converter

Automated Function Imaging

Shear Wave Elastography

KOIOS SW

Ultrasound Guided Attenuation Parameter (UGAP)

*The LOGIQ P8/P9/P10 is designed for compatibility with commercially available Ultrasound contrast 
agents. Because the availability of these agents is subject to government regulation and approval, product 
features intended for use with these agents may not be commercially marketed nor made available before 
the contrast agent is cleared for use. Contrast-related product features are enabled only on systems for 
delivery to an authorized country or region of use. 

Table 12-21:  Options (Continued)

Accessory
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Chapter 13

Advanced Features

This chapter consists of information about System 
Options.
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List of Advanced Features

Table of Contents

NOTE: The following features are an option. If these options are not 
installed, the button/key are disabled or not displayed. 

• ‘B-Mode Option’ on page 13-4

• ‘LOGIQView’ on page 13-4

• ‘B Steer+ (Option)’ on page 13-7

• ‘Biplane (BE9CS-RS probe)’ on page 13-10

• ‘Tissue Velocity Imaging (TVI)’ on page 13-12

• ‘Contrast Imaging’ on page 13-17

• ‘Ultrasound-Guided Attenuation Parameter (UGAP) Option’ 
on page 13-29

• ‘Time Intensity Curve (TIC) Analysis’ on page 13-35

• ‘Quantitative Analysis (QAnalysis)’ on page 13-67

• ‘Quantitative Flow Analysis’ on page 13-68

• ‘Elastography Quantification’ on page 13-73

• ‘Real-time 4D’ on page 13-100

• ‘VCI Static’ on page 13-147

• ‘Tomographic Ultrasound Imaging (TUI)’ on 
page 13-148

• ‘VOCAL’ on page 13-152

• ‘SonoRenderlive’ on page 13-156

• ‘OmniView’ on page 13-165

• ‘STIC (Spatio-Temporal Image Correlation)’ on 
page 13-170

• ‘Compare Assistant’ on page 13-178

• ‘Smart Start (Start Assistant)’ on page 13-193

• ‘Scan Assistant’ on page 13-197

• ‘OB Measure Assistant’ on page 13-258
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Table of Contents  (continued)

• ‘Breast Options’ on page 13-260

• ‘Breast Productivity Package (Lesion M&A)’ on 
page 13-261

• ‘Breast Measure Assistant (Auto Contour)’ on 
page 13-265

• ‘Thyroid Productivity Package’ on page 13-273

• ‘Auto EF Measurements’ on page 13-282

• ‘Cardiac Automated Function Imaging (Cardiac Strain)’ on 
page 13-298

• ‘Stress Echo’ on page 13-324

• ‘IMT Measurement - Auto’ on page 13-360

• ‘ECG’ on page 13-364

• ‘DICOM’ on page 13-370

• ‘Tricefy Uplink’ on page 13-398

• ‘Report Writer’ on page 13-404

• ‘Using InSite ExC’ on page 13-461

• ‘DVR’ on page 13-479

• ‘Configuring the Wireless Network’ on page 13-488

• ‘Power Assistant’ on page 13-502

• ‘Storage Options’ on page 13-511

• ‘Probe holder’ on page 13-511

• ‘Attachment for small probe’ on page 13-512

• ‘Wired Footswitch’ on page 13-513

• ‘Touch Control’ on page 13-514

• ‘Smart Device Apps’ on page 13-518

• ‘IOTA LR2 Worksheet’ on page 13-525

• ‘Hepatic Assistant’ on page 13-527

• ‘Digital Expert’ on page 13-532
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B-Mode Option

LOGIQView

Description LOGIQView provides the ability to construct and view a static 2D 
image which is wider than the field of view of a given transducer. 
This feature allows viewing and measurements of anatomy that 
is larger than what would fit in a single image. Examples include 
scanning of vascular structures and connective tissues in the 
arms and legs. 

LOGIQView constructs the extended image from individual 
image frames as the operator slides the transducer along the 
surface of the skin in the direction of the scan plane. The quality 
of the resulting image is somewhat user-dependent and requires 
some additional skill and practice to develop proper technique 
and become fully proficient. 

LOGIQView is not available for the following: 

• Multi Image

• Timeline Modes

• B-Flow Mode

• Color Flow Mode

• PDI Mode

Benefits The user can look at a larger region of interest within one field of 
view that is wider than any given probe would normally provide. 

Clinical Use LOGIQView is intended for scanning areas too large to fit on one 
image. 
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LOGIQView  (continued)

Using LOGIQView To perform an exam using LOGIQView, 

1. Perform a detailed examination of the anatomy/pathology. 
Optimize parameters for tissue texture and visible window 
PRIOR TO activating LOGIQView. 

2. Press the LOGIQView key on the Control Panel. 

3. To start acquiring the image, press Start (Left key). 

4. To restart the scan, press Start again. You can back up the 
probe, realign it, then go forward to redo a portion of the 
scan.

5. To complete the scan, press End or Freeze (or allow the 
scan to auto complete. The LOGIQView is then displayed, 
scaled to fit entirely on the screen. 

6. Perform measurements and record images. 

7. Select Frame Review to move through the LOGIQView one 
frame at a time. Use the Trackball to scroll. 

NOTE: Measurement error is within 10% or 4mm of the distance 
you measured for all linear probes. 

HINTS When you scan, start with a strong, quick sweep in the 
direction of the acquisition and then complete the 
LOGIQView image with a a slow steady sweep. 
LOGIQView acquires images via leading edge vectors 
(and does not acquire slices, as in CINE). The image is 
being stored as you perform the scan and you can watch 
the LOGIQView as it is being acquired. 
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LOGIQView  (continued)

Uniform Motion The quality and usefulness of LOGIQView images is affected by 
transducer motion. Incorrect technique can contribute to image 
distortion. 

Guidance and precautions for uniform motion: 

• Continuous contact is required throughout the length of the 
extended image. DO NOT lift the transducer from the skin 
surface. 

• Always keep the transducer perpendicular to the skin 
surface. DO NOT rock the transducer. 

• Keep the motion within the same scan plane, if possible. DO 
NOT slide the transducer laterally. 

• Lateral turning (change in direction to follow anatomical 
structure) can be accommodated with slower motion. DO 
NOT make abrupt changes in direction. 

• The system accommodates a reasonable range of motion 
velocity. DO NOT make abrupt changes in speed of motion. 
Deeper scans generally require reduced speed. 

Bioeffects Activating LOGIQView has no affect upon Acoustic Output 
values. 
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B Steer+ (Option)

Description B Steer+ allows you to obtain better biopsy (needle) imaging 
without slanting the B Mode image. B Steer+ is operable in B 
mode, Color Flow mode, PDI mode or GT mode. B Steer+ is 
available with all linear probes and following convex probes: 
C1-5-RS, 8C-RS, RAB2-6-RS, C1-6-D, C2-7-D, C3-10-D and 
10C-D.

Benefits B Steer+ provides better biopsy visualization compared to 
normal B Mode image. B Steer+ allows you to adjust beam 
angle and needle gain to achieve best biopsy image without 
changing B mode image.

Activating To acivate B Steer+ in B mode, press left or right key. To activate 
B Steer+ in B mode or Color flow mode or PDI mode or GT 
mode, press user-difined hard key after assigning the key to B 
Steer+ in Utility -> System -> User Configurable Key -> User 
Defined hard key. 

NOTE: Activating B Steer+ may decrease frame rate.

NOTE: B Steer+ user-defined key activates B Steer+ even when 
“Enable B Steer+” preset is off

Using B Steer+ To optimize biopsy image using B Steer+ functionality, adjust  B 
Steer+ beam direction, angle and needle gain.

Adjust B Steer+ beam direction and angle to make biopsy and 
beam angle as perpendicular as possible. B Steer+ beam 
direction and angle are selectable using the direction and angle 
buttons on the touch panel (supporting 20, 30, 40 and 50 degree 
for linear probes, 10, 20, 30, 40 degree for following four convex 
probes: C1-5-RS, 8C-RS, RAB2-6-RS, C1-6-D, C2-7-D, 
C3-10-D and 10C-D)

Adjust Needle Gain and find best brightness for biopsy. Needle 
Gain is adjustable using the Needle Gain rotary (range from 0 to 
100).

Turn on B Steer+ Dynamic FOV preset option that helps you to 
achieve better biopsy visualization when your biopsy and beam 
angle are not perpendicular enough. B Steer+ Dynamic FOV is 
selectable in Utility -> Imaging -> B Tab.

NOTE: Turning on B Steer+ Dynamic FOV preset option may decrease 
frame rate.
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B Steer+ (Option)  (continued)

Select Needle Thickness preset option to make biopsy 
visualized thin or thick. B Steer+ Needle Thickness is selectable 
in Utility -> Imaging -> B Tab.

B Steer+ values (including enable/disable, beam direction, angle 
and Needle Gain) are returned to factory default values or user 
preset values when you change: Probe, Exam Category, Exam 
Calcs or New Patient.

Figure 13-1. B Steer+ Tab in Touch Panel

Preset B Steer+ Enable/Disable - preset via Utility -> Imaging -> 
General.

B Steer+ Beam Direction - preset via Utility -> Imaging -> B Tab.

B Steer+ Beam Angle - preset via Utility -> Imaging -> B Tab.

B Steer+ Needle Gain - preset via Utility -> Imaging -> B Tab.

B Steer+ Dynamic FOV - preset via Utility -> Imaging -> B Tab.

B Steer+ Needle Thickness - preset via Utility -> Imaging ->  B 
Tab.
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B Steer+ (Option)  (continued)

Bioeffects Activating B Steer+ may change the TI and/or MI. Observe the 
output display for possible effects.

Figure 13-2. Enable B Steer+

Figure 13-3. B Steer+ Preset+
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Biplane (BE9CS-RS probe)

Description BE9CS-RS probe can scan and display both the longitudinal 
and the transverse planes simultaneously. 

NOTE: When displaying single plane, pressing  the button on the probe 
toggles scan plane between the longitudinal and the transverse. 
When scanning biplanes, pressing the button exits biplane and 
displays only the longitudinal scan plane.

 Figure 13-4. Biplane Image Display (Example)
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Biplane (BE9CS-RS probe)  (continued)

Values On/Off.

To activate Biplane, select Biplane on the 2nd Touch Panel page 
of B, CF and PDI.

NOTE: Only the longitudinal plane can scan CF and PDI during Biplane.

Preset User Configurable key can activate/deactivate Biplane. Assign 
"Biplane" to the key in Utility -> System -> User Configurable 
Key.

BE9CS-RS can start Biplane scan as default. Check "Start with 
Biplane" in Utility -> Imaging -> B.

Biplane can display two planes side by side. Check "Horizontal 
Display for Biplane" in Utility -> Application -> Settings -> Image 
Control & Display.

BE9CS-RS Probe Changing Scan Method

Changing scan methods between two micro-convex. Press the 
switch on the BE9CS-RS probe.

Figure 13-5. Switching button

a. Switching button

Figure 13-6. Scan plane orientation

a. Longitudinal scan plane

b. Transverse scan plane
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Tissue Velocity Imaging (TVI)

Intended Use

Tissue Velocity Imaging (TVI) calculates and color-codes the 
velocities in tissue. The tissue velocity information is acquired by 
sampling of tissue Doppler velocity values at discrete points. 
The information is stored in a combined format with gray scale 
imaging during one or several cardiac cycles with high temporal 
resolution.

 Figure 13-7. Tissue Velocity Imaging Display
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Activating TVI

1. Select the desired probe.

2. While in B-Mode, press the TVI key. The TVI image and the 
Touch Panel display.

While in TVI, press M to activate TVM.

While in TVI, press PW to activate TVD.

3. Use the trackball (assigned function: Pos) to position the 
ROI frame over the area to be examined.

4. Use the trackball (assigned function: Size) to adjust the 
dimension of the ROI.
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Optimizing TVI

The use of preset gives optimum performance with minimum 
adjustment. If necessary, the following controls can be adjusted 
to further optimize the TVI display:

• To reduce quantification noise (variance), the Nyquist limit 
should be as low as possible, without creating aliasing. To 
reduce the Nyquist limit: Reduce the Scale value.

NOTE: The Scale value also affects the frame rate. There is a trade 
off between the frame rate and quantification noise.

• TVI provides velocity information only in the beam direction. 
The apical view typically provides the best window since the 
beams are then approximately aligned to the longitudinal 
direction of the myocardium (except near the apex). To 
obtain radial or circumferential tissue velocities, a 
parasternal view must be used. However, from this window 
the beam cannot be aligned to the muscle for all the parts of 
the ventricle.

NOTE: PW will be optimized for Tissue Velocities when activated 
from inside TVI.

NOTE: You can preset the value on the Utility -> Imaging -> TVI or 
TVD mode and press Save.
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TVI

You can preset all parameters in Utility -> Imaging ->TVI.

The TVI parameters function the same as those described in the 
Color Flow specific section. The only differences would be that it 
pertains to tissue velocity rather than the color flow image. In the 
table below any TVI parameter or parameter specifics are noted.

About optimizing other parameters, see ‘Optimizing Color Flow’ 
on page 5-44  for details. 

Table 13-1:  TVI Parameters

Control Details

Visible
Description
Adjusting
Values

In LIVE/Freeze/Archive, you can display TVI Color with TVI.
Select Visible on the Touch Panel.
On or Off.

Line Density 0 or 1. Optimizes B-Mode frame rate or spatial resolution for the best possible 
image.

Map Values: TV1 and TV2. 

Threshold High values display more color. Low values limit the color to lower tissue echo 
(Opposite of Threshold in Color Flow Mode). 

Spatial Filter Values 0, 1 and 2. 

TVI Gain Control color transparency. High values display more color; low values 
display more tissue. This parameter is assigned to the Color Gain control.



Advanced Features

13-16 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

TVM Parameters

About optimizing other parameters, see ‘Optimizing M-Mode’ on 
page 5-38 for more information.

Axial Filter
Description Smooths out the color, makes it look less pixely.

Adjusting Press left or right arrow key to select the value. 

Values 0, 1 or 2.

Benefits Smooths the image. 

TVD Parameters

About optimizing other parameters, see ‘Optimizing Spectral 
Doppler’ on page 5-64  for details.
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Contrast Imaging

Overview

WARNING Appropriate training

Only physicians or echo technicians who have received 
appropriate training can use the Contrast applications.

WARNING Misdiagnosis based on image artifacts

Misdiagnosis in ultrasound contrast images may be caused by 
several artifacts, most importantly:

Motion artifacts: gives rise to signals independently of contrast 
presence. This may be caused by patient movement; including 
respiration, or by probe movement influenced by the operator.

Regional drop outs: caused by unintentional destruction of the 
contrast agent, too low concentration of contrast agent, poor 
acoustic penetration due to rib/lung shadows or system failing 
to detect the contrast agent due to erroneous settings induced 
by the operator.

Tissue harmonics: gives contrast-like signals independently of 
the presence of contrast agent.

CAUTION Cardiac rhythm disturbances during perfusion studies using 
gas ultrasound contrast agents have been observed in the 
diagnostic range of Mechanical Index (MI) values. See the 
specific package insert for the contrast agent being used for 
details.
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Overview  (continued)

NOTE: The LOGIQ P8/P9/P10 is designed for compatibility with 
commercially available Ultrasound contrast agents. Because the 
availability of these agents is subject to government regulation 
and approval, product features intended for use with these 
agents may not be commercially marketed nor made available 
before the contrast agent is cleared for use. Contrast-related 
product features are enabled only on systems for delivery to an 
authorized country or region of use. 

CAUTION Read and follow contrast agent instructions provided by the 
manufacturer.
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Contrast Imaging Overview

Benefits Injected contrast agents re-emit incident acoustic energy at a 
harmonic frequency much more efficiently than the surrounding 
tissue. Blood containing the contrast agent stands out brightly 
against a dark background of normal tissue. 

Clinical Use Possible clinical uses are to detect and characterize tumors of 
the liver, kidney, and pancreas and to enhance flow signals in 
the determination of stenosis or thrombus. 

Affect on other 
controls

The default acoustic output adjusts for contrast imaging and the 
Power Output key provides more subtle gradations for use while 
in contrast imaging. When you exit Contrast Imaging, the 
system returns the acoustic output to its original setting. When 
you reactivate Contrast Imaging, the system enters the default 
Contrast Mode. 

Most system controls are available (Depth, Zoom, Colorize, 
etc.). However, some controls are not available (Anatomical M 
Mode, Rejection, and Suppression). 

Controls adjusted while in Contrast Imaging retain these values 
when you exit Contrast Imaging (except for post-processing 
controls). 

Bioeffect Activating Contrast Imaging may change the TI and/or MI. 
Observe the output display for possible effects. 

Feature 
Availability

Multi Image and LOGIQView are not available. 
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Mode

Reference Mode

Reference (Ref) Mode is to image the anatomical reference, not 
the contrast enhancement.

Contrast Mode

There are several contrast imaging techniques. Note that the 
appropriate imaging technique may vary by agent and 
application. In other words, the imaging technique is not 
dedicated for the agent and vice versa.
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Parameters

You can be preset almost controls in the Utility --> Imaging --> 
CON or Ref Tab. 

Contrast Tech.

Description Select the active contrast acquisition mode. “HRes”, “AM”, and 
“CHA” 

NOTE: The available options for the Contrast Tech. is depend on the 
supported contrast acquisition mode for the active probe.

Table 13-2:  Available Contrast Techniques 

 Label Description Clinical Use

HRes The main purpose of HRes mode is to image the 
harmonic signal from the contrast agent. This 
mode transmits two consecutive pulses with 
inverted polarity as a contrast transmit group. The 
received signals are summed to cancel the 
fundamental (i.e. linear) responses and then the 
non-linear harmonic responses are extracted.

Harmonic - perfusion, tumor 
flow characteristics

Coded Harmonic 
Angio (CHA)

The main purpose of CHA mode is to image the 
non-linear signal from the contrast agent with 
strong tissue suppression. This mode transmits 
four consecutive pulses with alternate polarity (i.e. 
two pairs of Phase Inversion) as a contrast transmit 
group.

Vascular, early phase imaging

Amplitude
Modulation (AM)

The main purpose of AM mode is to image the 
non-linear signal from the contrast agent. This 
mode transmits two or more consecutive pulses 
with the different amplitude as a contrast transmit 
group. The received signals are summed with the 
different coefficients to cancel the linear responses 
and then the non-linear responses are extracted. 

Tumor detection and 
characterization
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Parameters  (continued)

Single View/Dual View

Description Single View displays the active Contrast image only.

Dual View displays the active Contrast image and the reference 
image simultaneously.

Visualization

Description Define the display technique.

Values • Contrast. Displays the contrast-enhanced image. 

• Tissue. Displays the tissue image. 

• Hybrid Contrast. Displays the contrast-enhanced image 
and the tissue image using Hybrid Map. 

Visualization/Map 
Indication

Figure 13-8. Imaging parameter

1. Gray/Colorize Map for current visualization. 

2. Visualization: C=Contrast, T=Tissue, HC=Hybrid Contrast
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Parameters  (continued)

Hybrid Map

Description Select the hybrid map for the Hybrid Contrast visualization in the 
Dual/Hybrid Display.

Gray Map

Description You can select a map for the contrast image and reference 
tissue image independently. 

Adjusting Press Gray Map and select the map in each tab.

Contrast Color

Description Select the color map for the Contrast mode image.

Adjusting Press Colorize and select the map.

Contrast only

Description Only transmit and receive the acoustic power signal for the 
contrast-enhanced image.

Adjusting Press Contrast Only.
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Parameters  (continued)

Frequency

Description Select frequency type for each contrast technique.

Adjusting Frequency can be preset in the Utility -> Imaging -> CON. 

• Frequency (AM): Res, Gen, Pen 

• Frequency (HRes): Gen

Sonazoid

Description If you use Sonazoid for Contrast agent, you have to check 
Sonazoid in Utility -> Imaging -> CON.

Target MI

Description Target MI Control provides the automated adjustment of the 
acoustic output to keep the specified target MI value to reduce 
the unexpected results on the contrast exam.

Target MI control can be preset in the Utility -> Imaging -> CON 
and Ref. 

NOTE: The value of Target MI for Reference Image is adjustable on Ref 
tab, only when Ref-Only mode.

Accumulation

Description Accumulation enhances the flow in an image. 

If Accumulation is turned off, then Frame Averaging is used; if 
Accumulation value is set, then Accumulation is used. 

Availability Available in Contrast, Color Flow, PDI, and B-Flow. 

Benefit Accumulation detects the maximum signal and holds it for the 
level specified. 



Contrast Imaging

LOGIQ P8/P9/P10 – Basic User Manual 13-25
Direction 5841298-1EN Rev. 2

Parameters  (continued)

Max (Maximum) Enhance

Description Sets the acoustic output to its maximum setting (100%)

Values On/Off. When you deactivate Max Enhance, the acoustic output 
is returned to its previous setting. Max Enhance is deactivated 
by the system when you turn it off, change probes, or change 
the contrast technique. 

Benefits This control provides quick transition to High MI imaging. This 
allows the user a quick one-button push to destroy the agent. 
Useful when the user is interested in the bubble wash-in 
characteristics of the anatomy being scanned. 

Trigger

Description The Contrast Trigger scans images at set intervals, delaying 
imaging according to the time delay that you specify.

Adjusting On/Off. Press Trigger assigned rotary. 

Time Delay

Description The Contrast Trigger scans images at set intervals, delaying 
imaging according to the time delay that you specify.

Adjusting Press Trigger to activate Time Delay (select the interval of the 
interval timer triggered acquisition). Move the rotary up/down to 
select the index. 

Set the default seconds of Time Delay in Utility -> Imaging -> 
Con.
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Parameters  (continued)

Flash

Description This feature provides a way to expose the higher acoustic power 
for a specified time duration by pressing a control once. 

Adjusting Press Flash.

Set the frame numbers to scanned with the higher acoustic 
power in Utility--> Imaging--> Con--> Flash Frames. The frame 
numbers defined by Flash Frames are applied to both the 
contrast imaging modes.

• If you select Flash once in the Con menus, the system 
scans with 100% acoustic output burst pulses for the 
specified number of frames. The acoustic output then 
reverts to the original settings.

• When Max Enhance is ON for the contrast imaging modes, 
the system keeps Max Enhance = ON with no acoustic 
output change when Flash is selected in the Con menu.
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Parameters  (continued)

Contrast Clock (Timer)

Description You can use the Contrast Clock by activating it at the time of 
injection and deactivating it at the end of the exam.

Two timers can be displayed on the bottom-left corner in image 
area and info area for several injection.

NOTE: You can also configure the system to perform a countdown for 
the contrast injection with the Utility -> System -> System 
Imaging -> Countdown Time for Contrast preset.

Adjusting • Press Contrast Clock 1 to start/stop the T1 timer.

• Press Contrast Clock 2 to start/stop the T2 timer.

Display There are two areas on the screen where the Contrast Clock 
displays: on the image and on the lower, left-hand portion of the 
display. The timer on the image freezes when you freeze the 
image (the timer updates when you unfreeze the image). 
However, the timer located on the lower, left-hand portion of the 
display continues to display over a freeze, probe change, mode 
change, multi image, and zoom. 

The timer also appears on CINE Loops and archived images. 

Benefits The Contrast Clock measures the time since injection. 

You can save the data of contrast clock to an external file by 
using Export Traces of TIC.

1. Press Freeze. Scroll with the Trackball to show Cine tab.

2. Press TIC Analysis on the Touch Panel to enter TIC 
application.

3. Put a ROI on the image.

4. Press Export Traces. Type the file name and store it to the 
storage device.
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Relationship with other controls

• L + R Simultaneous Display (L: Tissue, R: Active 
Visualization)

• Accumulation/Cine Capture

- Applied on the right side image only.

- You cannot compare On and Off image using L + R.

• SRI-HD

- Applied on both side image.

• Frame Average

- Applied on both side image.

• TIC

• Measured on active visualization, except “Hybrid 
Contrast”.

• “Hybrid Contrast” is disabled and measured on 
“Contrast” visualization.

• Easy 3D

• Build volume data from active visualization, except 
“Hybrid Contrast”.

• Hybrid map is disabled and forces “Contrast” 
visualization.

• Advanced 3D

• Build volume data from active visualization.

• For the Single/Dual View data set of contrast mode, 
both reference and contrast data are rendered in 
individual volume segments. Each volume data is 
manipulated using Active Data and Visual Data.

• Archive

• The raw data size increases between two to three times 
the size compared to the previous raw data. It takes a 
longer period of time to save as Cine.
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Ultrasound-Guided Attenuation

Parameter (UGAP) Option

Overview

Ultrasound-Guided Attenuation Parameter (UGAP) measures 
the attenuation value (i.e. attenuation coefficient [dB/cm/MHz] or 
attenuation rate [dB/m]) in the liver to evaluate diffuse liver 
disease. There are three visualizations: B Ref, Color Ref and 
Color Dual. All visualizations measure a representative 
attenuation value. Color Ref and Color Dual measure a 
representative attenuation value in 2D color map and dual 
display of B-mode and 2D color map, respectively. 

UPGAP is available on the C1-6-D probe in the Abdomen (ABD) 
application.

Figure 13-9. Set UGAP as any User-defined Hard Key
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Activation

To activate UGAP, select the C1-6-D probe Abdominal 
application, then press User Defined Hard Key you 
selected.UGAP parameters are displayed as “U” (Frequency 
and Acoustic Output Percent) in Simple Mode. Unit of 
attenuation coefficient values are displayed as dB/cm/MHz.

Figure 13-10. UGAP Display



Ultrasound-Guided Attenuation Parameter (UGAP) Option

LOGIQ P8/P9/P10 – Basic User Manual 13-31
Direction 5841298-1EN Rev. 2

Measurement and Worksheet

Measure the Coefficient Value

1. Scan to get the appropriate view to measure.

2. Press Start (right Set key)

NOTE: The Measurement ROI can be moved using the Trackball; 
more than one ROI can be placed in one frame. 

Figure 13-11. UGAP Study

Measurements can be performed afterwards using CINE or 
recalled data where multiple frames can be selected to measure 
attenuation coefficients. 
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Add a New Site

Once measurements are complete, you can elect to add another  
site to the exam. To add another site:

1. Press the Measurement button on the console.

2. Select Add Site on the Touch Panel

3. Select Enter Site Name to add the name for the new site. 

Figure 13-12. Add Additional Shear Wave Site and Enter Site 
Name

NOTE: If you no longer need the added site, you can select to delete 
the site via Delete Site on the Touch Panel. 
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Summary and Overall Worksheets

Measurements are transferred to the Summary and Overall 
Worksheets.

Figure 13-13. UGAP Summary Worksheet

Figure 13-14. UGAP Overall Worksheet

Attenuation Coefficients are displayed (C1, C2, C3), Median, 
IQR, IQR/Median, and number of measurements (N). 
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2D Color Map

2D color map is available on Color Ref and Color Dual. There 
are two 2D color maps: Attenuation Map and Quality Map. 
Attenuation Map provides the distribution of attenuation values. 
Quality Map provides the position where attenuation can be 
measured with high accuracy. 

 Figure 13-15. Attenuation Map

 Figure 13-16. Quality Map
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Time Intensity Curve (TIC) Analysis

Overview

Time Intensity Curve (TIC) enables the user to perform the 
following analysis:

• Time-Intensity analysis allows instant time-intensity 
calculation from up to eight regions of interest.

• Curve fitting analysis for research studies of myocardial 
contrast agent concentration rates.

The basic TIC process works as follows:

1. Scan the patient after injecting the contrast agent.

2. Watch the agent flow through the anatomy of interest.

3. When the desired contrast effect has been visualized, 
freeze the image and select a range of images for analysis.

4. Position an ROI (region of interest) on one of those images 
where the contrast effect is visible.

5. The system then calculates the mean pixel intensity within 
that ROI for all frames in the user designated loop and plots 
the resulting data as a function of time.

You can also choose to fit this data to one of several 
mathematical functions. The fundamental idea is that the 
contrast effect flowing through the organ of interest can be 
modeled mathematically, and details of the wash in and washout 
of the agent can be gleaned by analyzing the numerical 
parameters of the mathematical model.
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Activating TIC

Starting TIC in cine loop

1. Open an examination and select a contrast cineloop.

2. Select TIC Analysis on the Touch Panel.

Starting TIC in live mode

1. Scan and freeze the patient in Contrast live mode.

2. Move the trackball to activate Cine.

3. Select TIC Analysis ont the Touch Panel..

Exiting TIC Analysis

There are several methods to exit TIC Analysis.

• Select Exit TIC Analysis on the TIC Touch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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TIC Analysis Screen Description

 Figure 13-17. TIC Analysis Screen - Graph with dual image layout (example) 

1. Contrast cineloop window
2. B-Mode cineloop window
3. Analysis window
4. Sample area

5. Time and velocity at cursor position
6. Sample area tools
7. Layout icons
8. Frame marker

Table 13-3:  Cineloop windows 

 Graphic Description

Displays Contrast image data
Sample area:
Indicates sampling position of the intensity trace. The sample 
area is color-coded: the first sample area is yellow, the 
second blue...etc.
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Displays B-mode data
Sample area:
Indicates sampling position of the intensity trace. The sample 
area is color-coded: the first sample area is yellow, the 
second blue...etc.
NOTE: B-mode image is not displayed when cine clip stored 
in contrast only mode.

System menu on Sample Area
This menu is displayed by pressing the left Set key when the 
cursor is placed over a sample area in one of the Cineloop 
windows.
Note: The system menu is dependent on mode.
• Set As Default ROI Size: Displays on elliptical ROI.
• Delete Anchor (On ROI setting as anchor point only)
• Label Sample Area: sets a descriptive name to the sample 

area. The label is useful for identification of the sample area 
when exporting data.

• Copy Sample Area
• Copy & Move
• Copy & Move (Same Depth)
• Move (Same Depth)
• Set Curve Fit Start Frame: Displays only while curve fitting
• Set Curve Fit End Frame: Displays only while curve fitting
• Cancel: exits the System menu.
System menu on Image when copy sample area is selected. 
• Paste Sample Area

Displays time-intensity curve.
• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).
• X axis: Time(s) or Dt(s), elapsed time from previous frame. 
• ECG (where available -- not shown): displays ECG trace 

(where available).
• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.
• Time at cursor position and velocity at cursor position.
• Intensity (dB or AU) at cursor position.
• Intensity (dB or AU) at frame marker position (color coded)

Table 13-3:  Cineloop windows  (Continued)

 Graphic Description
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System menu of the analysis window
This menu is displayed by pressing left Set key when the 
cursor is in the Analysis window.
Note: The system menu is dependent on mode.
• Vertical Auto-Scaling: selects between full unit range or a 

range according to the maximum and minimum values of 
the displayed trace(s). Delayed, On, Off.

• Vertical Unit: toggles between logarithmic (dB) and linear 
acoustical units (AU).

• Line Style: selects between solid line only or solid line with 
square markers at each data point.

• Curve Fitting Parameters: toggles between Wash-in, 
Wash-out, Gamma Variate and off.

• Gradient : On or Off.
• Gradient Plot: Gradient, Gradient Derivative, All or Off
• ECG Triggering
• Cancel: exits the System menu.

Table 13-4:  Analysis windows 

 Graphic Description

Displays time-intensity curve.
• Y axis: Intensity scale (logarithmic) (db) or linear acoustic 

units (AU).
• X axis: Time(s) or Dt(s), elapsed time from previous frame. 
• ECG (where available -- not shown): displays ECG trace 

(where available).
• Frame Marker: the current frame marker and the start and 

stop markers for the cineloop.
• Time at cursor position and velocity at cursor position.
• Intensity (dB or AU) at cursor position.
• Intensity (dB or AU) at frame marker position (color coded)

Table 13-5:  Layout icon 

 Graphic Description

You can select layout from following.
• Graph with Dual Image Layout
• Small Data Layout
• Large Data Layout
• Everything Layout
• Single Image Layout
• Dual Image Layout

Table 13-3:  Cineloop windows  (Continued)

 Graphic Description
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Indicates an analysis graph.

Indicates an image
One icon means Contrast image. Two icons mean Contrast 
and B-Mode.

Indicates parameters.
10 dots means that all parameters display. 4 dots means that 
only displays high level parameters.

Table 13-6:  Sample area drawing tool 

 Graphic Description

Creates a sample are based on freehand drawing.

Creates a sample area with a pre-defined circular/elliptic 
shape.

Table 13-7:  Trackball Assignment 

 Graphic Description

Press the top Trackball key to toggle the trackball assignment 
between QA and Scroll.

• QA
Pointing tool in TIC mode.

• Scroll
When the cineloop is stopped, enables scrolling through the 
cineloop.

• Menu
Press left Set key to display System Menu.

• Set

Table 13-5:  Layout icon  (Continued)

 Graphic Description
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TIC Touch Panel

Figure 13-18. TIC Touch Panel

Table 13-8:  TIC Touch Panel Description

Parameter Description

Exit TIC Analysis Exit TIC. 

Motion Tracking Users use TIC to analyze tumor characteristics precisely, without distortion 
due to patient movement. Motion Tracker enables the system to 
automatically adjust the ROI’s placement across multiple frames in order to 
accommodate patient breathing or body movements.  
To activate, press Motion Tracking on the Touch Panel.This starts the 
calculation to adjust the all ROI positions for every image frame. After 
completion, the ROI graphic on each frame is changed to the ROI with the 
anchor. 

Accumulation Enhances the flow in an image. 

Enable All Frames Re-enables disabled frames. 

Curve Fitting Toggles between Wash-In, Wash-Out, Gamma Variable and Off. 

Smoothing Smooths the trace displayed by applying a filter over a defined time window. 
Both the filter type and time window are user-selectable. The type of filter 
available depends on the analysis signal displayed. 

Delete Sample Area Removes selected sample area from the CINE Loop window and 
accompanying trace in the Analysis window. The Trackball marker must be 
pointed at an anchored sample area. 

First Move to the first frame of cineloop.

Last Move to the last frame of cineloop.
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Run/Stop Start/Stop the cineloop review.

Loop Speed Adjust the cine loop playback speed.

Start Frame Rotate the rotary to select the start frame and push to set the frame.

End Frame Rotate the rotary to select the end frame and push to set the frame..

Frame by Frame Rotate the rotary to review the CINE image frame by frame manually.

Disable Frame Push the rotary to disable the selected frame.

Table 13-8:  TIC Touch Panel Description (Continued)

Parameter Description
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Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring. 

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between he anchored positions when playing/scrolling the 
cineloop. 

Trace from a pre-defined sample area (Ellipse ROI)

1. Press the top Trackball key until the QA trackball 
assignment is selected.

2. If necessary, select the sample area Ellipse ROI button 
(shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball

4. The cursor is changed to a sample area (white circle). A 
preview of the trace is displayed in the Analysis window. .

5. Press Set to anchor the sample area.

6. In this frame, the sample area is marked with an anchor. If 
the cineloop has more than on heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle. 

The trace is updated accordingly in the Analysis window. 
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor 
display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Trace the ourline of the desired ROI by moving the caliper 
with the Trackball.

4. Press Set to anchor the sample area. 

5. The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window. 
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Copy, move and paste a Sample Area

To copy and past the ROI,

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays.

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied ROI 
and press the left Set key. The system menu displays.

4. Select Paste sample area.

To copy and move the ROI,

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays.

2. Select Copy & move. Or if you want to move to the same 
depth as the original ROI, select Copy & move (same 
depth).

3. Move the copied ROI using the Trackball. Press Set to fix 
the position. 

To move the ROI,

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays.

2. Select Move (same depth).

3. Move the ROI using the Trackball. Press Set to fix the 
position. 
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Manual tracking of the sample area (dynamic anchored sample area)

The sample area can be moved within the loop to ensure that 
data in the trace is generated from the same anatomical location 
during the cyclic motion of the heart.

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

NOTE: In the original frame and this particular frame the sample 
area is marked with an anchor.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.
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Manual tracking of the sample area (dynamic anchored sample area)  

(continued)

Moving a dynamic anchored sample area

1. Freeze the image.

2. Press top Trackball key until the scroll trackball assignment 
is selected.

3. Using the Trackball, browse through the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

4. Press top Trackball key until the QA trackball assignment is 
selected.

5. Move the cursor to the sample area using the Trackball.

6. Press Set. The sample area is unanchored.

7. Drag the sample area to a new location.

8. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 
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Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.

NOTE: Shown only in zoom mode.

Delete a trace

The user can delete all traces at once or one at a time.

1. If necessary, press the top Trackball key until the QA 
trackball assignment is selected.

2. Move the cursor over one of the sample area. Confirm that 
cursor is changed to hand icon.

3. Press the Delete Sample Area on the touch panel.

4. Select Current Sample or Delete all as necessary.

NOTE: The corresponding traces for the deleted ROIs are erased from 
the plot.
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Disabling/Enabling the frame

Frame disabling excludes the actual frame from the cineloop 
display. Frame disabling is available only with contrast data. 

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to he frame on the 
Frame Marker which you want disable. 

2. Press Set to disable the frame. 

3. The frame marker is changed from green to red to indicate 
the frame has been disabled.

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory. 

Disabling multi-frames from the frame marker

1. Use the Trackball to move the cursor to he frame on the 
Frame Marker. 

2. Press and hold down Set.

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.
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Disabling/Enabling the frame  (continued)

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle. 

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available). 

2. Position the cursor on the analysis window and press left 
Set key. The system menu displays.

3. Select ECG triggering  (where available).

All frames in all heart cycles are disabled except for the selected 
and corressponding frames in the other heart cycle. 
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Disabling/Enabling the frame  (continued)

To enable the frames 

1. Select Enable all frames on the Touch Panel. 

2. All disabled frames are re-enabled. 

Figure 13-19. Frame markers

1. Analysis Window
2. Frame markers axis
3. Enable frame (Green)
4. Disabled frame (Red)
5. ECG (where available)
6. Crrent frame
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Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the 
corresponding eight races plotted simulatneously on the graph. 
Each ROI display has a different color, and its corresponding 
trace data is plotted using that same color. 

Once eight ROIs have been saved, the system does not 
automatically generate an active ROI when the cursor is 
positioned over the displayed reference image. 

The saved ROIs can be a mixture of elliptical and freehand 
ROIs.

When the user repositions an ROI, the old trace data is erased 
from the plot and the trace data for the new position replotted. 

If the ROI position on the last frame of the selected image range 
is moved, the corresponding ROIs on all frames are 
repositioned to match the last frame. 

The user shall also have the capability of setting separate ROI 
positions on differend frames of he contrast images, and the 
system shall linearly interpolate the ROI positions for the frames 
in between the selected frames. 
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Manipulating the Sample Area  (continued)

Setting the default sample area shape

1. Place the cursor on the sample area. 

2. Press left Set key. The system menu displays.

3. Select Set as Default ROI Size.

4. The current ROI size is set as the default for subsequent 
Ellipse ROIs.
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Manipulating the Sample Area  (continued)

Labeling a Sample Area

The sample area label is used to idenify data associated with the 
sample area when exporting. 

1. Position the cursor on the ROI to label and press the left Set
key. 

2. The ROI sysem menu displays. Select Label sample area.
The Label Dialog box displays. 

3. Enter a name for the sample area. 

4. Select OK.
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TIC Plot Control

Vertical Unit

When analyzing the contrast data, the Y-axis can be set to 
display either logarithmic scale (dB) or linear, acoustic units (AU) 
for both tissue intensity (2D) or Angio intensity data.

To toggle between dB and acoustical display units for the Y-axis.

• dB—The traditional log compressed B-mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the TIC 
analysis.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new ROI is saved, to 
account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
ROI is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Y-Scale

1. When you select “Off” for Vertical Auto-Scaling, Y-Scale 
dialog displays.

2. Enter maximum and minimum value for vertical scale on the 
graph.

3. Press OK. The vertical scale is updated. 



Advanced Features

13-56 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

TIC Plot Control  (continued)

Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Horizontal Scale

Set the horizontal unit as time scaling (s) or time interval (dt) 
between frames.

NOTE: The Horizontal Scale menu displays for Phase Inversion.

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing on the Touch Panel.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays.  Select the appropriate 
parameter.

NOTE: When smoothing is turned on, it applies to all traces in the plot 
window.
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Trace Measurement

Gradient

Gradient is displayed on the screen instead of Intensity (db or 
AU). The gradient calculates from 7 points (includes previous 
and next frames). 

 Figure 13-20. Gradient
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Trace Measurement  (continued)

Max Gradient

Max Gradient is displayed when Small Data Layout and 
Everything Layout is selected while Curve fitting is off.

Displays the time and gradient that becomes the maximum 
gradient between the cine start and end frame. 

 Figure 13-21. Max Gradient
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Trace Measurement  (continued)

Show graph (Gradient plot)

1. Select Gradient Plot from the pull-down menu.

2. Select the parameter.

• Off: A graph plots TIC.

• Gradient: Two graphs plot TIC and TIC gradient.

- Unit of Y-axis is dB or AU in case of intensity.

- The unit is d(db)/dt or d(AU)/dt in case of the intensity 
gradient.

- Gradient values for the current frame are displayed in 
the upper right corner of the graph.

• Gradient Derivative: Two graphs plot TIC and TIC 
gradient derivative.

- The Y-axis units is d2(dB)/dt2 or d2(AU)/dts in case of 
the intensity gradient derivative.

- Gradient derivative values for the current frame are 
displayed in the upper right corner of the graph.

• All: Three graphs plot TIC, TIC gradient and TIC 
gradient derivative.
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Curve Fit

1. Select Curve Fiting on the Touch Panel.

2. The Curve Fit selection list displays.

Figure 13-22. Curve Fit Selection List

• Off—Remove the fitted curves from the plot and the fit 
parameters from the display.

• Wash-in—Used to find and estimate the local perfusion rate 
using the contrast agent. Expotential wash-in is described 
by the function:

Y(t) = A(1-exp(-kt))+B, where:

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity at time t=0 (defined as the 
time of the left marker). This corresponds to the tissue 
(baseline) signal if no contrast is present at the selected 
starting point.

NOTE: A + B = contrast + tissue = plateau level.

• k (1/s) is a time constant.
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Curve Fit  (continued)

• Wash-out—Used to find and estimate a local wash-out rate. 
Expotential wash-out is described by the function:

Y(t) = Aexp(-kt)+B, where :

• A (dB or AU) is the intensity from the contrast agent.

• B (dB or AU) is the intensity from the tissue = baseline 
signal.

NOTE: A + B is the initial intensity level.

• k (1/s) is a time constant.

• Gamma variate

Y(t) = Atcexp(-kt)+B
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Parameters of Gamma curve fitting

Figure 13-23. Gamma Curve

• tc: Increasing function (C>0) for “Wash-in”. 

For larger C, the intensity increases quickly before the peak. 

• exp(-kt): Decreasing function (k>0) for “Wash-out”. 

For larger k, the intensity decreases quickly after the peak. 

• B: Intercept intensity at t=0. 

• The peak intensity of the curve is affected by all parameters. 

Larger A, larger B, larger C, and smaller k make larger peak. 
The peak time is calculated by C/k. 

• MSE: Mean Square Error

If the MSE is small, the difference of actual data and the 
fitted curve is small. 
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Set Start/End Frame for Curve Fit per ROI position

1. Generate TIC and perform a Curve Fit.

In this state, the Curve Fit graph is drawn from Cine Start 
Frame to Cine End Frame for all the ROIs.

2. Select the start frame as with Cine or move the cursor to the 
desired position on the graph and press the right Set key.

3. Move the arrow pointer on the ROI (hand cursor appears) 
and press the left Set key. The system menu appears. 

4. Select Set curve fit start frame from the menu.

5. Select the End Frame as with Cine or move the cursor to the 
desired position on the graph and select the right Set key.

6. Move the arrow pointer on the ROI (hand cursor appears) 
and select the unmarked key (the left Set key). The system 
menu appears. 

7. Select Set curve fit end frame from the menu. The ROI 
colored line displays.

8. Repeat the above procedures as necessary.

The system retains the start/end frame per ROI while TIC is 
active. Once the TIC menu is closed, the settings are lost.
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Display/Hide Calculation Values

1. Place the cursor on the analysis graph and press left Set
key. Select Curve Fitting Parameters from the pull-down 
menu. The Curve Fitting Parameters dialog appears. 

2. The Curve Fitting Parameters dialog appears. 

Figure 13-24. Curve Fitting Parameters Dialog

3. Select a maximum of 5 parameters to display for each curve 
fitting. 

• Save as default: saves as a system preset. 

• Save: saves as temporary. 

• Cancel

NOTE: If you select more than 5 parameters and select “Save” 
or “Save as default,” you will be prompted to select only 
4 parameters. 

4. The selected parameter displays below the image with the 
curve fitting active. Press the display button to display all 
parameters; or press the hide button to hide all parameters. 
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Raw Data store with TIC Setting

You can store the raw data with TIC setting.

1. Run TIC cineloop. 

2. During cine running mode, press appropriate print key.

When you recall the raw data clip with TIC data, you can add, 
delete or modify the analysis measurements on the recalled raw 
data in TIC mode.

Printing TIC Data

1. Press Run/Stop to freeze the image.

The still image can be get when cineloop is stopped by Run/
Stop button. 

2. 

The system capture a single still frame which consists of the 
plot, the reference image and user annotation.

Annotating the TIC Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.
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SaveAs (Save image file and export trace data)

You can save the image file and trace data.

1. Select SaveAs.

2. The following dialog displays.

• Location: Select Location which to save.

• Filename: Enter the file name. (Only Text)

• Export Trace: If you check this box, LOGIQ P8/P9/P10 
exports trace data to csv file. 

Note: Name of exported file has same name as the 
image file saved at the same time.

3. Select OK to save the image and data and return to the TIC 
Analysis screen.

• All displayed ROI traces are saved in the exported file.

• The fit parameters are included in the trace file if the 
user has done a curve fit.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: Data for disabled frames are not included in the exported trace 
file.

NOTE: No trace results are saved in the standard image database.

NOTE: Trace results are not shown on the Worksheet.
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Quantitative Analysis (QAnalysis)

Overview

Quantitative Analysis is available for the following CINE loops 
obtained in the following modes: Tissue Velocity Imaging, Color 
Flow Mode, Power Doppler Mode and Elastography. All of the 
Quantitative Analysis modes operate similarly, with some 
variation.

The Touch Panel may be slightly different, for example; and the 
type of information you quantify varies by mode as well. Please 
see a summary of each mode below; followed by general 
instructions on how to perform Quantitative Analysis. 
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Quantitative Flow Analysis

Provide tools for semi-quantitative assessment of inflammation 
in joints and vascularization in tumors.

NOTE: There is frame number limitation for color quantification as 400 
frames.

Statistics

The LOGIQ P8/P9/P10 extracts various statistics from the 
image data within each ROI. The statistics depends on the 
imaging mode in use.

Press Statistics to enable/disable display of statistics of the 
frame or loop. The statistics are shown only when the loop is 
stopped.

• Ratio: Ratio of Color (Power) Doppler pixels over total ROI 
area.

• Area (mm2): The size of ROI

• Max Ratio/Time of Max Ratio: Maximum Ratio of Color 
(Power) Doppler pixels in each ROI, and which frame that 
occurs in.

• Min Ratio/Time of Min Ratio: Minimum Ratio of Color 
(Power) Doppler pixels in each ROI, and which frame that 
occurs in.

Quantification supports two different statistical display formats: 
Short Form and Long Form.
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Statistics  (continued)

• Short Form: Ratio and Area. 

 Figure 13-25. Color Flow Mode Short Form - Example

• Long Form: Ratio, Area, Max Ratio/Time of Max Ratio, Min 
Ratio/Time of Min Ratio 

 Figure 13-26. Color Flow Mode Long Form - Example
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QAnalysis - Tissue Velocity Imaging 

Multiple Time -Motion trace display from selected points in the 
myocardium.

QAnalysis Screen Description

 Figure 13-27. Q-Analysis Screen

Table 13-9:  QAnalysis Screen Description

1. TVI Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

2. B Cineloop Window
Sample Area: Indicates sampling position of the velocity. The sample area is color-coded: the first 
sample area is yellow, the second green, etc.

3. Analysis Window.
• Y axis: Velocity scale (cm/s)
• X axis: Time(s) 
• ECG
• Time at cursor position.
• Velocity at Cursor position.
• Velocity at frame marker position (Color coded)

4. Sample Area

5. Time at cursor position and velocity at cursor position. Position the pointer cursor over the analysis 
window. 

6. Sample Area Tools.
• Pencil Icon: Creates a sample area based on freehand drawing.
• Shape Icon: Creates a sample area with a pre-defined circular/ellipse shape.
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QAnalysis Plot Control

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

To switch trace 
(Analysis signal)

Analysis Signal toggles the trace display between velocity, 
displacement or gray scale intensity curves.

1. Position the cursor over the plot window and select Analysis 
Signal from the pull-down menu.

2. Select Velocity, Displacement or Grayscale Intensity as 
necessary. 

Vertical Unit

NOTE: Vertical Unit is only available when Grayscale intensity is 
selected in Analysis Signal.

When analyzing the data, the Y-axis can be set to display either 
logarithmic scale (dB) or linear, acoustic units (AU).

To toggle between dB and acoustical display units for the Y-axis.

• dB—The traditional log compressed B-mode data is used to 
calculate the time-intensity curve values.

• Acoustic—The system reverse the log compression 
function to provide un-log compressed data for the 
Qanalysis.

Drift Compensation

Drift Compensation compensates drifting of Tissue Tracking 
curves by either resetting the curve to zero at the tracking start 
point (cycle resetting) or by linear compensation throughout the 
cycle (linear compensation).

NOTE: When Displacement is chosen by AnalysisSignal, Drift 
Compensation is active.

NOTE: Drift Compensation is inactive if ECG data cannot be acquired.
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Trace Measurements

Gradient Select Gradient entry on the pull-down menu that is obtained 
when the cursor is placed over the plot.

Gradient is displayed on the screen instead of velocity. The 
gradient calculates from 7 points (includes previous and next 
frames).

Max Gradient Displays the time and gradient that becomes the maximum 
gradient between the CINE start and end frame. 

Figure 13-28. Max Gradient
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Elastography Quantification

Use Quantification Analysis in Elastography to determine the 
Elastography index of a single ROI, and the ratio between  
multiple ROIs.  

NOTE: Elastography Quantification IS NOT available in the United 
States.

Q-Analysis.  Plot each elasticity index and their ratio on the 
timeline axis. Use the first ROI as a reference point [in yellow] 
for calculating the ratio between multiple ROIs. A maximum of 8 
ROI and 7 ratio curves are available. Automatic disables (skips) 
low quality frames. ECG and Quality graph are displayed on the 
same time line. 

Figure 13-29. Q-Analysis

a. E Index - graph

b. E Ratio - graph

c. Skip frames is shown as a red bar

d. Quality
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Plot Control

Ratio

Select Ratio allows the user to toggle between Elastography 
data and Ratio plot display. 

The LOGIQ P8/P9/P10 plots the ratio of the original ROI and the 
first ROI (ROI 1). The two plots are displayed together one on 
top of the other in the plot area.

Ratio formula: Ratio = ROI 1 / ROI n (n: 2-8)

Ratio for ROI 1 is 1.0 for all frames. When ROI 1 is removed, 
then Ratio is not calculated for ROI n (n: 2-8).

Ratio Plot
Values • Ratio

• Diff: The LOGIQ P8/P9/P10 displays the second derivative 
as a function of time below the traditional plot.

Diff formula: Ratio Diff = ROI 1- ROI n (n: 2-8),

• All: The LOGIQ P8/P9/P10 plots the three plots in the plot 
area of the screen.

• Off
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Additional Notes for Elastography Quantification

When the desired elastography image has been visualized, 
press Freeze; then select a range of CINE loops for analysis. 
The Q Analysis button appears on the CINE Touch Panel. Press 
Q Analysis to enter analysis mode. Set the ROI on the image for 
the E graph to appear. For ratio calculation, set the first ROI and 
then set the second and more ROI; then press “Ratio” or select 
“System Menu => Ratio Plot => Ratio”. Adjust the ROI size by 
using the “body pattern and ellipse” controls.

Figure 13-30. Q-Analysis
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Additional Notes for Elastography Quantification  (continued)

HINTS Highlights: 

• Raw data capability. User can do some further calculations 
(modifying ROI position/size, adding another ROI, and 
recalculating the ratio or difference between them) for 
recalled images at a later time.

• The result of just one ROI (elasticity index) becomes the 
effective index. This quantifies the color distribution in the 
area of interest. By setting two ROI, the ratio is 
automatically calculated.

HINTS Limitations: 

• This is a relative quantification tool based on freehand 
manual palpation technology. It cannot show the stiffness 
by the kPa (kilopascal).

• There is no compatibility among manufacturers regarding 
the value. It depends on their strain imaging technology 
and definition of the value.

• Colors indicate degree of stiffness and do not directly 
correlate to a specific tissue type. Interpretation of what the 
tissues are and how to apply these ratios clinically is at the 
discretion of the user.

• Elastography physics dictates that cystic structures will be 
displayed with a three-layer pattern. This three-layer 
pattern will start with blue on the LOGIQ P8/P9/P10 factory 
default map (which corresponds to hard), then progresses 
to green and then to red (which corresponds to soft). The 
posterior displacement of elastography patterns also may 
cause the B-Mode cyst to consist primarily of blue with the 
green to red being posterior to the B-Mode cyst. You need 
to be aware of the three-layer pattern of a cyst in 
elastography. Utilizing elastography quantification and 
setting the ROI in the blue portion of the three-layer pattern 
on the cyst and then setting the ROI in the “normal” tissue 
may cause you to misinterpret the elastography 
quantification ratio as the cyst to be hard as compared to 
the “normal” tissue. 
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Selecting QAnalysis Image Range

A range of frames is selected for the Qanalysis in Cine mode 
(before accessing QAnalysis). Only the frames in this range are 
used for the QAnalysis.

If a range is not selected prior to accessing the QAnalysis, the 
system uses the default Cine start and end frames as the default  
start and stop frames.

1. The first frame in the analysis series is selected by adjusting 
the Start Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired first frame and then selecting the Start 
Frame control.

2. The last frame in the analysis series is selected by adjusting 
the CINE End Frame control to the desired frame

OR

using the Trackball or the Frame by Frame control to 
select the desired end frame and then selecting the End
Frame control.
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Activating QAnalysis

1. Scan and Freeze the patient in the desired live mode or 
recall a desired cine loop from the stored images.

NOTE: QAnalysis is only available when the system is in CINE 
mode.

NOTE: Images from the current scan session acquired in the 
desired analysis mode (already in CINE) or from a saved 
image loop can be used for QAnalysis.

2. QAnalysis displays on the Cine Touch Panel.

Figure 13-31. Cine  Touch Panel

3. Select QAnalysis. The QAnalysis screen and Touch Panel 
displays. To toggle the trackball function between QA and 
Scroll, press the top Trackball key.
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Activating QAnalysis  (continued)

Figure 13-32. TVI QAnalysis Touch Panel, Page 1

Figure 13-33. Color Flow and PDI Mode QAnalysis Touch 
Panel
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Activating QAnalysis  (continued)

Figure 13-34. Elastography QAnalysis Touch Panel
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Common QAnalysis Function

Display the System Menu

Place the cursor to the desired position and press the left Set
key. The system menu displays at the cursor position.

The system menu is dependent on the area which you place the 
cursor.



Advanced Features

13-82 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Generating a Trace

Up to eight traces can be generated.

About the sample area

The sample area can be in three different states:

• Free sample area: freely moving sample area (QA cursor) 
before anchoring.

NOTE: The free sample area disappears when the QA cursor is 
moved over a static anchored frame.

• Static sample area: the free sample area is anchored by 
pressing Set.

• Dynamic anchored sample area: the sample area is 
anchored in two or more frames (see Manual tracking 
below). In these particular frames, the sample area is 
displayed with an anchor. The sample area moves smoothly 
between the anchored positions when playing/scrolling the 
cineloop.

Trace from a pre-defined sample area

1. If the trackball assignment is not on QA, press the top 
Trackball key until QA highlights.

2. If necessary, select the sample area Ellipse ROI button 
(shape icon on the monitor display).

3. Move the cursor to one of the Cineloop windows using the 
Trackball.

4. Press Set to anchor the sample area.

In this frame, the sample area is marked with an anchor. If 
the cineloop has more than one heart cycle, a sample area 
will also be anchored in the corresponding frame in the next 
heart cycle.

The trace is updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Trace from freehand sample area

1. Select the Freehand ROI button (pencil icon on the monitor 
display).

2. Move the cursor to one of the Cineloop windows using the 
Trackball.

3. Press and hold down the Set key while drawing a sample 
area using the Trackball.

4. Release the Set key.

The sample area is automatically closed and the trace is 
updated accordingly in the Analysis window.
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Generating a Trace  (continued)

Manual tracking of the sample area (dynamic anchored sample area)

1. Place a sample area over a region of interest. Note the 
anatomical location of the sample area.

2. Scroll to a new frame using the Trackball.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to the corresponding anatomical 
location in the new frame.

When the sample area is anchored in more than one frame, 
linear interpolation is performed so that the sample area is 
smoothly moved between the anchored positions in the 
selected frames when running the cineloop.

7. Press the top Trackball key until the scroll trackball 
assignment is selected.

8. Using the Trackball, scroll through the cineloop and control 
that the sample area follows the moving anatomical 
structure.

9. Add anchored sample areas in several frames to obtain a 
more accurate displacement of the sample area.
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Generating a Trace  (continued)

Moving a dynamic anchored sample area

1. Press the top Trackball key until the scroll trackball 
assignment is selected.

2. Using the Trackball, browse thought the cineloop to display 
one of the frames where the sample area was anchored.

NOTE: In these frames, the sample area is marked with an anchor.

3. Press the top Trackball key until the QA trackball 
assignment is selected.

4. Move the cursor to the sample area using the Trackball.

5. Press Set. The sample area is unanchored.

6. Drag the sample area to a new location.

7. Press Set to anchor the sample area to the new location.

If you want to move the sample area to the same depth, select 
Move (same depth) from the System Menu. 
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Manipulating the Sample Area

Up to eight ROIs can be saved on the reference image, with the 
corresponding eight traces plotted simultaneously on the graph. 
Each ROI display has a different color, and its corresponding 
trace data is plotted using that same color.

Once eight ROIs have been saved, the system does not 
automatically generate an active ROI when the cursor is 
positioned over the displayed reference image.

The saved ROIs can be a mixture of elliptical and freehand 
ROIs.

When the user repositions an ROI, the old trace data is erased 
from the plot and the trace data for the new position replotted.

If the ROI position on the last frame of the selected image range 
is moved, the corresponding ROIs on all frames are 
repositioned to match the last frame.

The user shall also have the capability of setting separate ROI 
positions on different frames of the contrast images, and the 
system shall linearly interpolate the ROI positions for the frames 
in between the selected frames. 
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Setting the default sample area shape

1. Select Set sample area shape. The Information Box 
displays.

Figure 13-35. Sample Area Information Box

2. Select Height, Width and Tilt angle.

3. Select Set as default. The current ROI size is set as the 
default for subsequent Ellipse ROIs.
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Sample Area Shapes

There are two different methods for determining the shapes of 
the sample area.

Ellipse ROI

1. Select the ellipse icon (shape icon on the monitor display).

2. When the trackball positions the image display cursor over 
the reference image(s), an elliptical ROI is automatically 
generated and displays on the reference image(s). 

3. The average velocity value inside the ellipse is calculated 
for every image in the image analysis range and plotted in 
the image display area.

4. The last generated or selected ellipse is considered the 
active ROI, and its trace plot automatically updates as the 
user repositions it on the reference image. Old traces are 
erased.

5. When scanning with an elliptical ROI, press Set to fix the 
ROI position and freeze its corresponding trace on the plot. 
A new active ROI is generated whose position is 
manipulated by the trackball and whose velocity curve 
traces will be plotted as before, while the previous ROI and 
trace remain fixed at the points they were saved at.

NOTE: Elliptical ROIs can be positioned in any manner that keeps their 
center within the image boundaries. In the case that part of the 
ROI is outside the image boundary, only data from within the 
image boundary is used for calculating the mean velocity value.

NOTE: You can change the size of the Ellipse ROI by adjusting the 
Ellipse control. 
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Sample Area Shapes  (continued)

Freehand ROI

1. Select Freehand icon (pencil icon on the monitor display).

Use the Trackball to position the caliper on the reference 
image at the start point. Press Set to fix the start point.

2. While holding down the Set key, trace the outline of the 
desired ROI by moving the caliper with the Trackball.

Reshaping a Sample Area

To reshape the sample area:

1. Position the cursor on the ROI to reshape and press the left 
Set key.

2. The ROI system menu displays. Select Set sample area 
shape.

Figure 13-36. Sample Area Information Box

3. Adjust Height, Width and Tilt angle.

4. Press OK. The selected ROI size changes.
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Labeling a Sample Area

The sample area label is used to identify data associated with 
the sample area when exporting.

1. Position the cursor on the ROI to label and press the left Set
key.

2. The ROI system menu displays. Select Label sample area.
The Label Dialog box displays.

Figure 13-37. Label Dialog Box

3. Enter a name for the sample area.

4. Select OK.

Copy, move, and paste a Sample Area

To copy and paste the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy sample area.

3. Move the cursor to the desired location for the copied ROI 
and press the left Set Key. The system menu displays. 

4. Select Paste sample area.

To copy and move the ROI, 

1. Move the cursor over the ROI and press the left Set key. 
The system menu displays. 

2. Select Copy & move. Or if you want to move to the same 
depth as the original ROI, select Copy & move (same 
depth).

3. Move the copied ROI using the Trackball. Press Set to fix 
the position.
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Deleting a Sample Area

Sample ROIs and their corresponding traces can be deleted 
using Delete Sample Area.

1. Select Delete Sample Area; a pull-down menu displays.

Figure 13-38. Delete Sample Area pull-down menu

2. Select Current sample to delete the currently active ROI.

Select Delete all to delete all currently set ROIs and all of 
their traces.

NOTE: The corresponding traces for the deleted ROIs are erased from 
the plot.

NOTE: Deleting an ROI causes the ROIs to be deleted from all frames 
in the analysis loop.
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QAnalysis Plot Control

NOTE: Plot Control is available only with TVI and Elastography modes.

The following controls are user configurable presets which are 
configurable through the pull-down menu in QAnalysis mode. 
When using the pull-down menu:

1. Place the cursor over the analysis window and press the left 
Set key. The system menu displays at the cursor position.

2. Select the appropriate parameter.

Vertical auto-scaling

The system can be configured to display the full unit range or a 
range according to the maximum and minimum values of the 
displayed trace(s) (auto-scaling function). In addition, the 
auto-scaling function can be set to be live update (updates while 
the sample area is moved) or delayed (updated when the 
sample area is anchored).

• Delayed—The system automatically rescale the vertical 
axis of the trace graph only when a new ROI is saved, to 
account for changing input dynamic range.

• On—The system automatically rescale the vertical axis of 
the trace graph every time the currently selected (active) 
ROI is moved.

• Off—Disable any automatic scaling of the vertical axis. 
There is user-defined system defaults on the system preset 
page for the fixed vertical scale to be used for the plot.

Figure 13-39. Vertical Autoscale Pop-up menu
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Line Style

• Solid—Setting the results in a plotted trace that does not 
display small boxes at the data points.

• Squares—Setting the results in a plot where small squares 
are displayed at each data point, and the squares are linked 
together by lines.

Figure 13-40. Line Style Pop-up menu

Smoothing

The system can smooth the traces displayed by applying a filter 
over a defined time window. The type of filter available is 
depending on the analysis signal displayed.

1. Select Smoothing.

NOTE: When smoothing is turned on, it applies to all traces in the 
plot window.

2. The smoothing filter list displays.  Select the appropriate 
parameter.

Horizontal Sweep

Horizontal Sweep allows you to increase or decrease the time 
interval over which to plot the analysis curve. 

The default is the user selected image range. If the user has not 
yet selected a first and last frame, the first and last default 
frames from the displayed CINE loop are used.
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Zooming in the Analysis window

To zoom:

1. In the Analysis window, press and hold down the Set key 
while dragging the cursor to define the zooming area.

2. Release the Set key.

To unzoom:

1. Press the left Set key in the Analysis window. The system 
menu displays.

2. Select Unzoom.
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Disabling/Enabling the frame

NOTE: Frame disable/enable is available only with Elastography, CF, 
and PDI modes.

Frame disabling excludes the actual frame from the cineloop 
display.

Disabling the frame from the frame marker

To disable One Frame:

1. Use the Trackball to move the cursor to the frame maker to 
disable.

2. Press Set to disable the frame.

3. The frame marker is changed from green to red to indicate 
the frame has been disabled. 

NOTE: The disabled frame is no longer displayed in the reference 
window when scrolling through CINE memory.

Disabling multi-frames from the frame marker 

1. Use the trackball to move the cursor to the first frame maker 
to disable.

2. Press and hold down Set

3. Move the cursor with the Trackball to the last frame to be 
disabled and release Set.

The marker is turn red and the data from that frame is 
removed from the trace and any subsequent trace 
processing.

Disabling a frame from the cineloop window

1. Use the trackball to move the cursor to the cineloop window.

2. Press the left Set key. The system menu displays.

3. Select Disable frame.

The current frame is disabled and the corresponding frame 
marker displays red.
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Disabling/Enabling the frame  (continued)

Disabling Frames - Auto

When the user enters Elasto Quantification, the useless frames 
are disabled automatically. The LOGIQ P8/P9/P10 uses 
Elastography Index value to find useless frame (low quality 
frames).

Disabling ECG triggered frame (where available)

In a multi-cycle acquisition, the user may deselect all frames in 
all heart cycles but a selected one. This function can be used for 
example to select a particular systolic frame for each heart 
cycle.

1. Scroll through the cineloop to identify the cardiac phase to 
analyze or identify the cardiac phase on the ECG trace 
(where available).

2. Position the cursor on the ECG trace (where available) and 
press left Set key. The system menu displays.

3. Select ECG triggering (where available).

All frames in all heart cycles are disabled except for the 
selected and corresponding frames in the other heart 
cycles.
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Disabling/Enabling the frame  (continued)

To enable the frames

To re-enable all deleted frames:

1. Position the cursor on the Frame Marker line and press the 
left Set key. The system menu is displayed at the cursor 
position.

2. Select Enable all frames.

3. All disabled frames are re-enabled.

Figure 13-41. Frame Makers

1. Analysis Window
2. Frame markers axis
3. Enabled frame (Green)
4. Disabled frame (Red)
5. ECG (where available)
6. Current frame
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Exporting Traces (Saving the Trace Data)

You can save the trace data to an external file in ASCII format, 
readable in spreadsheet programs.

1. Select Export Traces to save the trace data.

2. The following window displays.

Figure 13-42. Export Trace Window

• Location : Select Location which to save.

• Filename : Enter the filename. (Only Text)

3. Select OK to save the data and return to the QAnalysis 
screen.

• All displayed ROI traces are saved in the exported file.

NOTE: The Smoothed trace is the one saved if the user has applied a 
smoothing filter.

NOTE: Only data from the user selected image range is included in the 
exported trace file.

NOTE: No trace results are saved in the standard image database.
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Annotating the QAnalysis Data

The user can annotate both the reference image and the trace 
plot displays. Use Comment key to type the annotation. See 
Chapter 6 for reference.

Printing QAnalysis Data

Press the appropriate print key in the desired analysis mode 
mode. 

The system captures a single still frame which consists of the 
plot, the reference image, and user annotation.

Exiting QAnalysis

There are several methods to exit QAnalysis.

• Toggling Exit QAnalysis on the QATouch Panel.

• Press Freeze to unfreeze and resume scanning.

• Press any other button that returns the system to real-time 
scanning.
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Real-time 4D

4D Introduction

4D provides continuous, high volume acquisition of 3D images. 
4D adds the dimension of “movement” to a 3D image by 
providing continuous, real-time displays. With 4D, you can apply 
rendering techniques to smooth out the appearance of an 
anatomical structure, for example, a baby’s spine.

You can perform the following types of volume acquisitions 
within the 4D feature:

Table 13-10:  4D Package Options

4D Type Description
Acquisition 

Mode

4D Designed for continuous volume acquisition of a 3D image. B, 4D

Static 3D Designed for single volume acquisition of a 3D image. B, 3D
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Features supported with 4D

The following features are supported with 4D:

• Most B-Mode controls

• Annotations

• Measurements and Calculations

The following post-processing controls are available with 4D:

• CINE 

• Zoom
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4D Principles of Operation

The acquisition of volume starts with a 2D image using special 
probes designed for performing 3D sweeps and 4D scans. The 
volume box defines the region of interest to be used for the 
volume sweep.

Volume sweep refers to the range of the sweep of the 2D image 
to be transformed into a rendered, 3D or 4D image. Static 3D 
acquisition involves a single volume sweep. 4D involves 
multiple, continuous volume sweeps. 

Figure 13-43. Volume Sweep 

1. Central 2D scan

2. Start 2D scan

3. Range of VOI sweep

When you initiate a volume sweep, you can adjust the angle of 
the volume.

What is Interactive 3D Rendering? 

Interactive 3D rendering allows you to visualize certain 
structures and to view and analyze different sections of the 
volume.
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Region of Interest (ROI) / Render Box

The Region of Interest (ROI) - also referred to as the Render 
Box in rendering  - contains the section of the volume you want 
to render. Therefore, objects that are not inside of the box are 
not included in the render process and are cut out (this is 
important in surface mode to allow a free line of sight). This may 
or might not be the entire Volume of Interest (VOI). 

You can adjust the view direction of the ROI.

Figure 13-44. Render View Directions

1. Up/Down
2. Left/Right
3. Front/Back

4. Down/Up
5. Right/Left
6. Back/Front
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Principle of Sectional Planes

Sectional planes represent three different planes of the same 3D 
volume. There are three separate planes, A (Longitudinal), B, 
(Transverse) and C (Coronal). 

Figure 13-45. Illustration of Sectional Planes

The presentation of three orthogonal sectional planes is different 
from the conventional patient orientation in 2D sonography. 

NOTE: Whenever you select the usual, longitudinal section of the 
patient to display in field A, the conventional orientation for 
longitudinal and transverse sections is valid. 
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Reference Images

Reference images are the individual image displays within the 
corresponding sectional plane. Reference image A represents 
the longitudinal view; reference image B the transverse view, 
and reference image C represents the coronal view.

 Figure 13-46. Monitor Display of Reference Images in Sectional View

1. Reference Image A (Longitudinal)

2. Reference Image B (Transverse)

3. Reference Image C (Coronal)

Orientation Help. When you view a 4D image on the display, 
it’s sometimes difficult to recognize the orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view. 
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Reference Images  (continued)

Figure 13-47. Reference Image A

For Reference image A, the transducer plane migrates from the 
FRONT to the REAR through the volume body.

Figure 13-48. Reference Image B

For Reference image B, the transducer plane migrates from the 
LEFT to the RIGHT through the volume body.

Figure 13-49. Reference Image C

For Reference image C, the transducer plane migrates from the 
TOP to the BOTTOM through the volume body.
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-50. Abdominal Probe Orientation

1. Image Plane A

2. image Plane B

3. Image Plane C
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Reference Images  (continued)

Examples of Probe Orientation with Reference Planes

Figure 13-51. Endocavity Probe Orientation

1. Image Plane A

2. Image Plane B

3. Image Plane C

4. Groove
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4D Operational Controls

Control Panel Overview

When you enter 3D/4D mode, the behavior of some of the 
Control Panel buttons changes. For example, in 3D/4D mode, 
you use the PW-Mode, CF-Mode, M-Mode buttons (along with 
Depth) to manipulate the Volume of Interest (VOI).

 Figure 13-52. Control Panel Buttons

1. 3D/4D key, used to activate/deactivate 3D/4D.
2. CF Key, CF-Mode key is used to rotate about the X axis.
3. PW Key, PW-Mode key is used to rotate about the X axis.
4. M Key, M-Mode key is used to rotate about the X axis.
5. Ellipse key, used as a transverse translation through the image.
6. Top Trackball  key, used to adjust the size and position of the VOI.
7. Trackball, used to move the VOI. Also, the 4 keys surrounding the Trackball map to additional 

functionality, as shown on the monitor display. 
8. L (left) key, used to begin a 4D acquisition.
9. Freeze or R (right) key, used to freeze a 4D image.
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4D Monitor Display

Imaging parameters are displayed in the upper right-hand 
portion of the display. The 4D specific parameters are Quality 
(Q), Volume Angle (A) and Volume Rate (VR). The Status Bar 
contains instructions on the tasks you can perform at each stage 
of the 4D imaging process. Remember to take a look at the 
Status Bar as needed.
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4D Touch Panel Overview

The following is the first Touch Panel that appears when you 
press 3D/4D.

Figure 13-53. First Touch Panel displayed when entering 3D/
4D mode

Common 4D Touch Panel Controls

Most 4D Touch Panel screens contain some similar controls. 
Refer to the table below for descriptions of these controls. 
Controls that are unique to or that contain slightly different 
functionality are described in their respective sections.

Table 13-11:  Common 4D Touch Panel Controls

Preset Parameter Description

SRI-HD Allows you to apply SRI-HD (High Detection Speckle Reduction Imaging) to 
the selected reference image. 

Tile You can divide the display into 1, 2, or 4 windows for Render view (Render = 
On) and 1 or 4 windows for Sectional view (Render = Off). 

Reset Curve Resets the three-point curve to a straight line. 

Direction Adjusts the view direction of the ROI. 

Visualization Sectional, Render, VCI-Static, or Tomographic Ultrasound Imaging (TUI). 
Render view displays one rendered image, or reference image(s) and 
rendered image. 

Focus Position Adjusts the focal position. 
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Volume Angle Sets the range of the volume sweep. 

Quality Balances speed with line density. Max combines the highest density with the 
slowest speed; Low combines the lowest density with the highest speed. 

Table 13-11:  Common 4D Touch Panel Controls (Continued)

Preset Parameter Description
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Real-Time 4D/Static 3D Presets

1. When you enter 3D/4D mode, press the Preset tab.

Figure 13-54. 4D Preset

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Static 3D Presets

1. When you enter 3D/4D mode, press Static 3D, then the 
Preset tab.

2. Select one of the preset settings for data acquisition and 
display. Presets are defined in the preset file and differ by 
application.

Table 13-12:  Common 4D Touch Panel Controls

Preset Parameter Description

Save Selections: Overwrite, Create New, Cancel. Overwrite. Overwrite the 
application preset file with the changes you just made. Create New.  Create 
a new user application preset file based upon the current exam category and 
application. Cancel. Cancel without saving preset parameters.   

Pre-defined Preset Reloads the presets for the selected application. 
Abdomen, Obstetric, Gyn, Surface, Skeleton, Default, Peri. Vasc., Small Part, 
Contrast

User Used to define new user presets for a given application. 
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Storing 4D Images

You store 4D images exactly as you would your 2D images. 
Because 4D images contain more data, they also require more 
space. Pay close attention to the size of the volumes.

• Still image: Store as Raw Data

• CINE: Store as DICOM
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Anatomical Markers in 4D

Anatomical markers are available in 4D. 

To add an anatomical marker in 4D, 

• Rotate the Body Pattern/Ellipse key. A person pattern 
overlays the 4th quadrant on the display.

To change the person pattern, 

• Press the Touch Panel key. From left to right, select either 
Transrectal, Neonatal Head, Face (down), or Face (up). 

To rotate the person pattern, 

• Rotate the Body Rotation Touch Panel key (0, 45, 90, 135, 
180, 225, 270, or 315 degrees). 

To tilt the probe, 

• Rotate the Probe Tilt Touch Panel key (0, 45, 90).

To align the marker with the probe’s orientation marker. 

• Rotate the Body Pattern/Ellipse key. 

To position the marker on the anatomy, 

• Move the Trackball to position the marker at the appropriate 
anatomy.

The display is also annotated, for example:  

• Cr = Cranial

• Ca = Caudal

• A = Anterior

• P = Posterior

• L = Left

• R = Right

To exit Anatomical Markers:

• Press the Set key.
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Performing a 4D Scan

4D provides continuous, high volume acquisition of 3D images. 
You can apply rendering techniques to smooth out the 
appearance of an anatomical structure, for example, a baby 
face.

4D imaging contains three main viewing modes: Sectional, 
Render, and Tomographic Ultrasound Imaging (TUI). Sectional 
mode displays three separate representations of the image: 
Longitudinal (original 2D image), Transverse (elevational), and 
Coronal (horizontal). Render mode displays one rendered 4D 
image.
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Visualizations

4D provides two types of views for displaying and working with 
images: Sectional, Render, and Tomographic Ultrasound 
Imaging (TUI).

Sectional View

Sectional view contains one display for each sectional plane. 

 Figure 13-55. Monitor Display in Sectional View

1. Sectional Image A

2. Sectional Image B

3. Sectional Image C
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Visualizations  (continued)

Render View

The LOGIQ P8/P9/P10 continuously displays the 4D rendered 
image. 

NOTE: When the tile selection is single, only the rendered 4D image 
appears. When the tile selection is quad, the sectional images 
are located in 3 quadrants with the rendered 4D image in the 
fourth.

Figure 13-56. Quad Tile Render View
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Visualizations  (continued)

Orientation Help

When you view a 4D image on the display monitor, it’s 
sometimes difficult to recognize he orientation. To help, the 
system displays a three-dimensional drawing to illustrate the 
orientation. This drawing displays ONLY in sectional view. 

Figure 13-57. Orientation Help Graphic
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Acquiring and Rendering a 4D VOI

Starting with a 2D Image

To create a 4D image, you start with an optimized 2D image. 
The 2D image serves as the mid-line for the resulting 4D image.

1. Connect the appropriae 4D-compatible probe, leaving the 
probes in their respective holders. Follow he guidelines in 
Chapter 3 for connecting probes. 

NOTE: If the appropriate 4D probe is not connected, the original 3D 
Touch Panel appears. 

2. Obtain a 2D image. Optimize the image as usual.

Entering 3D/4D Mode

In 3D/4D mode, you choose the type of scan you want to 
perform: 4D or Static 3D.

1. Press 3D/4D to enter 3D/4D mode. The first time you press 
3D/4D, the system is in B Pre mode. 

NOTE: The location of the number of focal zones might change 
when you enter 3D/4D mode, since the number of zones is 
pre-determined by the default ROI.

The default acquisition mode varies by application. If you 
are in OB, the default acquisition mode is Real-Time 4D; for 
all other applications, Static 3D is the default acquisition 
mode. Wen you enter pre-mode, an ROI graphic may 
appear on the monitor display that defines the initial ROI 
(Region of Interest) of the volume.

Figure 13-58. ROI Graphic

2. Press the Preset tab. Select one of the preset settings for 
data acquisition and display. Presets are defined in the 
preset file and differ by application.  
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Quick Acquisition Steps

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D. An ROI graphic appears. 4D is selected.

5. Define the Volume of Interest (VOI) to be scanned. Use the 
Trackball to move the VOI and the Width button to re-size 
and re-position the VOI. Only the area defined within the 
VOI is rendered.

6. Adjust the volume angle and quality. This defines the range 
of the volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

7. To begin 4D acquisition, press the L key.

You DO NOT have to hold the probe steady during data 
acquisition.

During data acquisition, you can manipulate the VOI to see 
different views of the image. To rotate the VOI left or right, 
use the PW control. To rotate the VOI forward or backward, 
use the M control. To rotate the VOI in a circular motion, use 
the CF control.

To return to 3D/4D pre-mode, press L.

NOTE: If the volume size is too large, the message “Volume Size 
Too Big - Quality Degraded” displays in the status bar.  The 
system changes the quality automatically to below the upper 
limit and displays the proper Quality value in the information 
window. 

8. Set Render to On.

9. To complete the acquisition, press Freeze or R.

10. Store the image.
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Acquiring a 4D Volume of Interest (VOI)

Once you have acquired an optimized 2D image, you can 
perform a 4D scan to acquire the 4D image.

During 4D image acquisition:

• Frame Averaging is disabled.

• You cannot change the transmit frequency.

• To change the position of the focal zone, adjust the depth of 
the VOI.

• You cannot change the number of focal zones.
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Acquiring a 4D Volume of Interest (VOI)  (continued)

To acquire a 4D VOI:

1. Press 4D.

2. Make sure the VOI is defined appropriately. If necessary, 
adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a higher volume rate.

See Manipulating the Volume of Interest (VOI) for more 
information.

3. To begin 4D acquisition, press the L key. The system will 
perform continuous sweeps across the VOI. You do not 
have to hold the probe steady during a 4D scan.

To return to 4D pre-mode, press L.

4. Set the Render to On.
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Sectional VOI Acquisition

Sectional view provides three separate views of the same 
image: Longitudinal (original image), Transverse (elevational), 
and Coronal (horizontal).

1. In the 4D tab, Render defaults to On (Render mode). 
Change Render to Off for Sectional view.

2. To select a reference image, use the Ref Image control on 
the Touch Panel. The reference image selected contains the 
focus for control panel keys, allowing you to manipulate or 
optimize that image.

Figure 13-59. 4D Data Acquisition Sectional View

Table 13-13:  4D Data Acquisition Parameters 

4D Parameter Description

Restore View Resets all parameters back to the original values or chosen presets.

Tile Selections:  Single, Quad. You can divide the display into 1 or 4 windows. 

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 
displays one rendered image, or reference image(s) and rendered image. 

Ref Image Use to select the reference image that has focus for use with the control 
panel keys and Trackball.

Orientation Help Displays a three-dimensional drawing to illustrate the orientation. Only 
displays in sectional view. 

Volume Angle Sets the range of the volume sweep. 
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B Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 
density. Max combines the highest density with the slowest speed. Low 
combines the lowest density with the highest speed. BQ displays on the 
display. 

Table 13-13:  4D Data Acquisition Parameters  (Continued)

4D Parameter Description
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Render VOI Acquisition

Rendering allows you to distinguish subtle anatomical detail. 
You can render all areas of an VOI, or just certain regions of the 
VOI. The region you define for rendering is referred to as the 
Render Box.

1. Define the area you want to render. For example, if you 
have an image of an entire fetus, you might only want the 
fetal face to be rendered. Therefore, you would define the 
fetal face as the VOI.

2. Set Render to On.
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Render VOI Acquisition  (continued)

Figure 13-60. 4D Tab (Data Acquisition) Render View

Table 13-14:  4D Data Acquisition Parameters - Render Mode 

4D Parameter Description

Restore View Select to reset all parameters back to the original values or chosen presets.

Tile Selections:  Single, Dual, Quad. You can divide the display into 1, 2, or 4 
windows.

Visualization Sectional, Render, or Tomographic Ultrasound Imaging (TUI). Render view 
displays one rendered image, or reference image(s) and rendered image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 

Ref Image Use to select the reference image that has focus for use with the control 
panel keys and Trackball. This control is enabled only if Tile is set to Quad.

Volume Angle Sets the range of the volume sweep. 

Quality Selections: Max, Hi2, Hi1, Mid2, Mid1, Low. Used to balance speed with line 
density. Max combines the highest density with the slowest speed. Low 
combines the lowest density with the highest speed. 

Activate Curve Define a three-point curved surface for the render window using the 
Trackball. 

Reset Curve Reset the three-point curve to a straight line. 

Mix Selections: 0-100% in increments of 2. Allows you to mix a Rend Mode 1 
mode with a Rend Mode 2 mode. Always select two modes. 
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Lower Threshold Selections: 0-255. Sets a lower threshold below which weaker echoes are 
removed.

Table 13-14:  4D Data Acquisition Parameters - Render Mode  (Continued)

4D Parameter Description
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Render VOI Acquisition  (continued)

1. Select the Render Setting tab.

The Render Setting tab allows you select and combine 
gray-scale and color rendering modes.

Figure 13-61. Render Setting Tab (4D Data Acquisition)

HINTS If you are using Surface modes, we recommend that you 
adjust the Lower Threshold to recognize border structures 
more clearly.

Table 13-15:  4D (Data Acquisition) Render Parameters

4D Parameter Description

Direction The ROI determines the region that is rendered during 4D acquisition. You 
can change the direction in which this ROI is viewed. Selections: Up/Down,
Down Up, Left/Right, Right/Left, Front/Back, Back/Front.

Gray Map Displays the gray map selections on the display monitor. Select maps using 
the Trackball.

Colorize Displays the tint map selections on the display monitor. Select maps using 
the Trackball.

Render Mode Select Gray or Inversion. If you select Inversion, inverts the gray values of the 
rendered image (e.g., image information that was black becomes white and 
vice versa). 
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Render 1 Allows you to combine render mode values from render mode 1. Select the 
render map combination from the upper-left portion of the monitor display. 
Select map combinations using the Trackball.
Render Mode 1 Selections: Surface Smooth, Surface Texture, Transp Max, 
Transp X-ray, Transp Min, HDlive Texture. 
Surface Smooth - Surface displays in a smoothed texture mode, which 
means that the gray values of the surface are identical with the gray values of 
the original 2D scan.  Surface Texture - Surface displays in texture mode, 
which means that the gray values of the surface are identical with the gray 
values of the original 2D scan. Transp Max. - Displays the maximum 
intensity of gray values in the ROI. This is helpful for viewing bony structures. 
Transp X-Ray - Displays the mean value of all gray values in the ROI.  Trans 
Min. - Displays the minimum number of gray values in the ROI. This is helpful 
for viewing vessels and hollow structures. HDlive Texture - Uses an 
illumination source that can be positioned by the user around the rendered 
3D object on a spherical coordinate. By highlighting structures from the side, 
the three-dimensional impression can be improved considerably. 

Render 2 Allows you to combine render mode values from render mode 2. 
Render Mode 2 Selections: Surface Smooth, Light, Gradient Light, Transp 
Max, Transp X-ray, Transp. Min., HDlive Smooth. 
Surface Smooth - Surface displays in a smoothed texture mode, which 
means that the gray values of the surface are identical with the gray values of 
the original 2D scan.  Light - Surface displays in light mode. Structures in the 
near field are brighter; structures in the far field are darker.  Gradient Light - 
Surface displays as if it is illuminated from a spot light source. This is helpful if 
the displayed surface is surrounded by hypoechoic structures (for example, 
liquids). Transp Max. - Displays the maximum intensity of gray values in the 
ROI. This is helpful for viewing bony structures. Transp X-ray - Displays the 
mean value of all gray values in the ROI.  Transp Min. - Displays the 
minimum number of gray values in the ROI. This is helpful for viewing vessels 
and hollo4w structures. HDlive Smooth - Smoothed HDlive texture mode.  
When Render 1 value is set to HDlive Texture, the only available mode for 
Render 2 is HDlive Smooth.Note:  HDlive rendering is not available if VCI is 
active.

Edit Light Activates the light editor for the virtual light source in HDlive render mode. 
User can position the light source by moving the Trackball, A light icon on the 
main display  indicates the direction of the light. Note: The Edit Light
parameter is only available for the HDlive rendering modes. 

Transparency Selections: 20 to 250. Sets the transparency of the image. The higher the 
number, the more transparent the gray scale information.

Table 13-15:  4D (Data Acquisition) Render Parameters (Continued)

4D Parameter Description



Real-time 4D

LOGIQ P8/P9/P10 – Basic User Manual 13-131
Direction 5841298-1EN Rev. 2

Manipulating the Volume of Interest (VOI)

Imagine you are able to manipulate the 4D volume of interest 
(VOI) in your hand. The 3D/4D ROI is a tangible anatomical 
object that you can see and manipulate easily using the 
Trackball and other control panel keys.

If the monitor display is in Sectional view, select the desired 
reference image before you manipulate the image.

NOTE: The manipulation examples are with A set as the reference 
image.

Rotating the 4D 
VOI Left/Right or 
Forward/Backward

You can rotate the VOI around the X, Y, and Z axes. To rotate 
the VOI around the X axis, turn the CF left/right. 

Figure 13-62. Rotate about X Axis with CF Control
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Manipulating the Volume of Interest (VOI)  (continued)

To rotate the VOI around the Y axis, turn the PW left/right. 

Figure 13-63. Rotate about Y Axis with PW Control

Rotating the 4D 
Image in a Circular 
Motion

To rotate the VOI around the Z axis, turn the M left/right. 

Figure 13-64. Rotate about Z Axis with M Control

NOTE: To speed up the rotation, press the PW, CF, or M controls before 
you turn them. To slow down the rotation, press PW or CF again. 
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Manipulating the Volume of Interest (VOI)  (continued)

Moving through 
the VOI

To move through the image to view a particular slice, press 
Depth.

This allows a displacement of the center of rotation along the 
intersection lines of the sectional planes A, B, and C. The 
displacement of the center of rotation leads to the display of 
parallel sectional images. See ‘Reference Images’ on 
page 13-105 for more information.

Zooming the 
Image

Rotate Zoom to zoom on the image.

Moving the VOI 
Position

To move the position of the VOI, move the Trackball left, right, 
up and down, as needed.

Resizing the VOI To re-size the VOI, use the Width control panel button. See the 
Width section in this chapter.

Stopping 4D Image Acquisition

To stop acquiring a 4D image, press Freeze or R if you are in 
Render view or just Freeze if you are in Sectional view.
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4D VOI Post-Processing

When you press Freeze or R, one of the following Touch Panel 
displays, depending on whether you are in Render view or 
Sectional view.

Figure 13-65. 4D (After Acquisition) Touch Panel - Sectional 
View

Figure 13-66. 4D (After Acquisition) Touch Panel - Render 
View
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Static 3D

You can create a single sweep, single volume static 3D image.

Performing a Static 3D Scan

1. Connect the appropriate 4D-compatible probe, leaving the 
probes in their respective holders. Follow the guidelines in 
Chapter 3 for connecting probes.

2. Select a 4D probe from the probe indicator.

3. Obtain a 2D image. Optimize the image as usual.

4. Press 3D/4D.

5. Press Static 3D. Set Visualization to Render. 

6. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move the VOI and Width to re-size the ROI. 

7. Adjust the volume angle. This defines the range of the 
volume sweep. A small sweep angle results in a lower 
number of slices with a high volume rate.

8. Set the probe down on the patient, making sure the probe is 
held steady. Press the L key to start acquisition.

NOTE: During 3D acquisition, no control panel keys are not 
available, except for ‘R.’ 

NOTE: When the 3D acquisition begins, the Touch Panel appears 
blank for a brief moment.

9. Hold the probe steady until the system stops automatically. 
You will know the acquisition has stopped when the Touch 
Panel changes to display the Render Setting, 3D Rotational 
Cine, and Scalpel tabs.

To stop the acquisition manually, press the R key. 

10. Save the image.

11. To further manipulate the 3D image, press Static 3D.

The Touch Panel that displays depends on the visualization 
mode selected prior to freeze, Sectional, Render, TUI or VCI 
Static.
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Static 3D  Sectional View

Figure 13-67. 3D (After Acquisition) Touch Panel - Sectional 
View

Table 13-16:  3D After Acquisition Parameters - Sectional View

Preset Parameter Description

Orientation Help Displays a 3-dimensional drawing to illustrate the orientation. Only displays in 
sectional view.
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Static 3D Render View

Figure 13-68. 3D (After Acquisition) Touch Panel - Render 
View

Table 13-17:  3D After Acquisition Parameters - Render View - Page 1

Preset Parameter Description

Edit/Accept ROI Selections include Edit, Accept. Edit - Select to adjust the size of the Region 
of Interest (ROI). Accept - accepts the active 3D image. 

3D Orient When selected, changes the orientation of the image on the monitor display. 
Selections include: 0 degrees, 90 degrees, 180 degrees, and 270 degrees. 
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Volume Review

You can post process VOI (the entire volume of interest) and 
scroll through acquisition planes via Volume Review. This allows 
you to review all of the frames within this volume set.  

In Volume Review, start in Run/Stop so that every frame in the 
volume is displayed. 

NOTE: If you adjust the screen while in Volume Review, these changes 
ARE NOT reflected on the Static 3D volume. 
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Static 3D Color

To view Static 3D Color, 

1. Acquire the anatomy you want to view in B-Mode. 

2. Activate Color Flow or PDI. 

3. Activate 3D/4D. The Pre-3D displays. Select the desired 
Visualization.  

NOTE: 4D cannot be selected from Pre-Mode with Color active.

4. Press ‘L’ to render the image. 

The color is rendered. You can adjust the Render Mode (default 
is Glass Body): 

• Gray. Gray, no color. 

Figure 13-69. 3D Color - Gray

• Inversion. Inverts the grayscale. 
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Static 3D Color  (continued)

• Color. Displays Color-Flow. 

Select the rendering method ([Rend Color1] (Surface only) 
or [Rend Color2]) and the mixing ratio.

Figure 13-70. 3D Color - Color

• Glass Body. Displays both Color-Flow and B-Mode. 

Select the rendering method ([Rend Gray] or [Rend Color]) 
and the mixing ratio.

Figure 13-71. 3D Color - Glass Body

To hide the color on the sectional planes, select Color Off from 
the Touch Panel. 

NOTE: If you scan in Render mode and select Tile as Quad, you can 
hide the color with the Color Off Touch Panel key.



Real-time 4D

LOGIQ P8/P9/P10 – Basic User Manual 13-141
Direction 5841298-1EN Rev. 2

Scalpel

Scalpel allows you to edit/cut sections of a 3D image. Scalpel is 
available only on a rendered image.

1. Press Scalpel.

2. Select the cut mode.

3. Use the Trackball and Set key to define the portion of the 
image to cut. Press Set to start, move the Trackball to 
define the region, then press Set again to cut the image. 
The portion is removed.

To undo the last cut, select Undo Last.

To undo all cuts in the current session, select Undo All.

Figure 13-72. Scalpel

Table 13-18:  Scalpel Parameters

Preset Parameter Description

Cut Mode Selections: Inside Contour, Outside Contour, Inside Box, Outside Box, Eraser 
Big, Eraser Small. Inside Contour, Outside Contour - Allows you to trace 
the portion of the image you want to cut. Trace Outside removes all portions 
of the image that fall outside your traced region. Trace Inside removes all 
portions of the image that fall inside your traced region.  Inside Box, Outside 
Box - Displays a box you can use to define the portion of the image you want 
to cut. Outside Box removes all portions of the image that fall outside the box. 
Inside Box  removes all portions of the image that fall inside the box. Eraser
Big, Eraser Small - Provides a big and small eraser tool you can use to 
define the portion of the image to cut by hand. Available only if Depth is Full.
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NOTE: With the cut image displayed, if you attempt to switch to the 
Static 3D tab to edit the ROI, the following warning message 
appears: Scalpel changes will be lost. Do you want to continue? 
[Yes/No]. 

Cut Depth Selections: Full, Define. Full -The entire depth of the selected region will be 
cut.   Define - Allows you to define the depth to cut using the Depth control 
panel knob.

Undo Last Undoes the last cut only.

Redo Select to redo scalpel.

Undo All Undoes all cuts since you entered Scalpel mode.

Done Applies to User Defined Cut Depth when complete. 

Table 13-18:  Scalpel Parameters (Continued)

Preset Parameter Description
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3D Rotation CINE

3D Rotation CINE allows you to view the 3D image from various 
angles.

To activate rotation CINE in 3D:

1. Press Freeze.

2. Select the 3DRot Cine tab. 

Figure 13-73. 3D Rotation Cine

Table 13-19:  3D Rotation Cine Parameters 

Preset Parameter Description

Rotational Angle Sets the rotational angle of the 3D image over which the CINE loop is played. 
Typical values are 30, 45, 60, 90, 180 and 360 degrees.

Step Angle Sets the step angle between individual frames in the CINE loop. 

Rotation Axis Sets the axis about which the CINE loop is calculated. Selections X and Y.

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 
loop sequence forward.  BiDirectional - plays the sequence forward and 
backward.

First Displays the first volume in the CINE. 

Last Displays the last volume in the CINE. 

Run/Stop Starts and stops the CINE sequence.
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Start Angle Used to select the starting angle in the CINE loop range. The default Start 
Image is calculated from the rotational angle as:   -1 X Rotational angle / 2 If 
you adjust the Start Image, the Rotational Angle is re-set to be the value of 
the adjusted Start Image.

End Angle Used to select the ending angle in the CINE loop range. The default End 
Image is calculated from the rotational angle as:   Rotational angle / 2 If you 
adjust the End Image, the Rotational Angle is re-set to be the value of the 
adjusted End Image.

Image by Image Used to select an individual image in the CINE loop. 

Table 13-19:  3D Rotation Cine Parameters  (Continued)

Preset Parameter Description
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Volume CINE

The system constantly stores CINE images so you can play 
back and review those images. CINE is useful for focusing on 
images during the specific part of the heart cycle or to view short 
segments of a scan session.

To activate CINE in 4D:

1. Press Freeze.

2. Select the VolCine tab. 

Figure 13-74. 4D Volume Cine

Table 13-20:  4D Cine Parameters

Preset Parameter Description

Loop Mode Selections include: One Way, BiDirectional (two-way). One Way - plays one 
loop sequence forward.  BiDirectional - plays the sequence forward and 
backward.

First Displays the first volume in the CINE loop. 

Last Displays the last volume in the CINE loop. 

Run/Stop Starts and stops the CINE loop.

Loop Speed Adjusts the CINE loop speed. 

Volume by Volume Used to select an individual volume in the CINE loop. 
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Volume CINE  (continued)

1. If you were in Render visualization mode when you entered 
4D CINE mode; press L to return to Pre-Mode.

If you were in Sectional visualization mode when you 
entered 4D CINE mode; press L to return to Pre-Mode. 

2. To re-start real-time 4D acquisition, press Freeze.
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VCI Static

Introduction

VCI (Volume Contrast Imaging) allows you to sweep smaller 
slices of data with a higher volume rate. The resulting image 
shows an average, integrated gray value of the tissue contained 
within the ROI. VCI improves the contrast resolution and signal/
noise ratio. It also reduces image speckle. This may facilitate 
finding diffuse lesions in organs. 

Touch Panel

The data is represented as in Static 3D - Sectional Planes. 
However, the three planes are VCI renderings (tissue 
information of a thick slice) computed from the 3D dataset. 

Figure 13-75. 3D (After Acquisition) Touch Panel VCI Static 

Table 13-21:  VCI Static View

Preset Parameter Description

Slice Thickness Select the slice thickness
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Tomographic Ultrasound Imaging (TUI)

Tomographic Ultrasound Imaging (TUI) is a visualization mode 
which presents data as parallel slices (planes) through the 
dataset. This method of visualization is consistent with CT and 
MRI. The distance between the different planes can be adjusted.   

1. Select TUI as the Visualization mode. 

2. Press ‘L’ to start acquisition. 

3. If in 4D, press ‘R’ to end the acquisition. This step is not 
required in Static 3D.

The reference image + the number of specified slices 
appears. The reference image always displays and 
indicates which slices you are currently viewing as solid 
lines.
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Tomographic Ultrasound Imaging (TUI)  (continued)

Figure 13-76. TUI 3x3 Example

a. The TUI reference image that shows the slice position. 
This image is orthogonal to the reference image.

b. The number and green asterisk shows the position of 
each slice. A green asterisk indicates the center image 
(A, B or C-plane).

c. Slice distance displays when the slices are in certain 
intervals.

d. A solid line indicates the slice appears on the monitor.

A dotted line indicates the slice did not appear on the 
monitor.

NOTE: TUI with Color is only available with Static 3D, not with 4D. 
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Tomographic Ultrasound Imaging (TUI)  (continued)

4. Adjust the number of slices and slice distance.

You can adjust the number of slices by using the Slices
rotary. You can adjust the distance between the slices using 
the Slice Distance rotary. Max value is 40mm.

Figure 13-77. TUI Touch Panel

• Move forward/backward through the slices via Prev./
Next Slice.

• Change the center image via Ref. Image if needed 
(Reference image A, B or C).

• Select Display Format from 1X1, 1X2, 2X2 and 3X3.

• For Orientation Marker, please refer to ‘Easy 3D’ on 
page 5-143 .

• The following features are supported in TUI: Zoom, 
Rotation (X/Y/Z), Trackball (Move the position), 
Translation and Gain.

• To hide the color, select Color Off from the Touch 
Panel.



Real-time 4D

LOGIQ P8/P9/P10 – Basic User Manual 13-151
Direction 5841298-1EN Rev. 2

Tomographic Ultrasound Imaging (TUI)  (continued)

You can adjust each slice position with Adjust Slices.

1. Press Adjust Slices on the Touch Panel.

2. The pointer displays. Select a slice by using the Trackball.

Figure 13-78. Adjust Slice screen (example)

a. Selected slice displays with yellow border

b. Distance from the center image

• Adjust the slice distance from the reference image by 
using Slice Position. Slice Position only affects the 
selected slice. 

NOTE: If you place the pointer on the reference image and 
rotate Slice Position, the position of the reference 
image and all slices are moved.

• Adjust the number of right and left slices off the center 
image by using Left Slices or Right Slices.

3. After the adjustment is finished, press Set. The slice is 
marked with an “X”. To print this slice, press a print key. 
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VOCAL

You use VOCAL (Virtual Organ Computer-aided Analysis) to 
visualize and calculate the volume of anatomical structures, 
such as a tumor lesion, cysts, and the prostate. VOCAL is 
available after a Static 3D or Real-Time 4D acquisition. 

1. Press Vocal. Specify the volume calculation method 
(Manual, Contour Detect, SemiAuto Detect, or Sphere).
Select the reference image you want to use to perform the 
trace by selecting Ref Image A, B, or C. Press Start.

2. Trace the anatomy using the Trackball. Press Set to start 
and end the trace. You must go across the dotted line for the 
trace to take effect (it turns yellow). The trace is performed 
on each image slice, separated by the rotational step angle. 
Rotate the Rot. Ref dial until you have completed the total 
of the required rotations (for example, if you’ve selected 30 
degrees, you need to complete six traces if you’ve selected 
Manual). After you’ve completed the trace target, the Calc
Volume button is active for you to press. The calculated 
VOCAL image appears in the lower, right-hand corner of the 
display. You are now in the edit state. 

NOTE: Trace not used for Sphere. For Sphere, set the Poles. 

3. Edit as necessary. You can apply a shell, adjust its 
thickness, navigate through the reference angles, or restart 
the VOCAL. 
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VOCAL  (continued)

Figure 13-79. VOCAL Setup 

Table 13-22:  VOCAL Parameters on Setup Touch Panel

Parameter Description

Manual When you select the Manual method, you need to perform a manual trace on 
each of the rotation angles. 

Contour Detect When you select the Contour Detect method, you need to perform a manual 
trace on each of the rotation angles. 

SemiAuto Detect When you select the Semi Automatic Detect method, you need to perform a 
trace on only two rotation angles. The system applies an algorithm to define 
the traces. 

Structure Structure is only available with the SemiAuto Detect method. Select Hypo, 
Cystic, or Hyper/Iso. 

Sphere Calculates the volume based on the pole settings. 

Pole 1 Adjust the upper contour point  (green arrow) of the structure. 

Pole 2 Adjust the lower contour point (green arrow) of the structure.

Rotational Step Angle Specify the angular spacing between contour traces. Typical values are 6, 9, 
15, and 30 degrees. The number of planes varies by this formula: 180 
degrees / selected rotational step angle. 

Ref Image Use this to select the image you want to use to perform the trace. 

Start Press Start when you’re ready to perform the trace. 

Rot.Ref #/#    Back/Next Select Next/Back to move to the next image for contour definition in the 
rotation step. 
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VOCAL  (continued)

Figure 13-80. VOCAL Calculate Volume Touch Panel

Table 13-23:  VOCAL Calculate Volume Touch Panel

Parameter Description

Calc Volume Press Calc Volume to initiate the VOCAL image calculation. 

Clear Press Clear to remove the trace from the image. 

Restart Vocal Press Restart Vocal to return to the initial VOCAL state. 
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VOCAL  (continued)

Figure 13-81. VOCAL Edit Touch Panel

The Shell Modes allows you to construct a shell or contour 
“around” the structure of interest, which enables you to 
distinguish between the contour of the targeted structure and 
the contours the inside and outside of the structure.

Table 13-24:  VOCAL Parameters on Edit Touch Panel

Parameter Description

Shell Off Select Shell Off if you do not want a shell around the VOCAL image. 

Inside Select Inside if you want a shell inside the volume. 

Outside Select Outside if you want a shell outside the volume. 

Symmetric Select Symmetric if you want half of the shell thickness inside and half 
outside the volume’s perimeter. 

Shell Thickness Adjust to vary the thickness of the shell. 
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SonoRenderlive

SonoRenderlive helps to find the render start position to easily 
separate solid tissue in front of the render object. 

The SonoRenderlive algorithm “looks” for the transition from 
solid to liquid tissue and positions the “Render Start” into the 
liquid area visualized by the green render start line. The render 
start line is not a staright line but a “free” trace for optimal 
adaptation to the render object. 

 Figure 13-82. Screen Display Off

 Figure 13-83. Screen Display On
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Using SonoRenderlive

1. Start the Render Visualization Mode.

2. Press the SonoRenderlive Rotary control.

3. To adjust the distance between the render start position and 
the render object, rotate the Sensitivity control below the 
touch panel. A high value indicates a smaller distance. 

NOTE: If SonoRenderlive is not used, the Render Start line can also be 
modified manually. Press the trackball button Curve to activate 
Curved Render Start and move the trackball to modify the line. 
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SonoAVCTM

Overview

SonoAVC helps detect low echogenic objects (eg. cysts) in an 
organ (eg. Kidney) and analyzes their shape and volume. From 
the calculated volume of the object, an average diameter is 
calculated. All calculated objects are listed according to size. 
The calculation results are displayed in the top left corner, with 
the object numbers color-coded to denote the object on the 
image. If the mouse cursor hovers over a specific item on the 
list, the respective object in the image is highlighted (and vice 
versa). The color of the object is bound to its position on the list. 

Figure 13-84. SonoAVC Display Screen

• d(V): Diameter, calculated as if the object were a perfect 
sphere

• dx: Length of x-axis of the best fitting ellipsoid

• dy: Length of y-axis of the best fitting ellipsoid

• dz: Length of z-axis of the best fitting ellipsoid

• mean d: Average value of the x-axis, y-axis and z-axis

• V: Volume of the object
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Overview  (continued)

Figure 13-85. SonoAVC Menu

Table 13-25:  Menu

Parameter Description

Measure Method • Manual: Each object has to be selected and measured manually
• SemiAuto: Each object is selected manually with the system cursor 

but traced / measured automatically
• Auto: Objects are detected automatically (Default)

ROI Shape • Rounded: The box has the shape of a rectangle
• Angular: The box has an elliptic shape with rounded corners (Default)

Ref Image Select the reference image to which all image dependent functions like 
parallel shifts, rotations, etc. are applied. 

Start SonoAVC With Abd application:
• Left Kidney
• Right Kidney
With Gyn application:
• Left Ovary
• Right Ovary
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SonoAVC Main Menu

Figure 13-86. SonoAVC main Menu

Figure 13-87. SonoAVC Trackball Menu
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SonoAVC Main Menu  (continued)

Table 13-26:  

Parameter Description

New Analysis Starts a new analysis.

Add Manual Only available when auto or semi-auto is selected. Objects not automatically 
detected can be added manually, or wrongly detected objects can be 
removed. 

Save Add the result to database. 

Worksheet Open the worksheet.

Cut/Merge • Undo All: Undo all edits
• Redo: Redo the last edit
• Undo: Undo the last edit

Display • None: No visible segmentation
• Contour: Segmentation are shown with a contour-line
• Filled: Segmentation are filled with color

Ref Image Select the reference image to which all image dependent functions like 
parallel shifts, rotations, etc. are applied. 

Add/Rem. Add detected objects manually. 

Cut Cut detected objects.

Merge Combine detected objects.
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Using SonoAVC

Manual

1. Acquire 3D volume or reload previously acquired volume. 

2. Select SonoAVC tab.

3. Switch sect. plane A to full size if not present.

4. Adjust the sect. plane A with x, y, z rotation, parallel shift and 
zoom to achieve the correct measuring plane. 

5. Select SonoAVC.

6. Select Manual and adjust the ROI shape, if desired.

7. Start the measurement by selecting either Left Ovary or 
Right Ovary. 

8. The green measurement cross appears in the middle of the 
image.

9. Perform measurements:

a. Position the start-point of the long diameter with the 
Trackball and press Set.

b. Position end-point of the long diameter with the 
Trackball and press Set.

c. Position the start-point of the short diameter with the 
Trackball and press Set.

d. Position end-point of the short diameter with the 
Trackball and press Set.

e. To start the next measurement, move the Trackball and 
repeat step 9.

10. Select Save to save the measurements to the current exam. 
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Using SonoAVC  (continued)

Semi Auto

1. Acquire 3D volume or reload previously acquired volume. 

2. Select SonoAVC.

3. Select SemiAuto and adjust the ROI shape, if desired.

4. Start the measurement by selecting either Left Ovary or 
Right Ovary.

5. Measure all desired objects on the current plane:

a. Position the system cursor over the object to be 
measured and press Add/Rem.

b. Click the cursor by pressing Set on the object.

The selected trace with corresponding color and 
number is displayed. 

c. Position the system cursor over the next object to be 
measured. 

d. If the measurement is not finished, repeat step 5.

6. Select Save to save the measurements to the current exam.

Auto

1. Acquire 3D volume or reload previously acquired volume.

2. Select SonoAVC.

3. Select Auto and adjust the ROI shape, if desired.

4. Start the measurement by selecting either Left Ovary or 
Right Ovary.

The rendered objects and the result list are displayed on the 
screen. 

5. Select Save to save the measurements to the current exam.
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Using SonoAVC  (continued)

Add Manual

1. Press Add Manual button.

2. The measurement cross appears in the middle of the sect. 
plane A.

3. Perform measurements:

a. Position the start-point of the long diameter with the 
Trackball and press Set.

b. Position end-point of the long diameter with the 
Trackball and press Set.

c. Position the start-point of the short diameter with the 
Trackball and press Set.

d. Position end-point of the short diameter with the 
Trackball and press Set.

The second measurement displays. 

e. To start the next measurement move the Trackball and 
repeat step 3.
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OmniView

OmniView provides an arbitrary cross-sectional plane, as 
opposed to a strict coronal plane.  In VCI OmniView, the 
rendering box is very thin so you can visualize the tissue 
information of a thick slice. The resulting image shows the 
average (integrated) gray value of the tissue contained within 
the narrow box. 

VCI OmniView improves the contrast resolution and the signal/
noise ratio and therefore facilitates the detection of diffuse 
lesions in organs. The result is an image with no speckle pattern 
and a highly improved tissue contrast.

Possible Acquisition Modes: (Sectional Planes Visualization 
only)

• 4D Real Time

• 3D Static

• STIC
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Workflow

1. Press 3D/4D.

2. Select VCI OmniView.

3. Adjust Volume Angle and B Quality as necessary.

4. Press the right Set key to start acquisition.

The volume acquisition starts and the acquired images are 
displayed.

5. The cross cursor displays on the reference image. 

6. Select the appropriate trace mode to display the sectional 
plane. 

• Line: Select the sectional image by using straight line. 

• Curve: Select the sectional image by using curved line. 

Move the cursor to the start point and press Set. Move 
the cursor to the end point and press Set. Use the 
Trackball to make a curved line and press Set.

• Trace: Select the sectional image by using any arbitrary 
curve.

• Polyline: Select the sectional image by using a 
continuous line composed of one or more line 
segments. You can create a polyline by specifying the 
endopoints of each segment by press Set.
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OmniView Main Menu

Figure 13-88. OmniView Menu

Table 13-27:  OmniView Parameters on Edit Touch Panel

Parameter Description

View Icon Show or hide the OmniView Icon.

View Line Show or hide the OmniView Line.

VCI OmniView Switch to VCI Omniview.

Trace Mode Four tracking line methods are available.

Tile Select a display format (Singul, Dual, Quad)

Clear All All existing lines are deleted and a new line entry is started.

Ref. OmniV To activate OmniView Ref. Line view.

Ref. Image Select the Reference image.

OmniV. Rot Rotates the OmniView line.

Undo To re-adjust the traced line.
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OmniView Control

Figure 13-89. OmniView Control

Table 13-28:  OmniView Parameters on Line Edit Mode: New

Parameter Description

Undo Restart the line.

Pre mode Go back to Pre-mode.
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VCI OmniView

With help of OmniView sectional planes derived from an entered 
trace can be visualized and so special coronal planes are 
possible. The trace can be entered in the Vol. Pre image or if a 
volume data set is present on image A, B or C. The trace can be 
a straight line, a curved line or any freeform trace. Together with 
the VCI function images with less speckle pattern and a highly 
improved tissue contrast can be archived.

Figure 13-90. VCI OmniView

1. OmniView pre mode:
Entered OmniView line in center position of Vol. sweep

2. Acquired Volume block:
dashed line: plane position orthogonal to the center image dotted line: 
VCI (slice) thickness

3. Calculated result:
OmniView image including VCI rendering if on

4. Render direction
5. Screen display
6. Ref. Image
7. OmniView image
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STIC (Spatio-Temporal Image Correlation) 

NOTE: STIC is an option.

Overview

With this acquisition method the fetal heart or vascularity can be 
visualized. It is not a Real Time 4D technique, but a post 
processed 3D acquisition.

STIC is designed for beating (fetal heart) as well as blood 
perfused organs. Only STIC can synchronize structures that 
have a pulsation in Doppler mode, but no visible pulsation in 
B-mode.

Data is acquired for a predefined period of time. The acquired 
images are post processed to calculate a Volume Cine 
sequence representing one complete heart cycle.

In order to achieve a good result, try to adjust the size of the 
volume box and the sweep angle to be as small as possible. The 
longer the acquisition time, the better the spatial resolution will 
be. The user must be sure that there is minimal movement of the 
participating persons (e.g., mother and fetus), and that the probe 
is held absolutely still throughout the acquisition period. 
Movement will cause a failure of the acquisition. If the user 
(trained operator) clearly recognizes a disturbance during the 
acquisition period, the acquisition has to be canceled.

A good STIC data set shows a regular and synchronous beating 
of the fetal heart or of an artery. Please make sure that the 
borders of the fetal heart or the artery are smooth and there are 
no sudden discontinuities. Always adopt a critical attitude to 
images created in STIC mode.

If the expected frame rate is too low (10Hz) for a good STIC 
quality, a warning is displayed in STIC mode.

After the STIC acquisition is finished the calculation process 
starts to calculate the volume cine sequence. If a result is 
detected by the system, the Volume cine sequence is shown in 
run mode and the STIC accept menu appears. As soon as the 
result is accepted the system releases the volume cine mode. If 
the result is not accepted but canceled, the system switches 
back to STICpre mode.
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Overview  (continued)

One or more of the following artefacts in the data set indicate a 
disturbance during acquisition:

• Sudden discontinuities in the reference image B: These are 
due to the motion of the mother, the fetus or fetal arrhythmia 
during acquisition.

• Sudden discontinuities in the color display: Motion of the 
mother, the fetus or fetal arrhythmia affects the color flow in 
the same way it affects the gray image.

• Fetal heart rate far too low or far too high: After acquisition 
the estimated fetal heart rate is displayed. If the value does 
not correspond to the estimations based on other diagnostic 
methods at all, the acquisition failed and has to be repeated.

• Asynchronous movement in different parts of the image: 
e.g., the left part of the image is contracting and the right 
part is expanding at the same time.

• The color does not fit the structures displayed in gray mode: 
The color is displayed above or below the actual vessel.

• Color “moves” through the image in a certain direction: This 
artefact is caused by a failure in detecting the heart rate due 
to low acquisition frame rate. Use higher acquisition frame 
rate for better result.

NOTE: In all of the above cases the data set has to be discarded and 
the acquisition has to be repeated.

When is it not allowed to perform the STIC fetal cardio 
acquisition?

• Severe fetal arrhythmia

Following STIC acquisition modes are available:

• STIC

• STIC CFM

• STIC PDI
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Performing STIC Scan

NOTE: STIC can only use in OB application.

NOTE: Supported probe: RAB2-6-D and RIC5-9-RS.

1. Select a 4D probe from the probe indicator.

2. After obtaining a feasible 2D image of the fetal heart or an 
artery, press 3D/4D to activate the Volume mode.

3. Select STIC.

4. Set the Volume of Interest (VOI) to be rendered. Use the 
Trackball to move and resize the VOI.

NOTE: Press top Trackball key to switch Pos and Size.

5. Adjust the Acquisition Time.

6. Set the volume sweep angle by using Volume Angle.

NOTE: In order to acquire a good result, try to adjust the ROI and 
the sweep angle to be as small as possible. The longer the 
acquisition time, the better the spatial resolution will be.

7. Hold the probe still and ask the patient not to move.

8. Press the right Set key to start the acquisition.

NOTE: When the STIC acquisition begins, the Stop Acquisition 
button appears. If the user recognizes a movement of the 
probe, fetus or the patient during the scan, press Stop 
acquisition to cancel the acquisition.

9. Hold the probe steady until the system stops automatically. 
Estimated Fetal Heart Rate and Accept/Cancel buttons 
appears on the Touch Panel.

10. Press Accept if the fetal heart rate displayed on the Touch 
Panel is accepted. STIC image is displayed.

If the result is not accepted, select Cancel. The system 
switches back to STIC-pre mode.

NOTE: If the user (trained operator) clearly recognizes a 
disturbance during the acquisition period, the acquisition 
has to be canceled.



Real-time 4D

LOGIQ P8/P9/P10 – Basic User Manual 13-173
Direction 5841298-1EN Rev. 2

Screen Layout

The yellow caution icon and the calculated heart rate are 
displayed as well.

NOTE: Displayed Heart Rate indicates the heart rate [B/min] calculated 
from the delta time length per beat. A yellow caution icon 
indicates that the displayed heart rate is only an estimation. Do 
not diagnose based on this value.

 Figure 13-91. Screen Layout



Advanced Features

13-174 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

STIC Controls

Touch Panel/All hard key and trackball controls are the same as 
in 4D/Static 3D mode. Therefore only the STIC relevant controls 
are described here:

Table 13-29:  STIC Pre-mode Touch Panel

Relevant controls Description

Acq. Time Only available in STIC. Acquisition time can be set.

Volume Angle Adjusts the volume angle.
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HDLive

NOTE: HDlive is an option

NOTE: The virtual light source of HDlive mode can be positioned by 
keeping the small center trackball button pressed while moving 
the trackball.

NOTE: HDlive rendering is just available if Static 3D is active.

NOTE: The Render Mode for HDLive is available when HDLive is 
activated.

Render Parameter

HDlive Texture  Activates HDlive Texture.

HDlive Smooth  Activates HDlive Smooth.
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HDLive Activation

1. Press 3D/4D.

2. Select [Static3D] button and then HDLive preset

3. Select Render in Visualization.

4. Start Static3D acquisition.

Figure 13-92. HDLive Preset
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Light Control

1. Select Light with Top-Left setkey

2. Move the cursor with trackball the direction of light

Figure 13-93. HDLive Light Control

Figure 13-94. HDLive Light Control
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Compare Assistant

Overview

Compare Assistant allows you to perform serial scans on a 
patient when you can compare the images from a patient’s 
previous exam(s) to the patient’s current exam.

NOTE: In order to reload imaging parameters from a previous exam, the 
image must have been stored as raw data.

NOTE: Side-by-side scanning comparison is present whether or not you 
are able to import the scanning parameters.

In Comparison Mode the system can automatically reload  
scanning parameters from a previous exam performed on a 
LOGIQ P8/P9/P10 archived as raw data and allow for 
side-by-side scanning for image comparison. This allows you to 
use consistent scanning parameters from exam to exam on the 
same patient and may assist in assessing the progress of the 
patient.

Compare Assistant is available in B-Mode, Harmonics, Contrast, 
and in Color Flow and Power Doppler Imaging Modes. 

In B-Mode the following parameters can be transferred from the 
Compared Image to the Active B-Mode Image: Gain, Depth, 
Frequency, CrossXBeam, Virtual Convex (linear probes), SRI, 
Frame Averaging, Map, Dynamic Range, Acoustic Output, 
Harmonic state, Focal Zone Number and Position, Width, and 
Line Density. 

In Color Flow/PDI Mode the following parameters can be 
transferred from the Compared Image to the Active Color Flow/
PDI Mode image: Gain, ROI Size/Position, Frequency, Frame 
Averaging, Packet Size, Flow Model, Scale (PRF), Wall Filter, 
Spatial Filter, Acoustic Output, Invert, Threshold, Sample 
Volume, Color Map, Virtual Convex (linear probes), and Line 
Density.  
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Overview  (continued)

Image parameter copy is now supported for the following 
additional modes: Contrast (supports depth, focal zone position, 
acoustic output, and frequency), Elasto (supports ROI size, ROI 
position, frequency, and scale), B-Flow (supports depth, 
frequency, focal zones, and sensitivity), and B-Flow Color 
(supports ROI Size, ROI Position, frequency, and scale)

Annotations and Body Patterns can also be transferred from a 
patient’s previous exam to the patient’s current active exam. 

Up to four (4) exams, three (3) other exams and the current 
active exam, can be compared. Each exam is displayed on the 
bottom of the display, with Tabs indicating each exam. Tabs are 
shown in chronological order with the most recent exam 
displayed on the left. 

Compare Assistant is not supported with PW, CW, M-Mode, 
V-Nav, 3D/4D, Quantitative Analysis, Stress Echo, or 
LOGIQView. 

Only measurements taken during the active exam are 
transferred to the current exam’s Worksheet; previous exam 
measurement information is not included on active worksheets. 

In order to utilize the Compare Assistant tool, images should 
have RawDICOM data. The RawDICOM data is saved locally 
when available. Some scanning modes do not provide raw data. 
If the raw data associated with the comparison image cannot be 
displayed in dual image format, the DICOM image data is used 
to display the image. RawDICOM data is typically removed 
when images are sent to PACS; therefore, images that are 
loaded using Query/Retrieve will likely be standard DICOM only.  

NOTE: Images from some other ‘unsupported’ modes (PW Mode, CW 
Mode, and M-Mode) can be recalled in Compare Assistant, but 
the tool will not attempt to copy over imaging parameters unless 
it is one of the types listed above (it will still attempt annotation 
copy). Imaging parameter copy will also not be attempted unless 
the current probe is the same as the probe used to capture the 
original image and RawDICOM data for the original image is 
available.
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Workflow example

NOTE: If you use DICOM images for comparison, check "Compare" 
checkbox of the DICOM Image folder and press Compare in the 
Image History page.

1. Place the cursor on the Compare Assistant icon and press 
Set to activate Compare Assistant.

2. Place the cursor on the date tab of the desired comparison 
exam and press Set.

3. Place the cursor on the desired comparison image and 
press Set.

4. Start scan and freeze the image at the same position to 
make a comparison.

Use Copy Setting Icon as necessary. Comparison Image 
parameters transfer to the Active Image based on your 
preset (automatic or manual).

5. Place the cursor on the Compare Assistant icon and press 
Set to deactivate Compare Assistant.

 Figure 13-95. Compare Assistant Screen (example)

1. Active Image
2. Comparison Image
3. Active Exam clipboard
4. Date tab of comparison exam
5. Comparison exam clipboard
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Setting Up Compare Assistant

Compare Assistant allows you to set the following parameters: 

• Side to place the compared image (left/right)

• Date settings for the compared image

• Imaging and Annotation parameters to be copied from the 
patient’s Compared to the Current image

• Clipboard, Active Image, and Image History Label Layout 
and Color

You can set these parameters on the System Imaging page via 
Utility--> System--> System Imaging. 

Figure 13-96. Setting Up Compare Assistant Parameters

Table 13-30:  Compare Assistant Parameters

Parameter Settings

Comparison Image Side • Left
• Right (Default)

Comparison Image Date • All Dates (Default): The date is always displayed on the comparison image. 
• Different Date: Date only displayed when the date of the comparison image 

is different than the active exam date. 
• None: No comparison image date is displayed. 
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To set Compare Assistant print parameters, select Utility--> 
Connectivity--> Button--> Advanced. You can set the system to 
print the Comparison image only, to store the New Image only; 
or to store both the Comparison and New Image. 

Copying Settings You can set the default Compare settings on the  System Imaging Utility page 
or you can select the Compare setting via the On-screen controls. 
Comparison Image parameters transfer to the Active Image based on your 
preset (automatic or manual). 
Automatic Settings are copied from the Comparison Image to the current 
image as soon as the comparison image is loaded. 
• Automatic: Imaging & Annotations (Default): Imaging Parameters, 

Annotations, and Body Patterns copied
• Automatic: Imaging Only:  Only Imaging Parameters copied
• Automatic: Annotation Only:  Only Annotations and Body Patterns copied
Manual Settings are copied from the Comparison Image to the current 
image when you manually select the control. 
• Manual: Imaging & Annotations: (Default) Imaging parameters, 

Annotations, and Body Patterns copied
• Manual: Imaging Only: Only Imaging Parameters copied
• Manual: Annotations Only: Only Annotations and Body Patterns copied
Off: No parameters copied. 

Note: Copy settings are restored to the default whenever Compare Assistant is turned on and the active 
exam or current patient has changed since the last time it was on.  

Image Label Layout:
Clipboard
Active Images
Image History

• No Label
• 1-Line Label (Default)
• 2-Line Label

Image Label Color: 
Clipboard
Active Images
Image History

• Bright/Soft White
• Bright/Soft Yellow
• Bright/Soft Red
• Bright/Soft Orange
• Bright/Soft Blue
• Bright/Soft Purple

Table 13-30:  Compare Assistant Parameters

Parameter Settings
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Compare Assistant Controls

The following controls can be used while in Compare Assistant: 

Table 13-31:  Compare Assistant Controls

Control Description

1. Image Display Area Icon
2. Worksheet
3. Active Image Screen
4. Compare Assistant On/Off. Select the Compare Assistant Icon to activate 

Compare Assistant. 
5. Copying Settings
6. Save As Menu
7. Next/Previous Image, or Press [Ctrl]+[Next Image Arrow] to start a Slide 

Show. 

Keyboard Arrow Keys You can also use the Arrow Keys on the Keyboard to move to the next/
previous clipboard image. 

Operator Panel L/R Keys If comparison mode is on and the single image display is active, to enter dual 
comparison display press the L (Left) or R (Right) key. 
If dual comparison display is on and the dual comparison display is active, to 
enter single image display, press the L (Left) or R (Right) key. 

Freeze Key To deactivate Comparison Mode, select the comparison image side while in 
Dual Comparison Display and press Freeze. 

Print Key When you store an image while in Dual Comparison Display, the system 
automatically switches to the active exam side prior to storing the image. 
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Compare Assistant Controls  (continued)

Table 13-32:  Compare Assistant icon and Copy Setting icon

Compare Assistant On. Copy to 
Right.

Compare Assistant On. Copy to 
Left.

Off Off

Automatic: Imaging and 
Annotations

Automatic: Imaging Only

Automatic: Annotation Only Manual: Imaging & Annotations

Manual: Imaging Only Manual: Annotations Only

Off. No parameters copied. Disabled.

Table 13-33:  Compare Assistant icon and Copy Setting icon

Compare Assistant On. Copy 
to Right.

Compare Assistant On. Copy to 
Left.

Off Off
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NOTE: Compare Assistant icon is disabled when the system does not 
have Compare Assistant Option.

Automatic: Imaging and 
Annotations

Automatic: Imaging Only

Automatic: Annotation Only Manual: Imaging & Annotations

Manual: Imaging Only Manual: Annotations Only

Off. No parameters copied. Disabled.

Table 13-33:  Compare Assistant icon and Copy Setting icon
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Comparison Clipboard

In Comparison Mode two (2) image clipboard areas display 
images from the active exam and the selected comparison 
exam. The Comparison Clipboard can display up to four (4) 
exams, including the active exam. Each exam has a tab that you 
click on to select the desired comparison or active exam. The 
active exam is always displayed (either on the Left or Right side, 
depending on your preset).

Figure 13-97. Comparison Clipboard

The comparison exam(s) are identified by the date of the exam 
on the tab; the active exam is identified by the word, “Active” and 
by the asterisk (*). You can activate the Image History screen by 
clicking on the “...” tab.  

Each image clipboard has its own scroll bar that can be used to 
scroll through all the images. 

The highlighted image in the clipboard is the image that’s 
displayed along with the exam’s active image. 
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Query/Retrieve

You can use DICOM Query/Retrieve to search for a patient’s 
previous exams. When you select a patient on the Patient 
Screen, select the “Query” button. This automatically registers 
the patient (if needed) and initiates a query via the Data Transfer 
page. Select the exams you wish to be transferred and press the 
“Transfer” button.  

After the retrieve completes, the system automatically returns to 
the Patient Screen with the same patient and exam active as 
when you selected to Query this patient. 

Figure 13-98. Patient Exam View
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Activating Compare Assistant

Compare Assistant displays an image associated with the active 
exam (live, frozen, or CINE) and the other side contains an 
image from the comparison exam. 

Comparison Image parameters transfer to the Active Image 
based on your preset (automatic or manual). You can also use 
the Display Copying control adjacent to the clipboard to copy 
settings from the comparison image to the active image. 

NOTE: If an imaging parameter is not available for the current probe, a 
message in the status bar indicates that this parameter is not 
available.

You activate Compare Assistant via the Comparison Mode Key 
adjacent to the Image Clipboard and On-screen Trackball 
Controls or you can activate Compare Assistant via the Patient 
Image History screen by selecting the image and pressing 
“Compare.”   

 Figure 13-99. Image History

At the start of an exam the system automatically checkmarks the 
three (3) most recent exams, excluding active exams and 
exams without any images as the comparison exams. You can 
adjust this by placing a checkmark next to the exam you wish to 
include in Compare Mode (the system automatically deselects 
the oldest checked exam). To activate Comparison Mode, select 
which specific image you would like to compare to the current 
image from the clipboard on the Image History screen. Select 
the image and press the “Compare” button. 
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Exiting Compare Assistant

To exit Compare Assistant Mode, select the Comparison Mode 
Key adjacent to the Image Clipboard, or change the exam 
Model, change active exam, change patient, or recall an image 
from the active clipboard.  
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Compare Assistant Quick Card

LOGIQ Techniques: Compare Assistant

Table 13-34:  Getting Started

1. Import Previous images onto system by using a 
USB, DVD or by Query retrieve directly from 
PACS.

2. Select patient from Patient View by double 
clicking over name.

3. Start a new exam.
4. Select Image History to view previous studies. 

Note: Compare Assistant is also accessible from 
Active Image Screen by using icon adjacent to 
clipboard. At anytime, select Compare Assistant 
icon to get in or out of Compare Assistant.
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LOGIQ Techniques: Compare Assistant  (continued)

Table 13-35:  Comparing Studies

1. From Image History Screen, select  image from 
exam to compare and then select the Compare 
Key.

OR
2. Select the Compare Assistant icon to the right of 

the clipboard to start Compare Assistant from 
main screen.

Note: In image history screen . Select checkboxes 
adjacent to previous exams to be compared.  These 
exams will show up as tabs within compare 
assistant shown by date of study.  Up to 3 exams 
may be chosen to compare.

Table 13-36:  Clinical Use

1. Follow-up Routine Exams and known pathology.
2. View prior exams side-by-side with a real-time 

ultrasound image so you can quickly identify the 
area of interest.
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LOGIQ Techniques: Compare Assistant  (continued)

Table 13-37:  Compare Assistant Screen

1. In Dual screen, the left side is the  active image 
and the right side is the prior image.

2. Comparison image date will be seen at top of 
comparison image.

Note: Active Image side can be changed by default.



Smart Start (Start Assistant)

LOGIQ P8/P9/P10 – Basic User Manual 13-193
Direction 5841298-1EN Rev. 2

Smart Start (Start Assistant)

Introduction

Smart Start (Start Assistant) saves exam setting Mappings 
automatically when the first image is acquired during an exam. 
Saved Smart Start Exam Mappings are automatically recalled 
when a Worklist item is loaded, keying off the Worklist Exam 
Description.

Smart Start saves and loads the following exam settings:

• Exam Description - Populated from the Worklist item, the 
Exam Description is the default key by which the exam 
Mapping is saved. 

• Category

• Scan Assistant

• Preset

• Probe

NOTE: If a new Patient is entered manually (without using a Worklist), 
and no Exam Description is entered, Scan Assistant will become 
the key by which the Mapping is saved. An Exam Description or 
Scan Assistant program entry must be present for Smart Start to 
save the Mapping. 

Saved Smart Start Exam Mappings can also be added, edited or 
deleted with the Smart Start Mapping Editor - See 

NOTE: The “Use Smart Start” box on the Utility-> System-> General 
page is checked by default. 
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Smart Start (Start Assistant) Mapping Editor

The Smart Start (Start Assistant) Mapping Editor can be 
accessed from the Utility-> System-> General screen by 
selecting “Edit mappings” under the Smart Start section. 

Figure 13-100. Smart Start (Start Assistant) on Utility-> 
System-> General Page

On the Smart Start Mapping Editor screen you can Add, Edit or 
Remove a Smart Start map. 

Figure 13-101. Smart Start (Start Assistant) Mapping Editor
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Add a Smart Start (Start Assistant) Mapping

Select Add to add a new mapping. 

Figure 13-102. Add Smart Start (Start Assistant) Mapping
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Edit a Smart Start (Start Assistant) Mapping

Highlight an existing mapping and select Editor double-click the 
item to edit a mapping. 

Figure 13-103. Edit Smart Start (Start Assistant) Mapping

Delete a Smart Start (Start Assistant) Mapping

Highlight one or more existing mappings and select Delete to 
delete.

Save and Exit Smart Start (Start Assistant) Mapping Editor

Before exiting Smart Start (Start Assistant) Mapping Editor, 
select Save to save any changes you have made. 

Select Exit to exit Smart Start mapping Editor.



Scan Assistant

LOGIQ P8/P9/P10 – Basic User Manual 13-197
Direction 5841298-1EN Rev. 2

Scan Assistant

Introduction

Scan Assistant provides an automated exam script that moves 
you through an exam step-by-step. This allows you to focus on 
performing the exam rather than on controlling the system and 
can help you to increase consistency while reducing keystrokes. 
The system automatically invokes the correct mode and imaging 
parameters, advances to the next step in an exam, annotates 
the image, initiates measurements, and assigns the 
measurements to the worksheet/report. 

Availability

The following additional imaging parameters and preferences 
are available for use in a Scan Assistant program: Contrast, 
Contrast Clock, CW Doppler, Dual on Freeze, Depth, Color 
Scale, PW Doppler Scale, PW Sample Volume size, and Flow 
Model Selection.

You can initiate one or more manual Doppler measurements/
calculations.

Body Patterns are available for use during a Scan Assistant 
program. You can turn a Body Pattern on/off, select a particular 
Body Pattern graphic, and specify the position of the probe mark 
on the Body Pattern graphic. 

The footswitch can be used with Scan Assistant.  You can map 
Pause/Resume, Previous Step, and Next Step to the footswitch.

The “Always Use Doppler Cursor” preset, available on the 
Utility --> System --> General page, allows all PW Doppler steps 
to start with full screen 2D image plus mode cursor. You can 
specify the Store Order in Scan Assistant to set the Reading 
Order for the radiologist. The Learn Probe attribute can be set to 
learn and change the probe for the user in the middle of the 
exam.
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Scan Assistant Definitions

Scan Assistant definitions: 

• Scan Assistant Manager. Available via the Utility -> Scan 
Assistant page to import/export Programs created via the 
Scan Assistant Creator and to assign Programs to a user/
exam category. 

• Import. Used to load Programs created via the Scan 
Assistant Creator on to the LOGIQ P8/P9/P10. 

• Export. Used to move Programs from one LOGIQ P8/P9/
P10 system to another LOGIQ P8/P9/P10. 

• Scan Assistant Creator. Used to create Scan Assistant 
Programs. 
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Scan Assistant Description

Figure 13-104. Scan Assistant Display Description

1. Program name, completed steps/out of total number of 
steps, and step description area.  

2. Program step status (Complete/Incomplete), step number, 
step name. A checkmark indicates that this step has been 
completed. You can also manually check the box to bypass 
this step. 

3. This column indicates the mode or when a measurement 
needs to be made.  

4. This column indicates that the action moves the Program to 
the next step. 

5. Active step The box is green when the program is active or 
yellow when it is paused. 

6. Navigation: Stop, Pause, Pause/Resume. Edit (Pencil Icon). 
Also available via the left/right keyboard arrow keys. Stop 
also allows the program to be stopped, restarted, or a new 
program selected.  



Advanced Features

13-200 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Setting up Scan Assistant

To set up Scan Assistant, 

1. Import the Scan Assistant Program created using the Scan 
Assistant Creator or exported from another LOGIQ P8/P9/
P10 program. 

a. Insert the media with the saved Program from the Scan 
Assistant Creator or exported program from another 
LOGIQ P8/P9/P10. 

NOTE: If you insert the media with exported program from 
another LOGIQ S8 and LOGIQ E9, the following dialog 
displays before Import Programs. Select Default for 
LOGIQ P9/P7 or LOGIQ S8 or LOGIQ E9.

Figure 13-105. LOGIQ S8 and LOGIQ E9

NOTE: If you insert the media with exported program from 
LOGIQ E9, the following dialog displays before Import 
Programs. Click OK.

Figure 13-106. LOGIQ E9 only
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Setting up Scan Assistant  (continued)

b. Press Utility -> Scan Assistant. 

c. Select Import from the Scan Assistant Manager page. 

Figure 13-107. Import Programs



Advanced Features

13-202 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Setting up Scan Assistant  (continued)

d. In the Source field at the top of the Import Programs 
pop-up, select the media that the Program is stored on. 

e. Highlight the Program(s) to be imported. If a folder is 
highlighted, all programs in the folder are selected.  

Figure 13-108. Import Programs
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Setting up Scan Assistant  (continued)

f. Select Import. The Program(s) you selected are stored 
to the LOGIQ P8/P9/P10. You can add it to the exam 
category and user. 

Figure 13-109. Add Program
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Setting up Scan Assistant  (continued)

2. Assign the imported Program to the exam category and 
user. Under Program Selections on the right-hand side of 
the Scan Assistant Manager page, specify the Exam 
Category and User for this Program. You can select All 
Users, or a specific user. If you specify All Users, all users 
will have the ability to use this Program while in the specified 
exam category, unless the user has his/her own list defined. 

3. Select the imported Program from Available Programs -> 
Custom Programs on the left-hand side of the page. Then 
press the right arrow button to move the imported Program 
to the exam category and user selected above. 

Figure 13-110. Add Program
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Setting up Scan Assistant  (continued)

4. If you want the system to automatically select the last-used 
Program based on the Exam Description or Exam Category, 
you can preset the system to do so. Go to Utility -> 
System -> General -> Scan Assistant -> Auto Selection -> 
and select Description or Category. 

Figure 13-111. Scan Assistant Auto Selection

5. The Program list you created in Utility ->Scan Assistant is  
visible in the Program field on the Patient menu. Pressing 
New Patient erases any patient data and Scan Assistant 
program you entered. First press New Patient and then set 
up patient data, Scan Assistant program, and finally, press 
Register Patient. 

Figure 13-112. Patient Scan Assistant Program



Advanced Features

13-206 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Setting up Scan Assistant  (continued)

You can access the Scan Assistant Creator to edit the exam’s 
program from the imaging display via the Creator Icon located at 
the bottom, left-hand corner of the Scan Assistant Program 
monitor on the display. You can activate the Scan Assistant 
Creator from the image screen, make edits, and then run Scan 
Assistant to test your changes. 

NOTE: If you edit the program after you have already stored several 
images, and your edits change the number of program steps, 
you are prompted to Restart or Continue the Scan Assistant 
program. 

NOTE: If you edit the program after you have already completed several 
steps, checkmarked steps remain checkmarked, even if you 
insert a new step between checkmarked steps. If this is not 
correct, you can edit the checkmarks or restart the program. 



Scan Assistant

LOGIQ P8/P9/P10 – Basic User Manual 13-207
Direction 5841298-1EN Rev. 2

Using Scan Assistant

After you have set up Scan Assistant, the Program is active 
when you exit the Patient menu. The Program is located on the 
left-hand side of the display and as you can see in the example 
below, the annotation for the first step has been automatically 
noted on the image, ready for you to scan the specified 
anatomy. 

 Figure 13-113. Scan Assistant Display
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Using Scan Assistant  (continued)

1. Follow the steps indicated in the Program: image/measure 
the appropriate anatomy. 

2. Perform the indicated trigger to move to the next step in the 
Program. 

NOTE: The footswitch can be used with Scan Assistant.  You can 
map Pause/Resume, Previous Step, and Next Step to the 
footswitch.

3. To pause or unpause Scan Assistant, press the pause 
button on the display or press the left/right arrow on the 
keyboard.

4. To stop or restart a Program, press the Stop icon at the 
bottom of the Scan Assistant Program. A dialog pops up. 
This dialog lets you restart the current Program, start 
another Program, or stop Scan Assistant. 

5. To skip a step or move to a certain step, press the up/down 
arrows on the keyboard or select the step you want to move 
to using the Trackball and Set keys. 
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Inserting a step

1. To insert a pre-defined step to the active Scan Assistant 
Program, press the Plus Sign (+) on the Scan Assistant 
Display. 

Figure 13-114. Insert Steps

The Insert Steps Pop-Up Menu appears. 

Figure 13-115. Insert Steps Pop-up menu

2. Select the steps to be inserted via the pull-down Scan 
Assistant menu.  

Figure 13-116. Select from pull-down menu
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Inserting a step  (continued)

3. Press Insert. All the steps in the inserted program are added 
immediately after the active step in the current program. 

To undo inserted steps, use Edit button to edit the program 
and delete the recently inserted steps.

NOTE: After the exam is completed, the system removes the 
temporarily saved Scan Assistant program with inserted steps.

NOTE: The inserted steps is not adapt the annotation and body pattern 
from the active step.
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Breast Measurement Auto Insert Steps

To add a program to be inserted whenever the Add Lesion key is 
selected, 

1. Press the Plus Sign (+) on the Scan Assistant Display. 

Figure 13-117. Insert Steps

2. Select the "Add Lesion" tab.  

Figure 13-118. Select from pull-down menu
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Breast Measurement Auto Insert Steps  (continued)

3. In the Scan Assistant field, select the steps to be inserted 
when the user presses the Add Lesion Touch Key shown 
below. 

Figure 13-119. Add Lesion key
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Exporting Scan Assistant Programs

Exporting Scan Assistant Programs allows them to be imported 
to another LOGIQ P8/P9/P10 or to be edited offline with the 
Scan Assistant Creator tool. To export a Program, 

1. Insert the media to save the Program to.  

2. Press Utility -> Scan Assistant. 

3. Select Export from the Scan Assistant Manager page. 

4. In the Source field at the top of the Export Programs pop-up, 
select the media that the Program is to be stored on. 

5. Specify the Program Directory using the drop-down menu if 
the desired Program Directory already exists on the media. 
If not, or if you want to export the Program to a new Program 
Directory, type a new Program Directory name in the field. 

6. Highlight the Program(s) to be exported. If a folder is 
highlighted, all programs in the folder are selected. 

Figure 13-120. Export Programs

7. Select Export. The Program(s) you selected are stored to 
the media. You can now import it to a new LOGIQ P8/P9/
P10.
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Scan Assistant Creator

Activating the Scan Assistant Creator

To activate the Scan Assistant Creator on the LOGIQ P8/P9/
P10, press the Creator key in Utility -> Scan Assistant Manager. 

Figure 13-121. Scan Assistant Manager
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Overview

The Scan Assistant Creator is used to build customized 
Programs that can be imported onto the LOGIQ P8/P9/P10. 
These Programs automate many of the steps normally 
performed manually by the user, thereby reducing the number of 
user actions and the amount of time to perform an exam.

 Figure 13-122. Tool Layout Overview

1. Menu

2. Toolbars

3. Steps

4. Step Attributes

5. Rule Checking
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Overview  (continued)

The Scan Assistant Creator tool can be used both on the 
scanner and as an off scanner tool. Where there are differences 
in behavior, this user’s guide uses the term ‘on scanner’ to 
indicate when the tool is running on the scanner and ‘off 
scanner’ to indicate when the tool is running off the scanner. 

File Handling

When using Scan Assistant Creator off the scanner, it is very 
important to organize the programs in a way that will make it 
easy to import the programs onto the scanner. Each Program is 
a computer file. While these computer files can be copied, 
pasted and deleted like any other computer file, the Program 
files are only viewable using the Scan Assistant Creator.

Off-Scanner Directory Structure

The Scan Assistant Creator organizes the Programs in a 
directory structure that allows easy importing into the 
LOGIQ P8/P9/P10. In order to be imported, all Programs must 
be stored in a LOGIQ_SCAN_ASSISTANT Programs Directory. 
Within this directory, one or more user-specified directories are 
created. Within each of these user-specified directories are the 
category directories (VAS, ABD, etc.) that hold the actual 
Programs.

The dialog in the figure below allows the user to specify the 
location of the LOGIQ_SCAN_ASSISTANT directory (root 
directory) and to either select an existing User Program 
Directory or create a new one.

Figure 13-123. Directory Structure
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Off-Scanner Directory Structure  (continued)

The Directory Structure dialog can be accessed via the File 
menu. 

Figure 13-124. File Menu

Figure 13-125. File Toolbar

File Extensions

Factory defined Programs have an .ep (exam Program) 
extension while user-defined Programs have an .uep (user 
exam Program) extension. Both factory and user-defined 
Programs can be read into the Scan Assistant Creator, but only 
user-defined Programs are created. If a factory Program is read 
into the Scan Assistant Creator and then edited, it is saved as a 
user-defined Program.

Upon installation of the Scan Assistant Creator, files with a .ep 
or .uep extension are automatically associated with the Scan 
Assistant Creator.



Advanced Features

13-218 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Exporting Programs from LOGIQ P8/P9/P10

Factory or user-defined Programs on the LOGIQ P8/P9/P10 are 
easily exported for editing with the Scan Assistant Creator.

On the LOGIQ P8/P9/P10:

1. Insert a USB storage device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Export.

4. Select the media type and specify a directory. If a directory 
is specified that already exists, the Export adds the 
Programs along with any existing Programs. If the names of 
Programs are the same, use the resulting dialog to decide 
how to continue.

5. Select the Program to be exported and export them.

On the computer with the Scan Assistant Creator installed:

1. Insert the USB storage device (or CD/DVD) used above.

2. Copy the LOGIQ_SCAN_ASSISTANT directory from the 
USB storage device (or CD/DVD) to the hard drive. The 
hard drive directory that you copy to is the root directory. If 
you want to work with the Programs directly on the USB 
storage device, this step can be skipped.

3. Either open a Program by double-clicking it or selecting 
File ‘-> Open from the Scan Assistant Creator.



Scan Assistant

LOGIQ P8/P9/P10 – Basic User Manual 13-219
Direction 5841298-1EN Rev. 2

Importing Programs to LOGIQ P8/P9/P10

Programs created with the Scan Assistant Creator are easily 
imported to the LOGIQ P8/P9/P10.

On the computer with the Scan Assistant Creator installed:

Copy the complete LOGIQ_SCAN_ASSISTANT directory from 
the computer hard drive to a USB device (or CD/DVD). The 
LOGIQ_SCAN_ASSISTANT directory needs to be at the top 
level (not in a subdirectory) on the USB device (or CD/DVD).

Example of Directory structure:

LOGIQ_SCAN_ASSISTANT

MyUserNameDirectory

ABD

CARD

GYN

OB

PED

SMP

UR

VAS

On the LOGIQ P8/P9/P10:

1. Insert the USB device (or CD/DVD).

2. Select Utility -> Scan Assistant.

3. Select Import.

4. Select the media type.

5. Select the Programs to be imported and import them. If you 
attempt to import Programs that already exist with the same 
name, use the resulting dialog to decide how to continue.
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Creating New Programs

A new Program is created by selecting File -> New, by clicking 
on the New document icon in the Toolbar, or by using the 
keyboard shortcut Ctrl+N. 

1. Before creating a New Program, select Single Step or Multi 
Step in the Toolbar.

 Figure 13-126. File Toolbar

2. Proceed to add/update your settings for the Step: Step 
Name, Instructions, etc.

3. Once finished, highlight the finished Step.



Scan Assistant

LOGIQ P8/P9/P10 – Basic User Manual 13-221
Direction 5841298-1EN Rev. 2

Creating New Programs  (continued)

4. Select Edit -> Copy

Figure 13-127. Edit -> Copy

5. In the Toolbar along the left, select Insert Step Before 
Selected or Insert Step After Selected.

Figure 13-128. Insert Step

6. Highlight the copied step and proceed to edit accordingly.

7. Proceed to follow the same procedure to add more steps to 
your Program.
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Creating New Programs  (continued)

8. When you are done, select Check to verify your Steps.

Figure 13-129. Rule Check and results area

9. The results are listed as to whether the Scan Assistant Rule 
Check Passed or if any Issues were detected. Issues found 
when running the check do not mean the Program is 
unusable. 

NOTE: The rule check may report an unequal number of left and 
right steps. This may or may not be the expected result. If a 
change is made in response to the rule check results, a new 
rule check can be run to see if the issue has been resolved.

Opening New Programs

Multiple Programs can be open at the same time by selecting 
File -> Open. Each Program will open within the primary Scan 
Assistant Creator window.

Opening Existing Programs

An existing Program is opened by selecting File -> Open, by 
clicking on the File -> Open icon in the Toolbar, or by using the 
shortcut Ctrl+O. Finding the Program file (.ep or .uep) and 
opening the file automatically opens the file in the Scan 
Assistant Creator. Multiple Programs can be opened at the 
same time.
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Saving Programs

Programs are saved via the Save or Save As functions available 
on the File Menu and the File Toolbar. Save is also available via 
the Ctrl+S keyboard shortcut. "Save" saves the Program using 
its current name and file location. "Save As" allows the name 
and file locations to be edited.

When Saving a Program, the Scan Assistant Creator provides 
an opportunity to run a rule check on the Program before saving 
it as shown in the following figure. Yes runs the rule check, No
bypasses the rule check and Cancel cancels the Save request. 
See ‘Rule Checking’ on page 13-252  for more details on Rule 
Checking Programs.

Figure 13-130. Program Rule Check Reminder

NOTE: The name of a Program is appended with an asterisk (*) when 
the Program has been changed, but those changes have not yet 
been saved

A Program can be closed without saving it using the Close 
selection on the File Menu or by using the "X" in the upper right 
corner of the Program window.
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Sharing Programs

If you want to share a program with someone else, the file can 
simply be sent via e-mail as an attachment or copied onto a 
media. If the person receiving the program has the Scan 
Assistant Creator tool installed, he can simply open the file and 
then  use “Save As” to save it to an appropriate directory. See 
Section 3.1. If the person receiving the program does not have 
the Scan Assistant Creator tool installed, he can still load the 
program onto a scanner by creating the following directory 
structure on a media device, copying the file to one of the 
category directories and then importing the protocol onto the 
scanner.

Top Level Directory on media: LOGIQ_SCAN_ASSISTANTUser 
Program Directory: Any user nameCategory Directories: Abd, 
Card, Gyn, OB, Ped, SMP, UR, Vas

If you want to share an entire portfolio of programs with some 
else, the entire user program directory can be zipped. Make 
sure to set the options to include subfolders and to include 
relative path information. On the receiving end, the user can 
unzip the directory into a LOGIQ_SCAN_ASSISTANT directory. 
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Views

A Program is made up of a series of steps. Each step is made 
up of various step attributes. The step and step attribute data 
can be viewed in many ways using the Scan Assistant Creator. 
The different ways to look at the data are called Views. The view 
of choice is selected from the View Selection Menu or the View 
Toolbar Menu.

Figure 13-131. View Selection Menu

 Figure 13-132. View Toolbar Menu
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Single Step Views

There are two Single Step views: Basic and All. The Basic view 
shows the most common attributes of the selected step. The All 
view shows all of the attributes of a given step.

For both views, the step names are shown on the left with the 
active step highlighted. The step attributes appear on the right 
and are separated into four groupings:

General attributes at the top

Imaging and Comment attributes on the left

Measure attributes on the right.

 Figure 13-133. Basic Single Step View

1. Steps

2. Step Attributes
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Multi Step Views

Multi Step views show certain step attributes for all the steps in a 
Program. There are six Multi Step views: General, Comment, 
Scan, Measure, Custom and All. 

 Figure 13-134. Multi Step Scan View

1. Steps

2. Step Attributes
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Customizing Multi Step Views

The contents of the Multi Step views is configurable via the 
Customize Menu or the small downward pointing arrow next to 
the word "Custom" on the View Toolbar Menu. In either case the 
Customize Multi Step Views dialog appears. Each tab 
represents a different Multi Step view. Within a tab, the checked 
boxes are the step attributes that are displayed in that Multi Step 
view.

See ‘HTML Export’ on page 13-254  for details on the HTML 
Export Multi Step view.

 Figure 13-135. Customize Multi Step Views Dialog
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Scan Assistant Features

Scan Assistant allows the user to program the steps in an exam 
and to program certain attributes for each step. The attributes 
are what give the Scan Assistant Program behavior.  The tables 
below provide the names of all attributes along with a 
description of how each one is interpreted by the Scan Assistant 
feature.
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General Attributes

Table 13-38:  General Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Step Number Numeric Number of the 
step that appears 
in the Scan 
Assistant 
Navigation menu

1 Previous plus one

Step Name Any Name of the step 
that appears in the 
Scan Assistant 
Navigation menu

Step Name Same as previous 
step

Advance On Print Advance to the 
next step and go 
live after Print / 
Image Store 
(e.g P1 key). This 
can be a single 
image store or a 
loop store. 

Print Same as previous 
step

Print & Unfreeze Advance to the 
next step after 
Print / Image Store 
(e.g. P1 key) and 
unfreeze. This can 
be a single image 
store or a loop 
store.

User Selection Advance to next 
step only after 
next step is 
manually selected 
(e.g. down arrow)

Instructions [Any Text] User notes 
displayed in the 
Scan Assistant 
Navigation menu 
when the step is 
active

Blank Same as previous 
step
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Optional Optional 
(checked)

An optional step is 
given a check 
mark during 
Program 
execution even if 
no image is 
acquired

Mandatory Same as previous 
step

Mandatory 
(unchecked)

A mandatory step 
is given a check 
mark only if an 
image is acquired 
for the step

Table 13-38:  General Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Comment Attributes

Table 13-39:  Comment Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Comment 1, 
Comment 2

[Any Text] User annotation 
associated with 
the step. When 
editing in a Multi 
Step View, use 
Alt+Enter to create 
a new line.

Same as Step 
Name attribute

Same as Step 
Name attribute

Location 1, 
Location 2

Top Left Annotation is 
placed in the top 
left corner of the 
image area

Location 1: Bottom 
Center

Same as previous 
step

Middle Left Annotation is 
placed in the 
middle left side of 
the image area

Bottom Left Annotation is 
placed in the 
bottom left corner 
of the image area

Location 2: Dual 
Right: Bottom 
Center

Top Center Annotation is 
placed in the top 
center of the 
image area

Bottom Center Annotation is 
placed in the 
bottom center of 
the image area

Top Right Annotation is 
placed in the top 
right corner of the 
image area

Mid Right Annotation is 
placed in the 
middle right side of 
the image area

Bottom Right Annotation is 
placed in the 
bottom right 
corner of the 
image area
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Dual Left: Bottom 
Center

Annotation is 
placed on the 
bottom center of 
the left image in 
dual screen

Dual Left: Top Left Annotation is 
placed on the top 
left of the left 
image in dual 
screen

Dual Right: 
Bottom Center

Annotation is 
placed on the 
bottom center of 
the right image in 
dual screen

Dual Right: Top 
Left

Annotation is 
placed on the top 
left of the right 
image in dual 
screen

Table 13-39:  Comment Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Mode Attributes

The probe and application associated with a program is not 
configurable. Instead, the scanner remembers the last probe 
and application used for a given Scan Assistant program and 
automatically selects them the next time the program is started.

Table 13-40:  Imaging Mode Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Color Mode On (checked) Color Doppler is 
on

Off Same as previous 
step

Off (unchecked) Color Doppler is 
off

PW Doppler Mode On (checked) PW Doppler is on. 
If PW Doppler is 
not on and the 
new activated step 
indicates that 
Doppler should be 
on, the Mode 
Cursor is 
displayed or, if the 
Mode Cursor is 
already displayed, 
then PW Doppler 
is turned on.

Off Same as previous 
step

Off (unchecked) PW Doppler is off

M Mode On (checked) M-Mode is on Off Same as previous 
step

Off (unchecked) M-mode is off

Dual Off Dual screen not in 
use

Off Same as previous 
step

Left Active Dual screen is 
active and the left 
image is the active 
image.

Right Active Dual screen is 
active and the 
right image is the 
active image.

DualView (simul) DualView is active 
(both left and right 
images are live)
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3D On (checked) 3D on Off Same as previous 
step

Off (unchecked) 3D off

LOGIQView On (checked) LOGIQView on Off Same as previous 
step

Off (unchecked) LOGIQView off

Contrast Mode On (checked) Contrast mode on Off Same as previous 
step

Off (unchecked) Contrast mode off

Contrast Clock On (checked) Contrast Clock on Off Same as previous 
step

Off (unchecked) Contrast Clock off

B-Flow On (checked) B-Flow on Off Same as previous 
step

Off (unchecked) B-Flow off

B-Flow Color On (checked) BFC on Off Same as previous 
step

Off (unchecked) BFC off

Elastography On (checked) Elastography on Off Same as previous 
step

Off (unchecked) Elastography off

Table 13-40:  Imaging Mode Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Imaging Preference Attributes

Imaging Preferences work slightly different than other attributes. 
For example, if an abdomen Program has 20 steps and all steps 
have the Harmonics attribute set to Default, then Scan Assistant 
will not affect the harmonics setting. Now, assume that steps 
10-12 are gallbladder steps and that the harmonics attribute has 
been set to on for these steps. When transitioning into this group 
of steps (step 9 to step 10, e.g.), harmonics will be turned on (or 
remain on if it was previously on). If harmonics is then manually 
turned off in step 10 then Scan Assistant will not turn it back on 
when advancing to step 11. In other words, a group of 
consecutive steps with the same Imaging Preference are treated 
as a group by Scan Assistant and not as individual steps.

Table 13-41:  Imaging Preference Attributes

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default

Harmonics Off Harmonics off Default Same as previous 
step

On Harmonics on

Default Harmonics not 
specified. Scan 
Assistant does not 
set Harmonics on 
or off.

Virtual Convex Off Virtual Convex off Default Same as previous 
step

On Virtual Convex on

Default Virtual Convex not 
specified. Scan 
Assistant does not 
set Virtual Convex 
on or off.

CrossXBeam Off CrossXBeam off Default Same as previous 
step

On CrossXBeam on

Default CrossXBeam not 
specified. Scan 
Assistant does not 
set CrossXBeam 
on or off.

PDI Off PDI off Default Same as previous 
step

On PDI on
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Default PDI not specified. 
Scan Assistant 
does not set  PDI 
on or off.

Color/Doppler  
Steer

Left Color/Doppler 
steered to the left

Center Same as previous 
step

Center Color/Doppler not 
steered

Right Color/Doppler 
steered to the right

Flow Model Default Flow Model not 
specified. Scan 
Assistant does not 
set Flow Model

Default Default

Aorta, Renal, 
Penetration, Slow 
Flow, Med Flow, 
Fast Flow

Specified Flow 
Model is selected

Depth Default Depth not 
specified. Scan 
Assistant does not 
set Depth

Default Default

2.0 to 36.0 Specified or the 
nearest available 
Depth is selected

Color Scale Default Color Scale not 
specified. Scan 
Assistant does not 
set Color Scale

Default Default

1 to 200 Specified or the 
nearest available 
Color Scale is 
selected

Doppler Scale Default Doppler Scale not 
specified. Scan 
Assistant does not 
set Doppler Scale

Default Default

1 to 200 Specified or the 
nearest available 
Doppler Scale is 
selected

Default Default

Table 13-41:  Imaging Preference Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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SV Default PW Sample 
Volume Size not 
specified. Scan 
Assistant does not 
set PW Sample 
Volume Size

Default Default

1 to 16 Specified or the 
nearest available 
PW Sample 
Volume Size is 
selected

Baseline (PW 
Doppler and Color 
Flow)

Default Baseline not 
specified. Scan 
Assistant does not 
set PW Sample 
Volume Size.

Default Default

100 Specified or the 
nearest available 
Baseline is 
selected.

B-Flow Sensitivity Default B-Flow Sensitivity 
not specified. 
Scan Assistant 
does not set 
B-Flow Sensitivity.

Default Default

1.0 to 50 Specified or the 
nearest available 
B-Flow Sensitivity 
is selected.

B-Flow Color 
Scale

Default BFC Scale not 
specified. Scan 
Assistant does not 
set BFC Scale.

Default Default

0.20 to 1.500 Specified or the 
nearest available 
BFC Scale is 
selected.

Table 13-41:  Imaging Preference Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Color Baseline Default Color Baseline not 
specified. Scan 
Assistant does not 
set Color 
Baseline.

Default Default

0 to 100 Specified or the 
nearest available 
Color Baseline is 
selected.

Doppler Baseline Default Doppler Baseline 
not specified. 
Scan Assistant 
does not set 
Doppler Baseline.

Default Default

5 to 95 Specified or the 
nearest available 
Doppler Baseline 
is selected.

Table 13-41:  Imaging Preference Attributes (Continued)

Attribute Name Selections Description
First Step 

Default
Other Steps 

Default
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Measurement Attributes

Table 13-42:  Measure Attributes

Attribute
Name Selections Description

First Step 
Default

Other Steps 
Default

Measure
Trigger

Measure Key Initiate "Measure 1" attribute 
when the Measure key is 
manually selected.

None None

Freeze Key Initiate "Measure 1" attribute 
when the image is frozen.

Image Store Initiate "Measure 1" attribute 
when the Measure key is 
manually selected or the image is 
stored. This is used to store / print 
an image and then measure on it 
and then store it again. Therefore, 
the Advance On Print attribute is 
ignored on the first store / print 
when the Measure Trigger  
attribute is set to Image Store.

None Measurements are not triggered 
by Scan Assistant. The "Measure 
1" attribute is ignored.

Side Rt The side measurement qualifier is 
set to Right side of the body

Rt Derived from 
Step Name 
attribute if 
possible.
Otherwise, 
same as 
previous step

Lt The side measurement qualifier is 
set to Right side of the body

None The side measurement qualifier is 
not used (neither Right nor Left)

Fetus A The fetus measurement qualifier 
is set to Fetus A

A Same as 
previous step

B The fetus measurement qualifier 
is set to Fetus B

C The fetus measurement qualifier 
is set to Fetus C

D The fetus measurement qualifier 
is set to Fetus D
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Location Prox The location measurement 
qualifier is set to Proximal

Prox Same as 
previous step

Mid The location measurement 
qualifier is set to Middle

Dist The location measurement 
qualifier is set to Distal

None The location measurement 
qualifier is not used

Measure 1 Various 2D or 
M-mode 
measurements

Specifies the first 2D or M-mode 
measurement to be initiated. The 
point at which the measurement 
is initiated is based upon the 
Measure Trigger attribute. See 
Section 6 for more information.

Blank Blank

Measure 2 Various 2D or 
M-mode 
measurements

Specifies the second 2D or 
M-mode measurement to be 
initiated after the measurement 
associated with the Measure 1 
attribute is completed. See 
Section 6 for more information

Blank Blank

Measure 3 Various 2D or 
M-mode 
measurements

Specifies the second 2D or 
M-mode measurement to be 
initiated after the measurement 
associated with the Measure 2 
attribute is completed. See 
Section 6 for more information.

Blank Blank

Vessel Various 
Doppler
measurement
Vessel folders

Specifies the Vessel folder to 
assign auto calcs to.  The 
assignment happens when the 
image is stored / printed (e.g. P1 
key). See Section 6 for more 
information. 

Blank Blank

Auto Calcs Default Auto Calcs state not specified. 
Scan Assistant does not set Auto 
Calcs state.

Default Same as 
previous step

Off Auto Calcs state set to Off

Frozen Auto Calcs state set to Frozen

Live Auto Calcs state set to Live

Table 13-42:  Measure Attributes (Continued)

Attribute
Name Selections Description

First Step 
Default

Other Steps 
Default
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Auto Calc 
Params

Various Auto 
Calc
parameters

Specifies the auto calc 
parameters to be used. 

Default Same as 
previous step

Default Auto Calc parameters are not 
specified. Scan Assistant does 
not set the Auto Calc parameters.

Auto Calc 
Specify

[Not
Applicable]

Button used to enable the Auto 
Calcs Parameter Selection dialog 
so that the Auto Calc Params 
attribute can be set

[Not 
Applicable]

[Not 
Applicable]

Auto Calc 
Default

[Not
Applicable]

Button used to set the Auto Calcs 
Params attribute to Default.

[Not 
Applicable]

[Not 
Applicable]

Double Print On (checked) If an Image Store / Print (P1 key, 
e.g.)  is performed on an image 
with measurements, the image is 
stored / printed two times, once 
with the measurements and once 
without.

Off Same as 
previous step

Off 
(unchecked)

No special Store / Print behavior.

Double Print On (checked) If an Image Store / Print (P1 key, 
e.g.)  is performed on an image 
with color, the image is stored / 
printed two times, once with color 
and once without. If double print 
on color and double print on 
measurements are both 
configured to be on, the image is 
stored / printed two times, once 
with the measurements and once 
without.

Off 
(unchecked)

No special Store / Print behavior.

View 
Worksheet

On (checked) The worksheet is turned on Off Off

Off 
(unchecked)

The worksheet is not turned on

Table 13-42:  Measure Attributes (Continued)

Attribute
Name Selections Description

First Step 
Default

Other Steps 
Default



Scan Assistant

LOGIQ P8/P9/P10 – Basic User Manual 13-243
Direction 5841298-1EN Rev. 2

Measurements

Because there are many measurements available on the 
LOGIQ P8/P9/P10 and because the measurement package is 
highly customizable, there is some special handling for 
measurements. The Measurement attributes affected by this 
special handling are Measure 1-3 and Vessel.

Selecting a Measurement Package

The Measurement selection menu can be used to specify which 
measurement package is to be used for the Program. The 
Measurements packages are organized by category and 
subcategory. The choices for the Measure 1-3 and Vessel 
attributes are limited by the selection of category and 
subcategory. To select a subcategory, select a category, move to 
the subcategory list and select a subcategory. To select all 
subcategories for a given category, select the category and then 
reselect the Measurements menu item to remove the menu.

A single Program is not allowed to have measurements from 
multiple categories, but it may have measurements from 
multiple subcategories.

Figure 13-136. Measurements Menu
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User-Defined Measurements

User-defined subcategories and individual measurements can 
be used with the Scan Assistant feature. To do so, the Scan 
Assistant Creator needs to know about the user-defined 
measurements on the LOGIQ P8/P9/P10.

On the LOGIQ P8/P9/P10, use the Scan Assistant utility menu 
to Export Programs to a USB storage device (or CD/DVD). On 
the export menu, check the "Export user config data" checkbox 
to store the user-defined measurement information to the 
Program User Directory on the media. The name of the file is 
UserConfigSystemFile.res. When this file exists in the Program 
User Directory, then it is used. Otherwise, the default file 
installed with the Scan Assistant Creator is used.

Figure 13-137. Program Export Menu on LOGIQ P8/P9/P10
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Navigating Programs

In addition to moving the windows pointer and selecting an item, 
there are several keyboard controls that navigate a Program.

Table 13-43:  Keyboard Program Navigation

Keyboard Entry Step Selected Step Attribute Selected

Enter Moves to next step. If on the last 
step, it creates a new step and 
selects it.

Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to same step 
attribute in the next step. If on the 
last step, it creates a new step and 
selects it.

Tab Single Step View: Moves to next 
step. On the last step it moves to the 
first step attribute. Multi Step View: 
Moves to the first step attribute.

Moves to next step attribute. If last 
attribute for the step, moves to next 
step.

Alt+Tab Single Step View: Moves to previous 
step. On the first step it moves to the 
last step attribute. Multi Step View: 
Moves to the last step attribute of the 
previous step.

Moves to next step attribute. If first 
attribute for the step, moves to 
previous step.

Up Arrow Moves to previous step Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to same step 
attribute in the previous step.

Down Arrow Moves to next step Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to same step 
attribute in the next step.

Left Arrow No action Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to the previous 
step attribute.

Right Arrow Single Step View: No action. Multi 
Step View: Moves to the first step 
attribute.

Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to next step 
attribute.

Page Up Scrolls to previous page of steps Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to same step 
attribute in the previous step.

Page Down Scroll to next page of steps Single Step View: Varies based on 
the step attribute selected. Multi 
Step View: Moves to same step 
attribute in the next step.
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Editing Programs

When editing Programs, changes can be made at both the step 
level and the step attribute level. Steps can be added, inserted, 
moved, deleted, copied and pasted. Step attributes can be 
modified for a given step or across multiple steps.

Editing Steps

The step toolbar allows steps to be inserted, moved up and 
down, and deleted. For steps to be moved, one or more 
consecutive steps must be selected. Some of the controls have 
shortcuts (Control Key + another key).

When the last step in a Program is selected, the Enter key 
automatically appends a new step to the end of the Program 
and selects the new step. When the Enter key is pressed on any 
other step, the next step is activated. The up and down arrows 
can also be used to move between steps.

Figure 13-138. Step Toolbar

1. Insert Step above selected step (Ctrl+l)

2. Insert Step below selected step

3. Move selected step(s) up (Ctrl+Up Arrow)

4. Move selected step(s) down (Ctrl+Down Arrow)

5. Delete selected step(s)
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Editing Steps  (continued)

The Edit Menu and Edit toolbar provides access to the Cut, 
Copy, Paste and Paste Special features. The Undo and Redo 
actions also appear on Edit Menu and Edit Toolbar.

Figure 13-139. Edit Menu

Figure 13-140. Edit Toolbar

When selecting multiple steps for Cutting or Copying, the Shift + 
Left Mouse and Ctrl + Left Mouse key combinations can be 
used. Multiple steps are also selected by holding the Left Mouse 
key and dragging across the steps of interest. When pasting 
steps they are added after the currently selected step.

The Paste Special control allows copied steps to be pasted with 
some modification. For example, the steps associated with the 
Right Kidney can be Copied and Pasted so that they are 
converted into Left Kidney steps during the paste. The Paste 
Special dialog is shown in the figure below . Simply select the 
desired Conversion and choose the "Paste" key. 
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Editing Steps  (continued)

• Step Name (Text)

• Comment 1 (Text)

• Comment 2 (Text)

• Side (Measurement qualifier)

• Location (Measurement qualifier)

• Fetus (Measurement qualifier)

Figure 13-141. Paste Special Dialog
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Editing Steps  (continued)

The Define Conversions key is used to define the text that is 
converted. An example is shown in the figure below. If an exact 
case match is found, it is used for the conversion. If there is a 
match, but with different case, it is used only if there is not an 
exact case match.

There are 3 user-defined conversions that can be edited and 
named.  These user-defined conversions can also be used to 
perform a find and replace capability.

Figure 13-142. Define Conversions Dialog
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Editing Step Attributes

To edit a step attribute simply select the step attribute and edit it, 
such as picking from a drop down menu, checking or 
unchecking a box or typing in text. To edit multiple steps in a 
Multi Step view, select the step attribute of choice and do the 
following actions:

• Set the value of the step attribute as desired.

• Left click (and release) in the square in the bottom 
right-hand corner of the attribute.                                                                       

• Drag to highlight the other steps to be changed in the same 
way.

• Left click (and release) again.

This will take the original step's content and copy it down the 
highlighted steps. This is also available when multiple attributes 
are selected within the same step.

To edit multiple steps in the single step view, highlight the 
multiple steps that you want to edit and then change the step 
attribute. If a step attribute is highlighted in green, this indicates 
that its current value varies across the selected steps.

If a step attribute is not editable, it may be because the attribute 
requires a different attribute to be set a particular way in order to 
become enabled. These dependencies are outlined below.

Table 13-44:  Step Attribute Dependencies

Step Attribute Dependency

PDI Color step attribute must be checked

Color / Dop Steer Color or PW step attribute must be checked

Measure 1 Measure Trigger must not be set to None

Measure 2 Measure 1 must be set

Measure 3 Measure 1 and Measure 2 must be set
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Editing Multiple Programs

Multiple Programs can be opened at the same time. To switch 
between Programs, the title banner of the window is selected or 
the Program is selected from the Window Menu. An asterisk 
indicates that the Program has been edited but not saved.

Figure 13-143. Window Menu

With multiple Programs open, steps copied from one Program 
can be put inserted into another Program via the paste or paste 
special features.

Undo/Redo

The Undo feature allows the previous action to be undone. For 
example, pressing undo 6 times will undo the last 6 changes. 
Redo cancels the Undo of an action. For example, pressing 
undo 6 times will undo the last 6 changes and then pressing 
Undo 2 times will cause only the last 4 actions to be undone.

Editing the Current Program on the Scanner

If you are currently using a Scan Assistant program and choose 
to edit that program while using it, the program will be reloaded 
when scanning is restarted. If the number of steps is changed, 
the checkmarks that were in place before editing are cleared.  If 
the number of steps in the program has not changed, the 
checkmarks that were in place before editing are maintained.

The current program can be restarted at any time by selecting 
the Stop button on the Scan Assistant navigation window and 
selecting restart.
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Rule Checking

Scan Assistant Creator allows Programs to be checked. During 
a rule check, Scan Assistant Creator applies a series of rules 
against the Program being checked and reports any 
inconsistencies between the rules and the Program. This rule 
check is intended to find potential issues in the Program before 
it is tested on a LOGIQ P8/P9/P10. Issues found when running 
the check do not mean the Program is unusable. It means that if 
there happens to be a problem with running the Program, the 
first place to look would be at the Issue noted when you ran the 
Check.

For example, if there is a step name Right Kidney and the 
Measurement Location is set to "Left", the rule check would 
report this inconsistency. 

Running a Rule Check

The "Check" button below the Program area is used to initiate a 
rule check. The results are displayed in the Rule Check Results 
window to the right of the button. A rule check is also initiated 
when attempting to save a Program that has not previously 
passed a rule check.

 Figure 13-144. Rule Check Button and Rule Check Results
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Rule Check Results

If the issue is specific to a particular step, double-clicking on the 
issue number in the Rule Check Results window selects the 
step associated with the issue. The results are intended to be 
potential issues and therefore may be ignored at the discretion 
of the user. For example, the rule check may report that there 
are an unequal number of left and right steps. For a particular 
Program, this may be the expected result. If a change is made in 
response to the rule check results, a new rule check can be run 
to see if the issue has been resolved.
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Documenting Programs

The HTML Export feature allows a Program to be stored in a file 
format (*.mht) that is compatible with Windows Internet Explorer. 
This file is useful for printing the Program or viewing the 
Program, but is not useful for editing the Program. HTML Export 
is available via the File Menu.

An example of how a Program looks in HTML format is shown 
below.

 Figure 13-145. HTML Export

The step attributes shown in the HTML Export are configurable 
via the Views selection on the Customize Menu.
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Customization

The Customize Menu is shown below. The Views selection 
allows the contents of the Multi Step views and HTML Export to 
be configured as described in ‘Customizing Multi Step Views’ on 
page 13-228 .

Figure 13-146. Customize Menu

The Language selection allows the Scan Assistant Creator 
language to be configured. 

The column widths of the steps and step attributes are 
customizable. The desired width is set by selecting and dragging 
the line separating column headers. These adjustments are 
remembered for the next time the Scan Assistant Creator is 
used.

The locations of the toolbars are customizable. The location is 
set by selecting and dragging the toolbar gripper as shown in 
the figure below. The toolbars can be placed at the top, left, right 
or bottom of the Scan Assistant Creator.

 Figure 13-147. Gripper used for Toolbar placement

1. Toolbar Gripper

Help

Help is available via the About Menu or the F1 key.



Advanced Features

13-256 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Exporting the Scan Assistant Creator to a PC

To export the Scan Assistant Creator to a PC, 

1. Insert a USB Flash Drive in a USB port on the Control 
Panel.

2. Press Utility--> Scan Assistant. 

3. Press Export.

4. Place a checkmark in the Export Scan Assistant Creator 
Installation. 

5. Press Export.

Figure 13-148. Export Scan Assistant Creator Installation
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Installation (Install from a zip file)

Create a directory called Scan Assistant Creator on your PC’s 
hard drive under \Program Files\GE\. It should look something 
like this: 

Drive Letter:\Program Files\GE\Scan Assistant Creator.

Unzip the contents of the zip file into the Scan Assistant Creator 
directory. After unzipping, go to the directory and double-click on 
the setup.exe file. Follow the steps in the setup wizard to 
complete installation.

To export the Scan Assistant Creator tool from the scanner for 
off scanner use, go to the Utility->Scan Assistant page on the 
LOGIQ P8/P9/P10 scanner. Select the Export button. On the 
Export dialog, select the media to be exported to, select the 
‘Scan Assistant Creator Tool’ check box and then choose 
Export. The files needed to install the tool off the scanner are 
copied to the media. Insert the media in the computer where you 
want to install the off scanner version and use the setup.exe file 
to initiate the installation.

System Requirements

Scan Assistant Creator requires the Windows XP Professional 
Service Pack 2 or Windows Vista Business operating system. It 
also requires .NET Framework 2.0 Service Pack 1. If the 
computer does not have this installed, the installation utility will 
direct you to a link where it can be downloaded.
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OB Measure Assistant

The user can request the system to trace/outline the borders of  
specified OB measurements using the OB Measure Assistant 
feature. You can auto-detect the Biparietal Diameter, Head 
Circumference, Abdominal Circumference, Femur Length and 
Humerus Length.  

NOTE: OB Measure Assistant is not currently available in the US (not 
cleared by the FDA). 

To automatically trace the fetal anatomy on the display, 

1. Press Measure Assist Settings on the OB B-Mode 
measurement Touch Panel to set OB Measure Assistant 
parameters. 

2. Press Return to return the measurement mode.

3. Press the measurement (BPD, HC, AC, FL or HL). The 
trace is auto generated on the display. 

4. To edit the selected measurement graphics: 

• Move the Trackball to appropriately size the edit region 
of interest 

• Edit the Calipers via Cursor Select. 

• Adjust the circumference using the Ellipse key. 

Press Set on the Trackball to complete the measurement. 

NOTE: Specify the mode to measure the BPD: Outer to Inner, or 
Outer to Outer via Utility--> Measure--> Advanced-->
Obstetrics-->  Measure Assistant BPD Method. 

If the system was not able to detect the anatomy automatically, 
measurement calipers are displayed in the center of the screen 
in an editable state and a message is displayed on the status 
bar. 
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OB Measure Assistant Touch Panel

Figure 13-149. OB Measure Assistant Touch Panel

Table 13-45:  OB Measure Assistant Touch Panel

Touch Panel Settings Description

Default When you first activate the Measure Assistant Touch Panel, the following 
measurements are highlighted: BPD, HC, AC, FL and HL. This means that 
OB Measure Assistant is active for all these measurements. 

There are four (4) BPD Auto Custom Settings: 

1. BPD Highlighted BPD and HC OB Measure Assistant is generated one at a time. BPD is auto 
generated--> Edit/Set--> HC is auto generated--> Edit/Set--> Done

2. BPD + AutoSet BPD BPD and HC generated at the same time. BPD and HC are auto 
generated--> Edit/Set HC--> Edit/Set BPD--> Done.  

3. BPD + BPD Only Only the BPD is auto generated--> Edit/Set--> Done. 

4. No Highlight User must perform these measurements manually
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Breast Options

There are two options related to Breast:

• Breast Measure Assistant — this contains the auto contour 
feature and auto Height and Length. It also has 
measurements related to Breast (distance to nipple, ratio)

• Breast Productivity Package — this includes lesion 
measurement folders, show features, summary, etc.

This section covers both the Breast Productivity Package 
(Breast Lesion) and Breast Measure Assistant (Auto Contour) 
features. 

NOTE: The Productivity Package is only activated when Breast 
Measure Assistant is available. 
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Breast Productivity Package (Lesion M&A) 

Breast Lesion M&A allows you to document up to 30 breast 
lesions for each breast. Lesion Height/Width/Length, Distance to 
Nipple, and A/B Ratio are available. Distance to Nipple allows 
you to enter the value. This is not a calculated measurement.

BI-RADS lesion classification can be notated via Show Features 
and Show Assessment. 

The Breast Measure Assistant (Auto Contour) feature can also 
be used to automatically detect and outline the breast lesion. 

Worksheet and Summary Worksheets show all the documented 
right/left breast lesions. 

From the Small Parts Model, select the Breast Application. Next, 
select the Right/Left Lesion (Select Rt Side/Lt Side below the 
Touch Panel). The following Touch Panel appears: 

Figure 13-150. Default Breast Lesion M&A Touch Panel

Table 13-46:  Breast Lesion M&A Touch Panel

Preset Parameter Description

Position Specify the position of the lesion: Clock position 1-12 O’Clock, Areolar, 
SubAreolar, Axillary, or “-” (default).

Segment Specify A, B, C, None, or “-” (default).
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Show Features Press to activate the Show Features notations. To add notations for each 
feature, position the trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature. If a Feature has an asterisk next to it (*), then you can select multiple 
notations -- select all that apply and then select ‘Done.’ These features are 
displayed on the Below is a list of each Feature with its possible notations: 
• Shape: Oval, Round, Irregular, None (-)
• Orientation: Parallel, Not Parallel, None (-)
• Margin: Circumscribed, Indistinct, Angular, Microlobulated, Spiculated, 

None (-)
• Boundary: Abrupt Interface, Echogenic Halo, None (-)
• Echo Pattern: Anechoic, Hyperechoic, Complex, Hypoechoic, Isoechoic, 

None (-)
• Posterior Features: No posterior features, Enhancement, Shadowing, 

Combined Pattern, None (-)
• Surrounding Tissue*: Duct changes, Cooper’s ligament changes, Edema, 

Architectural distortion, Skin thickening, Skin retraction/irregularity, None (-)
• Calcifications*: Macrocalcifications, Microcalcifications out of mass, 

Microcalcifications in mass, None (-)
• Special Cases*: Clustered microcysts, Complicated cysts, Mass in or on 

skin, Foreign body, Lymph nodes-intramammary, Lymph nodes-axillary, 
None (-)

• Vascularity: Not Present or not assessed, Present in Lesion, Adjacent to 
Lesion, Diffuse in surrounding tissue, None (-)

Show Assessment Specify the BI-RADS Assessment: None (-), 0, 1, 2, 3, 4a, 4b, 4c, 5, 6. A 
comment field is available directly below the BI-RADS Assessment. 

Koios Assessment Specify the Koios assessment.

Return Press to return to the previous Touch Panel. 

Lesion # Indicates which lesion you are viewing (Lesion # of Total Number of Lesions). 
Press the left/right arrow to move from lesion to lesion. 

L Lesion Length

H Lesion Height

W Lesion Width

Distance to Nipple Used to manually enter the distance the lesion is from the nipple. 

Auto Contour (HxL) Press to activate the Auto Contour feature, using the height and length. 

Auto Contour (HxW) Press to activate the Auto Contour feature, using the height and width. 

Rt or Lt A/B Ratio Right or Left Lesion A/B Ratio, measured by Area or Diameter. 

Composition Specify the composition of the lesion: None (-), Solid, Systolic, or Complex. 

Delete Lesion Press to delete this lesion. 

Table 13-46:  Breast Lesion M&A Touch Panel (Continued)

Preset Parameter Description
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Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Breast Lesions. 

Figure 13-151. Breast Lesion Worksheet
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Worksheet and Summary Worksheets  (continued)

To move to the next page, select the Page Change control 
beneath the Touch Panel. 

Figure 13-152. Breast Lesion Summary 

NOTE: Only defined features are displayed on the Summary. To display 
the undefined features, select “Show Undefined Features” at the 
bottom of the Summary Worksheet. 
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Breast Measure Assistant (Auto Contour)

You can request that the system trace/outline the border of a  
breast lesion using Breast Measure Assistant (Auto Contour). 
You do this by setting the Region of Interest (ROI) around the 
lesion; the system can then measure the lesion by drawing the 
contour around it. 

The system can store up to 30 breast lesions. The system tracks 
these by numbering the lesions consecutively. 

To automatically detect the breast lesion on the display, 

1. Press Measure.

2. Select the side of breast (Left or Right) using Side selection 
rotary below the Touch Panel.

3. Press Rt Lesion (or Lt Lesion) folder.

4. Press Auto Contour (HxW) on the Touch Panel. 

5. Place the Cursor in the center of the lesion and press Set.
Size the ROI around the lesion. Use the Trackball to resize 
the ROI.

• To increase the size of the circle, move the Trackball 
down and to the right. 

• To decrease the size of the circle, move the Trackball up 
and to the left. 

NOTE: Include the entire lesion, even if additional surrounding 
tissue is included. 

6. Press Set on the Trackball. A trace appears around the 
lesion. 

7. Size the trace via the Trackball. 

8. Press Set. The contour around the breast lesion is 
generated. 

NOTE: Multiple breast lesion traces may be generated by the 
system. 

9. Inspect the generated contour for accuracy. If edits are 
necessary, execute steps 8-10 to edit the contour prior to 
accepting the measurement. Otherwise, skip to step 11.

10. To cycle through the generated contours, use the Select 
Contours rotary on the Touch Panel. 
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Breast Measure Assistant (Auto Contour)  (continued)

11. To edit the selected contour, move the Trackball to 
appropriately size the edit region and then press Set on the 
Trackball. 

12. The blue portion of the contour can be edited by moving the 
Trackball to the portion of the contour you want to edit. 

NOTE: The Caliper closest to the cursor enables editing. 

NOTE: To limit the horizontal/vertical editing capabilities, you can 
set a preset via Utility--> Measure--> Advanced--> Small 
Parts--> Restrict Breast Contour Caliper Edit. 

13. After you have completed any required edits, to accept the 
measurement press Done on Trackball or press Print.
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Breast Assistant, Powered by Koios DS (not available in all 

countries)

Breast Assistant, Powered by Koios DS is a Breast Lesion 
Analysis Option. Breast Assistant, Powered by Koios DS is 
integrated with the General Topic or Product Name via DICOM. 
Koios DS is configured similar to a DICOM Service. The user 
can accept/reject analysis results. 

To perform Breast lesion analysis using Breast Assistant, 
Powered by Koios DS:

1. In B-Mofe in the Breast Application, select the Breast 
Productivity Package Lesion # then press Koios DSvia the 
Touch Panel. 

Figure 13-153. B-Mode Touch Panel in Breast Application
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Breast Assistant, Powered by Koios DS (not available in all 

countries)  (continued)

2. Press Dual Image, image the breast lesion, then press 
Freeze. 

3. Measure the breast lesion (Length, Width, Heigh) over 2 
scan planes; or measure the lesion using Auto Contour.

4. Using the Trackball control, press Analyze. 

5. Koios DS analyzes the lesion (a pop-up appears, 
“Analyzing”).

Figure 13-154. Koios DS Analysis

6. Accept the analysis and Koios DS returns a BI-RADS 
Assessment. This assessment is also transferred to the 
exam’s Summary Report. 

To deactivate Koios DS:

1. Access  Utiliy --> Connectivity --> Koios DS Configuration 
page. 

2. Press Deactivate.
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Breast Options Quick Card

LOGIQ Techniques:  Breast Productivity Package

Table 13-47:  Getting Started

1. Select measure to activate Breast productivity 
package.

2. Select side of scan. Use Rotary knob to change 
between Right and Left side at the bottom of the 
Touch Panel (TP).

3. Select position and segment using  rotary knobs 
on the left lower region of the touch panel.
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LOGIQ Techniques: Breast Productivity Package  (continued)

Table 13-48:  Measuring Lesions

1. Select lesion folder on TP.   Width and Height 
will become available.

2. To measure manually, use calipers and Set 
Keys located on either side of the Trackball.

Note: Length is available to be added to TP.  This 
may be confi gured in the utilities page.

3. For Auto Measurements, select  Auto-contour 
on TP.  (Two Choices Auto Contour (HxL) or 
Auto-contour (HxW).

4. Once Auto-contour is selected, identify the 
middle of lesion with cursor.  Select Set Key.

5. Next, identify borders of lesion using Trackball 
to change size of circle so it encompasses the 
entire lesion.  Select Set Key.

6. System will then segment lesion and generate 
measurements.

Note: System generates 4 different contour  
selections. Use Rotary Knob at bottom of TP to 
change between auto-contour selections.
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LOGIQ Techniques: Breast Productivity Package  (continued)

Table 13-49:  Characterize Lesion

1. Characterize the features of each  lesion by 
selecting the Show Features Button. Select 
Feature by using Trackball and Arrow Key.

2. Select show assessment if applicable. Add 
comments and BI-Rad™ assessment.

3. At the end of the exam, select worksheet to view 
measurements.  Select summary to view 
features and measurements.

Note: More than one Characteristic may be selected 
for each lesion. The Features and Characteristics 
that have an asterisk allow user to select more than 
one Feature within those selections.

Table 13-50:  Adding/Editing 

Enter multiple measurements by selecting the 
Lesion folder.  When adding a new Lesion, Add #2, 
3, 4, etc.  For example, after measuring fi rst Lesion 
select Return on TP.  Then select Lesion folder.  
This will add an additional Lesion to be measured. 

When editing, folder will appear open and Edit will 
be shown.

A 1st, 2nd, and/or 3rd left breast lesion will be edited 
or added.  (If the Lesion folder is selected to add a 
Lesion, but no measurements are completed, the 
Lesion is not added.)

This Selection control indicates which lesion is being 
assessed.
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LOGIQ Techniques: Breast Productivity Package  (continued)

Table 13-51:  Deleting

Select Delete Button on Touch Panel (TP) to delete 
current lesion that you are measuring.

Note: To access a different Lesion to Edit or delete, 
select the # of the Lesion in the upper Right hand 
corner of the TP while in the measurement package.
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Thyroid Productivity Package

The Thyroid Productivity Package is only available when the 
Thyroid Productivity Option is activated. 

Figure 13-155. Thyroid/Parathyroid/Lymph Node Touch Panel

Table 13-52:  Thyroid/Parathyroid/Lymph Node Touch Panel

Preset Parameter Description

Side Specify the side: Right, Left, Isthmus.

Worksheet/Summary Select to view the Worksheet/Summary Worksheet. 

Add#1, Add#2, etc. Cycles through the available lesions, or adds a new lesion/node/nodule, etc. 

Rt/Lt Thyroid
Rt/Lt Parathyroid
Rt/Lt Lymph Node
Rt/Lt Nodule

When measuring the Left/Right Thyroid/Parathyroid/Lymph Node/Nodule, 
these folders highlight on the Touch Panel. 
Length, Height, and Width are available for all thyroid measurements. The 
Cortical Thickness measurement is available for the Lymph Node. Show 
Features is available for all thyroid measurements.  
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Isthmus Lymph Node
Isthmus Nodule

When measuring the Isthmus Lymph Node/Nodule, these folders highlight on 
the Touch Panel. 
Length, Height, and Width are available for all isthmus measurements. The 
Cortical Thickness measurement is available for the Lymph Node. Show 
Features is available all isthmus measurements.  

Show Features - Overall 
Thyroid

Press to activate the Show Features notations. To add notations for each 
feature, position the trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature and on the Summary Worksheet. 
Below is a list of each Feature with its possible notations by measurement 
type:
• Overall Thyroid (Top Level Touch Panel)

• Resected: Totally, Partially, None (-)
• Appearance: Within normal limits, Abnormal, Symmetric, Asymmetric 

R>L, Asymmetric L>R, None (-)
• Comment

Table 13-52:  Thyroid/Parathyroid/Lymph Node Touch Panel (Continued)

Preset Parameter Description
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Show Features - Lt/Rt 
Thyroid / Parathyroid / 
Lymph Node / Nodule

Press to activate the Show Features notations. To add notations for each 
feature, position the trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature and on the Summary Worksheet. 
Below is a list of each Feature with its possible notations by measurement 
type:
• Lt/Rt Thyroid

• Resected: Totally, Partially, None (-)
• Echogenicity: Homogeneous; Coarse; Heterogeneous; Hashimoto, 

Classic; Hashimoto, Probable; None (-)
• Vascularity: Normal, Increased, Decreased, None (-)
• Size: Normal, Enlarged, Small, None (-)
• Comment
• Isthmus Comment

• Lt/Rt Parathyroid -- Upper/Lower Gland
• Visibility: Visualized, Not Visualized, None (-)
• Comment

• Lt/Rt Lymph Node
• Appearance: Within normal limits, Suspicious, Pathologic, None (-)
• Composition: Cystic, Complex, Solid, None (-)
• Vascularity: Normal, Increased hilar, Increased non-hilar, None (-)
• Comment

• Lt/Rt Nodule
• Shape: Round, Oval, Irregular, Lobulated, None (-)
• Margin: Well Defined, Well Defined with halo, Well Defined with partial 

halo, Well Defined with complete halo, Poorly defined, Irregular, None 
(-)

• Composition: Solid, Cystic, Mixed, Complex, Heterogeneous, None (-)
• Vascularity: Normal, Increased, Decreased, Central Vasc (Avascular, 

Hypovascular, Isovascular, Hypervascular, Severely Hypervascular), 
None (-)

• Calcification: No Calcification, Coarse central, Coarse rim, Punctate 
scattered, Punctate clumped, Colloid, Mixed, None(-)

• Comment
• Koios Assessment

Table 13-52:  Thyroid/Parathyroid/Lymph Node Touch Panel (Continued)

Preset Parameter Description
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Show Features - Isthmus Press to activate the Show Features notations. To add notations for each 
feature, position the trackball to the right of each feature and press Set. This 
brings up the available notations. Move the Trackball to highlight a notation 
and press Set to select a notation. The notation will then appear next to the 
feature. Below is a list of each Feature with its possible notations by 
measurement type: 
• Isthmus Lymph Node

• Appearance: Within normal limits, Pathologic, None (-)
• Composition: Cystic, Complex, Solid, None (-)
• Vascularity: Normal, Increased, None (-)
• Comment

• Isthmus Nodule
• Shape: Round, Oval, Irregular, Lobulated, None (-)
• Margin: Well Defined, Well Defined with halo, Well Defined with partial 

halo, Poorly defined, Irregular, None (-)
• Composition: Solid, Cystic, Mixed, Complex, Heterogeneous, None (-)
• Vascularity: Normal, Increased, Central Vasc (Avascular, Hypovascular, 

Isovascular, Hypervascular, Severely Hypervascular), None (-)
• Calcification: Coarse central, Coarse rim, Punctuate scattered, 

Punctuate clumped, Colloid, Mixed, None (-)
• Comment
• Koios Assessment

Return Press to return to the previous Touch Panel. 

H Height

W Width

L Length

Isthmus AP Used to measure the Isthmus height distance. 

Cortical Thickness Cortical thickness of the lymph node.  

Delete Press to delete this anatomy. 

Table 13-52:  Thyroid/Parathyroid/Lymph Node Touch Panel (Continued)

Preset Parameter Description



Thyroid Productivity Package

LOGIQ P8/P9/P10 – Basic User Manual 13-277
Direction 5841298-1EN Rev. 2

Worksheet and Summary Worksheets

Worksheets and Summary Worksheets are provided for all 
documented Thyroid anatomies. 

Figure 13-156. Thyroid Worksheet

To move to the next page, select the Page Change control 
beneath the Touch Panel. 
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Worksheet and Summary Worksheets  (continued)

Figure 13-157. Thyroid Summary Report

NOTE: Only defined features are displayed on the Summary Report. To 
display the undefined features, select “Show Undefined 
Features” at the bottom of the Summary Worksheet. 

NOTE: To exit back to the previous measurement screen, press Set on 
exit. 

NOTE: To exit back to the scan screen, press Worksheet/Summary on 
the Touch Panel. 
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Thyroid Productivity Package Quick Card

LOGIQ Techniques:  Thyroid Productivity Package

Table 13-53:  Getting Started

1. Select measure to activate Thyroid productivity 
package.

2. Select side of scan. Use Rotary Knob to change 
between Right, Left, and Isthmus at the bottom 
of the Touch Panel (TP).

3. Choose folder specific to the area of interest 
(Isthmus is an option as well as RT and LT 
Thyroid, Parathyroid, Lymph node or nodule).

Table 13-54:  Measuring

1. Once Folder is selected, L, H, and W 
measurements will become available. Use 
Trackball and Set Keys on either side of the 
Trackball to measure.

2. After measuring Area of Interest, select Location 
A and Location B.  Toggle rotary knobs up or 
down between selections, then choose desired 
locations.

3. Store image after measurements are completed.  
These measurements will then transfer to 
Worksheet/Summary Page.

Note: At any time, select Return on TP to return to 
previous page, or select measure again to exit the 
productivity package.
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LOGIQ Techniques: Thyroid Productivity Package  (continued)

Table 13-55:  Characterize Thyroid, Parathyroid, Lymph Node or Nodule

1. Select the show features button on the Touch 
Panel to describe the characteristics of the 
Thyroid, Parathyroid, Lymph node or nodule 
which is being measured.

2. Place arrow over selection and choose from 
items in Drop Box.

3. Add additional comments as needed in 
Comments Box.

4. At the end of the exam, select Worksheet to 
view measurements and Summary to view 
Features and Measurements.

5. Select Exit to get back to Measurements 
Package.

Note: More than one Characteristic may be 
selected. Features/Characteristics that have an 
asterisk allow user to select more than one Feature 
within those selections.

Table 13-56:  Adding/Editing 

Enter multiple measurements by selecting the 
Nodule, Lymph node or Parathyroid folder. When 
adding a new nodule, add #2, 3, 4, etc. For example, 
after measuring first nodule, select Return on Touch 
Panel. Then select nodule folder. This will add an 
additional nodule to be measured.  

When editing, folder will appear open and Edit will 
be shown.

A 1st, 2nd, and/or 3rd right thyroid nodule will be 
edited or added.  (If the nodule folder is selected to 
add a nodule, but no measurements are completed, 
the nodule is not added.)

This selection control indicates what action the 
Nodule folder above it is going to take when pushed.

Note: Up to 30 Rt/Lt thyroid lymph nodes/nodules 
can be added or edited.
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LOGIQ Techniques: Thyroid Productivity Package  (continued)

Table 13-57:  Deleting

Select Delete Button on Touch Panel to delete 
current nodule that you are measuring.

Note: To access a different nodule, Parathyroid or 
Lymph node to edit or delete, select the # of the 
nodule in the upper right hand corner of the TP while 
in the measurement package.
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Auto EF Measurements

Automated Ejection Fraction (AutoEF) is a semi-automatic 
measurement tool used for measurement of the global EF 
(Ejection fraction). The AutoEF tool is used as an optional 
decision support tool.

The AutoEF tool tracks and calculates the myocardial tissue 
deformation based on feature tracking on B-mode cine loops.

AutoEF is performed on either one or both apical 4-chamber or 
2-chamber views, in any order.

The result is presented as Ejection Fraction value for each view 
and average Ejection Fraction for the whole LV. All values are 
stored to the worksheet after the results are approved (see See 
‘Tracking Validation’ on page 13-292 for more information. ).

NOTE: The AutoEF tool is intended for adult cardiology and is not 
intended to be used in pediatrics cardiology.
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Acquisition

NOTE: AutoEF is only available on 3Sc-RS, 6S-RS, 12S-RS, 6Tc-RS 
and M5Sc-RS.

1. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

2. Acquire B-mode cineloops of an Apical 4 chamber view 
(4-ch) and an Apical 2 chamber view (2-ch).

• The frame rate should be between 37 and 80 frames 
per second. A higher frame rate is recommended for 
high heart rate.

• LOGIQ P8/P9/P10 should be configured to store at 
least 100 ms before and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will be done on the second last heart cycle.

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle 
should be used

NOTE: The AutoEF processed image loop runs slower than the actual 
cardiac motion. To see the loop in correct playback speed, exit 
AutoEF.
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Starting AutoEF

1. Recall any one of the stored views and press Measure.

2. In the Touch Panel, select AutoEF.

The View selection menu is displayed.

Figure 13-158. View Selection Menu

3. Select the name of the current view: 4-ch or 2-ch. A ROI is 
defined and tracked through the entire heart cycle as 
detailed below.
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Defining the endocardial border (EB)

When selecting a view to analyze, the system automatically 
displays a frame where the endocardial border is usually clearly 
visible. The system automatically displays the ROI for tracking 
on the screen and the tissue tracking starts. When the tracking 
is completed and displayed, you can either accept the results or 
recalculate/redraw the endocardial border (EB).

Selecting “Recalc”

When selecting Recalc, you have the option to correct the EB 
manually or to revert to the semi-automatic 3 Point EB definition 
mode. (To revert to semi-automatic mode, press Auto ROI.) If 
you adjust any point in the EB and wait a few seconds, the 
system automatically starts reprocessing.

You can also choose another frame to redefine the EB. To 
choose another frame, turn off the YOYO function, and adjust 
the Left/Right marker.

It is also possible to define an EB in semi-automatic 3 Point 
mode.
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Defining Endocardial Border (EB) in semi-automatic 3 Point mode

To define the endocardial border, place three points at the 
endocardial border; two annular points at the base and one at 
the apex. Follow the indications displayed on the screen when 
placing the three points.

After placing the third point on the Apex, an endocardial border 
will automatically be traced (Figure 13-159 on page 13-287 ).

After Selecting 3 Points, the old EB is cleared from the screen 
and you can redefine a new EB using the 3 Point EB Definition 
method as described above.

NOTE: Correct border tracing is important for an accurate EF 
measurement. The system has an adaptive border tracing 
function: using the endocardial three points as a guide, the 
system will analyze the image and automatically adapt the 
border tracing to an optimal position.

NOTE: The YOYO function is turned on to help finding the correct 
location for the points.
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Editing the endocardial border trace

1. If required, use the Edge Shift Left/Right controls to 
delineate separately the left or right portions of the 
endocardial border visually as best as possible.

2. If required, move the trackball cursor over the border trace, 
select an anchor point (red circle), press SET and correct 
the trace by dragging the anchor point to a new location 
(Figure 13-160 on page 13-288 ). The shape of the border 
trace will update accordingly.

3. In case you wish to start over, press 3 Points and re-position 
the 3 points defining the basal and apex points.

 Figure 13-159. Defining a ROI
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Editing the endocardial border trace  (continued)

4. Place the trackball cursor over the desired point.

5. Selected Point is marked by a red circle.

6. Click over the red circle, it will turn to a square.

Figure 13-160. Selected anchor point on the inner border trace

7. Move the square to re-align the border trace.

8. Press the Process button when ready.

NOTE: Data processing is configured by default to start automatically if 
the cursor is not moved for a few seconds. If the trace needs to 
be adjusted, make sure to make the changes immediately after 
the ROI is displayed.
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EF results screen

When processing is complete the EF results screen is displayed 
(Figure 13-161 on page 13-290 ).

NOTE: The bi-plane results (BiP) will only appear on screen 
(Figure 13-161 ) after measuring both 2-Ch and 4-Ch views.

The AutoEF processed image runs slower than the original loop 
speed. In order to see the loop in correct playback speed exit 
AutoEF.

The running loop is shown on the left. A green dotted line marks 
the inner border of the chamber. In case of poor tracking, the 
system will automatically display parts of the border in red.

The system will automatically pick the frames with the maximal 
area (ED) and minimal area (ES) and place them on the right 
area of the display.

The End Diastolic volume (EDV) and end Systolic Volume (ESV) 
is calculated and shown above each frame.

The resulting EF calculation is displayed on the top of the 
screen.
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EF results screen  (continued)

 Figure 13-161. AutoEF Result Multi Screen



Auto EF Measurements

LOGIQ P8/P9/P10 – Basic User Manual 13-291
Direction 5841298-1EN Rev. 2

EF results screen  (continued)

 Figure 13-162. AutoEF Results Dual Screen - Alternative screen mode
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Tracking Validation

The tracking must be visually controlled and validated. If the 
tracking results are visually correct press the red Approve 
button. The button turns green and is labeled Approved. The 
calculated values will be stored and appear in the worksheet.

The following can be done if tracking needs correction:

• Press EF Dual to enlarge ES and ED frames and position 
them side-by-side (Figure 13-162 on page 13-291 ).

• You may manually select a different ED frame or ES frame 
using the ED frame or ES frame rotary.

• You may edit any misaligned point on either ED or ES 
frames. This is done by:

a. Placing the trackball cursor over the desired point.

b. Clicking over the red circle, it will turn to a square.

c. Pressing Set and moving the square to re-align the 
border trace.

d. The ESV, EDV and EF will be recalculated accordingly.

 Figure 13-163. Border trace edit
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Tracking Validation  (continued)

• In case these results are incorrect, you may go back to the 
previous step by pressing the Recalc button and editing the 
endocardial border (‘Defining the endocardial border (EB)’ 
on page 13-285 ).

• In case editing the endocardial border is too difficult, you 
may start all over again by pressing Auto ROI and retrace 
the border (‘Defining the endocardial border (EB)’ on 
page 13-285 ).

Possible causes of poor tracking

Poor tracking quality could result from a variety of causes. The 
common causes for bad tracking are:

• Erroneous placement of the basal points when defining the 
border. If the basal points are placed too far from the 
annular region, the border segments at the annular base will 
not move together with the underlying 2D image throughout 
the entire heart beat.

• Erroneous placement of the apex point when defining the 
border. The point should be placed so that the resulting 
border trace covers mainly the endocardium. If the apex 
point is placed too high, the border trace will mainly cover 
the epicardium resulting in poor tracking.

• Too much clutter. Images with too much static clutter will 
result in poor tracking.



Advanced Features

13-294 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Results

For each of the views, a results screen containing the EF 
calculation, appears (Figure 13-161 on page 13-290 ) in a 
mini-report. The mini-report appears on the left side of the 
results window.

Figure 13-164. Mini Report
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Results  (continued)

The results are summarized in the worksheet and in the report.

Figure 13-165. Results in Worksheet - Page 1
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Results  (continued)

 Figure 13-166. Results in Report template
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Exit AutoEF

Press Exit to end AutoEF.

Pressing Report, Patient or Scan also closes the AutoEF 
package.

NOTE: Do not disable any sub-measurement of AutoEF in Utility --> 
Measure, as this will disable the whole set of AutoEF 
measurements.

NOTE: For consistent results, do not delete individual AutoEF 
measurements from the worksheet. Always delete a full column.
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Cardiac Automated Function

Imaging (Cardiac Strain)

Cardiac Strain is a decision support tool for regional assessment 
of the LV systolic function. Cardiac Strain is a tool derived from 
2D Strain, which calculates the myocardial tissue deformation 
based on feature tracking on B-Mode grey scale loops.

Cardiac Strain is performed on apical views in the following 
order: apical long-axis, 4-chamber and 2-chamber view, 
following an on screen guided workflow. The apical views may 
be acquired sequentially in B-Mode.

Cardiac Strain is also available for standard apical views 
acquired with a TEE probe.

The result is presented as a Bull's eye display showing color 
coded and numerical values for peak systolic longitudinal strain.

All values are stored to the worksheet. In addition, Global Strain 
for each view, Average Global Strain for the whole LV and the 
Aortic Valve Closure time used in the analysis are stored to the 
worksheet.

Table 13-58:  Cardiac Strain Workflow

1 2 3

StepAPLAX 4-CH 2-CH

1 Acquired views
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2 Defining a ROI

3 • Tracking 
Validation

4 - - AVC Timing 
Adjustment

5 - Parametric 
image result

Table 13-58:  Cardiac Strain Workflow (Continued)

1 2 3

StepAPLAX 4-CH 2-CH
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6 - - Trace and 
Bull’s eye 
result

Table 13-58:  Cardiac Strain Workflow (Continued)

1 2 3

StepAPLAX 4-CH 2-CH
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Acquisition

1. Specify Cardiac Strain-specific values for certain parameters 
in M&A Advanced Preset if needed.

2. Create an exam, connect the ECG device and make sure to 
obtain a stable ECG trace.

3. Select CARD -> Adult from the model menus. Acquire a 
sequential acquisition.

Acquire B-Mode gray scale cineloops of an Apical long axis 
(APLAX) view.

NOTE: It is recommended to acquire all three apical views 
sequentially in order to get similar heart rate in all views.

• The frame rate should be between 37 and 80 frames 
per second. A higher frame rate is recommended for 
high heart rate.

• The system should be configured to store 100 ms 
before and after each heart cycle.

• If the acquisition has more than one heart cycle, the 
analysis will be done on the second to last heart cycle.

• The entire myocardium should be visible.

• A depth range that includes the entire left ventricle 
should be used.

4. Press Freeze. Run the cine and press P1 to store the cine 
into the clipboard.

5. Acquire and store B-Mode gray scale cineloops of an Apical 
4 chamber view and an Apical 2 chamber view as described 
above.

CAUTION Cardiac Strain is only recommended for adult cardiac images 
acquired with the 3Sc-RS, 6S-RS, 12S-RS, 6Tc-RS and 
M5Sc-RS.
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Starting Cardiac Strain

Starting Cardiac Strain from sequential acquisition.

1. Open an APLAX view and press Measure.

2. Select AFI on the Touch Panel.

3. Three apical view buttons appears on the left side menu. 

CAUTION When performing Cardiac Strain on all three apical views, the 
user is asked to start with the APLAX view. This allows manual 
adjustment of the Aortic Valve Closure (AVC) event timing that 
is used in the calculation of the longitudinal systolic strain in all 
apical views.
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Cardiac Strain on the APLAX view

1. Select APLAX.

A ROI following the endocardium is created and the 
Tracking validation screen is displayed.

 Figure 13-167. Tracking Validation screen

1. Display Quick Tips on tracking quality assessment
2. The ROI divided in segments
3. The Scoring table

• acceptable tracking
• not acceptable tracking

4. Bull's eye icon:
• Green sectors with yellow border: views being analyzed.
• Green sectors: views already analyzed.
• Black sectors: views not analyzed.



Advanced Features

13-304 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Cardiac Strain on the APLAX view  (continued)

2. Pay attention on the left/right orientation of the image: 
compare the LV wall names with a visual inspection of the 
image.

If the image orientation is wrong create a new ROI manually 
as described in the section ‘To create a new ROI’ on 
page 13-308 . Make sure to place the basal points correctly 
relative to the image landmarks when defining the ROI.

NOTE: You may alternatively exit Cardiac Strain, invert the image 
and start Cardiac Strain again.

The ROI is divided into segments. The tracking quality for 
each segment is automatically evaluated and summarized 
in the Scoring table (see Figure 13-167 on page 13-303 ).

The tracking for each segment must be visually controlled 
and validated as described below.
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Tracking Validation

Poor tracking quality could result from a variety of causes. 
Select Quick tips (see Figure 13-167 on page 13-303 ) to get 
tips on the most common causes for bad tracking. The common 
causes for bad tracking are:

• Erroneous placement of the basal points when defining the 
ROI. If the basal points are placed too far from the annular 
region, the ROI segments at the annular base will not move 
together with the underlying 2D image throughout the entire 
heart beat (see example cineloops in the Quick tips).

• Erroneous placement of the apex point when defining the 
ROI. The point should be placed so that the resulting ROI 
covers mainly the myocardium. If the apex point is placed 
too high, the ROI will mainly cover the epicardium resulting 
in poor tracking (see example cineloops in the Quick tips).

• Too narrow ROI width. Narrowing the ROI too much will 
result in poor tracking due to lack of tissue data in the ROI 
(see example cineloops in the Quick tips).

• Too much clutter. Images with too much static clutter will 
result in poor tracking (see example cineloops in the Quick 
tips).

CAUTION Poor tracking quality may lead to incorrect measurement 
results. The tracking for each segment must be visually 
controlled and validated.
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Tracking Validation  (continued)

1. Inspect each segment and make sure that the center line is 
moving together with the underlying 2D image.

The tracking quality is automatically evaluated for each 
segment and displayed in the Scoring table.

The tracking in each segment is scored as either Acceptable 
(v) or Not acceptable (x).

If the tracking needs to be improved for some segments, the 
user can modify the ROI or create a new ROI as described 
in ‘ROI adjustment’ on page 13-307  or create a new ROI as 
described in ‘To create a new ROI’ on page 13-308 .

The user may override the tracking quality evaluation done 
by the system by clicking on the evaluation result in the 
Scoring table.

2. Once the tracking quality has been controlled for all 
segments, press Approve in the Scoring table.

The user is asked to confirm or adjust the AVC timing setting 
(see ‘Timing Validation’ on page 13-312 ).
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ROI adjustment

If the automatic ROI is not optimal resulting in poor tracking, the 
user can either adjust the ROI or create a new ROI as described 
below.

To adjust the ROI

1. Press Recalc.

2. The following adjustments can be done to the existing ROI:

• Adjust ROI Width.

• Adjust the shape of the existing ROI: move the cursor 
over the inner ROI border, select an anchor point and 
move it to a new location. The shape of the ROI is 
updated accordingly.

Figure 13-168. Selected anchor point on the inner ROI border

Data processing is started automatically if the cursor is not 
moved for a few seconds.

NOTE: If the ROI needs to be adjusted make sure to make the 
changes immediately after the ROI is displayed.

NOTE: The auto processing function is configurable (from Utility -> 
Measure -> Advanced -> AFI auto processing).

The Tracking validation screen is displayed.

3. Perform Tracking validation (see ‘Tracking Validation’ on 
page 13-305 ).
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To create a new ROI

1. Press Recalc.

2. Press 3 Points to re-define the ROI.

The system automatically displays a frame where the 
endocardial border is usually clearly visible.

3. To define a ROI, place three points at the endocardial 
border; two annular points and one at the apex (see 
Figure 13-169 ). Follow the indications displayed next to the 
pointer and on the Status bar when placing the three points.

NOTE: The Yo-yo function is turned on to help find correct location 
for the points.

Figure 13-169. Defining a ROI

After placing the apex point, the ROI is displayed.

NOTE: Correct ROI definition is important for an accurate strain 
measurement. The system has an adaptive ROI function: 
using the endocardial three points as a guide, the system 
will analyze the image and automatically adapt the ROI to 
an optimal position.

Data processing is started automatically if the cursor is not 
moved for a few seconds.

The Tracking validation screen is displayed.

4. Perform Tracking validation (see ‘Tracking Validation’ on 
page 13-305 ).



Cardiac Automated Function Imaging (Cardiac Strain)

LOGIQ P8/P9/P10 – Basic User Manual 13-309
Direction 5841298-1EN Rev. 2

Quick tips when re-creating the ROI

Correct ROI definition is crucial to get good tracking. Refer to 
the example displayed in the Tip window for correct point 
placements. To display additional guidelines, select Click for Tip. 
Make sure to follow the recommendations when placing the 
three points (see below).

Base Correct Wrong

1. Correct position of the base 
points.

2. The ROI extends into the 
aortic tract.

Apex Correct Wrong

1. Correct position of the Apex 
points.

2. The apex point is placed too 
high. The ROI is extending 
beyond the epicardium.
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Apex Correct Wrong

1. Correct position of the Apex 
points.

2. The upper right border of the 
ROI is way too much into the 
chamber cavity..

Bulges Correct Wrong

1. Correct ROI.
2. ROI should not be bulging or 

follow the papillary muscle. 
To edit the ROI, see ‘ROI 
adjustment’ on page 13-307 .
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General Correct Wrong

The left ventricle must be visible 
through the entire cycle.
1. End systole frame: the entire 

left ventricle is displayed..
2. End diastole frame: the 

annulus is not displayed.
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Timing Validation

Timing information may be crucial to accurate diagnosis. The 
most important event timing is the aortic valve closure (AVC), 
since it is part of the definition of the end systolic strain 
parameter.

Determination of the AVC timing by the system is as follows, 
depending on the situation:

• An automatic AVC estimate determined by the temporal 
contraction of all LV segments (Strain curves) is used.

• From the APLAX view, the user can adjust the estimated 
AVC timing. The adjusted AVC timing will then be used in 
the other apical views when running Cardiac Strain on these 
views.

This option is only available from the APLAX view.
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AVC Timing Adjustment

This procedure is available in the APLAX view only.

1. After validation of the tracking quality, the frame for the 
automatic AVC setting is displayed and highlighted on the 
ECG.

2. To keep the current AVC setting, press Set. To change the 
AVC setting, use the trackball to display another frame and 
press Set.

If the AVC setting was changed, a Confirmation window is 
displayed. Select one of the following options:

• Manual to accept the manual AVC setting.

• Auto to discard the manual AVC setting and use the 
automatic AVC timing.

The parametric systolic strain APLAX view is displayed.

 Figure 13-170. Parametric systolic strain APLAX view
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AVC Timing Adjustment  (continued)

NOTE: The image will not be saved unless Print key is pressed.

To activate a quad display, press and hold down L.

• 2D image with the ROI

• 2D image with Peak systolic strain parametric data

• Segmental curves with peak marker

• M-Mode image with strain parametric data

 Figure 13-171. Quad screen for the APLAX view

NOTE: The Quad screen will not be saved unless Print key is 
pressed.
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Cardiac Strain on A4-Ch and A2-Ch views

The procedure for Cardiac Strain on Apical 4-chamber and 
2-chamber views is similar to the one used in the APLAX view.

For sequential acquisition,

1. Open the apical view from the clipboard.

2. Select the corresponding view in the View selection menu.

3. Validate tracking (see ‘Tracking Validation’ on page 13-305
).

NOTE: The AVC timing setting defined in the APLAX view is used by 
the system when running Cardiac Strain on the other apical 
views.
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Results

For the APLAX and apical 4-chamber views the following results 
are available:

• Single screen (see Figure 13-170 on page 13-313 ) 
displaying a 2D image with strain parametric data.

• Quad screen (see Figure 13-171 on page 13-314 ) 
displaying:

• 2D image with the ROI

• 2D image with Peak systolic strain parametric data

• M-Mode image with strain data

• Segmental curves

CAUTION If auto-AVC is used as AVC timing calculation method when 
running Cardiac Strain (see ‘Timing Validation’ on page 13-312
), the strain values displayed in the Quad screen for the APLAX 
and 4 Chamber views may differ from the strain values 
obtained after the system has performed the final calculation 
from all three views. 

The reason for this is that the Auto-AVC calculation derived 
from all three views is most accurate and may be different from 
the intermediate AVC calculations used for each view. 

The strain values displayed in the Quad screen on APLAX and 
4 Chamber views are therefor preliminary values (A warning 
text about this is displayed on the Quad screen). Only final 
strain values should be reported. 

Note: If you enter Quad screen again after all three loops have 
been processed, the strain values will be correct.
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Results  (continued)

When performing Cardiac Strain on all three apical views the 
following results are also available:

• Bull's Eye and Traces screen displaying:

• Segmental curves for each three Apical views

• Bull's eye presentation with segmental Peak systolic 
strain color coding and segmental Peak systolic strain 
values.

Select BE+Trace to display.

 Figure 13-172. BE+Trace screen
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Results  (continued)

• Bull’s Eye and Review screen displaying:

• Bull’s Eye together with cine clips for all 3 views.

• Cine Stop or Cine Play (changed in toggle) on the Touch 
Panel controls the cine stop or play of the displayed 
image.

Select BE+Review to display.

 Figure 13-173. BE+Review screen
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Results  (continued)

• Bull's Eye Only screen displaying:

• Bull's eye presentation with segmental Peak systolic 
strain color coding and segmental Peak systolic strain 
values

NOTE: The Bull's eye can be configured to display either 18 or 
17 segments (from Utility/Measure/Advanced/AFI 
segment model).

NOTE: Press BE Maps to select another color map for the Bull's 
eye.

NOTE: The system can be configured so that the user can also 
choose to display Post systolic strain index (PSI) color 
coding and segmental PSI values in the Bull's eye (from 
Utility/Measure/Advanced/AFI PSS/PSI Mode). 

• Global Strain (GS) values for all three apical views.

In a given view the Global Strain (GS), also called 
Global Longitudinal Peak Strain (GLPS), is defined as 
the percentage of maximal contraction over the whole 
cardiac cycle of the entire myocardial wall relative to its 
end diastolic length.

• Averaged Global Strain value from all three apical view 
data.

• AVC measurement (either automatic or manual, see 
‘Timing Validation’ on page 13-312 )
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Results  (continued)

Select BE+Only to display.

Figure 13-174. Bull’s Eye Only screen
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Getting the result

To save the results, exit Cardiac Strain and answer yes to the 
question "Do you want to store AFI Results?". Once the results 
are saved, the measurements are available in the worksheet 
and can be used in the report.

If the tracking quality of a segment was scored as Not 
acceptable (x), the colorimetric display on the Bull's eye is 
greyed.

Figure 13-175. Colorimetric display

1. Segment with tracking quality scored as Not acceptable (x).
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Peak detection

The peak systolic strain detection for each segment can be 
verified and eventually manually changed.

To adjust the peak detection:

1. Press BE+Traces.

The Bull's Eye and Traces screen is displayed showing:

• Trace plots for all three loops

• Bull's Eye with Peak systolic strain values

2. To change the peak marker position on a curve:

• Press Set on the peak marker (square point) on one of 
the curves, move the peak marker to a new position and 
press Set again to fix the point.

or

• Place the cursor on a segment in the Bull's Eye. The 
corresponding curve is highlighted.

Click on the segment to select the corresponding peak 
marker and move it to a new position. Press Set to fix 
the point.

NOTE: You can change Peak Maker only during Start point of Heart 
Cycle and AVC Time.

The position of the AVC marker can also be checked in the Bull's 
Eye and Traces screen. If needed, the APLAX view should be 
reprocessed to change the AVC time.
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About the results

Be aware of the following:

• Clinical assessments should be made based on both color 
and segmental Peak systolic strain values.

• The Save As function is intended for research purposes and 
should not be used to archive diagnostic data.

• To populate the worksheet and the report the Bull's Eye 
Only screen must be saved.

• All results shown (curves, colors and values) are based on 
drift compensated values. Any strain drifting is linearly 
compensated throughout the cycle. If the drift compensation 
in a given segment is too high, the tracking quality is 
automatically set to Not acceptable (X).

• If the tracking quality was scored as Not acceptable (X) in 
more than one segment, the Global Strain value is not 
calculated.
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Stress Echo

Introduction

The LOGIQ P8/P9/P10 Ultrasound system provides an 
integrated stress echo package, with the ability to perform image 
acquisition, review, image optimization, and wall segment 
scoring and reporting for a complete, efficient stress echo 
examination.

The stress package provides a protocol template for the two 
types of stress exams (exercise and pharmacological stress). 

In addition to preset factory protocol templates, templates can 
be created or modified to suit your needs.

You can define various quad screen review groups, in any order 
and combination, that will suit your normal review protocol.

When reviewing stress examination images, the images are 
viewed at their original image quality, and different 
post-processing and zoom factors may be applied to the images 
under review for effective image optimization.

The protocol template may be configured for Continuous 
Capture.

A stress echo examination consists of three steps:

• Selection of a stress test protocol template

• Image acquisition

• Stress Analysis

NOTE: If Wall Motion Segment Score is not displayed on the screen, 
select the “Wall Motion” preset in the Utility -> Measure ->  M&A 
-> Plot -> Available Folders and Measurements. 
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Getting started with a stress study

1. After selecting the appropriate application and probe, press 
the Protocol tab on the Touch Panel. The protocol screen 
displays the layout of the default stress protocol for the 
current probe. This layout is also known as a template.

Figure 13-176. Protocol Tab

Table 13-59:  Protocol Tab

Parameter Description

Analyze Display the Analysis screen

Template Editor Display the template editor screen

Add Level Add Level to the template

Delete Images Delete the selected image

Move Image Move the selected image to the another cell

Sync. Select Synchronize the selected images.

End CC End Continuous Capture

Begin/Cont. Begin or continue the acquisition

Template Display the template list

T1 Display/Hide the timer T1

T2 Display/Hide the timer T2

Cancel Cancel Stress Echo



Advanced Features

13-326 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Getting started with a stress study  (continued)

2. To use the current template, press Begin/Cont. to initiate 
scanning. 

To use another template, press Template. The template list 
displays.

Figure 13-177. Template List

3. Trackball to the desired template and press Set.
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Getting started with a stress study  (continued)

4. The selected template displays.

Figure 13-178. Template (Example)

a. Level

b. Projection

c. Current Acquisition (green)

5. Press Begin/Cont. to initiate scanning using the new 
template.
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Image acquisition

Images are acquired in a pre-defined order, according to the 
selected template. The highlighted (green) cell of the template 
matrix, displayed in the Clipboard window, indicates which view 
is currently being acquired.

The names of the view and levels for the current cell are 
displayed on the top left corner of the image area and under the 
template matrix.

Acquisition Screen

1. Current View Level

2. Timer

3. Template Matrix

4. Current View (Green cell)
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Starting acquisition

1. Select the template.

2. Press Begin/Cont.

3. Perform a scan that conforms with the view that is 
highlighted in the template matrix on the Clipboard window.

4. Press the P1 (Image Store) key.

• If the actual stress level is configured to preview the 
cine loop before storing, use the cine loop controls to 
select the most appropriate heart cycle and if desired 
adjust the loop markers. Press P1 again to save the 
selected cine loop.

or

If you do not want to store the cine loop, press Freeze to 
cancel. Return to the scan screen.

• If the actual stress level is not configured to preview the 
cine loop before storing, the system automatically 
stores the last heart cycle.

Stress levels can be configured for side-by-side display/
comparison of the reference loop from baseline or previous 
level and the loop to acquire.

5. After storing the cine loop, the system automatically 
highlights the next view in the matrix to be acquired.

6. Repeat previous steps until all required views are 
completed.

7. If you select Auto Start Analysis on the Template Editor for 
this template, a dialogue asking “Do you want to start 
protocol analysis now?” displays when the last acquisition is 
complete. If you select Yes, the Stress Echo Analysis screen 
is displayed.

The template used can be configured so that analysis 
automatically starts by displaying the first protocol group. The 
wall segment scoring diagrams for each view is displayed in the 
Parameter window on the left side of the screen.
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Starting acquisition  (continued)

If the Protocol tab is selected during acquisition, the following 
Touch Panel displays.

Figure 13-179. Protocol Tab during acquisition

Table 13-60:  Protocol Tab during acquisition

Parameter Description

Stop Stop Stress Echo.

Pause Pause Stress Echo. The template matrix continues in display. Even if you 
press P1, the cine loop does not store to the matrix.

Select Cycles The Continuous Capture Selection screen is displayed (only available in 
Continuous Capture mode).

Analyze Enter Analysis screen.

Template Enter Template screen.

Add Level Add level to the template.

T2 Display (Start)/Hide Timer T2.
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Selecting a view during acquisition

A fixed protocol is provided for scanning, based on the selected 
template. The system automatically highlights the next view to 
be acquired in the template matrix, as images are stored. 
However, the order of scanning may be changed manually as 
follows:

Manual selection of a view during acquisition

1. Use the Trackball or the arrow keys on the alphanumeric 
keyboard to move the cursor to the cell that represents the 
view to be acquired.

The selected cell in the template matrix, highlighted in red, 
indicates the non-default position. When blinking, it contains 
a previously-stored acquisition.

2. Press Begin/Cont. to initiate scanning.

3. Scan and save the selected loop as explained in the 
previous section.

After storage, the system automatically highlights the next 
available view to be acquired.
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Moving an acquired image

An image can be moved from one cell to another during 
acquisition.

Procedure 1

1. When in the Protocol screen, press Move Image.

2. Use the Trackball to move the cursor to the desired image.

3. Press Set.

4. Use the Trackball to move the cursor to the destination cell.

5. Press Set. The image is moved from the source cell to the 
destination cell.

Procedure 2

1. In the Protocol screen, use the Trackball to move the cursor 
to the cell containing the image to move (source cell).

2. Press and hold down Set.

3. With the Set key still depressed, move the Trackball to the 
desired cell.

4. Release the Set key. The image is moved from the source 
cell to the destination cell.

If the destination cell contains an image, the images from the 
source and destination cells is exchanged when moving an 
acquired image.
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Timers

Two timers can be displayed in the Stress mode acquisition 
screen, beside the template matrix.

Timers

• T1 displays the elapsed time from the start of stress 
examination.

• T2 starts when entering live scanning on the second stress 
level.

Both T1 and T2 timers can be manually stopped and restarted 
during the acquisition.

The display of T1 and T2 is user-configurable.

NOTE: If you activate the Timer in Stress Echo, the T1 timer is 
displayed in the lower left-hand corner of the image area after 
exiting Stress Echo. 
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Continuous Capture mode

Continuous Capture mode enables the user to perform 
acquisition continuously for all views at any level depending on 
the selected template configuration. Continuous Capture 
consists of temporary images and loops acquired during the 
session in a storage buffer in system memory. To enable best 
possible use of the limited storage buffer capacity, a Pause/
Capture mode is provided, as opposed to the normal Freeze/
Scan mode. The Pause mode enables scanning and live display 
on the screen, without any capture, thereby leaving the buffer 
available.

To run Continuous Capture, the user has to select a template 
where this feature is activated.

The buffer bar

When entering a level with Continuous Capture enabled, a 
buffer bar displays in the window.

The Buffer bar displays the following information:

• The scanning state

• Pause (live scanning without storing)

• Capture (live scanning with storing temporary images 
and loops to system memory buffer)

• The percentage of the buffer that is filled

• The buffer filling progression showed by a filling gage

• The capturing sessions, reflected by the red lines along the 
buffer bar

Figure 13-180. Buffer Bar

1. System's state

2. Capture session

3. Pause session

4. Buffer gauge

5. Percentage of filled buffer
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Controlling the capture process

When entering a stress level with Continuous Capture enabled, 
the system is automatically set in Pause mode.

1. Press P1 to start image capture.

“Capture” is displayed in the buffer bar, the gage starts filling 
and the percentage of filled memory buffer increases.

2. Press P1 again to stop capture.

“Pause” is displayed in the buffer bar.

When 90% of the memory buffer is filled up, the text display in 
the buffer bar turns red.

The system enters Freeze mode automatically once the buffer is 
full and the captured loops display in the Continuous Capture 
selection screen.

Activating Continuous Capture

1. Do all your pre-stress acquisitions in the Cardiac 
application.

2. Press the Protocol tab to enter the Stress Echo mode. The 
Protocol screen displays.

3. Press Template. The template list displays.

4. Select the template Exercise 2x4 from the list.

5. Press Begin/Cont..

6. Acquire the resting loops in all four views.

NOTE: Use the P1 key to store the images.

7. Once the fourth loop is acquired, the system enters into a 
waiting mode where Continuous Capture is in a pause state 
awaiting the patient to exercise.

8. When the patient is back on the bed, press P1. The 
Continuous Capture acquisition starts.

9. Acquire all your views.

The memory buffer gage increases. When memory exceeds 
90%, the percent number turns red.

10. Press Freeze to finish.
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Activating Continuous Capture  (continued)

11. Press Select Cycle.

The Continuous Capture selection screen displays.

If the buffer is full, the system automatically displays the 
Continuous Capture Selection screen.

Refer to the next section if additional image acquisitions are 
necessary after the buffer is full.

 Figure 13-181. Continuous Capture Selection Screen
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Activating Continuous Capture  (continued)

12. Assign the cine loops to the four views. 

a. Trackball to the desired loop.

b. Press Set. A drop-down menu appears with the 
available choices.

c. Trackball to the appropriate view.

d. Press Set.

 Figure 13-182. Drop-down Menu

e. Continue these steps until all views are selected.

NOTE: To access additional cycles, use the arrow keys on the 
lower left portion of the select cycle screen.
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Activating Continuous Capture  (continued)

f. Select Done when complete. A dialogue window 
displays, asking whether the entire Continuous Capture 
acquisition should be saved.

Figure 13-183. Dialogue Window

13. Press Delete to discard the loop or press Store to keep the 
entire loop.

14. Perform Analysis and scoring.
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Continuous Capture with additional image acquisition

If the buffer is filled up before all the image acquisitions are 
done, additional loops can be stored in the clipboard before 
doing image assignment to the views.

1. Perform the Continuous Capture. See ‘Activating 
Continuous Capture’ on page 13-335 for more information.
(Steps 1 to 11).

2. In the Continuous Capture selection screen, press Select 
Later.

The Continuous Capture screen displays.

3. Perform the additional acquisition.

4. In order to resume the stress echo exam and assign loops 
for the views from the Continuous Capture buffer, press 
Protocol. If not displayed, select the template Exercise 2x4
from the template list.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view. See ‘Activating 
Continuous Capture’ on page 13-335 for more information.
(Step 12 a - f).

7. Press Delete to discard the loop or press Store all to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.

8. Perform Analysis and Scoring.
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Postponed image assignment

The assignment of the cine loops to the view can be done on a 
later stage on a stored Continuous Capture acquisition.

1. Perform the Continuous Capture.  See ‘Activating 
Continuous Capture’ on page 13-335 for more information.
(Steps 1 to 11).

2. Press Store all.

The entire Continuous Capture acquisition is stored. The 
examination can be ended and the image assignment, 
analysis and scoring can be done later.

3. Re-open the examination, if necessary.

4. Press Protocol. The Protocol screen displays.

5. Click the continuous capture images on the Protocol 
Template screen.

The Continuous Capture selection screen displays.

6. Assign the cine loops to the view.  See ‘Activating 
Continuous Capture’ on page 13-335 for more information.
(Step 12 a - f).

7. Select Done.

8. Perform analysis and scoring.

Restart capture from the Continuous Capture Selection

• Press Restart Capture.

The recording in memory is deleted and the Continuous 
Capture starts again.

Resume Continuous Capture

• Press Continue Capture.

Resumes Continuous Capture recording (only if the 
Continuous Capture buffer is not full).
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Assigning and storing the cine loop

The cine loops captured in the buffer are assigned to the stress 
protocol views and stored from the Continuous Capture 
selection screen.

 Figure 13-184. Continuous Capture Selection Screen

a. Highlighted loop

b. Cycle number and total number of cycles

c. Gray Gauge: Position of the highlighted loop within 
buffer area. 

d. Navigation Controls: << < > >> (back to first selection, 
back to previous selection, forward to next selection, 
and forward to final selection). 
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Assigning a cine loop to a view

1. Use the Trackball to move the cursor to the desired cine 
loop in order to assign it to a particular view of the stress 
template.

The frame of the loop is highlighted.

2. Press Set.

A pop-up menu displays with the view names of the 
template.

 Figure 13-185. Loop Assignment

a. Already assigned view

b. Views pop-up menu

NOTE: A checkmark appears on the Views pop-up after you 
have assigned a view to an image.
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Assigning a cine loop to a view  (continued)

3. Use the Trackball to select the required view name.

4. Press Set.

The name of the view displays above the timers in the 
window.

5. Repeat steps 1 through 4 to assign loops to the other views 
of the level.

6. Press Done when complete.

A dialogue window displays asking whether the entire 
Continuous Capture acquisition should be saved.

7. Press Delete to discard the loop or press Store all  to keep 
the entire loop.

The normal procedure is to discard the loop. The loop is 
very big and requires a lot of disk space.
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Post Acquisition Features

Post acquisition, you can utilize Raw Data to adjust the following 
in B-Mode: 

• Zoom

• SRI HD

• Rejection

• Frame Average

• TGC

• Maps

• Dynamic Range

• Gain

• Rotation

You can also take measurements post Stress Echo acquisition. 
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Analysis

Analysis consists of viewing previously saved loops and 
assigning scores to each cardiac segment, in order to quantify 
the function of the muscle or wall segment.

Depending on the protocol configuration, the analysis stage can 
start manually or automatically after completion of the stress 
test. In this case, the usual procedure consists of sequentially 
opening all image groups (if defined) and performing scoring 
from image to image.

The quad screen is the standard display for comparing heart 
cycles. The heart cycle loops in the display are synchronized to 
enable comparison. Each loop in the quad screen can be 
magnified, using the zoom control.

Image Selection for Analysis

Images can be selected manually or from a pre-defined group in 
the Protocol screen.

Selection of Images from a group

If groups of images have been defined in the protocol template, 
you can select a group of images for analysis and sequentially 
analyze all images from all groups from within the Analysis 
screen.

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Press Analysis. A pre-defined group appears in the display 
with a Wall Segment window on the left. 

3. To advance to other groups, use the Trackball to move the 
cursor to the arrows at the bottom of the Wall Segment 
window. Select an arrow to advance to another group. For 
further clarification, see callout E in Figure 13-186 . 
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Manual selection of images from Analysis screen

1. When currently in the protocol analysis screen in the Stress 
analysis quad screen, hold down the SHIFT key while 
performing Steps 2 through 4.

2. Use the Trackball to move the cursor to the first image to 
select in the template matrix.

3. Press Set. The frame of the selected loop is in the Stress 
analysis screen and the next window in the quad screen is 
automatically selected.

4. Repeat step 2 and 3 to select other images.

5. Depress SHIFT.

Manual selection of images in the Protocol screen

1. In a stress examination, press Protocol. A preview of the 
acquisition displays.

2. Use the Trackball to move the cursor to the first image to 
select.

3. Press Set. The frame of the selected loop highlights.

4. Repeat Steps 2 and 3 to select other images.

5. Press Analyze to open images in the Analysis screen.
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Scoring acquired loops

1. After image selection, press Analyze.

The Stress Echo analyze screen displays.

 Figure 13-186. Analysis Screen

a. Wall segment diagram

b. Selected loop (Highlighted frame)

c. Displayed loops (Highlighted frames)

d. Exit Wall motion scoring

e. Change page or enter next image group
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Scoring acquired loops  (continued)

2. Use the Trackball to move the cursor to a segment in one of 
the scoring diagrams and press Set.

The Score pop-up list displays.

3. Use the Trackball to move the cursor to a score.

4. Press Set.

The score displays in the relevant segment area in the 
diagram.

NOTE: To edit a score, select it and choose a new score.

5. Repeat step 1 through 3 to score relevant segments.

6. Press the Change Page arrow to display the next group of 
images.

7. Repeat step 1 through 3 to score relevant segments on the 
new loops.

Figure 13-187. Segment Scoring

NOTE: Since Cine changes into sync mode, subsequent scans are also 
synchronized. Exit sync mode from the Cine menu.
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Editing/Creating template

The stress package provides protocol templates for exercise as 
well as pharmacological stress examinations.

The user can create new templates or modify existing templates 
to suit the individual needs. Up to ten projections and fourteen 
stress levels can be created in a template.

Templates created may be temporary, used only during the 
current examination, or saved as new templates, for future use 
and reference.

The editions that may be performed include:

• Adding/Deleting levels and projections.

• Assigning new labels to levels and projections.

• Defining level options.

• Defining new groups.

Templates are edited/created from the Template editor screen.

Entering the Template editor screen

1. Press Protocol to enter the stress echo mode.

2. Press Template. The template list displays.

3. Use the Trackball to select the Template Editor.

4. Press Set. The Template Editor screen displays.

OR

1. Press Protocol to enter the stress echo mode.

2. Press Template Editor on the Touch Panel. The Template 
Editor screen displays.
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Template Editor screen overview

 Figure 13-188. Template Editor Screen

Table 13-61:  Template

Parameter Description

Template Select a pre-defined template from the pull-down menu. The protocol 
template preview updates accordingly.

Table 13-62:  Protocol Template Preview

Parameter Description

Protocol Template Preview • Displays an updated preview of the template accordingly to the settings 
applied.

• To change Projection and Stress level labels, select a pre-defined label 
from the pull-down menu or press Set in the actual label field and type a 
new name.
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Table 13-63:  Template Settings

Parameter Description

Template Settings • Cycles: select the number of cine loop heart cycles to store for each level 
from the pull-down menu or enter the desired value manually.

• Continuous Capture: Checking this parameter enables continuous image 
acquisition throughout the level. The images acquired are temporarily 
stored in the system’s storage buffer.

• Preview of store: Checking this parameter enables review and 
adjustment of cine loops before store.

• Show reference: Checking this parameter displays a dual screen with the 
reference level (first or previous level) on the left and the live image on 
the right.

Table 13-64:  Scan Mode

Parameter Description

Scan Modes • 2D, Color, PW (Pulsed Wave Doppler), CW (Continuous Wave Doppler), 
MM (M-Mode), Color MM, Color PW, Color CW

Table 13-65:  Other options

Parameter Description

Other Options • Grid Size: Enter the number of levels and projections for the selected 
template.

• Timers: If you check this parameter, starts T1 and T2 timers 
automatically.

• Auto-start analysis: If you check this parameter, displays the Stress Echo 
Analysis when the last acquisition is performed.

• Show Systole in Analysis: When selected, the systolic part of the cardiac 
or ECG cycle is only displayed. The whole cycle is not displayed. 

• Smart Stress: Check Smart Stress to store a subset of the image 
acquisition settings (e.g., Zoom, Gain, Compress, etc.) for each view in 
the protocol. Smart Stress enables you to set image acquisition settings 
for each view at a baseline level and automatically get the same image 
settings in the corresponding views in the next levels. 

• Reference image: When Show Reference is selected, selects either 
corresponding baseline loop or corresponding loop from the previous 
level to be displayed as reference image during acquisition.

Table 13-66:  Pre-defined groups

Parameter Description

Pre-defined groups • Shows the image groups created.
• New group: Creates a new image group. Select the desired images on 

the template preview.
• Update group: Edits a selected group after new loop selection on the 

template preview.
• Delete group: Deletes a selected group.
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Selecting a base template to edit

1. Select the base template from the template pull-down menu 
on the upper left corner.

2. Press Set.

The selected template displays in the protocol template 
preview field, showing the levels, projections and their 
labels.

Adding/Deleting levels and projections 

1. Enter the number of levels and projections in the Grid size 
field.

The new grid size displays in the protocol template preview 
field.

2. Press New Template to create a new template.

or

Press Save Template to update the base template.

Display timers

1. Check the box(es) to display timer(s) as specified.

NOTE: The timers can also be started or stopped at any time during 
stress examination by using the T1 and T2 Touch panel key.

Start analysis automatically

1. Check Auto Start Analysis to display the Stress Echo 
Analysis screen when the last acquisition is performed.
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Smart Stress

1. Check Smart Stress to store and automatically reuse a 
subset of the image acquisition settings in the baseline level 
view in the corresponding views in the next levels. 

Configuring levels

The following options can be set up for each level:

Number of cycles to be stored in the cine loop:

1. Enter the desired number (1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 15, 20) 
in the Cycles field.

Continuous Capture

1. Check Continuous Capture if continuous image acquisition 
throughout the level is desired.

When Continuous Capture is selected, preview of the cine 
loop and reference display during acquisition are not 
possible.

Preview of store

1. Check Preview of store if review and adjustment of cine 
loops before storage is desired.

Show reference

1. Check Show reference if the display of the corresponding 
reference loop is desired during acquisition (Dual screen 
mode).
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Adding a group

1. In the Protocol template preview field, select the cells to be 
part of the group.

2. In the Pre-defined group field, press New group.

A dialogue box displays to ask the user to enter a name for 
the new group.

3. Enter the group name.

4. Press OK. The new group displays in the pre-defined group 
field.

Updating an existing group

1. In the Pre-defined group field, select the group to edit.

The selected cells are highlighted in the Protocol template 
preview field.

NOTE: A selected group is highlighted by a blue frame.

2. Either select a new cell(s) to add to the group or deselect an 
existing cell(s) to remove from the group.

3. Press Update group.

The display in the Protocol template preview field is updated 
accordingly.

Deleting a group

1. In the Pre-defined group field, select the group to delete. 

NOTE: The selected group is highlighted by a blue frame.

2. Press Delete group.

The group is removed from the list in the pre-defined group 
field.

Specifying Scan Mode for each Projection

1. Specify the Scan Mode for each Projection: 2D (B-Mode), 
Color Flow Mode, M-Mode, Color M-Mode, PW Mode, Color 
PW Mode, CW Mode, or Color CW Mode. 
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Saving the Template

You can save the template using controls at the bottom of the 
Template Editor page, or use the controls on the Touch Panel. 

Figure 13-189. Template Editor Touch Panel

Table 13-67:  Template Editor Saving Options

Parameter Value

New Template Select this option to create an entirely new template. 

Save As Template If you would like to create a new template based on the existing template with 
your modifications, select to Save this Template As, and give it a name. 

Save Template Select this option to save the default template with your modifications. 

Delete Template Select this option to delete a template. 
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Wall Motion Segment Setup 

You can set up the following parameters for Wall Motion 
Segment in the Utility screen (Utility--> Measure--> Advanced--> 
Cardiac).

Figure 13-190. Cardiac Wall Motion Segment Setup

Table 13-68:  Wall Motion Segment Parameters

Parameter Value

WMS freeze loop at ES Specify to freeze the Loop at End Systole

WMS Segment Model Select 16 or 18 segments

WMS initial scoring Undefined or Normal

WMS scoring legend ASE, ASIA or European
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Utility Application Settings for Protocol

Figure 13-191. Protocol Setup 

Table 13-69:  Protocol Parameters

Parameter Description

Show Protocol Tab Show/Hide the Protocol tab for that preset (Bicycle Normal, Bicycle Sporty, 
Contrast Pharmacological, Pharmacological 4x4, Pharmacological 8x5, 
Exercise 2x4, Exercise 2x4 B, Pharmacological US 4x4, or User-configured).

Template Select the default template.



Advanced Features

13-358 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Report

If you set up the Wall Motion Analysis field on the Report, you 
can insert the results. See ‘Cardiac Studies Wall Motion 
Analysis’ on page 13-440 for more information.

Select Report to view either the Bull’s Eye or Cut Plane Report. 

 Figure 13-192. Bull’s Eye Report Sample
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Report  (continued)

 Figure 13-193. Cut Planes Report Example

HINTS Select either Bull’s Eye or Cut Plane on the Reports--> Adult 
Template. 
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IMT Measurement - Auto

Auto IMT automatically measures the thickness of the Intima 
Media on the far and near vessel walls. Near Wall IMT is the 
distance between the trailing edges of the adventitia and intima; 
the Far Wall IMT is the distance between the leading edges of 
the adventitia and intima. 

Set up

Set up the parameters you want to record on the worksheet on 
the Utility -> Measure -> M&A page while are in the Carotid 
application. Select CCA/ICA/BIF -> IMT Far/Near -> Parameter 
(Average, Max, Min, Standard Deviation, Points, or Distance). 

 Figure 13-194. Configuring Auto IMT
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Controls

In the Vascular Carotid application, the Auto IMT measurement 
is available. 

Figure 13-195. Auto IMT Touch Panel

The following controls are available. 

Table 13-70:  Auto IMT Touch Panel Description

Parameter Description

Worksheet Select to view the Worksheet

IMT Far Select to begin the Far Field IMT measurement. 

IMT Near Select to begin the Near Field IMT measurement. 

AP Anterior Posterior

Trans Transverse

Length/Offset Rotary -40/+40 Length. At zero, you can freely adjust the length, but only vertically. 
Offset distance, -20 (Left) / +20 (Right)

Save Length/Offset Push to save Length/Offset as a preset.
Press key to save value as default.

Overall / IMT Trace Fit / 
Intima

Adjusts (remeasures) the IMT automatically measured by the system. 

Rt / Lt Side Select Left / Right Side. 

Cursor Select Allows you to update cursor placement. 
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How to measure

To measure the IMT, 

1. In the Carotid application, press Freeze, press Measure.

2. Select the appropriate IMT measurement. For example, if 
measuring the IMT of the far wall of the right common 
carotid artery, select Rt CCA folder, and then IMT Far.

3. Use the Trackball to set the length.

Or

Use the Length / Offset control on the Touch Panel to set 
the length and offset distance.  The Offset key controls how 
far away from the vertical line the measurement starts. 
Length is the length of the tool itself. If set to zero, you can 
adjust it anywhere on the image. 

4. Press Set.

You can either adjust the trace prior to pressing the Print key 
or press the Print key to store the image which also saves 
the measurement to the Worksheet.

To adjust the trace, use the Overall IMT Trace Fit Intima
control on the Touch Panel. The Trace fit (up/down) adjusts 
the inter luminal line whereas the overall (rotate) adjusts 
both IMT lines.

Figure 13-196. Example of Auto IMT Far Measurement
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How to measure  (continued)

5. Position the cursor, then select IMT Near. 

6. Use the Trackball to set the length.

Or

Use the Length / Offset control on the Touch Panel to set 
the length and offset distance.

7. Press Set.  “Store image to accept IMT measurement” 
displays in the message area. If the traces fit both layers of 
the wall, approve the measurement by pressing the Print
key to store the image. 

To adjust the trace prior to pressing the Print key, use the 
IMT Trace Fit control on the Touch Panel. The measurement 
is saved to the Worksheet. 

NOTE: Since the IMT measurements are semi-automatic, the 
operator has to approve the detection by visual inspection 
before storing the results in the worksheet and report.
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ECG

Overview

WARNING DO NOT USE the physiological traces of the LOGIQ P8/P9/
P10 Ultrasound system for diagnosis and monitoring.

DO NOT USE with the Defibrillator.

CAUTION • ECG electrodes should not make contact with other 
conductive parts, including earth.

• After the defibrillator stimulates the patient, the ECG needs 
4 to 5 seconds for recovery.

• The quality of the ECG trace depends on the stability and 
conductivity of the electrodes during the test, especially 
during high stages when the patient’s movements can 
cause artifacts.

• Make sure that the lead wires do not swing.

• The device is not waterproof. Do not expose the device to 
water or any kind of liquid. Maintain in a dry place:

• The exterior of the recorder may be wiped clean with a 
soft cloth. Do not use harsh cleaning agents to clean 
the unit. Do not immerse the unit in any liquid.

• Clean the cables with a hospital approved cleaning 
procedure such as those recommended by AAMI or 
AORN. Do not immerse cables in water.

• Worn or damaged patient cables are the most common 
cause of poor ECG signals. ECG signals (or wave 
patterns) that consistently contain noise or artifact may 
suggest need for ECG wire or cable replacement.

• Store the device in a dry place.

• Always protect the recorder from coming into contact 
with moisture. In rain or snow conditions, protect the 
recorder from bad weather elements by wearing the 
recorder inside a coat.

• When Difibrillator is using, all attached patient applied parts 
connected to ultrasound system must remove from patient.
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ECG Cable

The ECG Cable is a modular cable consisting of two different 
cable parts:

• Single cable with a system connection at one end and a 
cable splitter at the other.

• A triple color-coded electrode cable to be inserted into the 
splitter device. Each electrode cable hooks up to the 
appropriate stick-on electrode by a color-coded clip type 
connector.

The color-coding of the electrodes follows one of two standards 
that are common in different parts of the world. The cable splitter 
device has a drawing defining the color codes, names and body 
location for the two standard color codes. 

WARNING For defibrillation situation, patient connection cable MUST BE 
USED with the “Norav, code C3-C-E-ODU-##” and “Norav, 
code C3-C-U-ODU-##” only.

WARNING The patient cable protects against the effects of the discharged 
of a cardiac defibrillator.

CAUTION Make sure the leads are attached properly, and use only GE 
recommended ECG leads. It is important to confirm ECG trace 
clarity before the scan.

Table 13-71:  ECG Color Code Cable

IEC
(Europe, Asia, ROW)

AHA 
(USA)

Position of the 
human body surfaceElectrode Mark Color Code Electrode Mark Color Code

R Red RA White Right Arm

L Yellow LA Black Left Arm

N or RF Black RL Green Right Leg (Neutral)
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ECG connector

The ECG connector is located on the base of the monitor arm.

Figure 13-197. ECG connector
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ECG Trace Monitor Display

The scanned image is synchronized with the ECG trace. In 
Doppler or M-Mode, the traces are synchronized with that 
particular mode’s sweep.

The user can control the gain, position and sweep speed of the 
traces using the Touch Panel controls.

 Figure 13-198. ECG Trace Display

1. ECG

2. Auto Heart Rate Display
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ECG Touch Panel

The ECG Touch Panel provides for control of the input signals.

Without the ECG option, the ECG Touch Panel is not displayed.

Figure 13-199. ECG Touch Panel

Table 13-72:  ECG parameters

Parameter Description

Sweep Speed Change the speed of the trace. The sweep speed of the physio signal on the 
B-Mode image can be set independent of the timeline (Doppler and M-Mode) 
sweep speed.

Timer Trigger On/Off. Enables intermittent imaging based on a timer.
NOTE: If Timer Trigger is turned on, the ECG Trigger is set to None.

ECG Trigger Enables intermittent imaging based on the ECG. The trigger location(s) 
relative to the R trigger are set with the Delay Time key.
Press ECG Trigger and select one of the options (None, Trig1, Trig2, and 
Both) and adjust the delay time using the Delay Time key.
• ECG Trig 1 specifies the delay (ms) from R-wave to triggered frame.
• ECG Trig 2 specifies the delay from R-wave to second frame.
• Both activates ECG Trig 1 and ECG Trig 2 simultaneously. Trig 2 must be 

greater than Trig 1 for dual triggering (Both) to be active.
NOTE: If other than None is selected, Timer Trigger is turned off.

ECG Display Provides the ability to turn on the ECG trace and Auto Heart Rate for display 
on the monitor.
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ECG Trigger Period The control specifies the number of heart cycles (R-waves) that are skipped 
between ECG triggers. 
The default is 1 or no skipping.

Delay Time In ECG Trigger Mode: If only ECG Trig1 or ECG Trig2 is selected via the ECG 
Trigger key, the Delay Time key controls the R-Delay time of the active 
trigger. If both triggers are selected (Both), press this key to toggle ECG Trig1 
and ECG Trig2 and rotate the key to change the delay time. Once the trigger 
is set, the snap shot image is displayed each time the update line passes the 
active trigger(s).
In Timer Trigger Mode: Rotating the knob changes the delay time between 
images.

ECG Gain/Position Allows for the amplitude control of the ECG trace or allows for the vertical 
positioning of the ECG trace on the image display.
Press the knob to toggle between Gain and Position. The default is Gain.

Table 13-72:  ECG parameters (Continued)

Parameter Description
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DICOM

Overview

Refer following sections for DICOM usage. 

• ‘Save As’ on page 9-19 .

• ‘DICOM Import’ on page 9-46 .

• Hide Patient Data in ‘System/General Preset Menu’ on 
page 10-7 .

• GSDF in ‘System/System Display Preset Menu’ on 
page 10-11 .



DICOM

LOGIQ P8/P9/P10 – Basic User Manual 13-371
Direction 5841298-1EN Rev. 2

Anonymize the  patient

Overview

The LOGIQ P8/P9/P10 offers an option to extract all 
measurements and DICOM tags from a selected patient in the 
Patient List when that patient is not active. This option makes 
the exam(s) anonymous and attaches this information to a newly 
created Anonymous Patient.

The LOGIQ P8/P9/P10 warns the user on possible data loss, 
data mismatch and data that cannot be copied anonymously, 
including:

• Links to Reports will be lost.

• Non-ultrasound exams will not be anonymous.
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Anonymize the patient

1. Ensure that you are logged in as an Administrator on the 
system. 

2. Select the Local Archive dataflow. 

3. Select the patient from the Patient View list and left click to 
bring up the “Anonymize” pop-up menu.

4. A confirmation dialog displays. Select OK.

5. The “Anonymize Patient” dialog displays. All the fields 
inherit the values from the original patient’s exam, except for 
Patient ID.

Fill in the Patient information fields. 

Press OK to continue.

NOTE: If the newly entered Patient ID is not unique in the database, 
the Patient ID turns to red and an error message displays on 
the status bar.
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Anonymize the patient  (continued)

• Empty Other DICOM Tags: Check to clear all DICOM 
Tags.

• Manage DICOM Tags: Manage DICOM tags dialog 
displays. Select DICOM tags individually.

 Figure 13-200. Manage DICOM Tags
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Structured Reporting

DICOM Structured Reporting provides the results of a procedure 
as structured data elements (well-defined fields) as opposed to 
unstructured data (large amounts of text undifferentiated by 
individual fields). This greatly improves query capability. DICOM 
Structured Reporting creates coded clinical data that can be 
used for clinical research, outcomes analysis, and disease 
management.

DICOM Structured Reporting is a standardized format for 
medical results. LOGIQ P8/P9/P10 supports the following 
templates:

• OB-GYN REPORT TEMPLATES

• VASCULAR ULTRASOUND REPORT TEMPLATES

The system supports selectable vessels with their locations 
for B-Mode measurements.

For Vascular studies (Bypass Graft, UEV Map, LEV Map, 
LEA/UEA, and Carotid), additional measurement locations 
were added. For instance, for a Bypass Graft, there are now 
measurements at Inflow, Anast, Thigh, Knee, Calf, Ankle, 
Graft, RunOff, Pre-Sent, Stent, Post-Stent, and Outflow 
locations.

• ECHOCARDIOGRAPHY PROCEDURE REPORT 
TEMPLATES

• Abdomen Report Templates

• Breast Report Templates

• Thyroid Report Templates

These templates do not support all M&A results for the 
LOGIQ P8/P9/P10.

Supported parameters

The DICOM supported parameters are listed in the DICOM 
Conformance Statement at the following website under DICOM - 
Ultrasound:

http://www.gehealthcare.com/usen/interoperability/dicom/
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DICOM Image Storage

DICOM Image Storage allows the system to send or receive 
ultrasound images in a format that can be interpreted by PACS.

CAUTION GE does not warrant the operation if the DICOM format of send 
image (US, USMF, SC) does not correspond with the DICOM 
Server. 

Table 13-73:  DICOM Image Storage

Preset Parameter Description

Allow Clips Select to allow cine loop storage.

Allow raw data Select to save data in both TruAccess (raw data) and DICOM format. Clear to 
save in DICOM format only.

Compression Select the compression type: None, Rle or Jpeg.

Max Frame rate Select the Max Frame rate : Full, 25, 30, 60, 80.

Color Support Select: Mixed, Gray or Color

Reopen per image Reopen per image

Enable Structured 
Reporting

Select for Structured Reporting. 

Key Image Notes Image deletion notification. ONLY available for the Direct Store Workflow and 
ONLY generated when there are images deleted during the exam. Selecting 
this lets the reader at the PACS system know which images have been 
deleted. An indicator is placed on deleted images with a reason, “Rejected for 
Quality Reasons,” for example. 
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DICOM Performed Procedure

DICOM Performed Procedure provides an acknowledgement 
that a study has been performed.
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DICOM Print

DICOM Print provides the ability to send or receive ultrasound 
image data to DICOM printers.

Table 13-74:  Properties 

Preset Parameter Description

Vendor Specify PACS Vendor. This enables annotation on patient information since 
by definition patient information is missing on the title bar.  

Format Indicates how many prints to print per page, for example, 1,1, 1,2, 1,3, up to 
7,5. Partial prints are displayed as one print job.

Priority Specify the print job priority: High, Medium, or Low.

Medium Select the print medium: Clear Film, Paper, or Blue Film.

Copies Enter the number of copies. 

Orientation Specify whether to print the image Portrait (vertically) or Landscape 
(horizontally).

Film Size Specify the dimensions of the film size.

Film Destination Specify the film destination for the exposed film
• Magazine – Store in a film magazine
• Processor – Develop in a film processor

Magnification Specify how the printer magnifies the image to fit it onto the film. 
• Replicate – Interpolated pixel are copies of the adjacent pixels 
• Bilinear – Interpolated pixels are created by bilinear interpolations between 

the adjacent pixels
• Cubic – Interpolated pixels are created by cubic interpolations between the 

adjacent pixels
• None – No interpolation

Smoothing Type Specify the printer’s magnification interpolation for the output.

Trim Specify whether you want a trim box to be printed around each image on the 
film: Yes or No.

Min Density Enter a number indicating the minimum density level of the film.

Max Density Enter a number indicating the maximum density level of the film.

Border Select to have the border area surrounding and between the images of the 
film: Black or White.

Empty Image Select to have a Black or White empty image.

Color Select whether to have the image Color or Grey.

Configuration Information Enter vendor-specific image quality settings.

Film Session Label Type a name for the group of film labels associated with the print job.
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Table 13-75:  Annotation 

Preset Parameter Description

Enable Lets you annotate the image. 
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DICOM Query/Retrieve

DICOM Query/Retrieve provides a list of patients sorted by 
query parameters. 

NOTE: Some PACS vendors only offer Query/Retrieve as an option. 
Please confirm that this service is available. 

Verify Before 
Query

Box Checked. The system DOES CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query/Retrieve 
request. This way, the system ensures that the PACS or HIS/
RIS server is ’alive’ before performing the actual query. If the 
server is down, the scanner will not issue the query request and 
the system is accessible to the user within the configured “Verify 
Timeout (sec.)” preset value which is ~10 minutes.

Box unchecked. The system DOES NOT CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query/Retrieve 
request to the PACS or HIS/RIS server. If the server is down, the 
scanner is accessible only AFTER configured query timeout 
value with configured number of retries which is ~5 minutes. 

Table 13-76:  DICOM Query/Retrieve

Preset Parameter Description

Maximum Results Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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DICOM Query/Retrieve  (continued)

NOTE: If you are experiencing problems with slow responses from 
DICOM servers, increase the time-out in the DICOM server 
properties dialog. (Utility -> Connectivity -> Service -> Properties 
-> Maximum Retries and Timeout). Problems with slow 
responses may result in images being re-sent automatically and 
low transfer rates. The retry settings can be used to make jobs 
retry on bad networks. When portable (off-line), use minimum 
time-out and no retries or it will affect shutdown speed.

Table 13-77:  DICOM Query/Retrieve Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters. 
The following searches are allowed: Patient Name, Patient ID, Modality, 
Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician’s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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Query/Retrieve Per Series

You can now display/retrieve multiple series by patient on the 
Patient--> Data Transfer--> Q/R page. 



Advanced Features

13-382 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

DICOM Storage Commitment

DICOM Storage Commitment provides acknowledgement from 
PACS that the study has been accepted into archive.

Table 13-78:  DICOM Storage Commitment

Preset Parameter Description

Associated Storage This selection is based on the services entered by the user. 
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DICOM Worklist

DICOM Worklist provides a list of patients sorted by query 
parameters.

Figure 13-201. DICOM Worklist Service

Verify Before 
Query

Box Checked. The system DOES CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query/Retrieve 
request. This way, the system ensures that the PACS or HIS/
RIS server is ’alive’ before performing the actual query. If the 
server is down, the scanner will not issue the query request and 
the system is accessible to the user within the configured “Verify 
Timeout (sec.)” preset value which is ~10 minutes.

Box unchecked. The system DOES NOT CHECK the DICOM 
connection status PRIOR to issuing the Worklist Query/Retrieve 
request to the PACS or HIS/RIS server. If the server is down, the 
scanner is accessible only AFTER configured query timeout 
value with configured number of retries which is ~5 minutes. 

Table 13-79:  DICOM Worklist

Preset Parameter Description

Max. Result Specify the maximum number of patient records you want the system to 
retrieve when searching the patient database.

Search Criteria Displays the Search Criteria window, where you can enter search parameters 
for the system to use when searching the patient database.
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Table 13-80:  DICOM Worklist Search Criteria 

Preset Parameter Description

Select Search Criteria to 
Add

Select the type of information that you want to define for search parameters. 
The following searches are allowed: Patient Name, Patient ID, Modality, 
Scheduled Procedure Start Date, Start Time, and End Time. 

Tags (at least one) The name of a tag selected to use for search criteria.

Properties: Value Type the value of the Selected Tag item. For example, if you select Referring 
Physician’s Name in the Select Tag field, you can enter the name of the 
physician in the Value field. 

Properties: Don’t Use Select to turn off the selected search criteria. To exclude a tag from the worklist 
query, select Don’t Use and then select Add to List.

Add Select to add the tag and value to the list of search criteria.

Remove Select to remove the tag and value from the list of search criteria.

Clear Clears all tags. 
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Query/Retrieve (Search and retrieve the data from DICOM device)

You can display/retrieve individual images or multiple series by 
patient on the Patient--> Data Transfer--> Q/R page.

NOTE: For Query/Retrieve to find a patient, the patient MUST have a 
Patient ID. 

Query

1. Press Patient and select Data Transfer. The Data Transfer 
screen displays.

2. Select Q/R. The patient/exam list in the Local Archive 
displays in the Transfer To section.

NOTE: Only “Local Archive - Int.HD” is enabled for Transfer To.

3. Select the Query/Retrieve server from the Transfer From 
pull-down menu.

NOTE: The server is configured in the Utility screen. Multiple 
servers are able to be configured.

4. Press Query in the Transfer From section. The Query is 
performed.

5. The server’s patient list displays.

NOTE: Press Query again to refresh the list.

Retrieve

1. Select the patient(s) or the exam(s) to be retrieved from the 
patient list.

2. Press Transfer. Retrieve the data from the Query/Retrieve 
Server. The progress bar displays during the transfer.
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One Click Query/Retrieve (One Click Q/R) 

When a patient is selected on the Patient Screen, you can press 
the Query This Patient button on the Patient Screen to initiate a 
DICOM Query. 

1. Select the patient.

2. Select Query This Patient.

The following occurs automatically:

• The patient is registered (if needed)

• The Data Transfer page appears with the following steps 
automatically performed: 

• The Q/R service is selected. 

NOTE: If there is more than one Q/R service defined, the last 
one used is selected by default.

• The current patient ID is filled in as the Search Criteria 
(not editable by the user). 

• The Query is initiated. 

The Queried patient is expanded to show a full list of series with 
the most recent series at the top. 

NOTE: The current active series is not listed. 
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One Click Query/Retrieve (One Click Q/R)  (continued)

If the retrieved patient has a single study, the system 
automatically imports that exam. If the retrieved patient has 
multiple exams, then: 

1. Manually select exam(s) for transfer. 

2. Press Transfer. The Retrieve is completed without any 
confirmation required by the user regarding the patient 
already existing. 

After the retrieve completes, the system automatically returns to 
the Patient screen with the same patient and exam active as 
when the Query This Patient was first selected. 

If the Retrieve fails, the system does not auto return to the 
Patient screen. 

If the user manually returns to the Patient screen or otherwise 
exits the Data Transfer screen, the same patient and exam are 
active as when the Query this Patient button was first selected. 
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Send To (Send the image to the DICOM Device)

“Send To” sends the selected exam for a patient and to 
interactively Send-To the exam to a destination DICOM device 
configured on the system. An exam in this case includes its 
images and any corresponding Structured Report.

1. Search and select the patient and press Review. The 
Patient Exam screen displays. 

2. Select the exam which has the images and press Send to.

NOTE: You can only select “Local Archive - Int.HD” for Workflow.

The Send To Dialogue box displays. 

3. Select the destination device and press OK.

NOTE: The destination device is configured in the Utility screen. 
Multiple devices are able to be configured.

The successful/unsuccessful message is displayed at the 
bottom of the screen.
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Selectable Send To

“Selectable Send To” sends the selected exam image(s) and  
from the Local Archive or DICOM Read device to a destination 
DICOM device configured in the system via Utility--> 
Connectivity--> Service.

1. Select a patient or an exam in the Patient menu.

2. Go to Active Images.

3. Select an image (images) and press Send To. The Send To 
Dialogue displays.

NOTE: If the image is not selected, a warning dialog is displayed 
and no image is sent. 

4. Select a destination from the pull-down menu and press OK.

“Selected image(s) is (are) send to” message displays on 
the status bar.

NOTE: Active Images menu and the Touch Panel shall not have “Send 
To” button if the patient is not selected.
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Using the DICOM Spooler

To monitor/control DICOM jobs, press F4. You can view, resend, 
redirect, and delete images from the DICOM spooler by 
selecting a job, then specifying the action to be performed on 
this job. 

NOTE: If you find a failed job(s) in the Spooler, please remove the failed 
job(s) from the Spooler. 

CAUTION If working off-line with a dataflow pointing to a DICOM server, 
the images stored during the examination may have to be 
manually resent in the DICOM spooler when reconnecting the 
unit. Resend all jobs that are failed or on hold.

Table 13-81:  Spooler status description

Status Description

Hold Waiting for user activity.  Select Resend or Send-To to complete the job. 

Pending Waiting for the previous job(s) to finish (a previous job may be Active or 
Pending).
No user interaction required.

Append Not completed. 
Example 1: Direct Storing job.  Waiting for more images or the end of the 
exam (by selecting New Patient or End Current Patient).  
Example 2: Print job with 3x3 images has only 8 images.  Waiting for one 
more image or the end of the exam (by selecting New Patient or End Current 
Patient).

Active Signifies network activity (or connection attempt).

Success Sent successfully.

Failed Unsuccessful job attempt.  Job stays in spooler. Select Retry or Delete to 
complete the job.

Done Finished successfully.
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Load DICOM Volume Dataset

To load a pre-acquired DICOM volume dataset, 

You can exit and re-enter V Nav and retain the Dataset by 
pressing the V Nav control. OR, to discard the pre-acquired 
Dataset, press Exit and Clear on the Touch Panel. 

From disk

NOTE: Volume  datasets  that  can  be  loaded  from  disk  may  include  
CT,  MR, PET, XA, DX and Invenia (US).

1. If applicable, insert the media containing the pre-acquired 
3D dataset. 

2. Press Load and select from Disk.

3. Double click on the DICOMDIR or database file (or single 
click and select the Open button). 

4. Navigate to the location of the 3D dataset. 

5. A list of patients and a list of image series for each patient 
displays. Highlight the Series you want to import and select 
Import Series.

Figure 13-202. Selecting the Patient’s 3D Dataset
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From disk  (continued)

6. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These are 
remained on the live scanning image. 

Figure 13-203. Check Patient Data Dialog

NOTE: If Hide Patient Data preset (Utility->System->General) is set 
to "On Store", then the patient data is removed from the 
volume dataset prior to image storage and then redisplayed 
after image storage.

7. B-mode image displays on the left side and the loaded 
volume data displays on the right side.
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Load DICOM Volume Dataset  (continued)

From Database

NOTE: Volume datasets that can be loaded from the database: CT, MR, 
PET, XA and Auto Sweep.

1. Press Load and select from Database.

2. Select the desired volume from the Image History screen 
and press Load.

3. The Check Patient Data screen appears. Confirm that the 
patient information matches the patient associated with the 
current exam. After verifying patient information, press 
Accept (or Reject). You can also specify to display Patient 
Data by checking the Display Patient Data box. 

If you turn on “Display Patient Data”, Patient name, ID and 
birth date are displayed on the Volume data. These are 
remained on the live scanning image. 

Figure 13-204. Check Patient Data Dialog

NOTE: If Hide Patient Data preset (Utility->System->General) is set 
to "On Store", then the patient data is removed from the 
volume dataset prior to image storage and then redisplayed 
after image storage.

NOTE: If you Load From Database and want to cancel out, use the 
Exit button on the Image History screen.

4. B-mode image displays on the left side and the loaded 
volume data displays on the right side.
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Load Multi Volume Datasets

You can load multiple datasets (up to 10 datasets) of same study 
at the same time: 

Sometimes there are multiple acquisitions stored within a single 
series. When you select Load All, these are loaded as one 
dataset (if they are not overlapping) or as two datasets (if two or 
more datasets are overlapping). 

1. Load dataset from disk, check data of the Select Series 
pop-up.

Figure 13-205. Select Series pop-up

Load dataset from database, select one image from each 
exam and press Load in the Image History screen.

Figure 13-206. Image History screen
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Load Multi Volume Datasets  (continued)

2. V Nav screen and multiple dataset menu are displayed.

Table 13-82:  Multiple dataset menu

Item Description

1-5 Dataset List (CT, US and MR in this example)

1 Active Dataset Indicator

2 Name of dataset

3 Visivility Indicator

4 Display Weighting

5 Display Color

6-12 Control Area

6 Single Display

7 Multiple Overlapping Display

8 Color Control

9 Volume-to-Volume Registration

10 Delete

11 Compare Volume

12 Expand/Collapse Dataset list
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Load Multi Volume Datasets  (continued)

Using the Touch Panel control, you can adjust: 

NOTE: When you select Save Volume on the Touch Panel, all 
volumes are saved to a single file on the Clipboard, 
including GPS Markers. 

Table 13-83:  

Item Description

1 Toggle Up/Down: Select the dataset.

2 Push: Fix the selected dataset.

3 Rotate: Weight Dataset. You can weight the overlay amount of 
the volume dataset. 

4 Dataset number and its Weight (%)
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Load additional volume datasets

Whenever a dataset is loaded and you want to load another 
dataset from disk, from clipboard or from database or if you 
generate a dataset and switches then back to VNav, the system 
asks you that add the dataset as an additional or replace the 
existing dataset(s).

If you choose to add the dataset, the necessary adaption of the 
datasets with regard to size and resolution will be performed 
automatically at the end of the load.



Advanced Features

13-398 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Tricefy Uplink

Introduction

Tricefy is a cloud-based image viewer and a platform to archive, 
collaborate, and share. The Tricefy DICOM server may be used 
in the way any DICOM server on the product may be used, i.e., 
Print keys, Send To, etc. The corresponding DICOM 
destinations can be used via the Print keys. An internet 
connection is necessary for uploading data to Tricefy. 

NOTE: To engage in service offerings with Tricefy, confirm that your 
country has entered into an agreement with Tricefy. 

NOTE: Tricefy DOES NOT support IPv6 and cannot be used in 
conjunction with Tricefy. 

Figure 13-207. Tricefy Account

The tab displays a general info area with a short description of 
Tricefy, an uplink ID, and an info badge for how to configure 
Print buttons on system setup (only available when an account 
is active). Furthermore the account area displays controls and 
information about the Tricefy account while the test connection 
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area enables you to test a connection and gives detailed 
information about it.
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Uploading Exam Information to the Tricefy Cloud

Enabling Tricefy

1. To enable Tricefy, fill out the information on Utility --> 
Connectivity--> Tricefy. As soon as this option is enabled, 
relevant Tricefy items are displayed (e.g. email text field, 
Activate button,.... and options within the system setup to 
share or store data to Tricefy via the print key or status bar 
icons (described below). 

2. Enter your email address to register and click Activate 
account. (If you want to deactivate an active account, click 
Deactivate account.) 

3. Depending on the account status, different account 
information is displayed:

• green badge containing the account info, email address, 
account name, customer name and account status- 
account activated

• blue badge - information about a disconnected account

• orange badge - connection to Tricefy™ failed (due to 
timeout,...)

4. For testing the connection click Activate. Depending on the 
connection status, different information is displayed:

• green badge - connection ok

• blue badge - instruction for testing the connection (only 
displayed as long as Activate is not pressed)

• orange badge - connection failed

5. Upon success activation, you will receive an Uplink ID. 

NOTE: When tricefy is successfully activated an image storage and 
Query//Retrieve service will be created with port number 
8104. 
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Configuring Tricefy

1. Set up the Tricefy Service via Utility > Connectivity > 
Service. Set the DICOM Image Storage and Query/Retrieve 
ports to Port 8104. Refer to the DICOM sections in this 
chapter and in Chapter 10 for more information. Verify the 
service.

2. Set up a Dataflow for Tricefy. Refer to the DICOM sections 
in this chapter and in Chapter 10 for more information. Verify 
the Dataflow. 

3. Configure the Print buttons via Utility > Connectivity > 
button. Refer to the DICOM sections in this chapter and in 
Chapter 10 for more information. Verify the Print button(s). 
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Using Tricefy

1. You can send a patient’s exam to the Tricefy Image Storage 
service via the Exam Tab. . 

1. Select the patient’s exam and press the Send To button. 
Select the Tricefy Image Storage service. Press OK.  

You can check the job status by pressing F4 (DICOM Job 
Spooler).

You can confirm the exam is on the Tricefy Server via a web 
browser. Navigate to https://tricefy4.com. Log in with your 
account information. The patient and image(s) you sent are 
on the Tricefy cloud. 

2. To Query/Receive patient information on the Tricefy cloud, 
on the Patient page, go to the Data Transfer page. Select 
the Q/R radial button, then press Query. A list of patients on 
the Tricefy cloud is displayed. Select the patient you want to 
retrieve, then select Transfer. 
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Tricefy Icons

Tricefy icons are explained below. 

Tricefy Activation

Refer to Chapter 10 for more information. 

Table 13-84:  Tricefy Icons

Connection Icons Store Icons Share Icons

Connected to Tricefy. Ready to 
Store and Share

Upload Image to Tricefy Share Image with Patient via 
Tricefy. 

Disconnected from Tricefy. Upload CINE to Tricefy Share CINE with Patient via 
Tricefy. 

Registration incomplete. Upload 4D Image to Tricefy
ri

Upload 3D Image to Tricefy
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Report Writer

Introduction

The LOGIQ P8/P9/P10 enables the generation of patient reports 
based on the examination performed and the analyses that were 
made during the exam. The reports are generated using the 
data stored in the system with pre-selected templates.

You may edit a report while performing the exam; customize, 
delete, or add measurements; and save changes until you use 
the Store command. Once Stored, the reports are read-only.

It is recommended that the data be saved often, and then 
carefully reviewed before the report is Stored. Use the 
worksheet to facilitate the review and adjust data before storing 
a report. The final report can be printed on a standard printer.
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Creating a report

Reports summarize the data obtained in the examination. They 
can contain data, images, and cine loops.

Once generated, the report can be viewed, images can be 
added, and the patient’s personal data can be modified. The 
examination data itself CANNOT be changed.

Figure 13-208. Report Example

Name : GE Test     Patient ID : 123-4567            Date : 07/09/2004

Comments

Test exam
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Activating the Report

1. Select Reports on the Touch Panel. 

2. The system displays the default report for the current 
application on the monitor. 

The information entered during the examination is 
automatically filled in the appropriate fields (e.g. 
demographic, diagnosis, comments).

The preview image appears when the cursor is over the 
clipboard image.

NOTE: The template is the skeleton of your report. It is composed 
of different objects that can be customized by the user.

3. Adjust the Page Change control to move down the page.

 Figure 13-209. Report Page Example
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Activating the Report  (continued)

Table 13-85:  Report Button Controls

Button Description

Print Prints out the report to the default printer.

Store Stores the report page into Archive as CHM* file.

Retrieve Retrieves the report page from Archive.
Stored Date/Time is appended to the name of stored report.

Template Selects template from the list of selected applications. 

Designer Accesses template editor screen.

Save As Exports the report page to storage media as CHM or PDF format. 

Delete Deletes the report page from Archive.

Worksheet Accesses Worksheet Page.

Graph Accesses OB Graph page (applies only to OB).

Anatomical Page Accesses Anatomical Survey page (applies only to OB).

*CHM is a compressed HTML help file.
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Selecting another template

You can select another template for the current patient:

1. Select TEMPLATE at the bottom of the monitor display or 
the Touch Panel.

2. A list of available templates and exam categories 
(Abdomen, Adul, Carotid, etc.) displays.

3. Select the desired template using the Trackball/Trackball
and press Set.

The selected template displays on the monitor.

NOTE: If you select another exam category, the template list of the 
selected category displays. Select the desired template.

Figure 13-210. Available Template list

4. Select the desired template name and press Set.

5. The report changes to the selected template.
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Factory Templates

The system has factory templates for each application. You can 
modify these templates or create user-defined templates. You 
need to save revised/new templates with unique names. 

A template may include one or more of the following:

• Measurements

• Worksheet or Vessel Summary Images

• Anatomical Surveys or Biophysical Profiles

• Anatomical Graphics

• Graphs

• Images areas

• Score Boxes

NOTE: Additional factory templates can be added from the 
Utility-->Report menu (OB for multiple gestation, Renal, etc.). 
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Editing a Report

Entering the hospital address

When using a factory template, the area for the hospital 
information is usually placed in the upper portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-448  for more 
information.

To modify the factory template:

1. Select Reports.

2. Select Designer.

3. Double-click on the area for the hospital information in the 
template. The Fixed Text dialogue box displays.

Figure 13-211. Fixed Text Dialogue Box

4. Make changes as necessary.

a. Enter the hospital address in the text area.

b. Modify Box Properties (box width, box border line width, 
text align, box height, box left margin, and font).

5. Select OK.
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Entering the hospital address  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
appends “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and appends “[user]”. 
For example, NewReport[user].

7. Exit the Report Designer. The report with the hospital 
address displays.
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Inserting the hospital logo

When using a factory template, the area for the logo is usually 
placed in the upper left portion of the report.

To make a new area, see ‘Fixed Text’ on page 13-448  for more 
information.

To modify the factory template:

1. Save the preferred hospital logo in either a jpeg or bmp 
format on the removable media.

NOTE: Label the logo with a unique name (e.g. 
HospitalNameLogo.bmp).

2. Insert the removable media.

3. Select Reports.

4. Select Designer.

5. Double-click logo box at the left top so that the frame is 
highlighted. The logo box displays.

Figure 13-212. Logo Box
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Inserting the hospital logo  (continued)

6. Select Import Logo (1). Select the CD drive first and then 
the hospital logo.

7. Select OK. The hospital logo displays in the logo list (2). 
Click the logo to select.

NOTE: Scroll the logo list using the left/right arrow key (3).

8. Modify Appearance (4).

9. Select OK.

10. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

11. Exit the Report Designer. The template with the hospital 
logo displays.

NOTE: If a different logo prints on the report, rename the logo image 
which you want on the report and insert it into the report 
template again.
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Changing the Archive Information

When using a factory template, the Archive Information is 
usually placed below the hospital name and logo. 

The contents of the Archive Information is inserted through the 
related page automatically. If you want to change the 
description, such as Information or Comments that was entered 
in the patient menu:

1. Double-click the yellow text to be changed, e.g. Information 
or Comments.

The area where the description was entered (e.g. Patient 
menu) displays.

2. Change the existing data as necessary.

3. Select Report to return to the report.

Figure 13-213. Patient Information Area (Example)
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Modifying the displayed objects of Archive Information

1. Select Designer.

2. Double click on the area for the Archive Information in the 
template. The Archive Information Box displays.

 Figure 13-214. Archive Information Box

3. Click the checkboxes to select and deselect the objects. 

Objects with checkmarks will appear in the report template.

4. Select Box Properties to change the font, font size, font 
color, or box size, and select OK.

5. Select OK to return to the Report Designer.
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Modifying the displayed objects of Archive Information  (continued)

6. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

7. Select File -> Exit to leave the Report Designer.

Entering free text

You can enter free text to the report using the alphanumeric 
keyboard.

The factory template terms their text area as “Summary or 
Comments”. 

1. Move the cursor to the text field and press Set.

NOTE: You can enter the text only to the field set as free text in the 
Report Designer.

NOTE: DO NOT enter “%s” in a free text field and then try to edit/
save the template in the Report Designer. 

2. Type the text.
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Inserting Text

1. Select Designer.

2. Move the cursor where the text is to be inserted and press 
Set.

3. Select the Text Field from the Insert menu. The Text Field 
dialog box displays.

Figure 13-215. Text Field Dialogue Box

4. Select the appropriate display items:

• Ref. Reasons: Retrieves this information from the Direct 
Report

• Comments: Retrieves this information from the 
Comment field of the patient screen and the Exam 
Comment field of the worksheet.

• Diagnosis: Retrieves this information from the Direct 
Report

• Free Text 1 - 8
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Inserting Text  (continued)

5. Type the heading Text.

6. Modify box properties, the heading text and font, and data.

7. Select OK or Cancel. 

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

Inserting an image to the report

Some factory templates include an image area. If you want to 
insert or modify the image area, see ‘Image Display Fields’ on 
page 13-440  for more information.

To insert images from clipboard into the image field of the report:

1. Move the cursor to the desired image on the clipboard.

NOTE: The preview image appears when the cursor is over a 
clipboard image.

2. Press and hold down the Set key and drag the selected 
image to the report by using the Trackball or double click 
the Set key on the desired image. 

3. To move images between image areas, press and hold 
down the Set key and using the Trackball, drag the 
selected image to the new location.

To remove an image from the report, press and hold down 
the Set key and using the Trackball, drag the select image 
back to the clipboard.
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Measurement result section

Measurement results for the current patient display 
automatically if you have the measurement section in the report 
template.

The factory template has an appropriate measurement result 
area. If you want to insert or modify the measurement area, see 
‘Measurements’ on page 13-446  for more information.

 Figure 13-216. Measurement section
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Inserting the worksheet

You can insert the worksheet (like you can insert an image) to 
the image display field.  To set an image display field in the 
report template, see ‘Image Display Fields’ on page 13-440  for 
more information.

1. Display the worksheet on the monitor display.

2. Save the worksheet using the Print key.

3. Press Report.

4. Drag the worksheet into the report.

a. Move the cursor to the desired worksheet on the 
clipboard.

b. Press and hold down the Set key. Use the Trackball to 
drag the selected worksheet into the Image Display 
Field.

c. Release Set.

NOTE: You can also move the cursor to the desired worksheet on 
the clipboard, double-click the worksheet, move the cursor 
to the Image Display Field, and select Set.

5. The worksheet displays on the report.

NOTE: You can double-click the worksheet in the report to change 
the background color to white to save ink during printing. 
Double-click the worksheet again to return the worksheet to 
the original color.
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Placing objects side-by-side

If you want to place images, the image and comment, 
anatomical graphic and comment, etc. side-by-side, you must 
first place a table, which has two (or more) columns, into the 
report template.

1. Select Report.

2. Select Designer to display the Report Designer.

3. Place the cursor where you want to insert the object.

4. Select Table from the Insert menu. Insert Table box 
displays.

Figure 13-217. Insert Table Box

5. Set the number of columns to 2 (or more, as required) and 
change the table parameters, if needed. Select OK.

NOTE: If you do not need a table border, set the Border to 0. Add 
additional rows if required.

6. Place the cursor in the column and select the desired items 
from the Insert menu (e.g. logo, image, free text). Specify 
those items.

7. Repeat step 6 for each column as required.
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Placing objects side-by-side  (continued)

8. Save the template.

To keep the same template name:

• Select Save from the File menu, and press Set. The 
Save Template dialog box opens. 

• Select Yes. The template retains the same name and 
adds “[user]”. For example, OB23-Basic[user]. 

To save the template with a new name:

• Select Save As from the File menu, and press Set. The 
Save Template As dialog box opens. 

• Enter the name of the new template, and press Set. The 
template receives the new name and adds “[user]”. For 
example, NewReport[user].

You can insert the images in the order preferred, by row or 
column, on the factory templates. See ‘Inserting the Table’ on 
page 13-432 for more information.
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Accessing Worksheet, OB Graph and Anatomical Survey Pages

If the Worksheet, OB Graph, and/or Anatomical Survey pages 
have been saved for the current patient, you can access these 
pages from the report page.

NOTE: OB Graph and Anatomical Survey pages applies to OB, GYN 
and Abdomen.

1. Select either Worksheet, Graph or Anatomical Page on 
the Touch Panel.

NOTE: There is also Fixed Text set up as hyperlinks for these 
pages. Cursor to the fixed text and press Set.

2. The system displays the appropriate page (Worksheet, OB 
Graph or Anatomical Survey) with the corresponding Touch 
Panel.

3. Select Report to return to the Report page.

Storing the Report

1. Select Store.

The Report is saved as a CHM file to Archive. 

NOTE: The archived report cannot be edited; therefore, it is 
recommended that the data is carefully reviewed before the 
report is saved.

Retrieving an Archived Report 

1. Select Retrieve. The Retrieve menu displays.

Figure 13-218. Retrieve Menu (Prefix “User1\” may not 
appear)

2. Select the desired report and press Set.

NOTE: The retrieved report cannot be edited.
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Deleting a Report from Archive

1. Select Delete. The Retrieve menu appears on the screen.

Figure 13-219. Delete Reports Menu (Prefix “User1\” may not 
appear)

2. Select the report to delete and press Set.

Printing the Report

To preview the Print Layout before printing, see ‘Preview the 
Print Layout’ on page 13-430  for more information.

NOTE: Double-click the worksheet and/or image in the report to change 
the background color to white A white background will save ink 
during printing. Double-click the worksheet or image again to 
return to the original color.

1. Select Print to print out the report.

The Report is printed on the default printer.
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Exporting the Report to Media

1. Select More.

2. Select Save As.

The Save As dialog box appears on the screen.

3. Enter the Report title and select the file format.

4. Select the media to export the Report. The system supplies 
a name (numeric DICOM UID, unique identifier). 

Figure 13-220. Save as Dialog Box

5. Select Save.

Exiting the report

1. Select Store to save the report.

NOTE: If the user is working on a report and leaves the report 
screen for any reason, all information added to the report is 
automatically saved without loss of data.

2. Select another key to close the report page.
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Designing Your Own Template

Template Designer

You can design and create your own customized template from 
a blank template page, or you can use an existing template 
(factory or user-defined) and save the changes.

Display the desired template and select Designer to open the 
Template Designer page.

 Figure 13-221. Report Designer
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File Menu

Create a new  template

To design a new template without using a pre-existing factory 
template:

1. Select Designer to open the Report Designer.

2. Select New from the File menu, and press Set.

The blank template displays.

3. Create the report template as needed.

4. Select Save from the File menu, and press Set.

The Save Template As dialogue box displays.

5. Enter a template name and click OK.

6. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

Table 13-86:  File Menu

Description

New Creates a new template. A blank template appears. 

Save Overwrites the existing template.

Save As Saves as a new name.

Page Setup Enters Print Layout screen.

Print Preview Executes print preview.

Exit Exits Report Designer page.
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Create a new template and save as a factory template name 

To design a new template by modifying an existing factory 
template and keeping the same name of the factory template:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. To save changes, select Save from the File menu, and 
press Set.

The Save Template dialog box displays.

• Yes: Saves changes.

• No: Does not save changes.

• Cancel: Returns to Report Designer.

NOTE: The template name displays in the template list, retains the 
same name, and adds “[user]”. For example, 
“OB23-Basic[user]”. You do not lose the original factory 
template.

5. To exit Report Designer, select Exit from the File menu, and 
press Set.

• Yes: Saves changes and exits Report Designer.

• No: Does not save changes and exits Report Designer.

• Cancel: Returns to Report Designer.

HINTS Save changes frequently as you modify your template. Saving 
often reduces the risk of losing all your changes.
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Create a new template and save  with a new name

To design a new template by modifying or copying an existing 
factory template and saving it with a new name:

1. Select and display the existing factory template.

2. Select Designer to open the Report Designer.

3. Modify the report template as needed.

4. Select Save as from File menu and press Set.

 The Save Template As dialog box displays.

5. Type the new template name and click OK.

6. Select Exit from the File menu and Set.

7. The Report Designer closes and returns to the Report Page.

NOTE: The template receives the new name and adds “[user]”. For 
example, NewReport[user].

Page Setup

1. Modify the factory template as necessary in Designer.

2. Select Page Setup from File menu and press Set.

3. Change the paper size or orientation to fit the print layout, as 
necessary.

To define the header and footer for the printed report, type 
text and enter the required variables listed in the table 
below. Select “Different for first page” and enter a specific 
header/footer for that page.

NOTE: Default is left aligned. Report will appear as black ink on 
white background.

Table 13-87:  Variable and Definition

Variable Definition Variable Definition

{pid} Patient ID {prt} Current time (printing time)

{pnm} Patient name {cp} Current page

{pbd} Patient date of birth {tp} Page count

{exd} Examination date {c} Subsequent text is centered

{prd} Current date (printing date) {r} Subsequent text is right aligned.

{inm} Institution name
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Page Setup  (continued)

4. Select OK or Cancel.

Figure 13-222. Page Setup with Header Example

Preview the Print Layout

1. Select Template to choose the Report Template.

2. The Print Preview screen displays.

If changes need to be made, select Close to exit the 
Preview page. Modify the template or return to the Report 
and modify the contents.

Edit Menu

Deleting a template object

1. Select the object to be deleted.

2. Select Delete from the Edit menu, and press Set. The 
object is deleted from the template.

Undoing the operation

1. Select Undo from the Edit menu, and press Set.

2. Repeat as required.

Table 13-88:  Edit Menu

Description

Delete Deletes the selected object from the report template.

Undo Restores the previous state(s) of the report template.
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Insert Menu

Inserting the Page Break

1. Place the cursor where the Page Break is to be inserted and 
press Set.

2. Select Page Break from the Insert menu and press Set. The 
page break line displays on the template.

NOTE: To edit the page break line, select the line and double click 
the Set key.

Table 13-89:  Insert Menu

Description

Page Break Inserts a Page Break.

Table Inserts a Table.

Logo Inserts a Logo Bitmap File.

Archive Info Inserts Archive Information.

Anatomical Graphics Selects anatomical graphics by category to be inserted into a field.

Anatomical Survey Selects OB, GYN or Abdomen.

Image Inserts the image display field to the template.

Wall Motion Analysis Selects Cut Planes, Bull’s Eye, or Score Table Box.

OB/GYN Selects OB Graph, Bar Graph or Anatomy.

Small Parts Selects Breast or Thyroid.

Measurements Inserts the measurement display field in the template.

Text Field Edits text field.

Fixed Text Enters any comments as Fixed Text.
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Inserting the Table

1. Place the cursor where the table is to be inserted and press 
Set.

2. Select Table from the Insert menu and press Set. The Insert 
Table dialog box displays.

Figure 13-223. Insert Table Dialog

3. Specify each parameter as required.

NOTE: To set the table border as not visible, set “Border” parameter 
to 0 (zero)

4. Select OK to insert the table or Cancel. 

NOTE: To insert/delete a row/column from the table or access table 
properties, double click the Set key in any empty area inside 
the table. A table menu appears with those options.
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Inserting Images in a Table

You can choose the order in which images are inserted into 
tables: by row (default) or by column.

Image Order by Row

The system default inserts images in the cells of the first row, 
then to the next row. 

Figure 13-224. Image Order—Row Preference 
(System Default)

1. Follow the instruction for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=2

2. After inserting the table, insert an image box in each cell of 
the table.  

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the table.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed in the default order.
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Inserting Images in a Table  (continued)

Image Order by Column

If you prefer to have the image placement by column, images 
are inserted in each cell of the first column, then the next 
column.

Figure 13-225. Image Order—Column preference

In order to achieve the column preference, you need to create a 
table with 2 columns and 1 row. In each cell of this table, you 
need to insert another table.

1. Follow the instructions for inserting a table. When specifying 
parameters, specify:

No. of Columns=2; No. of Rows=1

2. After inserting the table, create a table inside each of the 
existing table’s cells.  

a. Move the cursor to the left column’s cell and press Set.

b. Select Table from the Insert menu and press Set.

c. When specifying parameters, specify:

No. of Columns=2; No. of Rows=1; Width=290 pixels.

Select OK.

d. Repeat steps a-c for the next column.

3. Insert an image box to each table cell. 

a. Move the cursor to the first cell and select Insert -> 
Image.

b. Repeat this step for each cell in the 2  tables.

After the template is saved and you are working in the 
ReportWriter, when you select images to be inserted in the 
table, they are placed with your column preference.
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Inserting Logos

1. Place the cursor where you want to insert the logo and 
press Set.

2. Select Logo from the Insert menu and press Set. The Logo 
Box displays.

Figure 13-226. Logo box

3. Select a logo that you want to insert (1). or import a bmp or 
jpg file from the removable media (2). Scroll the images 
using the arrow key (3). Specify the appearance (4).

4. Select OK to insert the logo or Cancel.

Changing a logo:

1. Place the cursor on the logo to be changed and press Set
twice. The Logo Box displays.

2. Select a different logo. If the desired logo is not shown, 
select Import Logo to import a different logo.

3. Specify the appearance.

4. Select OK or Cancel.
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Inserting Archive Information

Archive information contains all the objects from the different 
information menus (Patient, Exam, and Site Information). This 
box accumulates different information menu selections that can 
be grouped together and displayed in one table.

1. Place the cursor where you want to enter the archive 
information and press Set.

If you use a factory template, double click on the current 
archive information area to display the Archive Information 
Box.

2. Select Archive Info from the Insert menu and press Set.
The Archive Info Box displays.

Figure 13-227. Archive Information Box

3. Type the Heading, select a heading link from the pull-down 
menu, and select the parameters you want to display in the 
report.
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Inserting Archive Information  (continued)

4. Select Box Properties to change the Font, Alignment, 
Appearance, etc.

NOTE: To set the same font to all fields, select Set All fields.  

Figure 13-228. Table Properties

5. Select OK or Cancel. The contents of the Archive 
Information is inserted to the related page automatically.

Figure 13-229. Patient (Archive) Information Example
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Inserting Archive Information  (continued)

Editing displayed Archive Information:

1. Select Designer.

2. Move the cursor to Archive Information field to be edited.

3. Press Set twice. The Archive Information Box displays.

4. Edit the heading, the Heading Link and Information 
parameters, as necessary.

5. Select OK to save or Cancel.
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Anatomical graphics

1. Place the cursor where you want to insert the Anatomical 
Graphics and press Set.

2. Select Anatomical Graphics from the Insert menu.

3. Select the desired category and press Set. The graphic box 
displays.

Figure 13-230. Anatomical Graphics Box Example

4. Select the graphic to be inserted to the template or import a 
bmp or jpg file from the removable media. Scroll the images 
using the arrow key. 

5. Select Appearance.

6. Select OK or Cancel.
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Image Display Fields

1. Place the cursor where you want to insert the image.

2. Select  image from the Insert menu and press Set. The 
Ultrasound Image Box displays.

Figure 13-231. Ultrasound Image Box

3. Type the Heading text, modify the box properties, and 
change the heading text font, as necessary.

NOTE: For no heading, type a Space in the Heading text.

To keep the monitor image appearance, the ratio of width to 
height (W:H) should be 4:3. So, basically 640:480 for large 
images and 300:225 for two side-by-side images.

4. Select OK or Cancel.

Cardiac Studies Wall Motion Analysis

1. Place the cursor where you want to insert the wall motion 
analysis and press Set.

2. Select Wall Motion Analysis from the Insert menu.
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Cardiac Studies Wall Motion Analysis  (continued)

3. Select and set up the desired parameter.

• Bull’s Eye

Figure 13-232. Bull’s Eye Dialog Box

 Figure 13-233. Bull’s Eye Report Example
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Cardiac Studies Wall Motion Analysis  (continued)

• Cut Planes

NOTE: The Cut Planes dialog box parameters are similar to the 
Bull’s Eye Dialog Box shown previously.

 Figure 13-234. Cut Planes Report Example

• Score Table Box

Figure 13-235. Score Table Box Dialog Box
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OB/GYN (OB and GYN Only)

The OB Graph, Bar Graph and Anatomy can be entered into the 
Report.

1. Place the cursor where you want to insert the graph or 
anatomy and press Set.

2. From the Insert menu, select OB/GYN. The selection menu 
displays.

3. Select the appropriate item as necessary. A dialog box 
displays.

• OB Graph

Figure 13-236. OB Graph Dialog Box

a. Select the Measurement and Fetus Number.

b. Check Fetus Trending and Fetus Compare, if 
appropriate.

c. Modify the Layout, if necessary.

d. Select OK
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OB/GYN (OB and GYN Only)  (continued)

• Bar Graph

Figure 13-237. Bar Graph Dialog Box

a. Select the exam and fetus number.

b. Modify the Layout, if necessary.

c. Select OK.

NOTE: The Bar Graph already contains default application 
measurements.
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OB/GYN (OB and GYN Only)  (continued)

• Anatomy

Figure 13-238. Anatomy Dialog Box

a. Type the Heading.

b. Select qualifiers from the pull-down menu.

c. Select “Add all” to copy all measurements to the right 
column

d. Check the box in front of the measurement you need in 
the left column and select “Add”. The select 
measurements copy to the right column.

e. To remove measurements you do not need, check the 
boxes in front of those measurements in the right 
column, and select “Remove” or “Remove all”.

f. If you want to modify the properties, select Box 
Properties and set required parameters.
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Measurements

Insert a field to display the measurements. The measured 
parameters displayed in the measurement display field are 
configured.

1. Place the cursor where you want to insert the measurement 
and press Set.

2. Select Measurements from the Insert menu and press Set.
The Measurements Box displays.

Figure 13-239. Measurement Box

3. Type the Heading text, select the Filter Criteria and 
measurements from the tree, as necessary.

4. Select OK or Cancel.
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Text Fields

1. Place the cursor where you want to insert the text and press 
Set.

2. Select Text Field from the Insert menu and press Set. The 
Text Field dialog box displays.

Figure 13-240. Text Field Dialog Box

3. Type the Heading Text. If you do not need the heading, type 
a space.

4. Select Display item.

• Ref.Reason: Reason for Referral.

• Comments: Gets information from the Comment field of 
the Patient screen and the Exam Comment field of the 
Worksheet.

• Diagnosis.

• Free Text: 1 - 8

5. Specify the border of the Text Field and Font as necessary.

6. Select OK or Cancel. 

The text is saved automatically into the corresponding area 
selected on this dialog box.
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Text Fields  (continued)

Editing an existing text field:

1. Move the cursor to the Text Field to be edited.

2. Press Set twice. The Text Field dialog box displays.

3. Edit the heading, the settings, or font, as necessary.

4. Select OK or Cancel.

Fixed Text

1. Place the cursor where you want to insert the fixed text and 
press Set.

2. Select Text Field from the Customize menu and press Set.
The Fixed Text dialog box displays.

Figure 13-241. Fixed Text Dialog Box

3. Type the text (e.g. hospital information, report title, or table 
title) and specify the border and font.

4. Select OK or Cancel.

Editing existing Fixed Text:

1. Move the cursor to the Fixed Text to be edited.

2. Press Set twice. The Fixed Text dialog box displays.

3. Edit the text, the border or font, as necessary.

4. Select OK or Cancel.
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Customize Menu

Page Color

1. To change the page color, select Page Color from the 
Customize Menu and press Set. The Color dialog box 
displays.

Figure 13-242. Color Dialog

2. Choose the desired color or create a new color.

3. Select OK or Cancel.

Table 13-90:  Customize Menu

Description

Page Color Changes the template color.

Preference The Preference menu for Archive Information field displays.
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Setting  Preferences

To set preferences for the Archive Information:

1. Select Preferences from the Customize menu and press 
Set. The Preference Box displays. 

Figure 13-243. Preferences Box

2. Select the information to be modified and set the desired 
preferences.

3. Select OK or Cancel.

4. Save the template.
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Direct Report

You can use Direct Report to enter Comments, Diagnosis, and 
Referral Reasons at any time during the examination that will be 
part of the final report. The comments are reflected on the 
Report if the Report is configured for those parameters. 

1. Select Direct Rep. on the measurement Summary window.

Figure 13-244. Measurement Summary Window
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Direct Report  (continued)

2. The Direct Report displays on the left side of the screen.

Figure 13-245. Direct Report

a. Select the type of information

NOTE: Comments entered under Diagnosis appear in the 
Clinical Diagnosis section of the final report.    
Comments entered under Referral Reasons appear in 
the Referral Diagnosis section of the final report.

b. Create/insert pre-defined text

c. Text field

d. The measurement results display on the Measurement 
Overview field.

Double Click: inserts value only for selected line, 
e.g. 5.98 cm

Shift + Double Click: inserts whole line for selected line, 
e.g. BPD 5.98 cm 

e. Exits the Direct report
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Direct Report  (continued)

3. Select the appropriate parameter and type the free text with 
the alphanumeric keyboard or use Insert Text.

NOTE: You can configure the pre-defined text at the Utility Report 
screen.

a. Select Insert Text to display the Insert Text Window.

b. Use the Trackball to select the text to be inserted.

c. Press Set. The selected text displays on the Direct 
Report.

Figure 13-246. Full Insert Text Window

• New: Enters the new text

• Edit: Edits the existing text

• Delete: Deletes the existing text

• Close: Closes the insert text window

• More>>: Displays the Full Insert Text Window

• <<Less: Minimizes the insert text window

• Move up/Move down: Moves the text up or down

4. Move the cursor over the measurement result displayed in 
the overview window, and double click the Set key. 
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Direct Report  (continued)

5. Select Done at the bottom of Direct Report to exit.

If you configure the field of comment, diagnosis, referral 
reasons or Measurement on the Report, the text and/or 
measurement results entered in the Direct Report are 
automatically displayed on the Report.

Figure 13-247. Direct Report and Report
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Report Presets

You can edit the report template, diagnosis code, and text on the 
Utility Report page.

Templates

Left Column: The list of all templates (Factory Default, User 
defined, etc) 

Right Column: The list of templates displayed on the template 
list.

Figure 13-248. Report Template Tab
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Templates  (continued)

• To insert the template on the template list:

a. Select the application which you want to insert into the 
template from the pull-down menu above the right 
column.

b. Select the category (categories) and/or the template(s) 
in the left column by the check the box.

c. Select the right arrow to copy the template to the right 
column.

• To remove the template from the template list but not from 
the system):

a. Select the template in the right column.

b. Use the left arrow to remove the template from the right 
column.

• To edit the template or to make a new template:

a. Enter Utility -> Report -> Template tab.

b. Select the appropriate template in the left column.

c. Select Edit Template. The Template Designer page 
displays.

d. Edit the template and save or save as with a new name.

If you use Save As with a new name, the new template 
is added to the left column. See ‘Designing Your Own 
Template’ on page 13-426 for more information.

• To delete the template:

a. Select the template to be deleted.

b. Press Delete.
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Templates  (continued)

• To export the template:

a. Insert the removable media in the drive.

b. Move the cursor to “Export Templates” and press Set.
The available user-defined templates display in the 
Export Templates window.

Figure 13-249. Export Templates

c. Select the template(s) to be exported.

NOTE: To select multiple templates, use the Ctrl or Shift keys.

d. Select the desired removable media under the Select 
Target Device field.

e. Select OK.

f. Press F3 to eject the media.

HINTS Export templates to removable media (CDs, DVDs, USBs) 
so, at a later time, you can import those templates to a 
system. Export only works on templates, not data.
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Templates  (continued)

• To import the template:

NOTE: Import only works on templates, not data.

a. Insert the removable media with the report template(s) 
to be imported.

b. Select Import Template. The Import Template window 
displays.

Figure 13-250. Import Templates

c. Select the Source Device from the pull-down menu. 
Select OK.

d. Press F3 to eject the media.

NOTE: Imported templates are stored in the User defined 
templates\General directory. 

• To move the template from the left column to the right, or 
from the right to the left:

a. Select the template to be moved.

b. Select the Right Arrow or Left Arrow button.

• To move the template up or down in the right column:

a. Select the template to be moved.

b. Press the Up Arrow or Down Arrow button.
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Comment Texts

You can edit the comment text on the Comment Texts tab.

Figure 13-251. Comment Texts Tab

• New: Enters the new comment.

• Edit: Edits the existing comment.

• Delete: Deletes the existing comment.

• Move up/Move down: Moves the comment up or down.
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Backup/Restore Report Templates

Backup moves templates to removable media (CDs, DVDs, 
USBs).

Restore moves templates, that were backed up onto media, to 
the LOGIQ P8/P9/P10 with the same software version.

NOTE: To move reports with patient data, use Backup/Restore Report 
Archive and Patient Archive.

To backup the report template:

1. Select Utility.

2. Select System and select the Backup/Restore tab.

3. Select the media.

4. Check User Defined configuration box of the Backup field.

5. Select Backup.

6. Select Save and eject the media.

To restore the report template:

1. Insert the media.

2. Select Utility.

3. Select System and select Backup/Restore tab.

4. Check Report Template box of the Detailed Restore of User 
Defined.

5. Select Restore.

6. After the system reboot, select Utility and Report.

7. Select the Template tab.

8. Select the appropriate template (See ‘Templates’ on 
page 13-455 for more information. )

For preset specifics, see Chapter 11.
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 Using InSite ExC

Service Desktop (Administrator)

The Administrator (and others, granted the “Access Service 
Desktop” privilege) can access the Service Desktop to: 

• Access the Service Home Page. 

• Perform the following Utilities

• Change Password

• Data Transfer

• Delete Files

• SSA License

• Gather Logs

• View Third Party Licenses

• Disruptive Mode Utility

• View Installed Options

• InSite Agent Configuration

Figure 13-252. Service Desktop

Accessing the Service Desktop

1. Press Utility. Go to Page 2 of the Utility Menus. 

2. Press Service. 
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Using the Service Desktop

Disruptive mode is a way to control interruptions of operation.

• When Disruptive mode is On, all functionality on the Service 
Desktop is allowed but operation of the LOGIQ P8/P9/P10 
can be limited. 

• When Disruptive mode is Off, some functionality on the 
Service Desktop is not available operation of the LOGIQ P8/
P9/P10 is normal.

Additionally, setting Disruptive mode depends on the logged in 
user.

• Local user – a user locally logged into the machine will be 
able to set the system to Disruptive mode if they have 
“Authorize Remote Service Access. If the user does not 
have this right, the remote user’s request will be denied 
automatically. 

• Remote user – a user remotely accessing the machine will 
not be able to automatically switch to Disruptive mode. The 
logged in user (user actually logged on to the LOGIQ P8/P9/
P10) needs to have remote log in permissions (ability to 
grant remote access) The logged in user (user actually 
logged on to the LOGIQ P8/P9/P10) will be notified through 
a dialog box and asked to allow Disruptive mode.

Color Statuses

Throughout the Service Desktop, colors indicate the following:

• Green – Status is normal

• Orange – Status is a warning

• Red – Status is an error
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Viewing System Information

System Information displays general information about the 
LOGIQ P8/P9/P10. The information on System Information is 
available to all class licenses. 

Figure 13-253. System Information

Table 13-91:  System Information

 Parameter Description

CRM Number Customer Relationship Management (CRM) number. System identifier 
assigned to the customer unit by the service region.

Agent Registered Registered status of the agent. Valid values are:
• Yes – The agent is registered in the back office.
• No – The agent is not registered in the back office. 
• Not Available – Information about the agent is not available. 

Agent Quarantine Quarantine status of the agent. Valid values are:
• Yes – The agent has more than one device registered with the same CRM 

Number in the back office.
• No – The agent has one device registered with the listed CRM Number in 

the back office.
• Not Available – Information about the agent is not available.

Agent CRM Verified CRM verified status of the agent. Valid values are:
• Yes – The agent is verified in the back office.
• No – The agent is not verified in the back office.
• Not Available – Information about the agent is not available.

Model Number GE part number for the LOGIQ P8/P9/P10. The same number as listed on 
the rating plate.

Serial Number Serial number of the LOGIQ P8/P9/P10. The same number as listed on the 
rating plate. 

System Type Product name of the LOGIQ P8/P9/P10.

Facility Name of the hospital or facility where the LOGIQ P8/P9/P10 is installed. 
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Viewing System Information  (continued)

NOTE: Please note the following: 

• Model number and serial number are in the VPD. 

• CRM number and agent issues are corrected on the Agent 
Configuration page. 

• Facility is changed in the Utility Page of the  LOGIQ P8/P9/
P10.

• A system is successfully configured when the back office is: 

• Registered: Yes

• Quarantined: No

• Verified: Yes. The system cannot send data back to 
GGE or be accessed remotely if the Quarantine status 
is Yes. It is typically caused by two scanners having the 
same CRM number. 
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Viewing Software Status

Use Software Status to view general information about the 
software installed on the LOGIQ P8/P9/P10. The information on 
Software Status is available to all class licenses. 

Figure 13-254. Software Status

Table 13-92:  Software Status

 Parameter Description

System Date Current date in the format <day>, <month> <date> <year>.

System Time Local time based on the last time the system desktop was refreshed in the 
format <hh:mm:ss>.

Application Installation 
Date

Date the application software was installed. The application software 
includes the LOGIQ P8/P9/P10 product-specific software.

Base Image Installation 
Date

Date the base image software was installed. The base image software 
includes the Windows operating system and other supporting software.

Base Image Version Version number of the base image software. 

Application Software 
Version

Version number of the application software.

Application Status Status of the application. Valid values are: 
• Running
• Stopped
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Viewing Connected Probes

Connected Probes shows probes connected to the LOGIQ P8/
P9/P10. The order on the user interface is top down matching 
the left-to-right order on the LOGIQ P8/P9/P10. The information 
on Connected Probes is available to all class licenses. 

Figure 13-255. Connected Probes

Table 13-93:  Connected Probes

 Parameter Description

Active Probe (Celsius) Temperature of the active probe, if available.

Probe Name Name of the probe connected to the LOGIQ P8/P9/P10.

Probe ID Identifier of the probe connected to the LOGIQ P8/P9/P10.

Serial Number Serial number of the probe connected to the LOGIQ P8/P9/P10.

Status Statuses of the probe connected to the LOGIQ P8/P9/P10. Valid values are: 
• Active 
• Non Active
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Gathering Logs

Gather Logs provides a way to collect system logs and place the 
log files in a directory for retrieval by the online center. These log 
files do not include protected data such as crash dumps and 
keyboard shadow logs. The customer can collect logs (including 
protected data) using Alt+D when Protected Data is checked. 
Log files are compressed into a .zip file and the file path and file 
name display. If the application software is not running, use the 
Gather Logs shortcut on the Windows desktop. 

 Figure 13-256. Gathering Logs

To gather log files

1. Navigate to Utility > Service > Utilities > Gather Logs

2. Select one of the following: 

• 1 Day Logs

• 1 Week Logs

• All Logs

3. Click Gather Logs.

4. In the resulting dialog box, record the location of the log files 
and click OK.

Table 13-94:  Gathering Logs

 Parameter Description

1 Day Logs When selected, gathers log files for one day.

1 Week Logs When selected, gathers log files for one week.

All Logs When selected, gathers all available log files. 

Gather Logs Select to gather the log files for the selected time period. 
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Deleting Files

Delete Files displays all the files and folders present in the 
D:\Service folder and allows for their deletion. Deleting 
unneeded files improves performance and reduces the need to 
defragment the disk drive. To access Delete Files, select 
Utility--> Service--> Utilities--> Delete Files. 

Figure 13-257. Deleting Files

To delete files, 

1. Navigate to select Utility > Service > Utilities > Delete Files.

2. Under Delete Files, select the available folders and files that 
you want to delete. 

3. Press Delete.

4. In the resulting dialog box, click Delete and then click OK.

Table 13-95:  Deleting Files

 Parameter Description

Delete Files Displays the files that are available for deletion. 

Delete Deletes the selected files.
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Changing the Password

Change Password allows you to change the password for a 
specified user type. To access Change Password, select Utility > 
Service > Utilities > Change Password. 

WARNING The selected encryption password and the recovery key(s) 
must be stored and managed in a safe and secure manner. It is 
the responsibility of the owner of the system to take care of 
these keys. If the keys are lost, the patient data stored on the 
system will be lost. There is no way for GE Healthcare to 
recover the data if the keys and password are lost.

CAUTION If both password and recovery key are lost, you will not be able 
to access archived patient data (images and measurements 
included) nor store new patient data on this system.

The only way to recover the system to allow storing patient 
data is to reset the entire disk, which deletes all the archived 
patient data on the disk.

It is strongly recommended that all the patient data be stored in 
PACS or backup to media prior to encrypting the disk.

In addition, it is recommended that the recovery key be stored 
on a USB storage device, printed, and kept in a secure 
location, ensuring that is will not be lost.
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Changing the Password  (continued)

Figure 13-258. Changing the Password

Table 13-96:  Changing the Password

 Parameter Description

User Type Type of user for the password reset.

New Password Password

Confirm Password Password

Update Password Select to update the password.

Reset Select to reset the information. 
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Viewing Third Party Licenses

Third Party Software Licenses displays the third-party software 
licenses used as part of the service platform. To access Third 
Party Software Licenses, select Utility > Service > Utilities > 
Third Party Software Licenses.

Figure 13-259. Third Party Licenses
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Disruptive Mode

Disruptive Mode provides a way to enable and disable 
Disruptive mode. When enabled, Disruptive mode allows a 
remote user to access the LOGIQ P8/P9/P10 which can disrupt 
normal operation. Disruptive mode can be remotely turned on 
when the logged-in user has "Authorize Remote Service 
Access" privilege. If the logged-in user does not have remote 
service privilege, an error message displays. 

When initiating Disruptive mode from a remote location, a 
message displays on the LOGIQ P8/P9/P10 asking whether the 
user will allow Disruptive mode and notifying them that normal 
operation might be disturbed.

• If Yes is selected, then Disruptive mode is turned on.

• If No is selected, then Disruptive mode is not turned on and 
an error message displays saying that permission to change 
the mode was denied.

When Disruptive mode is On, the GE icon in the status bar 
changes to red and displays this message: "Due to Service 
testing restart needed."

When Disruptive mode is changed to Off, the GE icon turns 
white and this message displays: "Due to Service testing restart 
needed." In addition, VCO and SSH stop if running.

To access Disruptive Mode, select Utility > Service > Utilities > 
Disruptive Mode Utility.

Figure 13-260. Disruptive Mode
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Data Transfer

To enable data transfer, the schedule must be configured in the 
service platform and the types of data transferred must be 
enabled in the Utility page. Admin rights are needed to access 
this page. 

NOTE: Data is sent incrementally so that only what changed since the 
last transfer is sent. 

Data Transfer provides a way to do the following:

• View information about past transfers of (APM) information.

• Set up automatic/scheduled transfer of allowed data files 
from the LOGIQ P8/P9/P10 to the server. 

• Manually transfer data files allowed data files from the 
LOGIQ P8/P9/P10 to the server.

To access Data Transfer, select Utility > Service > Utilities > 
Data Transfer.

 Figure 13-261. Data Transfer

Table 13-97:  Data Transfer

 Parameter Description

Type of Upload Type of log file. For example, Incremental Logs or Full Logs. Monitoring Logs, 
System Logs, and Windows Logs are incrementally transferred when 
automatic transfer is enabled. To enable automatic transfer, navigate to 
System Admin and, under Service, check Enable Automatic Request for 
Service. 

Upload Permission Whether the permission to upload the log file is allowed or not. 

Last Upload Status Whether the last log file upload was successful or not.

Last Upload Attempt Date and time the last log file upload was attempted.

Last Successful Upload Date and time the last log file was successfully uploaded.
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To configure automatic data transfers: 

1. Navigate to Utility > System Admin. 

2. On System Admin, configure these settings:

• Transfer Machine Logs to GE – Default is checked

• Transfer Operator Information to GE

• Transfer Images (captured without patient information) 
to GE – Default is checked.

3. Click Save. 

Scheduler When selected, enables the related day selections. For example, All Days, 
Monday, and Tuesday. 

Save Settings Saves the information.

Send All Manually send the selected log files to the server.

Table 13-97:  Data Transfer (Continued)

 Parameter Description
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Data Transfer  (continued)

4. Navigate to Utility > Service > Utilities > Data Transfer

5. On Data Transfer, select Scheduler, and the select the days 
to perform the data transfer. 

6. Click Save Settings. 

7. To manually perform a data transfer, click Reset Send Full.
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Viewing/Adding Options

Shows the status of all possible options. You can select one of 
the option keys and view its details. If the key is valid, it reloads; 
shows which options are included in the selected key. 

You can also add a new option key by typing in its Key String 
and pressing Add. 

To access Options, navigate to Utility > Service > Options.

 Figure 13-262. Viewing Options

Table 13-98:  Viewing Options

 Parameter Description

Software Options

Option Software options on the LOGIQ P8/P9/P10.

Status Status of the options on the LOGIQ P8/P9/P10.

Software Option Details

Product Name of the product.

Hardware Number Number for the hardware. The hardware number is the hash of the serial 
number that is used to generate the option key.

Serial Number Serial number of the LOGIQ P8/P9/P10.

Software Option Keys

Available Keys List of the option keys installed on the LOGIQ P8/P9/P10.
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InSite ExC Agent Configuration

To access Agent Configuration, navigate to Utility > Service > 
Agent Configuration. Confirm with your IT whether a proxy and 
proxy confirmation is needed for the CRM. Use Agent 
Configuration to:

• Edit and configure the following: 

• Enterprise host name in the agent

• Enterprise port number in the agent

• Proxy server in the agent

• Proxy port in the agent

• CRM number in the agent

• Display name in the agent

• Set the serial number in the agent

• Enter the username and password for the proxy

• Reset the edited unsaved value

 Figure 13-263. Agent Configuration

Table 13-99:  Agent Configuration

 Parameter Description

Agent Configuration

Agent Status Status for the agent. Valid values are: 
• Running
• Not Running

Agent Registered Registered status of the agent. Valid values are:
• Yes – The agent is registered in the back office.
• No – The agent is not registered in the back office. 
• Not Available – Information about the agent is not available.



Advanced Features

13-478 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

NOTE: A new outbound firewall rule was added for Agent 
communication. Ports 88, 3011, 3031 have been added to port 
443 for available ports. 

Agent Quarantine Quarantine status of the agent. Valid values are:
• Yes – The agent has more than one device registered with the same CRM 

Number in the back office.
• No – The agent has one device registered with the listed CRM Number in 

the back office.
• Not Available – Information about the agent is not available.

Agent CRM Verified CRM verified status of the agent. Valid values are:
• Yes – The agent is verified in the back office.
• No – The agent is not verified in the back office. 
• Not Available – Information about the agent is not available.

Agent Model Number GE part number for the LOGIQ P8/P9/P10. The same number as listed on 
the rating plate.

Serial Number Serial number of the agent (read-only). If the agent is not registered with a 
serial number, this field is populated with the serial number of the LOGIQ P8/
P9/P10. The serial number of the agent is tied to the serial number of the 
LOGIQ P8/P9/P10.

CRM No Customer Relationship Management (CRM) number. System identifier 
assigned to the customer unit by the service region.

Display Name Displayed name of the agent.

Advanced Configuration

Enterprise Server Name of the enterprise server.

Enterprise Host Number of the enterprise host.

Enterprise Port Number of the enterprise port.

Proxy Configuration

Enable Proxy Enables the proxy server.

Proxy Server When Enable Proxy is selected, name of the proxy server IP.

Proxy Port When Enable Proxy is selected, number of the proxy server port.

Credentials

Enable Proxy Credentials Enables the proxy credentials.

Username When Enable Proxy Credentials is selected, name of the user.

Password When Enable Proxy Credentials is selected, password for the user.

Table 13-99:  Agent Configuration (Continued)

 Parameter Description
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DVR

Using the DVR

1. Create a patient record or open an existing one.

2. Press Video assigned key or Video tab.

3. Insert a DVD media or USB storage.

Advance configurations are required.See ‘Setting up the 
DVR’ on page 13-480  for details.

NOTE: The DVD which formatted in Utility > Connectivity > 
Removable Media is for data archiving, it cannot use for the 
DVR recording.

4. Scan a patient.

5. Press Record to start recording.

The status bar updates with the recording information. While 
recording, you can only pause or stop the recording and 
cannot start any other DVR functionalities.

NOTE: Recording automatically pauses when start Utility screen.

NOTE: When more than one USB storage is connected, the DVR 
records to the first drive letter in alphabetical order.

NOTE: The system does not start the recording when following 
operation is in progress: Data Transfer, EZBackup, Utility 
screen.

6. Press Record or Pause to pause/resume the recording.

7. Press Stop on the Touch Panel to stop the recording.

When you stop recording, the DVR writes the title data. 
During this period of time, the busy state icon is displayed in 
the status bar (green allow circling) and you cannot operate 
any DVR functionalities.

NOTE: Stop recording may take up to 2 minutes for DVD-RW/
DVD+RW.

NOTE: The DVR automatically stops recording before media 
reaches to full.

8. Press Eject on the Touch Panel or F3 key to eject.
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Setting up the DVR

To set up the Digital Video Recorder (DVR),

1. Set up following parameters in Utility --> System --> 
Peripherals.

• Media: DVD, USB

• DVD Format: NTSC, PAL

• Picture Quality: HQ, SP, LP, EP

• DVD Chapter Record Interval (sec.): 15, 30, 60, 120

• USB Playback Skip Interval (sec.): 15, 30, 60, 120

2. If needed, assign [Video] to one of the User Configurable 
Key to turn on/off Video tab, in Utility -> System -> User
Configurable Keys.

3. If needed, check “Show Video Tab”  in Utility -> 
Application -> Settings to display a Video tab on the Touch 
Panel.

4. If needed, assign [DVR Record/Pause] to a Print key in 
following steps.

a.  Add [Video Capture] and select [DVR Record/Pause] 
as the Type, in Utility -> Connectivity -> Service.

b. Assign the [Video Capture] to the Print Button, in Utility 
-> Connectivity -> Button.

5. Restart the system. 

The DVR functions records scan screen. 
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Video Touch Panel Menu

Following are the Touch Panel menu for the DVR operation.

Figure 13-264. Video tab 1

Figure 13-265. Video tab 2

Table 13-100:  Touch Panel Keys

Graphic Explanation

Skip
DVD media: Skip to the previous/next chapter.
USB storage: Skip specific time to backward/forward.



Advanced Features

13-482 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

4x Skip
DVD media: Skip the four chapters to backward/forward.
USB storage: Quad time interval skip to backward/forward.

Search
Press Search button to display the dialog. Select Title, then press Search on the 
dialog. 
The title name is as following: <Date>_<Time>_<Patient Last name>_<Patient 
First name>

Record
Start recording. 

Pause
Pauses and resumes Recording and Playback.  
NOTE: Freeze key works the same as Pause button, when Playback.

Eject
Eject the DVD media/USB storage. Also you can eject media pressing F3 key. 

Play
Play a video from DVD or USB storage.

Stop
Stop the playback or recording. 

Format
Reformats a DVD+RW/-RW.
NOTE: Format deletes all the contents in the media.

Finalize
Finalize a DVD-R.
NOTE: DVD+RW/-RW is automatically finalized when stop recording.

Table 13-100:  Touch Panel Keys (Continued)

Graphic Explanation
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DVR Display Icons

Displays the following icons in the status bar: 

Figure 13-266. DVR Disk Status

Table 13-101:  DVR icons 

1. DVR status

Recording Stopping

Pause Recording Pause Playback

Playback Busy

No media

2. DVD Media status
Displays media type and size of the free space size.

DVD+RW/-RW is in the tray DVD-R is in the tray

3. USB storage status
Displays the device availability and the free space size.

USB Storage is attached

4. Current Title Number. Displays while recording

5. Time counter.
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Recording Functionality

Table 13-102:  Recording Functionality 

Parameter DVD media USB Storage

Support media DVD-R, DVD+RW, DVD-RW USB-HDD (NTFS only) 
USB Flash Device (NTFS only) 
Note: Cannot record or play FAT 
(exFAT, FAT32, etc) on USB Device. 
Please format to NTFS file system on 
PC.

Support video format NTSC or PAL MPEG video file (*.mpg) for each title
Note: The file size is up to 2GB.
Note: The mpeg video file doesn't 
have a chapter.

Support Picture Quality • HQ (Record length: approx. 70 
minutes)

• SP (Record length: approx. 90 
minutes)

• LP (Record length: approx. 140 
minutes)

• EP (Record length: approx. 280 
minutes)

• HQ (Record length: approx. 30 
minutes)

• SP (Record length: approx. 40 
minutes)

• LP (Record length: approx. 60 
minutes)

• EP (Record length: approx. 130 
minutes)

Note: The maximum size of each 
video file: 4GB.

Number of Titles and 
Chapters

Up to 99 titles in a disk and 92 
chapters in a title.
Up to 92 chapters in a title.
While recording to DVD, chapter is 
automatically created at specific 
interval that is configured in Utility -> 
System -> Peripherals.
When you stop recording, DVR 
writes the title data.
When you end examination (e.g. 
pressing New Patient, End Current 
Patient, ...), DVR auto stops 
recording and creates a title.

N/A

Volume label The system automatically labels 
following string to DVD media: 
YYYYMMDD_XX
• YYYY - Year (4 digit)
• MM - Month (2 digit)
• DD - Day (2 digit)
• XX - Serial number of the day (2 

digit)
Note: Volume label of DVD+RW/-RW 
can edit in Utility -> Connectivity -> 
Removable Media.

N/A
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NOTE: Properties of the DVD media displays in Utility -> Configuration 
-> Removable media.

Video title <Date>_< Time>_<Patient Last 
name>_<Patient First name>
Note: If a patient name is not 
provided, a serial number is used as 
following: <Date>_< Time>_<serial 
number>.

<Date>_<Time>_<Patient Last 
name>_<Patient First name>.
Note: If a patient name is not 
provided, the video file name is as 
following, <Date>_<Time>_<serial 
number> where serial number is the 
number of video files in the media 
plus one.

Compatibility • Player on LOGIQ P8/P9/P10
• DVD video player on PC
• Commercial DVD video player

Table 13-102:  Recording Functionality  (Continued)

Parameter DVD media USB Storage
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Recovery from power failure (DVD only)

While recording to DVD (DVD-R or DVD+RW/-RW), if power 
failure occurs the system will automatically start recovery of the 
media right after system restart.

NOTE: If the recording is incomplete by the power failure, the last title 
may be unreadable. Recovery copies the cached last title to the 
media.

If the DVD media in the tray does not have sufficient free space, 
you get the following Recovery menu instead of starting auto 
recovery.

Figure 13-267. Recovery Menu

• Remind me later

If you select “Remind me later”, you can cancel the 
Recovery operation. But if you press Record button, 
displays the recovery menu again and cannot start the 
recording.

Select “Yes” (Recover) or “Delete Data” to enable the 
recording.
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Recovery from power failure (DVD only)  (continued)

• Yes (Recover)

If you select “Yes”, the following dialogue displays. Insert the 
blank media and press “OK”.

Figure 13-268. Recovery “Yes”

During recovery, the massage "Recovery of DVR media is in 
progress" displays in the status bar.

• Delete Data

If you select “Delete Data”, you get the following 
confirmation menu.

Figure 13-269. Delete Data

OK: Deletes the unburned cached data.

Cancel: Go back to the Recovery menu.
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Configuring the Wireless Network

A Wireless Network (WLAN) is available on the LOGIQ P8/P9/
P10. When the WLAN is active, an icon appears in the status 
bar to indicate whether the WLAN is installed or disconnected.  

Wireless LAN (WLAN) Specifications

The Wireless LAN (WLAN) supports the following network 
protocols: 

Standards • IEEE 802.11n, 802.11g, 802.11a, 802.11b, 802.11ac

Security Types • None/Open

• WPA2 - Enterprise

• WPA2 - Personal

Encryption Type • None

• WEP

• AES

Frequency • 2.4 GHz to 2.5 GHz CCK and CFDM modulation

• 5 GHz OFDM, 802. 11ac MCS0-9 coding scheme

Supported 
Standards

• FCC Part 15 

• Japan MIC

• Canada Requirements

• RED (Radio Equipment Directive) Directive 2014/53/EU 

• KC (South Korea)

• NCC (Taiwan)

• RCM (Australia, NewZealand)

• SRRC (China)
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Connecting to the WLAN

To connect the LOGIQ P8/P9/P10 to the WLAN,  

1. Press Utility --> Connectivity --> TCP/IP --> Wireless 
Network --> Configuration (located under Wireless 
Network). 

The Wireless Network Configuration tool appears. If 
enabled, Wireless Networks broadcasting in your area 
appear in the list.

2. If necessary, check the box for "Enable Wireless 
Connection".

3. Select the wireless network you want to use or set up.

4. Press Connect from the bottom of the Configuration tool. If 
prompted, enter the correct settings for this wireless 
network.

If the connection is successful, the status bar Active 
Wireless LAN indicator will no longer have a red "X".

NOTE: If the WLAN fails to connect, review and/or recreate the 
Wireless connection on the Security Tab. 
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Network and Spooler Status Icons

The following icons identify network and spooler statuses: 

Table 13-103:  Network and Spooler Status Icons 

Network and Spooler Status Icons

Ethernet Active Ethernet Error Ethernet Active 
Spooler Active

Ethernet Active 
Spooler Error

Mobile

Mobile Error Mobile Bluetooth Mobile Wifi Spooler Active Spooler Active 
Error

Spooler Inactive Spooler Inactive 
Error

Wifi 1 Bar Wifi 2 Bars Wifi 3 Bars

Wifi 4 Bars Wifi Alert Wifi Spooler Active Wifi Spooler Error Wifi Error
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Adding a Wireless Network

To add a WLAN profile (even for a network which is not yet 
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Add...

NOTE: If the security features implemented at your facility require 
signing onto the wireless network using a user name and 
password on your network, then you will need to contact GE 
Service to access maintenance mode if you have not 
purchased a service license.

4. Add the following information to the Wireless Network 
Properties page: 

a. Enter a Network Name (SSID), then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ P8/P9/P10 to 
connect to this network. 

The LOGIQ P8/P9/P10 attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Adding a Wireless Network  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The 
LOGIQ P8/P9/P10 does not support automatic 
prompting for user credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (user name and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel.

NOTE: If the system is not able to connect to the Enterprise wireless 
network, please re-enter the user name and password following 
the steps.
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Removing a WLAN

To remove a WLAN profile (even for a network which is not  
available), 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Security. The Wireless Network Configuration 
tool appears. Available Wireless Networks appear.  

2. Select the Security tab. 

3. Select Remove.
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Customizing Wireless Network Settings

To customize an existing WLAN profile, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Security tab. 

3. Select Customize...

4. Obtain and enter the correct information for each wireless 
network setting: 

a. Enter a Network Name (SSID), then press OK. 

A new window appears so you can enter the settings for 
this network. 

b. On the connection page, check the appropriate boxes 
based on how you want the LOGIQ P8/P9/P10 to 
connect to this network. 

The LOGIQ P8/P9/P10 attempts to connect to available 
wireless networks based on the options you enable. If 
multiple networks are available, connection attempts 
begin with the network appearing topmost on the list. 

c. Select the Security page. 

d. Select the Security Type from the available options. 

NOTE: Dialog boxes vary, depending on the Security Type 
selected. 

e. Select the Encryption Type from the available options. 

f. For Personal networks, enter the Network key. 
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Customizing Wireless Network Settings  (continued)

g. For Enterprise networks, choose the network 
authentication method and press Settings. 

Detailed settings for Enterprise networks are complex 
and must be correct for the connection to succeed. 
Ensure you have all the required information/settings 
and work with your site’s IT Network Administrator as 
needed. 

NOTE: Credentials must be entered at this time. The 
LOGIQ P8/P9/P10 does not support automatic 
prompting for user credentials. 

• For Microsoft PEAP networks, press Advanced and 
enter User authentication credentials (user name and 
password). 

• For Cisco networks, enter user credentials in the PEAP 
Properties dialog after pressing the Settings button. 

NOTE: IMPORTANT: User credentials are not validated until 
you attempt to connect to the network. 

h. When you have correctly entered all required settings, 
press OK in the Wireless Network Properties dialog. 

Your settings will be validated and you may be 
prompted about certain settings which are not 
recommended or supported. 

Examples: “Automatic connection to unencrypted 
networks is not recommended. Reminder to enter user 
credentials for Enterprise networks.” 

i. If changes are necessary, press Customize. Make 
corrections, then press OK. Settings will be validated 
again. 

5. After you have filled in all the required information, press 
OK. To cancel adding this profile, press Cancel.
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Refreshing a WLAN

Refreshes the list of available Wireless Networks. To refresh the 
Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Highlight the wireless network you want to refresh. 

3. Press Refresh from the bottom of the Configuration tool. 
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Managing Connectivity to a Wireless Network

You can control which wireless networks can be connected to 
and which networks are preferred over other networks. 

• Networks appearing on the Security page, Preferred 
Wireless Networks list are listed in decreasing preference. 

The network listed at the top of the list is the most preferred, 
and therefore the most likely to get connected. 

The network listed at the bottom of the list is the least 
preferred, and therefore the least likely to get connected. 

• Networks with the check box unchecked for automatic 
connection will never connect unless you manually press 
the Connect button.  

• Non-broadcasting networks will never connect unless the 
corresponding checkbox is checked; or, you manually press 
the Connect button.

• Once connected to a network, the system will not 
automatically switch over to a more preferred network 
unless the check box is checked. 
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Monitoring the WLAN

If there are wireless network communication problems, you can 
monitor the wireless network events.

To monitor Wireless Networking events, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Monitor Tab.
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WLAN Diagnostics

If the wireless network is connected, you can run diagnostics to 
determine how well, or poorly, the network itself is working. The 
diagnostic information displayed can help pinpoint causes of 
networking problems. Tests which pass are shown in green; 
tests which fail are shown in red. 

To run diagnostics for the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Run Diagnostics.
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Repairing the WLAN

Occasionally you may need to repair a WLAN that has lost its 
connection to the LOGIQ P8/P9/P10. To repair the Wireless 
Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Diagnostics Tab. 

3. Select Repair.

NOTE: DO NOT cancel the Repair operation after you have 
selected to repair the Wireless LAN connection. 

If the WLAN is functioning properly, the following message 
appears. Confirm your decision to repair (Yes), or cancel (No). 
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Available WLAN Channels

The available WLAN channels show availability of wireless 
connect points that the scanner can talk to. Each channel 
supports a finite number of users and has limited signal 
strength. This may effect the ability to connect, the throughput 
and the connection dropping out.

To check the available WLAN channels, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears. Available Wireless Networks 
appear.  

2. Select the Properties Tab. 

3. Select Available Channels....

Disconnecting from the  WLAN

To disconnect from the Wireless Network, 

1. Press Utility--> Connectivity--> TCP/IP--> Wireless 
Network--> Configuration. The Wireless Network 
Configuration tool appears.   

2. Select the WLAN you are connected to. 

3. Select Disconnect.

Viewing WLAN Online Help

To view the WLAN Online Help, press F1. 
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Power Assistant

Overview

With Power Assistant, the system power is maintained by the 
battery when there is an AC power failure or the power cable is 
unplugged. This can be used to reduce system startup time for 
portable exams.

While in Power Assistant, the system maintains the current 
patient. As a result, when power is restored, the current patient's 
details and stored images are readily available.

NOTE: Only GE Service personnel have access to the battery. Please 
contact the technical service department or your local GE 
representative for replacement.
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Standard battery

Standard battery is housed within the cabinet.

With a fresh battery that is fully charged, the LOGIQ P8/P9/P10 
stays powered for approximately 20 minutes when in Power 
Assistant.
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Battery Power mode with the standard battery

Before starting Battery Power mode

NOTE: If the system is switched to Battery Power mode when any of 
operations above are in progress, the system terminates the 
operation.

CAUTION The following operations must be completed before unplugging 
the AC cable. 

• Any access to the external media, such as CD, DVD, USB 
HDD via Export, Import, MPEGvue, Save As, EZBackup.

• Any access to the Network device, such as DICOM 
transfer or Network Storage.

• DVR recording should be stopped.
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Starting Battery Power mode

When the AC cable is unplugged or if there is an AC power 
failure, the system transitions to Battery Power mode. The 
following dialog displays before entering Battery Power mode.

Figure 13-270. Battery Power mode

NOTE: Verify that the system is in Battery Power mode after unplugging 
the power cable. The following message “Running on Battery. 
Key operation locked” appears on the display during Battery 
Power mode.

NOTE: If the system does not transition to Battery Power mode, contact 
the technical service department or your local GE 
representative.
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When in Battery Power mode

In Battery Power mode, most of the console devices, such as 
the keyboard, gel warmer and printers, are turned off to 
minimize battery usage.

NOTE: To shut down the system while in Battery Power mode, plug in 
the power cable, exit from Battery Power mode, and then 
perform regular shut down operations.

Recovering from Battery Power mode

The system recovers from Battery Power mode when power is 
supplied to the LOGIQ P8/P9/P10. The system returns to full 
functionality in 10 seconds.

CAUTION When in Battery Power mode, DO NOT perform the following 
operation:

• Connect and disconnect probes.

• Remove peripheral devices.

• Eject or insert CD/DVD media and the external USB 
storage device.
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Battery deterioration

When the system detects battery deterioration, the following 
dialog displays:

Figure 13-271. Battery life message

If this message displays, contact the technical service 
department or your local GE representative.



Advanced Features

13-508 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Refreshing the battery

To maintain the battery life, it is recommended to refresh the 
battery every 6 months. Refresh procedure:

1. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

2. Wait until the battery is fully charged. It takes about 3 hours 
(Standard battery)/9 hours (Extended battery) to fully charge 
the battery (depend on the remaining battery capacity).

3. Remove all probes.

4. Turn on the system.

5. Unplug the AC cable and wait until the system shuts down. 
It may take at least 30 minutes (Standard battery)/60 
minutes (Extended battery) to complete shutdown.

6. Wait at least 5 hours.

7. Plug the AC cable to the wall outlet and turn on the circuit 
breaker.

8. Wait until the battery is fully charged. It takes about 3 hours 
(Standard battery)/9 hours (Extended battery) to fully charge 
the battery.

Battery Disposal

Power Assistant uses a Lithium Ion battery. Used battery will 
require to discard as chemical waste. Please contact your local 
authority for the directions. 

NOTE: When removing a defective battery, ensure that it is disposed of 
in accordance with local regulations. Alternatively, forward it to 
GE for proper disposal.
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Video Converter

Video Converter 

The LOGIQ P8/P9/P10 Video Converter Option enables the 
ability for the console to view or record scanning HDMI Cable.

Figure 13-272. Video Converter

1. DVI Output

2. VGA Output

3. S-Video Output

4. Composite Video output (BNC)

5. Composite Video output (RCA)

NOTE: The Video Converter can be used with the Mid and High 
Cabinet.
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Video Converter (External type)

The LOGIQ P8/P9/P10 Video Converter Option enables the 
ability for the console to view or record scanning via an S-Video 
Cable.

If the Side cabinet is installed, the external type video converter 
can be used for the supported countries.

NOTE: The External type of Video Converter can be used in limited 
countries: EU, Korea, China, USA, Canada, and Japan.

Figure 13-273. Input side configuration

Figure 13-274. Output side configuration

a. Output port

a. Power switch
b. Power port
c. Function switch

a. Input HDMI LED
b. Input HDMI

CAUTION The provided AC/DC adapter is dedicated to the video 
converter. Never use this AC/DC adapter for other uses.
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Storage Options

Probe holder

Multi purpose probe holder

Figure 13-275. Multi purpose probe holder (option)



Advanced Features

13-512 LOGIQ P8/P9/P10 – Basic User Manual
Direction 5841298-1EN Rev. 2

Attachment for small probe

Figure 13-276. Attachment (Option)

Push the attachment into the probe holder as below.

Figure 13-277. Push the attachment

Figure 13-278. Attachment in the proper position
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Wired Footswitch

You can attach this Footswitch to the system by connecting it to 
any USB port on the system. 

Figure 13-279. Footswitch and USB Cable

This is a 3-pedal Footswitch. You can configure its functionality 
via the Utility -> Applications -> Footswitch parameters. 

CAUTION When using the Footswitch, DO NOT hold down the footswitch 
pedal. Press and release the Footswitch pedal. Pushing and 
holding down the pedal behaves the same way as pushing and 
holding down a key on the keyboard. 
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Touch Control

Description The Touch Control Function provides to make it possible to 
easily perform frequently used operations without using Front 
panel and Touch panel Menu.

Activation There are 2 ways to activate the Touch Control.

• Assign the Touch Control function to User Defined Hard Key 
or User Defined Touch Button in Utility -> System -> User 
Configurable Key.

• Swipe Down from the top of the Touch Panel from the light 
gray bar

Figure 13-280. The top of the Touch Panel

Deactivation There are 2 ways to deactivate the Touch Control.

• Use the Exit icon on the top right of the Touch Panel.

• Swipe Up from the bottom of the Touch Panel from the light 
gray bar.

Figure 13-281. The bottom of the Touch Panel
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Touch Control Display Layout

 Figure 13-282. Touch Control Display Layout

1. Mode Tab Control
2. Buttons for Scan Assistant (It only appears in 

Scan Assistant Mode)
3. Shortcut Icons (TGC, Keyboard, My Page)
4. Exit Icon
5. Gain Control (Scrolling up and down changes 

the gain value)

6. Depth Control (Scrolling up and down changes the 
depth value)

7. Mode Rotary (Press & Hold The button at the 
position will operate)

8. Hide/Unhide Scan Image Icon
9. Quick Menu (Anywhere in the image area Press & 

Hold displays the menu)
10. Trackball Upper Key Indicator
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Touch Control

• Touch Control Trackball Functions

You can either use one finger to move the CF/PDI ROI, PW 
cursor or trackball functions. One finger double tap will 
change the active function of the trackball. This is displayed 
at the top right of the touch panel.

Figure 13-283. Touch Control

• Two fingers will either zoom-in or zoom-out.

• More than 3 Fingers will Freeze/UnFreeze.
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Quick Menu

• Press and Hold one finger for additional mode/function 
controls.

B - CHI, Virtual Convex (For example)

CF- Invert, PDI, Quick Angle (For example)

PW- Invert, Quick Angle, Update (For example)

Comments - Comments from MyPage

Bodypatterns - Bodypatterns from MyPage

Figure 13-284. Quick Menu
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Smart Device Apps

LOGIQ Apps

Smart Device LOGIQ Apps are available for Android devices 
(both a phone and tablet) via Bluetooth: LOGIQ Remote Control 
App and LOGIQ Photo/Barcode Reader App. 

Figure 13-285. Smart Device Apps Mobile Devices

NOTE: The communication between the LOGIQ Apps and the 
ultrasound system is Bluetooth which is a wireless, secure 
transmission. At no time is patient data stored on the device 
hosting the LOGIQ Apps. For the LOGIQ Photo App, photos are 
never written to a file, but rather directly transferred to the 
LOGIQ ultrasound system. Once on the ultrasound system they 
can be included with the diagnostic images sent to the 
reviewing/reading physician.

WARNING DO NOT use the Smart Device Apps if the patient has a 
life-sustaining device, such as a pacemaker or defibrillator, as 
these devices do have an effect upon the life-sustaining device. 
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LOGIQ Apps  (continued)

NOTE: DO NOT use the USB Ports on the LOGIQ P8/P9/P10 to charge 
LOGIQ Apps devices as these devices are not approved 
devices to connect to a medical device. 

Connecting the Device

To link to the device, 

Table 13-104:  Linking the Device to the LOGIQ P8/P9/P10 

Steps On LOGIQ P8/P9/P10 On Device

1. Press the Mobile Icon on the 
LOGIQ P8/P9/P10 that’s 
located on the display. 

2. On the LOGIQ P8/P9/P10, 
the QR code appears on the 
display. 

3. On the device, press the 
LOGIQ Remote App. 
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4. Follow the instructions on the 
device.
a. Press “Connect.” 
b. Scan the QR Code with the 

device.

5. Place the device in front of  
the LOGIQ P8/P9/P10 as 
directed. “Scan QR code with 
your mobile application to pair 
and connect.” 

The LOGIQ P8/P9/P10 and the 
device are now ready to pair. 

6. The device displays the 
Bluetooth pairing request, 
“Confirm passkey is ##### to 
pair with the LOGIQ P8/P9/
P10.” Press OK.  

Table 13-104:  Linking the Device to the LOGIQ P8/P9/P10  (Continued)

Steps On LOGIQ P8/P9/P10 On Device
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7. The Bluetooth icon on the 
LOGIQ P8/P9/P10 is now 
paired to the device. 

8. The LOGIQ Remote 
application appears on the 
device. The Phone App and 
Tablet App displays are 
shown to the right. 

To switch to the LOGIQ Photo 
App, press the Camera icon 
located on the top of the remote 
device’s display. 
Note: The Camera Icon only 
appears if LOGIQ Photo App is 
already installed. 

Table 13-104:  Linking the Device to the LOGIQ P8/P9/P10  (Continued)

Steps On LOGIQ P8/P9/P10 On Device
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To completely break the association between the LOGIQ P8/P9/
P10 and the device (unpair the device from the LOGIQ P8/P9/
P10):

1. Access the Utility-> Connectivity-> Miscellaneous screen. 

2. In the LOGIQApps section, select Unpair Bluetooth 
Devices.

To disconnect the LOGIQ P8/P9/
P10 from the device, click on the 
“Bluetooth Connected to the 
Device” icon on the bottom of the 
display and select to disconnect.  
Or, 
You can press “Disconnect” on 
the Device. 

To Unpair a Device from the 
LOGIQ P8/P9/P10, press “Unpair 
Bluetooth Devices” via Utility> 
Connectivity> Miscellaneous> 
LOGIQ Apps. 

Table 13-104:  Linking the Device to the LOGIQ P8/P9/P10  (Continued)

Steps On LOGIQ P8/P9/P10 On Device
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Assigning LOGIQ Apps to a BT Key

To assign LOGIQ Apps to a BT key, select “LOGIQ Apps” to a 
“BT Key (restart needed)” via Utility> System> User 
Configurable Key.

Figure 13-286. Assign LOGIQ Apps to a BT Key

Using the Apps

Table 13-105:  Using Smart Device LOGIQ Apps 

Tablet/Phone Remote Control and Photo/Barcode reader Apps

1. LOGIQ Remote Control App
2. LOGIQ Photo/Barcode Reader App
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LOGIQ Remote Control App:  

Via the Tablet LOGIQ Remote Control App, you will 
be able to adjust the following controls: 
Depth, Gain (B-Mode, Color Flow Mode, PW 
Mode), Left/Right, Measure, Comment, Clear, 
Trackball, Freeze, Store, Color Flow Scale, and 
Cursor. 

Via the Phone LOGIQ Remote Control App, you will 
be able to adjust the following controls: 
Activate PW, CF, or B-Mode, adjust the Cursor, 
Freeze the image, and sent images to the P1 
control. 

Photo/Barcode Reader App 

You can use the LOGIQ Photo App to capture 
photos that will go to the patient’s exam and to use 
as a barcode reader to scan in patient exam 
information. 
Note: The photo does not go directly into the exam; 
instead the image must be stored from the 
LOGIQ P8/P9/P10. 
Note: The barcode scanner scans the barcode into 
the Patient ID field on the Patient menu. 

Table 13-105:  Using Smart Device LOGIQ Apps  (Continued)

Tablet/Phone Remote Control and Photo/Barcode reader Apps
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IOTA LR2 Worksheet

NOTE: IOTA LR2 Calculation is an option.

NOTE: IOTA LR2 Calculation may not be available in all countries.

THe IOTA (International Ovarian Tumor Analysis) LR2 
Worksheet contains an ovary measurement tool for women with 
adnexal tumors that have been selected to undergo surgery. 
The LR2 model is based on published literature and has been 
tested only on the stated population. The literature states that 
the LR2 model can help to estimate the probability of an adnexal 
mass of being malignant. The IOTA group has evaluated other 
ways including an LR1 model in additional to the LR2 model. 

NOTE: IOTA states that use outside of the intended population can 
overestimate risk. Users are expected to study the literature and 
reach their own professional conclusions regarding the clinical 
utility of the tool. The model cannot replace experience in 
ultrasonography and cannot compensate for poor quality 
ultrasound equipment. 

The IOTA mathematical logistic regression model, LR2 is stated 
in literature as described in the Advanced Reference Manual. 

NOTE: For details see H43122LE LOGIQ P8/P9/P10 R4 Advanced 
Reference Manual - Chapter IOTA LR2.

GE Healthcare is passing on this IOTA LR2 worksheet for your 
convenience based on published literature of one group, but 
makes no representation of its effectiveness in your practice. 
This calculation is not to be used as the primary driver in 
diagnostic decision making on the probability of malignancy. It is 
secondary information for a physician to use based on recent 
literature. 
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Workflow

1. Select IOTA LR2 Model on the Gynecology Worksheet 
touch panel. 

2. Fill in items 1 to 6. The Patient’s age is entered by the 
system if available from the Patient Information Dialog. 

3. The IOTA LR2 model result is displayed. 

Figure 13-287. IOTA LR2 model

CAUTION The IOTA LR2 model should not be used without an 
independent clinical evaluation and is not intended to be a 
screening test or to determine whether a patient should 
proceed to surgery. Incorrect use of the IOTA LR2 model 
carries the risk of unnecessary testing, surgery, and/or delayed 
diagnosis.  
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Hepatic Assistant

Overview

Hepatic Assistant is supported on C1-6-D (Abd(Abdomen)) to 
measure SWE and UGAP simultaneously.

See ‘Shear Wave Elastography’ and ‘Ultrasound- Guided 
Attenuation Parameter (UGAP) Option’ for detailed workflow. 
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Activate Hepatic Assistant

1. Configure presets for Hepatic Assistant in Utility -> Imaging 
-> UGAP -> Abdomen - C1-6 (Hepatic Assistant) if needed. 

• Visualization:

UGAP/SWE (A/E)

UGAP Q/SWE (A Qual./E)

B/SWE & UGAP/UGAP A (BE -> A/Att.)

SWE Q/SWE & UGAP Q/UGAP (E Qual./E -> A/Qual.)

• SWE Display Side: Right or Left.

• Frames to store: UGAP frames to store for Auto 
Measurement Multi can be configured in increments of 
10 from 0 to 300 (0, 10, 20, etc.).

• UGAP ROI Display in PreMode: On or Off.

Figure 13-288. Presets for Hepatic Assistnant

2. Assign Hepatic Assistant to any User Defined key in Utility 
-> System -> User Configurable key. Press Save.

3. Select C1-6-D probe and Abd for application.
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Activate Hepatic Assistant  (continued)

4. Press assigned User Defined key. Pre Mode is displayed. 

Figure 13-289. Pre Mode

5. Move SWE ROI to desired position if needed.

6. Press Start  to start SWE and UGAP live data acquisition. 
The UGAP measurement is activated when the SWE 
measurement is completed. 

• LOGIQ P9/P10 acquires one SWE frame data and one 
UGAP frame data for Auto Measurement Single.

• LOGIQ P9/P10 acquires SWE frames data until the user 
press Freeze and the specified number of UGAP 
frames data for Auto Measurement Multi.

• LOGIQ P9/P10 acquires SWE frames data until the user 
press Freeze and UGAP frames data the user press 
Store for Auto Measurement Off. 

7. Press assigned User Defined key to exit Hepatic Assistant.
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Visualization

Below Visualizations are selectable in Utility.

• Dual view of UGAP and SWE

Figure 13-290. Example - UGAP/SWE (A/E)

• Dual view of UGAP Quality Map and SWE

Figure 13-291. Example - UGAP Q/SWE (A Qual./E)
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Visualization  (continued)

• Dual view of B-mode and SWE to UGAP and UGAP 
Attenuation Map

Figure 13-292. Example - B/SWE & UGAP/UGAP A (B/E A/
Att.)
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Digital Expert

Digital Expert Remote Training

Digital Expert is a purchasable option which enables remote 
training between users and the GE Clinical Applications team, 
through scheduled and real-time sessions. Digital Expert is a 
self-contained, app-based companion solution, designed to pair 
with GE medical devices. Digital Expert utilizes intelehealth 
software for remote connectivity. 

NOTE: This tool is not for clinical diagnostics purposes.

Digital expert also enables customer to customer Enterprise 
Collaboration, where users can connect with each other within 
their own network. This provides on-demand access for 
guidance and consultation for clinicians from in-house experts. 
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Index

Symbols

% Stenosis
generic measurement, 7-24

Numerics

3D/4D imaging
introduction, 13-100
manipulating the volume of interest, 13-131
operational controls, 13-109
prinicples of operation, 13-102

3D/4D presets, changing, 10-74
Advanced, 10-82
Cine, 10-79
Render Setting, 10-78
ROI (Region of Interest), 10-77
Scalpel, 10-80

3D/4D presets, overview, 10-74

A

A/B Ratio
Doppler generic measurement, 7-42
Elastography measurement, 5-97
generic measurement, 7-32
M-Mode generic measurement, 7-35

Acceleration time (AT)
OB/GYN vessel measurement, 7-43

Acceleration, measuring, 7-43
accessories

ordering, 1-7
requesting a catalog, 1-7

accessory
connector panel, 3-10

accessory connector panel illustration, 3-11
Acclimation time, 3-57
Accumulation, B-Flow, 5-30
accuracy

clinical calculation, 12-11
clinical measurement, 12-8

acoustic output
default levels, 2-40

Activating Contious Capture, 13-335
Active Images, 9-11
active images, description, 4-5
Admin

overview of Utility screen, 10-125

Admin screen
Logon, 10-138
System Admin, 10-134
Users, 10-137

administrator
specifying system, 10-137

AFI
Acquisition, 13-301
AVC Timing Adjustment, 13-313
create a ROI, 13-308
Peak detection, 13-322
Tracking Validation, 13-305

AFI on Apical 2-chamber, 13-315
AFI on Apical 4-chamber, 13-315
AFI on the APLAX view, 13-303
air filter

removing, 12-26
ALARA (as low as reasonably achievable), bioeffects,
2-4
Alpha Hip, pediatric measurement, 8-96
Amplitude Modulation, Contrast, 13-21
Analysis

Stress Echo, 13-345
Anatomical M-Mode

activating, 5-42
overview, 5-41

Angle Correct, adjusting
Doppler Mode, 5-71

Angle Steer, adjusting
Color Flow, 5-52
Doppler Mode, 5-72

Angle, B-Mode generic measurement, 7-31
annotating an image

introduction, 6-25
using typed words, 6-31

Annotation mapping
Breast lesion, 10-52

Annotations Libraries Presets Menu, 10-43, 10-49
annotations, prresets, 10-47
anonymize, 13-371
Anonymize Patient

patient data, 13-371
application presets

selecting, 4-29
user-defined, 10-168

Applications
setting presets, 10-64

Applications Preset Menu, 10-61
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area measurements
ellipse, 7-48
spline, 7-50
trace, 7-47, 7-49, 7-50

AUA
OB worksheet, 7-76

Audio Volume, adjusting in Doppler Mode, 5-73
audio, speakers, 3-9
Auto sequence

using, 7-98
Auto Vascular Calculation, see also Manual Vasuclar 
calculations

activating, 8-76
setting up calculation parameters, 8-76

AutoEF
define the endocardial border, 13-285
Mini Report, 13-294
Results, 13-294
the endocardial border trace, 13-287
Tracking validation, 13-292

B

B Pause, activating, 5-75
B Steer plus, adjusting, 13-7
backing up data

EZBackup/Move, see EZBackup/Move, using
Backup and Restore preset, 10-19
Backup and Restore Preset Menu, 9-27
Baseline, adjusting

Color Flow, 5-51
Doppler Mode, 5-76

Battery status, 3-18
Battery, refresh, 3-22, 13-508
B-Flow Color, 5-32
biological hazards, 2-9, 2-11
Bladder volume, measuring, 8-85
B-Mode imaging

intended uses, 5-2
optimizing, 5-2
scanning hints, 5-4
typical exam protocol, 5-3

B-mode measurement
Echo Level, 7-52

B-Mode measurements
Gynecology exam, 8-54

B-Mode measurements, general, 7-45
B-Mode measurements, generic

% Stenosis, 7-24
A/B Ratio, 7-32
Angle, 7-31
Volume, 7-26

B-Mode measurements, mode
circumference and area (ellipse), 7-48
circumference and area (spline trace), 7-50
circumference and area (trace), 7-49
distance, 7-46

body pattern application libraries, selecting, 10-62

Body Patterns, 6-33
General tab, 10-59

Body Patterns Preset Menu, 10-59
Breast lesion

Annotation mapping, 10-52
Buttons screen

Connectivity, 10-107

C

Calculations
selecting, 7-12

calculations
OB worksheet, 7-77
urology, 8-84

calipers, description, 7-15
Capture Recon., B-Flow, 6-12
Capture, B-Flow, 5-30
Care and maintenance

cleaning the system, 12-22
footswitch, 12-23
operator controls, 12-23
system cabinet, 12-22

inspecting the system, 12-17
maintenance schedule, 12-19

Caution icon, defined, 2-3
CF/PDI Auto Sample Volume, adjusting, 5-58
CF/PDI Center Depth, adjusting, 5-58
CF/PDI Frequency, adjusting, 5-59
CF/PDI Vertical Size, adjusting, 5-50
CF/PDI Width, adjusting, 5-49
Change the display format, 3-81
CINE capture, 6-11

Enhancement, 6-13
CINE loop

previewing only, 9-8
storing and previewing, 9-7
storing without previewing, 9-7

CINE mode
introduction, 6-3
synchronizing loops, 6-7
using, 6-6

circuit breaker
description, 3-41

circumference measurements
ellipse, 7-48
spline, 7-50
trace, 7-47, 7-49, 7-50

Clinical
calculation accuracy, 12-11
measurement accuracy, 12-8

Coded Harmonic Angio, Contrast, 13-21
Coded Harmonic Imaging (CHI), activating, 5-14
Color Flow imaging

intended uses, 5-44
M-Mode, 5-62
optimizing, 5-44
Power Doppler, 5-60
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colorizing an image, 5-23
comments, see annotating an image
Compare Assistant

Control, 13-183
Set up, 13-181
Workflow, 13-180

Compression, 5-77
Connectivity

Buttons, 10-107
configuring, 10-83
overview of screens, 10-83
presets, 10-83
TCPIP, 10-85

console
left side view, 3-6
right side view, 3-6
transporting, 3-55
wheels, 3-52

contacts
clinical questions, 1-7
Internet, 1-7
service questions, 1-7

Contious Capture
Stress Echo, 13-334

contraindications, 1-6
Contrast Imaging

overview, 13-19
Control Panel

description, 3-58
controls

annotation function, 3-70
display function, 3-69
key illumination, 3-61
keyboard, 3-62
measurement function, 3-70
mode function, 3-69
operator, 3-58
print function, 3-69
probe keys, 3-46
Touch Panel, 3-66

CUA
OB worksheet, 7-76

Curved Anatomical M-Mode, 5-43
CW Doppler

activating, 5-87
exiting, 5-88
non-imaging, 5-86
overview, 5-85
steerable, 5-85

D

D/S ratio, 7-41
Data Transfer, description, 4-5
dD Ratio, pediatric measurement, 8-97
Depth, adjusting, 5-5
device labels, 2-41
devices

acceptable, 2-36
disinfecting probes, 11-26
disinfecting solutions, probes, 11-26
distance measurement

general, 7-46
Doppler Auto Calc Average Cycle, using, 7-58
Doppler measurements, generic

A/B Ratio, 7-42
D/S ratio, 7-41
Heart Rate, 7-41
Pulsatility Index (PI), 7-39
Resistive Index (RI), 7-40

Doppler measurements, mode
TAMAX and TAMEAN, 7-55
time interval, 7-54
velocity, 7-53

Doppler Mode
generic study, 7-37

Doppler Mode, general measurements, 7-53
Doppler Mode, PW

intended uses, 5-64
optimizing, 5-64
typical exam protocol, 5-65

dual image mode, see split-screen imaging
Duplex mode, activating

B-Mode/Color Flow, 5-75
Dynamic Range, adjusting

B-Mode, 5-21

E

E Map, Elastography, 5-95
ECG Trace, 13-367
Echo level measurement, 7-52
Edge Enhance, adjusting, 5-23
editing

patient information, 4-26
user-defined calculations, 7-110

EFW growth percentile
OB worksheet, 7-77

E-Index
Elastography measurement, 5-99

Elastography
Typical Exam Protocol, 5-96

Elastography, 2D measurement, 5-98
electrical

configurations, 3-3
electrical hazard, 2-9
electromagnetic compatiblity (EMC), 2-14
ellipse measurement, general, 7-48
EMC (electromagnetic compatiblity), 2-14
End diastole (ED)

OB/GYN vessel measurement, 7-43
Endometrium thickness (Endo), GYN exam, 8-55
Enhancement, 6-13
environmental requirements, 3-4
equipment safety, 2-9
Erasing
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measurements, 7-13
E-Ratio

Elastography, 5-98
exam

definition of terms, 7-11
deleting, 4-27
workflow, 7-11

External Video Converter, 13-510
EZBackup/Move, using, 9-36

F

Fast Key, 6-42
Federal law (USA), requirements, 1-6
Fetal growth bar graph, 8-17, 8-26
Fetal growth curve graph, 8-17

description, 8-19
multiple fetus, 8-31
quad view, 8-21
selecting, 8-20

Fetal trending
fetal growth curve graph, 8-23
multiple fetuses, 8-34

Fetus
entering number of, 8-28
selecting on an OB worksheet, 7-76

Fetus Compare
multiple fetus, 8-31

Flash Suppression, adjusting, 5-57
Flow Volume, 7-61
focal zone, see Focus, adjusting
Focus, adjusting, 5-7
folders, measurement

adding, 7-100
Follicle measurements, GYN exam, 8-55
Footswitch, 13-513
Frame Average, adjusting

B-Mode, 5-24
Color Flow, 5-55

freezing an image, 6-2
Frequency, adjusting, 5-15
FV, 7-61

G

Gain, adjusting
B-Mode, 5-6
Color Flow, 5-47

Gels, coupling, 11-31
General imaging

changing presets, 10-39
generic studies and measurements, 7-22
Generic study

Doppler mode, 7-37
GYN exam

endometrium thickness, 8-55
follicle measurements, 8-55
ovaries measurements, 8-56

uterus measurements, 8-56
Gynecology exam, 8-53

B-Mode measurements, 8-54

H

hazards, 11-23
biological, 11-12
electrical, 11-15
mechanical, 11-14

hazards, safety symbols, 2-4
hazards, types

biological, 2-9, 2-11
electrical, 2-8, 2-9
mechanical, 2-8

Heart Rate
Doppler generic measurement, 7-41
M-Mode generic measurement, 7-36

Hip Dysplasia, pediatric measurement, 8-94
HRes, Contrast, 13-21

I

Image acquisition
Stress Echo, 13-328

Image History, description, 4-5
images

deleting, 4-27
recalling from clipboard, 9-18
reviewing, 9-11

Imaging presets, changing
General, 10-39

Imaging presets, overview, 10-36
information, requesting, 1-7

K

keyboard
special keys, 3-62

L

left side view, console, 3-6
Libraries Preset Menu, 10-56
Line Density Zoom, adjusting B-Mode, 5-22
Line Density Zoom, adjusting Color Flow, 5-53
Line Density, adjusting

B-Mode, 5-22
Color Flow, 5-53

log on procedures
defining, 10-138

LOGIQ system
contraindications, 1-6

LOGIQView, 13-4
Logon

Admin screen, 10-138
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M

managing images
media handling tips, 9-59

Manual Vascular Calculation, 8-81
Map values, changing, 5-25
Measurement

Tool
Copy, Past&Move, 7-17

Measurement & Analysis screen
accessing, 7-89, 8-35

measurement controls, location, 7-6
Measurements

erasing, 7-13
general instructions, 7-14

measurements, general, 7-4
measurements, generic

overview, 7-22
measurements, using

adding, 7-100
automatically starting in workflow, 7-98
calipers, 7-15
changing, 7-99
deleting, 7-113
selecting in different category, 7-8

Minimum diastole (MD)
OB/GYN vessel measurement, 7-43

M-Mode
CAMM, 5-43

M-Mode imaging
color flow, activating, 5-63
intended uses, 5-38
optimizing, 5-38
scanning hints, 5-40
typical exam protocol, 5-38

M-Mode measurements, generic
% Stenosis, 7-34
A/B Ratio, 7-35
Heart Rate, 7-36

M-Mode measurements, mode
time interval, 7-67
tissue depth, 7-66

M-Mode, general measurements, 7-66
Mode Cursor, displaying

B-Mode, 5-17
monitor

speakers, 3-9
moving the system, 3-53

during transport, 3-55
wheels, 3-52

Multiple fetuses, 8-28
fetal trending, 8-34
identifying, 8-29
on OB worksheet, 8-32

My Desktop
set up, 3-79

N

new patient
scanning, 4-15

O

OB
graph, 8-17
identifying multiple fetuses, 8-29

OB graphs, 8-17
fetal growth bar graph, 8-26
patient data, 8-25
viewing, 8-18

OB mulitgestational, 8-28
OB worksheet

AUA, 7-76
calculations, 7-77
CUA, 7-76
EFW growth percentile, 7-77
multiple fetuses, 8-32
patient data, 7-76
selecting ultrasound age, 7-76

OB/GYN vessel measurements, 7-43
acceleration, 7-43
acceleration time, 7-43
end diastole, 7-43
minimum diastole, 7-43
peak systole, 7-43

Operator controls, 12-23
optimizing images

B-Mode, 5-2
Color Flow, 5-44
Doppler, PW, 5-64
M-Mode, 5-38

options
system, 10-134

ovaries, measurement, 8-56

P

Packet Size, adjusting, 5-58
password, protecting, 3-32
past exam

entering patient data, 8-24
Patient data

OB graphs, 8-25
OB worksheet, 7-76

patient data
deleting, 4-27
searching, 4-20

patient exam
reviewing, 9-10

patient list
entering, 4-19
printing, 4-13

patient safety, 2-6
Patient Screen
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active images, 4-5
Data Transfer, 4-5
Image History, 4-5

Peak systole (PS)
OB/GYN vessel measurement, 7-43

Peak systole/end diastole ratio, Doppler generic 
measurements, 7-41
pediatric exam

calculations, 8-92
pediatric measurements, types

alpha HIP, 8-96
dD ratio, 8-97
hip dysplasia, 8-94

peripherals
connector panel, 3-10
connector panel illustration, 3-11

peripherals, digital
setting up, 9-73

Phantoms, 12-36
Plot Both, fetal trending, 8-23
Plot Control

vertical auto scaling, 13-92
Position, adjusting color, 5-49
Power, 3-27

circuit breaker, 3-41
connection

USA, 3-27
On/Off, 3-29
switch, location, 3-29

power
power up sequence, 3-31
shut down, 3-40

Power Assistant, 13-502
Power Doppler imaging, 5-60
prescription device, caution, 1-6
presets

organizing folders and measurements, 7-94
presets, changing

Anootations/Libraries, 10-43
Body Patterns, 10-56, 10-59, 10-61
Connectivity, 10-83
Imaging, 10-36
System, 10-5

presets, overview, 10-2
previous exam data

entering manually, 8-24
PRF, adjusitng, 5-23
PRF, adjusting

Doppler Mode, 5-78
print keys

assigning to a device or dataflow, 10-107
Probe handling and infection control, 11-11
probe orientation, 3D.4D imaging

abdominal, 13-107
endocavity, 13-108

Probes
connecting, 3-43

probes

activating, 3-46
cable handling, 3-46
coupling gels

coupling gels, probes, 11-31
deactivating, 3-47
disconnecting, 3-47
disinfecting, 11-26
safety, 11-11
storing, 3-48
transporting, 3-48

probes, using
selecting, 4-30

Prostate volume, measuring, 8-87
prudent use, 2-3
PS/ED or ED/PS Ratio, measuring, 7-41
Pulsatility Index (PI), Doppler generic measurement,
7-39

Q

QAnalysis, 13-67
Drift Compensation, 13-71
Exit, 13-99
generating a trace, 13-82
manipulating the sample area, 13-86
Plot Control, 13-71, 13-74, 13-92
Select Image Range, 13-77
smoothing, 13-93

QAPlot Control
horizontal sweep, 13-93

Quality Assurance, 12-34
baselines, 12-38
frequency of tests, 12-35
Introduction, 12-34
periodic checks, 12-38
phantoms, 12-36
record keeping, 12-49
system setup, 12-40
test descriptions, 12-40
typical tests, 12-35

Quick Angle, adjusting, 5-71

R

real-time 4D imaging
stopping acquisition, 13-133

Record keeping, 12-49
reference images, 3D/4D, 13-105
rejecting low level echos, 5-26
removable media

verifying, 10-110
Renal volume, measuring, 8-86
Render view, 3D/4D imaging, 13-118
Report

Wall Motion Analysis, 13-358
Report Writer report templates, customizing, 13-426
Report Writer reports

activating, 13-406
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creating, 13-405
editing, 13-410
factory templates, 13-409
inserting images, 13-418

Resistive Index (RI), Doppler generic measurement,
7-40
Results window, 7-12
right side view, console, 3-6
rotating an image, 5-26

S

S Map, Elastography, 5-95
S/D Ratio, Doppler measurement, 7-41
safety

electromagnetic compatiblity (EMC), 2-14
equipment, 2-9
hazards, 2-4, 2-9, 2-11, 2-40, 11-12, 11-14, 

11-15
biological, 11-23
smoke and fire, 2-9

labels, 2-41
patient, 2-6

acoustic output hazard
hazard, types

acoustic output, 2-8
electrical hazards, 2-8
mechanical hazards, 2-8
patient identification, 2-6

patient training, ALARA, 2-8
personnel, 2-9
precaution icons, defined, 2-3
precaution levels, defined, 2-3
probes, 11-11

handling precautions, 11-11
sample volume, adjusting

gate position, 5-70
length, 5-70

Scale, adjusting
Color Flow, 5-47

Scalpel, 3D/4D imaging, 13-141
Scan Assistant

Availability, 13-197
Definitions, 13-198
Description, 13-199
Exporting Programs, 13-213
Setting Up, 13-200
Using, 13-207

Scan Assistant Creator
Activating, 13-214
Attributes, 13-229
Features, 13-229
File Handling, 13-216
Help, 13-255
Measurements, 13-243
Overview, 13-215
Programs

Editing, 13-246

Navigating, 13-245
Views, 13-225

Customization, 13-255
Scoring

Stress Echo, 13-347
Sectional view, 3D/4D imaging, 13-117
Sensitivity/PRI, B-Flow, 5-31
service, requesting, 1-7
Shear wave imaging

Activating Shear wave, 5-113
Configuring Shear wave, 5-109
Intended Uses, 5-108
Overview, 5-106
Scanning Hints, 5-133
Shear wave Measurements, 5-126
Typical Exam Protocol (Liver), 5-123
Using Shear wave, 5-122

site requirements, before the system arrives, 3-3
Size, adjusting

Color Flow, 5-49
small parts exam

thyroid measurements, 8-4, 8-5
Smart Stress

Stress Echo, 13-353
Spatial Filter, 13-16
Spatial Filter, adjusting, 5-56
speakers, description, 3-9
Speckle Reduction Imaging-High Detection (SRI-HD) 
see SRI-HD, adjusting
Spectral Doppler, see Doppler Mode, PW
Spectral Trace method, 5-80
Speed of Sound, 5-27
split-screen imaging, 3-69
SRI-HD, adjusting, 5-12
Static 3D imaging, 13-135

acquiring data, 13-135
storage area

location, 3-13
Strain Elastography, 5-89
Stress Echo

create a template, 13-349
study

adding, 7-100
definition, 7-11
deleting, 7-113
generic, 7-22
organizing, 7-94

Sweep Speed, adjusting, 5-40
System

acclimation time, 3-57
system

electrical configurations, 3-3
environmental requirements, 3-4
options, 10-134
power down, 3-40

System Admin
Admin screen, 10-134

System cabinet, 12-22
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System Imaging Preset Menu, 10-14
System Measure Preset menu, 10-16
System presets, changing

General, 10-7
System About, 10-30
System Imaging, 10-14
System Measure, 10-16
System Peripherals, 10-22
System/Backup and Restore, 9-27

System presets, overview, 10-5
System/General Preset Menu, 10-7

T

TAMAX and TAMEAN, Doppler mode measurement
manual trace, 7-55

TCPIP
Connectivity, 10-85

Test Patterns
overview, 10-187

TGC, adjusting, 5-19
Threshold, adjusting, 5-55
Thyroid measurements, 8-4, 8-5
TIC analysis

activating, 13-36
curve fitting, 13-60
exiting, 13-36
overview, 13-35
smoothing, 13-56

TIC Plot Control
horizontal scale, 13-56
line style, 13-56
overview, 13-55
vertical auto scaling, 13-55

Tilt, adjusting, 5-20
Time Gain Compensation, see TGC, adjusting, 5-19
Time interval

Doppler mode measurement, 7-54
M-Mode measurement, 7-67

Timers
Stress Echo, 13-333

Tissue depth, M-Mode measurement, 7-66
Tissue Velocity Imaging, 13-12
Trace Direction, adjusting, 5-80, 5-81
Trace measurement, general, 7-47, 7-49, 7-50
Trace Sensitivity, adjusting, 5-80
Trackball key map, 3-84
Transparency Map, adjusting, 5-56
Triplex mode, activating

B-Mode/Color Flow, 5-75
TVI, 13-15

Spatial Filter, 13-16

U

Ultrasound age
selecting on OB worksheet, 7-76

urology exam, preparing, 7-12

urology measurements
bladder volume, 8-85
prostate volume, 8-87
renal volume, 8-86

USB Quick Save, 9-68
user IDs

defining, 10-137
User label

set up, 3-80
user-defined calculations, editing, 7-110
Users

Admin screen, 10-137
Uterus measurements, 8-56
Utility

System
Backup and Restore, 10-19

Utility screens
Admin, 10-125
connectivity, 10-83

V

Vascular measurements, selecting, 8-82
Vascular worksheets

saving and printing, 7-75, 7-82
vessel summary, 7-80

Velocity, Doppler measurement, 7-53
verifying

removable media, 10-110
Vessel summary, vascular exam, 7-80
Video Converter, 13-509
Virtual Convex, adjusting, 5-18
Visualizations, 13-117
Volume measurement, B-Mode generic 
measurement, 7-26

W

Wall Filter, adjusting
Color Flow, 5-48
Doppler Mode, 5-80

Warning icon, defined, 2-3
wheels, console, 3-52
Width, adjusting

B-Mode, 5-20
word wrap, annotation, 6-31
Worksheet

viewing, 7-68

XYZ

zooming an image
bioeffects, 6-17
introduction, 6-16
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